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1 Help Videos on YouTube

Y ou can view webinars and how-to videos on many of the functions within
ICM on YouTube.

e Li nk to our YouTube Channel.
e Li nk to our Webinar Archives on YouTube.

1 Help Videos on YouTube
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2 Reference Guide

Chapter Contents:
| CM Browser Reference CGuide
| CM Browser - Pro Reference CGui de

Activel CM Ref erence Guide - Create 3D Mol ecul ar Docunents for the Wb
and Power Poi nt

| CM Cheni st Ref erence Guide
|CM-Chemist-Pro Reference Guide
Menu and Tab Reference Guide:
Menu Option Guide

Tab Gui de

2.1 Graphics Reference Guide

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[I CMt Chemi st || CM Pro

For instructions on how to use |CM-Browser to make fully-interactive
3D dlides and publish them in PowerPoint and the web please see the
Activel CM User Cui de. ActivelCM isafree plugin for Windows
PowerPoint and web browsers. Other related tutorials include:

* Graphical Display: Mlecule Representation, Coloring, Labeling
and Annot ati on

e Graphical Selections Tutori al

e Creating Fully Interactive Slides for PowerPoint and the Wb
Tut ori al

2.1.1 Download and Install ICM-Browser

Getting Started: Download and Install
ICM-Browser and Activel CM.

Download |CM-Browser Distribution. Downl oad vi deo

W ndows Li nux

Install ICM-Browser Instructions. MaC

Download Activel CM Distribution. Downl oad vi deo

W ndows Li nux

Install ActivelCM. VBC

2.1.2 How to use the Graphical Display

'; winRef.document.write(str); }
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How to usethe Graphical Display

How to search the PDB. g%aleu vi deo
How to Move a Structure in the Graphical HTM. GUI vi deo
Display. Manual

How to use the Graphics window controls. m% alGUI

How to use the ICM Workspace Panel D;m;alcul vi deo
How to Display a Molecule. g%afwl vi deo
How to Change Protein Representation. g% a|GUI vi deo
How to Change Ribbon Representation. m% alGUI vi deo
How to color wire or xstick carbon atoms. w% a|GUI vi deo
How to Display the Residues Surrounding the HTML. GUI vi deo
Ligand Binding Pocket. Manual

How to remove chain breaks (dotted lines). mm] a|GU| vi deo
How to Color. @%alcul vi deo
How to Change the Color of Molecule HTML GUI vi deo
Representations. Manual

How to Change the Background Color. w% alGUI vi deo
How to Display a Binding Pocket Surface m%aIGUI vi deo
How to (Un)Display Hydrogens. Q%afﬂ vi deo
How to Save an ICM Object. ng%aleu vi deo
How to Save an ICM Project File. E%alcu vi deo
How to Drag and Drop. @%alcu

How to: Right Click Options. g% a|GU|

2.1.2 How to use the Graphical Display




HTML GUI

How to Move Windows. Manual vi deo
How to Arrange Windows D;m;alcul vi deo
2.1.3 How to make Graphical Selections
How to M ake Selections. HTML GUI Manual
How to Select an Object HTML GUI Manual vi deo
How to Select aMolecule HTML. GUI Manual vi deo
How to Select Residues HTML. GUI  Manual vi deo
How to Select Atoms HTML GUI Manual vi deo
How to Make a Spherical Selection. HTML GUI  Manual vi deo
How to Invert a Selection. HTML GUI Manual vi deo
How to Remove a Selection. HTML GUI  Manual vi deo
How to Change the Selection Level and Mode. HTML GUI Manual vi deo
How to Check What is Selected. HTML GUl Manual
2.1.4 How to Convert Proteins, Display Hydrogens
and Ligand Binding Pocket.
Convert Protein, Display Hydrogens and Ligand
Binding Pocket.
How to Convert aPDB Structureinto an ICM HTML GUI vi deo
Object. Manual
How to Display Ligand Binding Pocket. grl\:talGUI vi deo
How to Display Hydrogen Bonds. w:\{t aIGUI vi deo
2.1.5 How to change Graphics Effects
How to change Graphics Effects
How to display the FOG effect. HTML GUI Manual vi deo
How to display side-by-side stereo. HTML GUI  Manual
How to display Anaglyph stereo. HTML GUI Manual
How to toggle full screen mode. HTML GUI Manual vi deo

2.1.3 How to make Graphical Selections




How to adjust perspective. HTML GUI Manual

How to change the lighting. HTML GUJ  Manual vi deo
How to display sketch accents. HTML GJ  Manual vi deo
Is-'gn(/:ﬁo display elegant ribbon and ligand HTM. GUI Manual vi deo

2.1.6 How to add Labels and Annotations

How to add Labels and Annotations

How to Label Residues. HTML QU Manual vi deo
How to Label Atoms. HTML GUI Manual vi deo
How to Label Variables. HTML GUI Manual vi deo
How to Display and Undisplay Sites. HTML GUI Manual
&Omé?ai“{'oiks_a”d Display Sites HTM. GU Manual

How to Make and Display 2D and 3D Labels. HTML GUI Manual vi deo

2.1.7 How to Make High Quality Publication

Images

How to Make High Quality Publication mages

How to Toggle High Quality Display HTML GUI Manual vi deo
How to Toggle Antialiasing. HTML GUI Manual vi deo
How to Copy Image to ClipBoard HTML GUI Manual vi deo
How to Write an Image. HTML GUI Manual vi deo
(I—)Ig\t/ivotr?s.UsetheAdvanced Write Image HTM. QU Manual vi deo
How to Add an Image to the ICM Photo Album. HTML GUI Manual vi deo

2.1.8 How to Superimpose Protein Structures.

How to Superimpose Protein Structures.

How to Superimpose Two or More Protein HTM. QU Manual

Structures. video
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2.1.9 How to Measure Distances and Angles.

How to M easure Distances and Angles.

How to Measure Distances Between Two Atoms. Hml—r'\]/t a|GU| vi deo
How to Measure Distances From One Atom to HTML GUI vi deo
Many. Manual

How to Show Corresponding Distancesin Two HTML GUI vi deo
Objects. Manual

. HTM. GUI ;

How to Display the Ruler Bar. Manual vi deo

2.2 ICM-Browser-Pro Reference Guide

NOTE: ICM-Browser-Pro contains all the featuresin |ICM-Browser. Click
her e for the ICM-Browser Reference Guide.

2.2.1 Download and Install ICM-Browser-Pro

Getting Started: Download and Install
ICM-Browser-Pro

Download |CM-Browser-Pro Distribution. Downl oad
Install ICM-Browser-Pro. VN\ggdoms Li nux

2.2.2 Graphics

Graphicsand Movie Making
HTM. GUI
How to generate the shadow effect. Vanual
; HTM. GUI
How to make a screenshot movie. Manual
. . HTM. GUI
How to make a movie from a set of dlides. Manual
How to move a molecule independently of the other HTML. GUI
display objects (Connect). Manual
2.2.3 Protein Structure Analysis
Protein Structure Analysis
How to calculate contact areas between molecules. HTML GUI Manual
How to identify closed cavities. HTML GUI Manual

2.1.9 How to Measure Distances and Angles.



How to calculate surface area.

HTML GUI Manual

How to generate interactive Ramachandran plots.

HTML GUI Manual

2.2.4 Surfaces

Surfaces
How to generate el ectrostatic and binding property HTML GUI
surfaces. Manual
HTML GUI
How to connect and rotate/trand ate surface (mesh). MVanual
HTML GUI
How to crop a mesh/surface. Manual
HTML GUI
How to save a mesh/surface. Manual
2.2.5 Superimpose Proteins
Superimpose Proteins
How to superimpose proteins based on 3D by visible HTML GUI
atoms, C-alpha, backbone or heavy atoms. Manual
How to superimpose multiple proteins based on aligned HTML GUI
residues.. Manual
2.2.6 Crystallographic Tools
Crystallographic Tools
How to contour electron density. HTML GUI Manual
How to display crystallographic cell. HTML GUI Manual
How to display crystallographic symmetry. HTML GUI Manual
How to convert x-ray density to agrid. HTML GUI Manual
2.2.7 Sequence Analysis
Sequence Analysis
- HTML GUI
How to annotate an alignment - box and shade. Manual
. . HTML GUI
How to annotate an alignment with text. Manual
. . . HTML GUI
How to display secondary structure in an alignment. Manual
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. HTML GUI
How to extract sequences from pdb files. Manual
; HTML GUI
How to assign secondary structure. Manual
. . HTML GUI
How to link sequence, alignments, and structures. Manual
How to save asimage, print, and delete sequences and HTML GUI
alignments. Manual
2.2.8 Plotting Tools
Plotting Tools
Make fully interactive colorful X-Y plots and HTML GUI
histograms with up to 4 dimensions. Manual
. . HTML GUI
Save plot and histogram as image. Manual

2.3 ActivelCM Reference Guide - Create
3D Molecular Documents for the Web and
PowerPoint

This guide is focused on how to make fully interactive 3D documents
for Windows PowerPoint and the Web. For more information on the other
featuresin ICM-Browser please seethe | CM Br owser User Gui de.

Creating 3D Documents Is Straightforward

Creating fully interactive 3D documents for PowerPoint, the web, and
standalone browser is straightforward.

1. Downl oad ICM-Browser and the Activel CM plugin. They are completely
free! [vi deo]

2. Open the ICM-Browser and make a series of animated
fully-interactive slides showing different colored and rendered
views of your molecules. [vi deo]

3. Add hyperlinked HTML t ext to annotate and link to your slides.

[vi deo]

4. Saveyour filein ICM-Browser and then insert into Power Poi nt or
theweb using the Activel CM plugin. Y ou can also share your
documentsin the standalone ICM-Browser. [vi deo - power poi nt ]
[vi deo -web browser]

'; winRef.document.write(str); }

2.3.1 Getting Started

Getting Started: Download and Install
ICM-Browser and Activel CM.

Download |ICM-Browser Distribution. Downl oad

vi deo

2.2.7 Sequence Analysis
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Install ICM-Browser Instructions.

W ndows Li nux
Mac

Download Activel CM Distribution. Downl oad vi deo
- W ndows Li nux
Install ActivelCM. VBC
2.3.2 How to Create a Series of
Fully-Interactive 3D Slides.
Creating Slides How to Create a Series of vi deo
Fully-Interactive 3D Slides.
. . HTM. GUI
How to Make Fully Interactive 3D Slides Manual
. . HTM. GUI
How to Animate Slides Manual
. . L HTM. GUI
How to View and Navigate Slidesin the ICM-Browser. Manual
I HTM. GUI
How to Edit Slides. Manual
How to Add Smooth Blending and Transition Effects HTM. GUI
Between Slides. Manual
2.3.3 How to Create Molecular Documents
How to Create Molecular Documents:. Linking Slides to vi deo
HTML Text.
HTM. GUI
How to Create an HTML Document. Manual
' HTM. GUI
How to Edit an HTML Document. Manual
How to Make a Hyperlink Between HTML Text and a HTML GUI
Slide. Manual
2.3.4 How to Display Molecular Documents in
PowerPoint
How to Display Molecular Documentsin Power Point vi deo
N : HTM. GUI
How to Embed in Microsoft PowerPoint 2003 Manual
P - HTM. GUI
How to Embed in Microsoft PowerPoint 2007 Manual
. : . HTM. GUI
How to Use Activel CM in PowerPoint Manual
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How to Change Activel CM Component Propertiesin HTM. GUI
PowerPoint Manual
Advanced use of Activel CM: Macrosto direct HTML GUI
visualisation changes. Manual

2.3.5 How to Display Molecular Documents on the

Web
How to Display Molecular Documentsin Web Browsers vi deo
How to Display Molecular Documentsin Web Browsers HTML GUI Manual

2.4 ICM-Chemist Reference Guide

2.4.1 How to Import, Sketch, and Edit Chemicals
How to Import, Sketch, and Edit Chemicals
How to load the ICM Molecular Editor. II\-g%alClJl vi deo
How to sketch chemicals in the ICM Molecular HTM. GUI vi deo
Editor. Manual
How to save a 2D sketch into a chemical HTM. GUI vi deo
spreadsheet. Manual
How to save a 2D sketch in mol format. w%aleul vi deo
How to use SMILES strings to sketch a chemical. Hgg/lulél Gul vi deo
How to load amol, sdf or mol2 file. g%alcbl vi deo
How to extract a 2D sketch of aligand in HTML GUI vi deo
complex with a PDB structure. Manual

2.4.2 How to Work with Chemical Spreadsheets
Working with Chemical Spreadsheets
How to add columns into a chemical HTML GUI vi deo
Spreadsheet. Manual
How to sort acolumn(s) in achemical HTM. GUI vi deo
Spreadsheet. Manual
How to change the view of achemical HTML GUI vi deo
spreadsheet - form, table and grid. Manual

2.3.4 How to Display Molecular Documents inPower Point 13




How to copy, cut and paste columns and rowsin

HTM. GUI

achemical spreadsheet. Manual video
How to show and hide columns and rowsin a HTML GUI vi deo
chemical spreadshest. Manual
How to save achemical spreadsheet in sdf HTML GUI vi deo
format. Manual
How to export your chemical spreadsheet into HTML GUI vi deo
Excel. Manual
How to print a chemical spreadshest. ur,\{t aIGUI vi deo
How to filter columnsin a chemical HTML GUI vi deo
Spreadsheet. Manual
How to use find and replace in a chemical HTM. GUI vi deo
Spreadsheet. Manual
How to mark and label rowsin achemical HTML GUI vi deo
Spreadsheet. Manual
How to insert hyperlinksto the PDB, PubMed, HTML GUI vi deo
and Uniprot. Manual
How to copy and paste 2D chemicals. g% aIGUI vi deo
How to edit data inside a chemical HTML GUI vi deo
spreadshest. Manual
How to remove salts, explicit hydrogens and HTML GUI vi deo
standardize chemical groups. Manual
How to calculate chemical propertiesin a HTML GUI vi deo
chemical spreadshest. Manual
How to identify duplicate chemicalsin a HTM. GUI vi deo
chemical spreadshest. Manual
How to compare two chemical spreadsheets. grl\l/t alGUI vi deo
; HTML GUI :
How to merge two chemical spreadsheets. Manual vi deo
2.4.3 How to Undertake a Chemical Search
How to Perform Chemical Searching
. HTM. GUI :
How to setup a chemical search. Vanual vi deo
; HTM. GUI :
How to draw a chemical search query. Manual vi deo
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HTML GUI

How to add conditions to your chemical search. Vanual vi deo
How to search chemical spreadsheets, local HTML GUI vi deo
databases and Mol Cart. Manual
How to send a chemical search query. g%alc’l‘" Vi deo

2.4.4 How to Work with Pharmacophores
How to Work with Phar macophores
How to draw 2D pharmacophore. ng—r'\]/t a|GUI vi deo
How to search a 2D pharmacophore. g% a|GUI vi deo
How to draw 3D pharmacophore. g% aIGUI vi deo
How to extract a 3D pharmacophore from a HTML GUI vi deo
ligand. Manual
How to edit a 3D pharmacophore. ur'\]/t aIGUI vi deo
How to send a 3D pharmacophore search query. Hmjr'\]/t alGUI vi deo
How to color a2D chemical sketch by HTML GUI vi deo
pharmacophore feature. Manual

2.4.5 How to Perform Chemical Clustering
How to Perform Chemical Clustering
How to perform chemical clustering. :\—g% a|GUI vi deo
How to select representative centers from a HTM. GUI vi deo
tree. Manual
How to reorder branches and change the HTM. GUI vi deo
distance of trees. Manual
How to edit the tree - l1abels, spacing and HTM. GUI vi deo
coloring. Manual

2.4.6 How to Generate Stereoisomers and

Tautomers

2.4.3 How to Undertake a Chemical Search 15




How to Generate Stereocisomersand Tautomers

How to generate stereoisomers. HTML GUI Manual vi deo

How to generate tautomers. HTML GUI Manual vi deo

2.4.7 How to Generate Combinatorial Libraries

How to Generate Combinatorial Libraries

. HTM. GUI :
How to enumerate a Markush library. Manual vi deo
How to decompose alibrary based on a Markush HTML GUI vi deo
structure. Manual

HTM. GUI ;
How to create a Markush structure. Manual vi deo
How to enumerate a chemical library by HTML GUI vi deo
reaction. Manual
2.4.8 How to Generate Plots and Histograms

How to Generate Plots and Histograms
How to make a histogram. HTML GUI Manual vi deo
How to make an X-Y scatter plot. HTML. GUI Manual vi deo

2.5 Menu Option Guide

Note: Click Next (top right hand corner) to navigate through this
chapter. Headings are listed on the |eft hand side (web version) or
by clicking the Contents button on the |eft-hand-side of the help
window in the graphical user interface.

Here we describe al the options in the drop down graphical user
interface menus.

€3 pep Molsoft irm 3 7 7= Mhi—.nooiooedn id Leooad
i Tools Homology Chemistry Docking MolMechanics  Windows  Hale

I mﬁwEﬁAb%& TE&i
M |22 @lEL R [E ) ()€ | erren@) |

Workspace Panel Menu Options 5 x
|no selection

. F:E&['-(E

2.5.1 File Menu
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2.5.1.1 New

This option alows you to create new peptides, dna, sequences etc... and
isdescribed inthe Cr eat e New Obj ect s chapter.

2.5.1.2 New ICM Session

File/New ICM Session

This option allows you to generate a new clear ICM session or clone the
current one.

2.5.1.3 Open

File/Open
Thisoption is described inthe Open and Read chapter.
2.5.1.4 Open with Password

File/Open with Password
Thisoption is described in the Open and Read chapter.
2.5.1.5 Extract from ICB

File/Extract from ICB

Thisoption is described inthe Open and Read chapter.

2.5.1.6 Convert to Local Database

Please seethe Local Dat abases chapter for more information about this
option.

2.5.1.7 Load

Options contained within the menu File/Load
PDB - read PDB from FTP, http, and local PDB

From Multiple Object File- A multiple object file will have afile
extension *.ob and you can select which member of the multiple object is

displayed.

PFam Alignment - PFam is a collection of multiple sequence alignments -
enter FASTA ID

SwissProt - Download SwissProt sequence.
All Images from Dir - Read into ICM multiple image files png or jpg.

Electron Density Map - Download electron density map from Uppsaa
electron density server htt p: / / eds. bnt. uu. se/ eds/

3D Meshin KMZ or COLLADA Format from Google - see
htt p: // sket chup. googl e. com 3dwar ehouse/ to download KMZ or COLLADA.

2.5.1 File Menu



2.5.1.8 Save Project

Thisisdescribed inthe Save Fi | e chapter.
2.5.1.9 Save Project As

Thisisdescribed inthe Save Fi | e chapter.
2.5.1.10 Save Project Compatible with ICM 3 5

File/Save Project Compatiblewith ICM 3 5

Use this option to save a version of your ICM project compatible with an
older version of ICM. Version 3.5 or older. If you have an ICM license
you can update your version of ICM by visiting our support site at
www.molsft.com/support

2.5.1.11 Save with Password

To save aproject which is protected by a password:

File/Save with Password

Enter afile name or browse for a previously saved project.

Enter a password

Determine whether you want the file to be Fully Protected, read
only or Read Only and Allow Comments.

2.5.1.12 Export as ActivelCM Html

To embed in aweb browser.

1. Download ActivelCM from here

htt p: //ww. nol soft. conl get browser. cgi ?product =acti vei cn&act =l i st
(itisfreel).

Creat e anHTML pagein ICM (File/New/Html).

Add aseriesof sl i des.

File/Export As ActivelCM Html..

PwWN

2.5.1.13 Close Project

To close a project:
File/Close Project
2.5.1.14 Quick Image

SeetheHi gh Qual ity Publication | nage chapter.
2.5.1.15 Write Image

SeetheH gh Qual ity Publication | nage chapter.
2.5.1.16 Preferences

Preferences are described in the Pr ef er ences chapter.
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2.5.1.17 Recent Files
Recently viewed projects and files can be easily downloaded from the
"Recent Files' option. To accessthis:

» Select File/Recent Files.
» Select the desired project by clicking on it once.

2.5.1.18 Recent PDB Codes
Quickly retrieve and display PDB structures that have recently been
viewed.
» Select File/Recent PDB Codes
e Select desired PDB code by clicking on it once and it will be
loaded into the graphical display.

2.5.1.19 Quit

Need to close down ICM - no problem. Y ou do one of the following:
1. Select File/Quit. ICM will quit without saving files.

2. Saveand Click X at the upper right corner of the ICM window.
3. Typequi t inthetermina window.

NOTE: You may want to savetheicm sessionasan| CM Proj ect file
before quiting.

2.5.2 Edit Menu

2.5.2.1 Delete

This option will delete anything that issel ect ed.

2.5.2.2 Delete All

This option will delete everything e.g. sequences, structures, tables
... Use with carel

2.5.2.3 Select All

This option will select everything e.g. sequences, structures, tables...

2.5.2.4 Search in Workspace

This option alow you to search for a particular text in the workspace

2.5.2.5 Selection

This option alows you to make a precise selection either by neighbors
or specifying a particular atom or neighbor. Click on the tabsto jump
between selection levels.

2.5.2.6 Invert Selection

This option will select everything that is not currently selected.

2.5.1 File Menu
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2.5.2.7 Clear Selection
This option will remove all selections. For more information on
selections seethe Maki ng Sel ecti ons Chapter.

2.5.2.8 Neighbor Selection

This option will allow you to select neighboring atoms. For more

information seethe Sel ect Nei ghbor s section in the Selections Chapter.

2.5.2.9Undo

Due to the complexities of working in an internal coordinates
environment not everything can be undone or redone. Certain things like
coloring and representations can be undone or redone.

2.5.2.10 Redo

Due to the complexities of working in an internal coordinates
environment not everything can be undone or redone. Certain things like
coloring and representations can be undone or redone.

2.5.2.11 Restore Recent Backup

ICM periodically makes a backup of your ICM project. If for whatever
reason you lose an ICM session and you want to load the backup for the
fileuse:

Edit/Restor e Recent Backup

2.5.2.12 PDB Search

See PDB Search Tab
2.5.2.13 PDB Search by Field

SeePDB Search Tab
2.5.2.14 PDB Search by Identity

See PDB Search Tab
2.5.2.15 PDB Search by Homology

See PDB Search Tab
2.5.2.16 PDB Search with External Segeuence

See PDB Search Tab
2.5.2.17 Ligand Tools

See the ligand editor section of the manual.
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2.5.2.18 Ligand Editor Preferences

See the ligand editor section of the manual.

2.5.3 View Menu

View Menu

Wiew Bioinfo Toolz Homology Chemistiy

-
=
=

Progrb0l @

Undisplay Al

Clear Dizplay and Flanes

Selection Level »
Selection Mode 3
Fog Cirl+D
Side-by-Side Steren Chl+5
Hardware Steren Alt+5
Full-screen A+
Perspective Chrl+a&k+P

Full Scene Antialias Chrl-+ale+,
High Quality

EasyRotate

Shadows

Anirnate WView 3
Drag Res Labels [MdME]
Antislias Lines

Calar Background

Save Viewpoint...

Center

Electrostatic Potential...

tacro Shape...

Select by Purple 30 Box

2.5.3.1 Undisplay All

View Buttons

.
B aEHODA@s & =

o+ Clipping tools

e (] |

Clip meshes —#%&
(% Lock mesh clipping

Toundisplay everything currently displayed in the graphical display

* View/Undisplay All

Note For more details on displaying structures please see the GUI
Over vi ew chapter.

2.5.3.2 Clear Display & Planes

Toclear thedisplay and planes

* View/Clear Display and Planes

NOTE: For more details on planes please see the sectionson cl i ppi ng
t ool s and mesh cl i ppi ng.

2.5.2 Edit Menu
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2.5.3.3 Selection Level
There are four levels of selection - atom, residue, molecule and object.
For more details on selections please see the Maki ng Sel ect i ons section.
2.5.3.4 Selection Mode
There are four different ways to make selections - new, add, remove and
toggle. For more details on selections please seethe Maki ng Sel ecti ons
section.
2.5.3.5 Fog
Fog Toggle(Ctrl + D) : this feature creates afog-like environment for
your object, so that the part of your structure that is closer appears
clear and the distant parts are faded asif they arein fog. The
cli ppi ng pl anes control the point at which the fog begins.
* View/Fog
2.5.3.6 Side-by-Side Stereo
Side-by-side stereo toggle(Ctrl + S) : this feature allows you to view
your structure in 3D form without any 3D goggles.
* View/Side-by-Side Stereo
2.5.3.7 Hardware Stereo
Hardwar e ster eo toggle(Alt + S) - if you have 3D goggles and you wish to
view your structure in 3D form, this feature will allow you to do so.
* View/Hardware Stereo
2.5.3.8 Full Screen
Full screen toggleAlt F - this makes your graphical display fill the
entire screen. If you wish to exit this mode, press escape.
» View/Full Screen
2.5.3.9 Perspective
Toggle perspective Ctrl_P thiswill add perspective to your structure,
enhancing depth in the graphical display.
* View/Perspective
2.5.3.10 Full Scene Antialias
Anti-aliasing is the technique of minimizing the distortion artifacts
known as aliasing when representing a high-resolution signal at alower
resolution. Always use this option before making hi gh resol uti on i nmages.

* View/Full Scene Antialias
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2.5.3.11 High Quality

Toggle High Quality: this option will give your ICM object better
resolution and higher quality. The change in quality is most visible at
a high magnification. However, if your object isvery large, this
feature could slow down your program.

Always use this option before making hi gh resol uti on i mages.

* View/High Quality
2.5.3.12 Easy Rotate
Toggle easy rotation: thisfeature is necessary if your structureis
very large or perhaps your computer cannot quickly r ot at e it. It will
prevent your structure from fully loading each time you rotate it,
therefore speeding up the process.

* View/Easy Rotate

2.5.3.13 Shadows

* View/Shadows
See Gr aphi cs Ef f ect s chapter.
2.5.3.14 Sketch Accents
To make images as shown below use:
» View/Sketch Accents
See G- aphi cs Ef f ect s chapter.
2.5.3.15 Animate View

Thistool is described in more detail inthe Mbl ecul ar Ani nati ons and

Transi ti ons section.

2.5.3.16 Drag Res Labels

To changethelocation of your residue label:

» Select View/Drag reslabels.

« If your mouse has a middle mouse button, then click on handle (as
shown) of the label you wish to move, and drag it to your desired

area.
Click on q
this area — -~
to drag

your

label.

* If your mouse does not have a middle mouse button, then click on

the Tranglation icon on the toolbar, and click on the handle (as

shown) of the label you wish to move, and drag it to your desired

area

The +/- buttons on the side of the Residue and Atom buttons will shift
the label. There are also other residue label move options available

2.5.3 View Menu
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when you click and hold the residue label button. These options include
Shift to Sidechain Tips, Shift to Calphas, and Restor e Positions

2.5.3.17 Antialias Lines
Use this option to activate antialias lines. It is recommended to leave
this option selected.

* View/AntidiasLines

2.5.3.18 Color Background

To change the background color

» View/Color Background
» Select acolor from the panel and press OK.

Thisoption is also in the more convenient di spl ay t ab.

2.5.3.19 Save Viewpoint

It is possible to store a current view using the button shown below.

B e EHDO K| =

Store Current View

Click on the button and the current view will be stored so that you can
view it later. A data entry box will be displayed asking you to name the

view. All stored views can be found in the ICM workspace as shown below.

=@ views (5 items)
¢ wiew_ligand_docked
~iew_hinding_site

~iew_hinding_patch

» Double click on the view in the ICM Workspace to display it.

A number of view display options are available by right clicking on the
view in the ICM workspace as shown below.

@ views (G items)
¢ ewview_ligand_docked

P e . Select
fview_binding_site e

Lview Set View
E----ViEWE Set View Smoath

: Leigw_binding_patch % Delat
[l abjects (1 items) =EE
- oBlicm  Ray 150 Aename |

Store current view right click menu

The option in the right click menu called "set view smooth" returns to
the view slowly showing the trajectory between the original view and the
current one.
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2.5.3.20 Center

To center on an object displayed in the graphical display

* Make a selection on the region on which you wish to center on.
» Tools/Center (or usethe cent er button on the right hand-side of

the graphical display).
2.5.3.21 Electrostatic potential

This option generates the skin representation of the molecular surface
colored according to the electrostatic potential calculated by the REBEL
method (hydrogen atoms are ignored). REBEL is a method to solve the
Poisson equation for amolecule. REBEL is a powerful implementation of
the boundary element method with analytical molecular surface as
dielectric boundary. This method is fast (takes seconds for a protein)

and accurate. REBEL stands for Rapid Exact-Boundary EL ectrostatics. The
energy calculated by this method consists of the Coulomb energy and the
solvation energy

In order to color the skin of your molecule by electrostatic potential:

» Select View/Electrostatic potential.

» Enter the potential scale value. Thisisthelocal electrostatic
potential in kcal/e.u.charge units at which the surface element is
colored by extreme red or extreme blue. All higher values will
have the same color. This absolute scaling is convenient to
develop afeeling of electrostatic properties of molecular
surfaces.

 Areas colored blue represent positive areas and red represents
negative areas.

2.5.3.22 Macro Shape

A macroshape allows easy viewing and manipulation of a structure. A
macroshape representation isideal for large structures which allows the
user to easily identify important regions of the structure and

facilitate the return to the ' standard’ view of a particular molecule.

The level of detail displayed in the macroshape can be controled by
changing the number of harmonics, gridStep, and, contour level.

2.5.3 View Menu
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* View/Macro Shape
2.5.3.23 Select by Purple 3D Box
An dternative way to make a make-selection{ selection} isto use the
purple 3D box. To do this:

» Select the display tab and the purple box button

» View/ Select by Purple 3D Box
e The atoms contained within the purple box will be selected.

2.5.4 Bioinfo Menu

Thetoolsin this menu are described in the Bioinfo Menu chapter.

2.5.5 Tools Menu - Xray

The optionsin the menu are described inthe Cr yst al | ogr aphi ¢ Anal ysi s
chapter.

2.5.6 Tools Menu - 3D Predict

The optionsin this menu are described in the 3D Predict chapter.

2.5.7 Tools Menu - Analysis

The optionsin this menu are described inthe Prot ei n St ructure Anal ysi s
chapter.

2.5.8 Tools Menu - Superimpose

The optionsin this menu are described in the Pr ot ei n Super posi ti on
chapter.

2.5.9 Tools Menu - Extras
2.5.9.1 Plot Function

Toplot afunction:

Tools/Extras/Plot Function

Enter the Function(x) eg Sin(x)

Enter the starting value of x (From).

Enter the end point of x (To).

Enter the number of points (N points).

Click OK and your plot will be displayed next to atable of values
for your function.

2.5.10 Tools Menu - Table

2.5.10.1 Build Prediction Model

Learn and Predict tools are described here.
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2.5.10.2 Predict

Learn and Predict tools are described here.

2.5.10.3 Cluster Set

Thisisdescribed inthecl ust er section of the Working with Tables
Chapter.

2.5.10.4 Sort Table

There are a couple of waysto sort achemical table. Y ou can right click

on the a column header and select sor t or you can use the option in the
menu Chemistry/Sort Table.

* Read achemical tableinto ICM.

» Select the columns by which you wish to sort by as shown below.

» Select Ascending or Descending and for each sort by option and
then click OK

9 Sort Table

T able _groups

Sart By |rnu:u| ﬂ v Aszcending i~ Dezcending
Then By |ID>< j ¥ Azcending i~ Dezcending
Then By |h-10|Weight j {* Aszcending i~ Descending

Ok | Cancel

2.5.10.5 Merge Two Sets

To mergetwo tables:

* Read thetwo tablesinto ICM.

* Tools/Table/Merge Two Sets

» Select thefirst table from the drop down list (Table A) and the
column you wish to use to merge the table by.

» Select merge method 1. inner - only molecules present in BOTH A
and B tables are kept; or 2. left ALL rows of A arekept ; or 3.
right ALL rows of B are kept.

» Select the second table from the drop down list (Table B) and the
column you wish to use to mergethe table by.

» Enter aname for the output table.

» Click OK and a new table will be displayed.

2.5.10 Tools Menu - Table



e Merge Two Sets @

Table & ricinligands20_tauto 1 _tauto Ji by Colurnn ral -
o inner " left " nght
Table B | nicinLigandsz2D_tauto j by Calumn mol -
Reszult Mame |T_i0in j
Hint

inner - only molecules present in EOTH & and B tables are kept
left - ALL rows of & are kept
night - ALL rows of B are kept

Ok | Cancel Help

2.5.10.6 Add External Columns

To add external columnsto a table (e.g. based on a merging key):

* Read at least two tablesinto ICM - the table you want to add to
and the table you want to add the column from.

» Toolsg/Table/Add External Columns

» Enter the target table name and the column you wish to match each
table by.

» Enter the source of the new column (Other table and column name)

» Chooseto add "all the columns' from the source or "overwrite
matching columns' or select the columns you want to add by
selecting the "choose column™ option.

» Select the columns you wish to add.

2.5.10.7 Append Rows

To append rows from one table to another one:

* Read at least two tablesinto ICM - the table you want to add to

and the table you want to add the column from.

Tools/Table/Append Rows

Enter the name of the Target Table (where you will append).

Enter the name of the Source Table (where you will append from).
Select whether to Merge Columns

Check whether you would like to Select New Rows. If you do this
you can easily highlight the new rows using themar k r ow opti on.
e Check whether you would like to Calculate Columnswith Formulas.

2.5.11 Tools Menu - Chemical Search

Chemical searching is described in the Chemistry chapter her e.
2.5.12 Tools Menu - Molecular Editor

The molecular editor is described in the Chemistry chapter her e.
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2.5.13 Homology Menu

The optionsin this menu are described in the Homology Modeling Chapter.
2.5.14 Chemistry Menu

Thetoolsin the Chemistry menu are described her e.

2.5.15 Docking Menu

Thetools in the Docking menu are described in the Docking chapter.

2.5.16 MolMechanics Menu

The optionsin this menu are described in the Molecular Mechanics
chapter.
2.5.17 Windows Menu

This menu allows you to choose the windows you wish to display. The
windows which open automatically when you first open GUI are shown in

theGetti ng Start ed section. Other windows can be displayed by selecting

the windows menu. For example, if you have loaded atable but cannot see
it in the GUI it may be because the Tables option in the window menu
hasnt been selected.

To add or remove windows from the GUI display select the 'window menu’.

Other windows not included in the default display such as tables and
alignments can be added.

2.5.13 Homology Menu
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| have windows open everywhere - Please bring some order.

thics | wWindowlz Help
i Drefault Layout I
D Slide Layout
ﬂ i HE Tables->Main
— & dignmentsoan - = \what do you want in the main window?
S‘S 30 Graphics-xMain
v Dizplay Parel
Terrmninal
v Alignments
Where is my Table? ——v Tables
v 3D Graphics
Htrnl Documents
Background jobs
v Workspace Panel
File Operations
Selection Tools
Check and Uncheck —v View Tooks
Graphic Layers — All the buttons

towe Tools

LY

Clip Taols

LIRS %

Misc Tools

To return to the default display option select the ' Default layout’
option in the windows menu.

OR
Click the default layout icon.

EBH Tables->Main
t = Alignments-»Main

$& 2D Graphics->Main Some options can be accessed at the
g Default Layout bottom of the GUI.

D Slide Layout
e—— B
L

oE0 &

2.6 Tab Guide

In this section we describe the contents of the tabs in the graphical
user interface.
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€3 pep Molsoft icm 3.7-2a [NewProject *] (1 object)

File Edit Wi i begpist Docking  MolMechanics  Windows  Help

B EBD AWK TFF1

e [ | m =) |

Workspace Panel 8 x

no selection

“Mowecs| 1ab Options

—[‘IF'[‘I T
“Bm

2.6.1 Display Tab

The display tab containstools for avariety of functionsincluding -
structural r epr esent ati ons, col ori ng, | abel i ng and super posi ti on. This
tab is shown below.

T’T\FB'_‘ "mﬁ(a—rv?r\/—\

H| 221 @l @ff aferdstd | BT 7Y G | WIS Q | A |2 X #fgs | G| S8

2.6.2 Light Tab

Iigh|t tab Save light seftings

S display Yy Tight %y labels "y pdb search " meshes Y movie ™, l

Shine Arnbignt Diffuze Spec Alpha A-Bright * Y o
e oo s ) g

Drag to Change 5etting$ Set default I|ght Settings

The optionsin thistab are described inthe Li ght i ng Secti on.
2.6.3 Labels Tab

Labels Tab

Jeplay " Taght Y Tabek Y pdb search Y meshes Y movie
ol5isols) | ot ]|

Text Labels Distance Labels

The optionsin thistab are described in the | abel s section of this
manual.

2.6.4 PDB Search Tab

Instructions on how to use this tab can be found in the Sear ch PDB
secti on.

2.6.5Ligedit Tab

Instructions on how to use the optionsin this tab can be found in the
How to use the 3D Interactive Ligand Editor section.
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2.6.6 Meshes Tab

Click on the tab button entitled 'meshes’ and three different graphical
display tools are available for you to use. The three displays are
surface, meshes and macroshape and are collectively referred to as
meshes.

§odisplay Y labels Y analysis ¥ pdb zearch ¥ meshes W movie

4’9 ‘ -all - | FF Ma El: step (00 *| W color MacioShape

surfaces meshes macroshape

W wire |

The benefits and applications of each display are described in the
section.
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3 Getting Started

Chapter Contents:

e The Basics of the Graphical User Interface

* How to search and Downl oad Protein Structure, Sequences, and
Chemi cal s

How to create new Objects

How to open files

How to save files

How t o Make Sel ecti ons

Changi ng Preferences

3.1 The Basics of the Graphical User
Interface

Availablein the following product(s): | CM Br owser || CM Br owser - Pr o
[ CM Pro |l CM Chem st

3.1.1 The Components of the GUI

The Graphical User I nterface (GUI) has many components. When you first
use the GUI the default window layout is displayed as shown below.

ol @ W g¥EdEL

B L de | ST U ] sarEre | A o B i | T3] nlgEg”

“Terminal

B B e

3.1.2 How to load a PDB Structure

There are three main waysto read in a PDB file.
1. Using the command line.
2. Using File/Open button
3. Using the PDB Search tab

Other PDB search options are described in more detail inthe PDB Sear ch
section of this manual.
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= Three different ways to load a PDB file. |

O oo BT TR i NGB GEAFe s TTELELL
i\ \ b \/ hes \/ 3o \/ i \

posaanch  »! kb £« [ | odtneadinmodes [ w locapancytispisy [nane =il
s < O T ——

Ineriapane Parel
no selection l Click on the search tab ]

Lo Elebens o] and enter the PDB code

¢ = fxbb 17

LIl s a 2684 5s2

sPasti M d(dme
43 tyrosine-profein ki

e JW (357 water rs

-----

megl P oG o

s W

: icm/ lxbb}undti,spi
i |icm/1lxbb>display Sl
i [icm/lxbb>undisplay residues label Res{a_*.//DD)
i icm/lxbbrread pdp "1xbb"g§ :

J e

Use the command line 7!

BBENR L Db ]

(2@ B0 = 0@ a8 v

3.1.3 How to Move a Structure in the Graphical
Display

Available buttons and options for moving molecules around the graphical
display window. Thisis described in more detail in the section entitled
Move Buttons.
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How to use the Graphics window controls

In the graphics window you can use varioust ool s described elsewhere but
it is helpful to know the following things:

e Picking atool: the left mouse button will function according to
the selected tool

» Popup menus: right click on an atom gives a pop-up menu

e Sdlecting in therotation mode: the right mouse button will select
atoms

» Trandatingin the rotation mode: the middle mouse button will
trans ate the scene

» Zooming and moving clipping planesin therotation mode: the | eft,
top and right margins of the graphics window are reserved for
other actions, zoom, z-rotation, and clipping plains,
respectively. That means that even if you are picking atoms, by
pressing control you can still rotate your molecule with the
left-mouse-button.

* Rotating in any non-rotation mode: if you press Control in any
mouse mode, e.g. zoom, pick etc., it will temporarily switch to
rotation

» Escaping from the connect and continuous movement modes: pressing
Escape helpsto get out of certain modes, such as Full Screen,
Continuous rotation or rocking, the Connect mode.

» Global rotation in the Connected mode: pressing Shift will
temporarily switch to the global rotation/translation mode.

3.1.4 How to Display Molecules using the ICM
Workspace Panel

The workspace panel (located on the left hand side panel of the gui) is

an important place within the graphical user interface because it

displays which sequences, structures, objects, tables and alignments are
currently loaded into ICM. From the ICM Workspace panel you can make
graphical selections and display and undisplay molecules.

3.1.3 How to Move a Srructure in the Graphical Display



548 106 Atoms 23 Res.1 Mol 4=

SR ® Jobjects (1 itemns)

]

Selected atoms and

residues
J==sgquences (2 items)
+-cfihd  len=77 Amino
R [en=86 Amino
Workspace ¥ alignments (1 items) |
anel |D=23% pP=27
P LEE fgbles R iterpns) Expand here for more
_ i PDBSearchResults 13 | information.

| |
1% | =+ | 8@ ||

Al
Display all J \— Tables

Objects —— Alignments

Sequences

Once a structure has been loaded into ICM the individual components of
that structure (i.e. amino acids, metal ions, binding sites etc) are
listed in the ICM workspace.

To display every component of the object except for binding sites and
water atoms:

 Click on the white box next to the word object at the top of the
ICM workspace. This box will be colored blue once the structureis

displayed
no selection

Click to display —— -=+-§0 objects (1 items)
or undisplay o w-Fiay: 280
Double click a0 J38Amina
to select an g b 305 Aming
object .4 cnag 1 Hete
or a molecule O =t 1 Het
g dnag 1 Heta
Click hereto . ls g dnag? 1 Het
unselect all B dman 1 Hete
£ enag 1 Heta
-84 enag? 1 Het
-fd Tnag 1 Hetah

To display the whole structure in wire, ribbon, cpk, skin, surface and
xstick representations:

* Right click on the blue box next to the word object. A menu will
be displayed.
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» Select which representation you desire for your structure by
clicking on the appropriate word. A check mark indicates the
representation currently displayed. To un-display a particular
representation click on the word again.

In order to clear your graphical display:
» Select View/Undisplay All

If you only wish to display part of the structure then click in the
boxes further down the tree in the ICM workspace.

To display selected regions of the molecule in wire, ribbon, cpk, skin,
surface and xstick representations:

» Right click on the appropriate box in the |ICM workspace. A menu
will be displayed and select the representation you would like to
use (e.g. wire, ribbon etc...)

3.1.5 How to Make Selections

Making selectionsin ICM is an important skill to master (e.g. you may
want to select a binding pocket for docking or aregion of amolecule
for coloring). The four levels of selection are:

1. Atoms

2. Residues

3. Molecules

4. Objects (multiple molecules comprising a PDB entry)

There are several ways of making selectionin ICM. The smplest isto
interact directly with the graphics window - right-click, hold and drag
around the area of the screen you want to select. Alternatively, in the
workspace window, expand the tree of molecules and chains until the
relevant protein sequences is displayed. Then left click and drag to
mark residuesto form a selection.

See the chapter entitled Maki ng Sel ect i ons for more information.

3.1.5 How to Make Selections
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3.1.6 How to Change Protein Representation

To change the representation of the protein, makeasel ect i on and then
usethetoolsinthedi spl ay t ab.

There are 6 main types of representation:

» Wire: Wires connecting covalently bound atoms of a molecule. This
representation has no defined thickness as such will not make
shadows. Useful for showing the chemical structure of a small
molecule.

» Xstick: Covaent bonds are represented as cylinders whilst atoms
are represented as small spheres.

» CPK: Atoms are represented as spheres with their respective van
der Waals radius and coloured according to a standard defined by
Corey, Pauling and Kultun.

» Surface: Solvent accessible surface. Thisisthe center of water
sphere as awater probe rolls over the molecule.

e Skin: A Connolly molecular surface over the selection. Thisisa
smooth envel ope touching the van der Waals surface of atomsasa
water probe rolls over the molecule.

» Ribbons. Cartoon representation of protein and DNA secondary
structure. Protein residues marked as alpha-helices (H’) are
shown as aflat, helical ribbon, those marked as beta-sheets ('E’)
are shown as aflat ribbon with an arrow-head, and the rest are
shown as acylindrical "worm". If secondary elements are not
defined everything will be shown as a cylindrical worm. ICM can
automatically assign secondary structure: Tools/3D predict /Assign
Helices and Strands
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Mote: The representation buttons are shade he molecule selectedis in that

particular representation, Click and hold on any button for more display options.
3.1.7 How to Color

To change the color of the representation you need to use the buttonsin
thedi spl ay tab.

Changing the colour of a representation works in much the same way as
displaying the representation itself. The selection rationaeis the

same followed by clicking on acolour in the paletteinthe di spl ay t ab.
Itisalso possible to colour different representations of the same

selection independently by clicking and holding on the representation
buttonsinthedi spl ay tab.

3.1.7 How to Color

meoh Bo+h o
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3.1.8 How to Display a Binding Pocket Surface

To display the surface of asmall molecule ligand or peptide binding
pocket:

¢ Load the PDB of interest.

e Convert PDB toICM object. If you do not convert you will not get
the properties of the pocket displayed on the surface.

¢ Right click on the small molecule or peptide in the ICM Workspace
and select Ligand Pocket.
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Mote: The surface {meshes) and h-bonds can be toggled on and off in the ICM workspace.

3.1.9 How to Save an ICM Object

Any ICM object such as a structure, sequence, or alignment, can be saved
for use at alater time.

To save an object:

¢ Right click on the object name in the ICM workspace or ICM
alignment editor and a menu will be displayed.

¢ Click on the Save As... option.

¢ Enter the unique name you wish to call your object in the box
labeled File name:

¢ Choose which folder or directory you wish to save your object by
clicking scrolling down in the box labeled Savein:

¢ Choose which file type you would like to save your object as by
scrolling down in the box labeled Save astype . ICM structure
objects should have the file ending yourfilename.ob and alignments
yourfilename.ali

« Once the appropriate information has been entered click on the
Save button in the bottom right hand section of the window.

¢ The object is how saved.

3.1.9 How to Save an ICM Object
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To save an ICM object or PDB
file right click and select
SaveAs..

3.1.10 How to Save an ICM Project File

All objects contained within an ICM session can be saved in asingle
file with the extension .ich. The file can then be read into ICM and the
exact layout of the file will be preserved. To save aproject filego to
the File menu and select Save Project.

3.1.11 How to Drag and Drop

NOTE: "Drag and Drop" is a useful way of moving objects and sequences
around the graphical user interface.

Sequences and objects can be moved around the graphical user interface
by dragging and dropping them. All loaded sequences and objects are
always displayed in the workspace panel. Select the desired object or
seguence from the workspace panel by clicking and holding, move the
selection to the desired location and release.

Thisisauseful application in the graphical user interface. For

example, you may have an alignment displayed and you wish to add another
seguence to the alignment. This can simply be accomplished by dragging a
loaded sequence from the workspace panel into the alignment display

panel. Or, you can quickly view an object by dragging and dropping it

from the workspace panel into the 3D graphics window.

3.1.12 How to: Right Click Options

NOTE: If you right click on any object you will see a new menu of
options related to that object.

Theright click mouse option can be used throughout the graphical user
interface. It is avery useful means of opening up awhole new world of
menus and options. Most of these options are described in this book.
However, when using the graphical user interfaceit is always a good
ideato try right clicking the mouse on an object and seeing which extra
options that are available for you to use.

3.1.13 How to Move Windows

Isyour graphical user interface looking a bit messy? Do you have
tables, alignments, plots all over the place? Here we show you how to
arrange everything to make a clearer GUI environment.

42 3.1.10 How to Save an ICM Project File
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Ga BEOD O 6= % 2 ron-JCM Obj

1. Too many windowsin your GUI? Y ou can move them around to make
viewing easier.

) example lignmentick Molsoft icm 3.7-2c [READ ONLY] [C:\Program Files (x86/\Motsoft LLOS o [Tel /4= g1 ] dr-ag on the title bar of a

File [dit View Bwinfe Tock Homology Chemitry Docdng  MolMechanics \’ﬂndﬂ‘w E|ement For examp|e here we
EEFEHO 9 TR0 HurFi N MMED~H &
e R e e e i i have clicked on a table.

M) 24 Eede ak8ssy: | (& BRI ([S @ | e || R
Wi Parel & x
no Selection
- [l objects
= g6

+BEa =196 a ¥alg

+ ﬂbam
b )
bmin2 30 z
u |8 =13 1. Click here
and drag.

H'i View oplons =

id=T5S nSeqeT

Blle | tonsensus orofie
1IAN 23 I e T

| sequence offset | | onder hudie body

Algnments B X Termi

Da BB QS - % 2 non-ICM Obj

2. Click and drag on awindow title bar to moveit.

3.1.13 How to Move Windows

'msol P $o+ d

Tables 7] :
| PoBseardmesdts | |
laddibaitiale 2. MNotice blue background. Indicates I

D head desc . A . !

R ransrenase Paeameeeny Lhe location where it will dock if drag i

2 2084 TRAMSFERASE LEEEr s released. ]
3 Zksd TRAMSFERASE Aerobic respratio . " q

4 Zkss TRAMSFERASE Sensor proten gsel 2010-01-02 backbon _ ? \

- # ' E
TR _—l:
o 2
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Dropped table window onto the
alignment.

3. example_algrmentah Mﬁﬁ_‘lg_h 3.7-2¢ [READ ONLY] [C\Program Files (oS6)\Molsaft
Eile .Edn Wi liﬂll'ﬂﬂ. TN-|I_ Homaology C?\r;nlstr,-_ .’JI.B-CII-HQ.--M-;M.:MICS:
CEFEHDo 9 RO AArFi SN AEw

ety \/ gt \f Tabrs \/ meshes \/ search \/ luedt \/ move |

- wl[=

Workapace Panel & x

sEla =1g6a Ealig

. batp I
bmin } +
bmin2 g # =

« s ="T%

il

POE Search resuits for kinase’

D | head desc date Toitle: ‘
1 TeriSFEE.ﬂsE Proto-oncogene tyresne-proten knase LOK 20070102 crystal st
2 Jofs  TRAMSFERASE Prato-oncogena Dymosne-proten ongse LOK HO7F-01-02 crystal st £
3 Zked TRAMSFERASE Asrobic nespration control sensar proten ar 2000-01-02 backban =
4 akiy TRAMSFERASE Sangar protein qeC 2000-01-02 backban _ cﬁm
a

¥

3. Drop one window on another one to dock it.
(BT P PR P LR UL NI\ otice new tabs are displayed which you

can toggle on and off,
BFEO O TR0 HBe P i LN [EEB
("t P\ T [ s\ e

=]

mic | ] [ [ m T ~
¥ | (4 EE e S | e | e |G| ([@e]
Viomkapace Pael +
1
| N Sebicton P
= [l obyects =
B :
L]
| [m]
| >
| - ]
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I A%
T
1
:
H
b ]
=]
4
FOE Search results for ‘inase’ by |
La
D | head desc date tithe - =
1 TR-‘-'JSFER-‘-SE Proto-onoogens tyrosne-proten knase LOK 2007-01-02 crystal st - -
2 2084 TRAMSFERASE Prato-oncogend tyrosne-proben knase LCK 20070102 crystal st
3

2kid TRANSFERASE Asrobic nespration control sensor prolen ar 2010=01-02 backhon _ o
= f L

¥

2 nane-JCM O

4. Y ou can access each window by clicking on the tabs.
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SRS IR A AL L T BT S ORI Repeat with the terminal window and
then your ICM GUI is much maore

NEEHO A0 TR R iAW [EEE organized!

cesplay '\ bght \f labels \/ meshes \J/ search W bgedt W) move

=FEEE rREcaE ] ) THT | AT T =) | =
A4 i@ @t | B BEE: W [ERe) | o G| &9 o
s - - | =
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no selection 5 2
- objects b 4
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+BEla =1ig6_a ¥ alg i
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+ csod =2
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El = o
4
gamma 33 &‘

b
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ram File

lick to toggle through windows

o6 B[O B o6 . % 2 non-ICM Obj

5. In this example we have the table, alignment, and terminal all in
the same panel

Is example_shgnmentich Molsoft iom 3.7-Jc [READ ONLY] [C\Program Files (xB&]\Mok:oft LLCUR Ve TH R w141 a|wa?5 returnto the oﬁgina[
layout by pressing the “Default Layout”

Y wEHO A THRE HE P PFE (EEE
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H
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- -
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4

icm/def> openfile £ - 1 " . -

2 mon-ICM Obj

6. Thereisaquick way to return the windows to their original
location.

3.1.13 How to Move Windows
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of the GUI and place them anywhere on

i [FE & B the Scresn.

el ot @

ws |

+Hb
ool _H_oby

[ date tite .

I nase LOK 2007-01-02 erystal 8 L3 -

In nase LCK 2007-01-02 orysial st X e

o protein ar 2010-00-02 backbon . &8
e BEO @GS s % 2 nan-ICM Oy

7. You can aso move awindow to any part of your screen.

NOTE: To return to the default display option select the ' Default
layout’ option in the windows menu.

OR
Click the default layout icon.

EE Tables->Main

t; Alignments-x M ain

5‘5 30 Graphics-xMain

[ Default Layout
N D Slide Layout |

®||=0 s @

OR

Some options can be accessed at the
bottom of the GUI.

Double click on the window header.

3.1.13.1 How to Arrange Windows

Sometimes when using ICM you may have many items displayed such as
structures, alignments and tables. As a default the graphical display is

the largest and centered in the middle of the ICM graphical user
interface. However if you wish to work on an alignment or table you can
place the alignment or table as the main display by clicking on the
buttons shown below. The larger display generally makesit easier to
manipul ate the alignment or table. There are of course other waysto

alter the layout such ast i er the windows but this optionisjust a
simple click and can sometimes come in useful.
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B Tables->kain
t; Alignments-x b ain
5’5 3D Graphics-»b ain
Diefault Lapout
N D Slide Layout

LlTm ]

3.1.14 How to Make a Picture

There are severa ways of taking a picture of the contents of the 3D

graphical display window see the wite inmage secti on. However the
easiest way isto simply click on the button in the view tools panel

(seeimage below).

quick high quality image
|

DEESG 90 TGO
[ display "\ light \/" labels \/ meshes /" s=ar

FDE Search = | text or smiles

Or select /File/Quick Image

The picture will be automatically saved as a PNG file in the directory

from which you loaded ICM. The default picture nameisicm[n].png, where

n is the number of pictures taken in one ICM session. To savein other

picture formats and to change the filenamesee the wite i nage section.

3.2 How to search and download Protein
Structure, Sequences, and Chemicals

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ICM Pro |l CM Chem st

The Sear ch tab allows you to search and download content from the
following databases:

» The Protein Databank www.wwpdb.org - search for protein and
chemical

The Pocketome Database ht t p: / / pocket one. or g/

BLAST search the NCBI sequence database

The UniProt Sequence database ht t p: / / www. uni pr ot . or g/
Search the PDB by ligand code.

Search Drug Bank ht t p: / / www. dr ugbank. ca/

Search PubChem ht t ps: // pubchem ncbi . nl m ni h. gov/
Search ChEMBL ht t ps: // www. ebi . ac. uk/ chenbl /
Search SureChEMBL ht t ps: / / www. sur echenbl . or g/ sear ch/
Search the Crystallography Open Database

http://ww. crystall ography. net/

3.1.14 How to Make a Picture
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i F) POBSsarchRopals Mobedt iom 1.7-3; {Moabngect 44 To see all the available search options

| Fig  Eda Wiew _w Cmmrmy Dﬁ-thm_] BAoihdsctanicy Wi i:"l:k on the llsearchhr tﬂb a“d use IhE

drop down menu.

7 y * acoapancyciay |nong =l :‘

© ~ |dh ok, 3

..... — v

# =

S

By SeqPattern &b
Close Match i
By Homolagy )
Ligand Code -
Dirug Bank -
ICE Index # ]
i

i

&5

R D | e al

d Staltupf Loading modules. macro bicinfo rebel ligedit dockime ¥
LICM startup file EchutEd.,, :
lfmfdef:generalbearuh~rcmGUI " 1 - s jclocoes " e
Info> using C:/Users/Andrew/. 1cmf:nxfﬂﬂH mulr daranaﬁp 2

Info> Searched 13561 rows. 8370 elements (i _out) stored in table '
iemfdef>delete PDBSearchResults
3 [icm/def>f
LI_! 4

s =M E G &8s %

Click on the search tab and then use the drop down menu to identify the
database you would like to search and download from.

3.2.1 Search the PDB

How to Search the Protein Databank and Download

The PDB sear ch tab provides easy access to the PDB database. Y ou can use
keyword searching or typein the PDB code you areinterested in. An

asterisk (*) wildcard can be used to list all the pdb files currently

available in the protein databank. Different fields can be searched by

using the drop down arrow as shown below. More advanced PDB search tools
and how to use the PDB search result table are described in the section
entititled Sear chi ng t he PDB.

Once a search is complete a table of PDB files relating to your search

query will be displayed. To view the PDB filein 3D in the graphical
display double click on arow in the PDBSearchResults table.

348How to search and download ProteinStructure, Sequences, and Chemicals




| Tosearch the Protein Data Bank.

mgmwmmmww,mmmn e
DEES 90 TR HB:gilE EcHDASE TEF 44888

= |ocapancybislay [rone 3 ‘|4.

date
1. Enter search string 2. Click here or press pummon :L_»:; :fj;::
or PDB code z enter key 20660123
231 oot TRAKSFERASE HGT-01-23
22 313 Tanshemse 20100125
233 206 TRANSFERASE HA1-61-25
234 Jybn TRANSFERASE H11-01-25
235 Jopw TRANSPERASEITRANSFERASE INHIBITOR 2011-401-23
236 ddgg TRANSFERAZE H1201-23
237 Qv TRAKSFERASE 2003-01-26
238 sy Transferse 2005-01-26
239 Zhty TRANSFERASE 2OE5-0] 26
40 TRANSFERASE F00501-28
41 ﬂ]a‘mﬁhﬁ %, HET-01-28
243 Zepy TRANSFERASE \\ 676128
243 2pgy Transferase N HCE-01-26
244 3fip  TRANSFERASE . a1y B ]
M5 dapr TRANSFERASE . 20126
3486  dagd TRANSFERASE 3. DOHblE Cll{:k to 121 -2
47 133w TRANSFERASE load structure 15801265
248 133 TRAWSFERASE FUGE-31-25
249 v KIMASE 19580126
B0 1y TRANSFERASE HG5-01-27
251 Qys) TRAMSFERASE HGS-01-27
1o TRANSFERASE HE5-01-27

=

 Click on the search tab and enter a search string or PDB code.

A table containing the results will be displayed.

» Doubleclick on arow to load the PDB file. Read more about PDB
search her e.

NOTE: If you have a PDB structure already saved you can read it into
ICM by going to the File Menu and selecting Open. PDB files that have
been viewed previously can be loaded using File/ Recent PDB Codes.

3.2.1.1 How to Search the Protein Databank by Chemical
Substructure

How to Search the Protein Databank and Download

LERT

=
&

s38ddddJ987eddd

[ B mEn s

Heod P Bo+E O

Ea F S

g
w2

o B X}

To Search the PDB and Download a Structure
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r@ PlESsarchResults Moot iom 3.7-3c [MewProject *]

To search the Protein Data Bank by

chemical substructure,

DFEG O TGO EH:pfifpE HMEaH e ————

T A A o ) ®
PoBSewch v mwmlmm[n-i;-w -4 * |ty [pes =
wiarksgace Panel +
1 Selection e § v B
1. Click on the 4. Click here or press @ ¢ :
molecule editor enter key I -
button : B
& |2 -
" i
4
[ . X
c ? % i
M [ b3
o o i kS
1)
L
& 1
E2
8 “ - ;E;
ol 155 e
2. Sketch the o o
substructure - L]
B [
H :
¢ 0 W0/= Clasms
Step 1: Click on the molecule editor button inside the search tab.
Sketch the substructure you are interested in.
& PoBSeanchfients Molsoft i 3.7-3¢ fewPicgect ] {2 tabde) | Double click on the table to load the
SRR S R e e e R e E g DB structure.
DEEe oo TR0 HWM e NS FEH B e mrrr—————
(RN sV \ T\ ; e
PBSearch = besctccciee(C0Ne0 0 v EW @ = Jocapancytie [pane "lg."_"; &
Vioriemace Sarel #x {FieSeandhResits Y o
ra selection : HETID mal o e e W |2
L tables (1 #ern) ) 7, Zihe 20050727 LYASE @ k2
-POBSearchResults  © rows 13 cofs § he ) " &
. . i O
o i E’
_ B
o
& i
WL o lzi  ZDO-09-30 LYASE @ b 5
¥
s
2 N i
&
8 - 13 HYDROLASE 'y
1. Double click to P!
! load PDB structure Py
i <f \> -
I & - £ :
G = TENCYCTENEN

Step 2: A table containing the results will be displayed. Double click

on arow to load the PDB file.
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3.2.1.2 How to Query the PDB by Sequence

There are a number of ways to search the PDB by sequences.

1. BLAST search the NCBI datase using the option " Sequences from
PDB".

2. Search by Sequence Pattern using the option in the Edit menu.

3. Search by I dentity using the option in the Edit menu.

4. Search by Homology using the option in the Edit menu.

3.2.1.3 How to Query PDB by PDB Field

Toquery the PDB by field (Author, Compound, PDB Header, Experiment
Type, Resolution or Ligand Code

» Select Edit/PDB search by field.

» Enter the search string or value

e Click OK and alist of related PDB entries based on your search
will be displayed in the PDBSearchResults table of the graphical
user interface.

Authars |i ﬂ Experiment Type |" ﬂ
Compound |’c j Resolution Eetter Than |9_9 j
Fdb Header |" ﬂ Ligand code |“ j

|Jpdate PDE Index
Ok | Cancel | Help |

3.2.1.4 Load and Display NMR Structures

Use the PDB Search tab to load NMR structures from the PDB. Y ou can use
the drop down button shown below to determine how you want to display
your NMR structure. Y ou can choose to display and download the first NMR
model, all modelsin the PDB file or all modelsin the PDB in a stack.

If you choose the stack option the the stack will be stored in the

object as described here.

" display \/ light \/ labels \/ meshes "Ur search U ligand /" maovie

PDE Search || Zkdz w pdbReaderMadeIs all skack, * |occupancyDisplay [none

First
all

Workspace Panel g X

Click for drop down m

3.2.1.5 Occupancy Display

Y ou can use the options in the PDB Search tab to control if and how the
partia or zero atom occupancies are displayed. Y ou can choose to circle
or label the poor occupancy atoms.
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[ display \/ light \/ labels \/ meshes V search "Ur ligand %/ movie \

PDE Search || 1xbb w pdbReaderModels all stack, | occupancyDisplay |circle

>>| oad-pdb-hyperlinks{ pdb search hyperlinks} h4-- Hyperlinksto PDB
Website and UniProt { Hyperlinks to Databases}

In the PDB Search Results Table you will see blue hyperlinks that will
take you directly to the PDB website or Uniprot website.

3.2.1.6 Display PDB Header

To display the PDB Header for aPDB file.

» Firstload aPDB fileinto ICM (see Sear ch PDB)
» Double click on the word header in the ICM Workspace.

/’ ki ICM wDrkglpatg """\5
g objects {1
SE fom
8« JOF

3 n:ran"l/bl%cham a; engineered

e datools

\i Double click here J

S

» The PDB Header information will be displayed.
¢ Click on the blue hyperlinked text to link to external web pages
for additional information if needed.

3.2.1.7 Direct link to PubMed

When you search for aPDB fileand load it into ICM you will see anicon
(shown below) next to your protein namein the ICM Workspace. Click the
icon and you will be taken directly to the PubMed primary reference
relating to the structure.

Direct access to PubMed

= ubjel:ts (1 iterm)
SR 1xbb  [1]XR; 1.6A
wfflla  Z6BA 1 site KSYK_HUMAN
el asti H 4-(d-methyl-piperazin-1-yim

----- &3 tyrosine-protein kinase syk; chain: a;

3.2.2 Search Pocketome
The Pocketome (www.pocketome.org) is an encyclopedia of conformational

ensembles of all druggable binding sites that can be identified
experimentally from co-crystal structuresin the Protein Data Bank.
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R — To search the Pocketome database.
File  Edit 2. Enter a search iy Docking  Melblechinics Winl o g0 org

b & string 0 AE e B

gy

4. Click here or press
enter key

1. Click on the
Pocketome option

3. Select search
category

Se 0= 0aas)

Step 1: Click on the search tab and choose the Pocketome option. Check
afield you would like to search e.g. Protein Name, Family, domain...

neol P Wo+d e

e A

& 2rows Molsoliiom 3.7-3c (awProject " i sbikcts 1 tabied |Tu ioad a pocketome entry,

Bﬂ-ﬂuﬂf&"ﬁ\f} HQRJ!JH @-ﬁ:ﬂ!iﬁtt TEEs8kl

o chatvy N bt VS labety \ mankan Y sserch \ hgedt )

Poceinee - BEERIg L] [ﬁﬂn-ﬂ—: - ﬁ]
. uasn_; H 2-hydmpmativd-B.ocivis

ierispncs el #%
&belai adrenergic receptor, chan: a,

no selection
A L

=i shdes (1 iem)

= shdeshoe
|9 Shide 1

ﬂ&w '?’{3 1 1. Double click to

50 RaL A load pocketome

x ;m\ entry

L2 Shde 2
=f obgects (B dems)
S 2ada (1) KR 274
+-E!-a 214 A 3 sles ADRBY_MELG:
w8 ap32 H A-fi(25-3-den-Dutyiaming
Fillana W sodum +

usodd Bo+dE o

et oe DBEMEH

& 7 = . o
Entry ] peuthiamad it I
ADQB]._HEIGI_E'L% A 2 ” Beza-1 sdrénarge receptar :;|ﬁ

g 1@

| | ADRBZ_HUBAN_26_357_cholestenc r Beta-2 adrenesgic recaptor [ %

2 FoE
i 4 " L
o8 E0x 0@aw a o [l 25 8 nen- KM Ot

Step 2: A table of pocketome hits will be displayed. Browse the results
and double click to load a pocketome entry.
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3.2.3 ChEMBL Search

ChEMBL (https://www.ebi.ac.uk/chembl/) is a manually curated chemical
database of bioactive molecules with drug-like properties. It is

maintained by the European Bioinformatics Institute (EBI), of the
European Molecular Biology Laboratory (EMBL), based at the Wellcome
Trust Genome Campus, Hinxton, UK.

To search and download datafrom ChEMBL:

» Click on the Sear ch tab.

e Choose ChEMBL from the drop down button.

» Enter asearch string or search by chemical sketch by clicking on
the editor button in the panel.

e Select afield to search e.g. Protein Name.

» Select whether you wish to return just activity dataor al data.

» Click the search button.

A table will be displayed as shown below.

 chemBLSearch |

{.i.ﬁear{:hTabehEMBL} <2 {3 Choose Field )

...1E--u‘vu- LR AS® K| TFT &+ 84 %
i mard ¥ igeda 4 l
:_r.'-ewn. w] | enaz G« Bl ln Prosniiame o[ B Recuna, vd, D0%D, BC30, N0, ACE, snd Putsncy (ITE) duta andy -
f chantd s | :i 5. Click to search . +
ol 2. Enter String e ST e = | & (e \ P V[ Aok | 2
]\4\ " - I CHEE1 501 208 BLH2 HUMAH Prosty _. Gt Bt Activity £
= ke &
- 4 U_” % Gl Ligarsd Tummary
3 # Ei t pe?
= 4, Click here for :
P 4E
additional data
CHEMBLE25247 BGMa HUMAN P .

-t [~
rl 3 N, aar
. [

& S o,

{ \ CHEMBLA93063 BGHE HIMAN Prosta -
- ! - £ ]
@ 7 U e be

7 Y

—

)

PRI 501 08 BIHT M MAN Prasiy
|

1 |

E..F;.‘J Ej i_ DJ_J ﬂ_l £ | 1 Juble. 15292 rowrs, 20 codurnny

The table contains the original activity data without merging or
aggregation. For instance,

Chemical 1, Protein 1, Activity 1

Chemical 1, Protein 1, Activity 2

Chemical 1, Protein 2, Activity 1

Chemical 2, Protein 1, Activity 1

Click on the button Get Best Activity to display the best activity for
each chemical, protein pair. For instance,

Chemica 1, Protein 1, Best(Activity 1, 2, 3, ...)

Chemical 1, Protein 2, Best(Activity 1, 2, 3, ...)

Chemical 2, Protein 1, Best(Activity 1, 2, 3, ...)

Click on the button Get Ligand Summary to display alist of chemicals
with all activities found in ChREMBL. For instance,
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Chemical 1, Protein 1, Activity 1

Protein 1, Activity 2
Protein 2, Activity 1
Protein 3, Activity 1

Chemical 2 Protein 1, Activity 1
Protein 2, Activity 1
Protein 2, Activity 2

3.2.4 Search SureChEMBL

SureChEMBL (https://www.surechembl.org/search/) provides free access to
chemical data extracted from the patent literature. To search
SureChEMBL:

» Click on the Sear ch tab.

e Choose SureChEMBL from the drop down button.

» Enter asearch string or search by chemical sketch by clicking on
the editor button in the panel.

e Select afield to search e.g. Protein Name.

» Select whether you wish to return just activity dataor al data.

» Click the search button.

3.2.5 BLAST Search

To BLAST search the NCBI sequence database:

viogy Chemistry Dockieg  Moidechanscs o)
OB R 5 B - roi (B o B8 G

bbb LT T | BLAST Search NCB! database. Read in a
sequence or load from UniProt,

' 1. Select BLAST
FrrTaal Y

BLA5T = | Chad Mpan

4. Select database to
BLAST

Warkspaos Paral
it Selechion
% SOGUENCES

= CHRKZ _HURAN

3. Select sequence or

i — drag and drop from
2. Load sequences to ICM Workspace
BLAST

A =1

o8 B ca=

e o &

B ®

Step 1: Load a sequenceinto ICM. Select the Search tab and choose the
BLAST option. Drag and drop the sequence into the search field, use the
drop down menu or type the sequence name.

3.2.4 Search SureChEMBL




@- blast_hits Molsol ko 3.7-3¢ [Mewdroject ] {1 table}
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- 2. Double click to
load sequence
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1. Click to select &

B
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i
! &

' 2
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X

Step 2: A fully interactive table and plot of sequence conservation
will be displayed. Double click to load a sequence.

3.2.6 Search UniProt

£ Hew lioksod icm L1-3: [lwbrciect*j 0 Search the UniProt Database and load
1. Select Uniprot T ™ sequence.
P LR F T 'L S
. | &
Urigant = | oz huaman o
eiorinace Parel o
no selechon £
b soqUanCEs (1 tern) 2. Enter Uniprot code %
i s ’*“”‘ij or search string -
I 23 HEGBOGT Y 5
| 431 Q.s*ma:asyrz. B
| 841 LYSIFEDQEF o
| 81 Prgfrwrrr APWMARLMALS
| 101 poFRLECYN aF
121
| 141 1
161 Y
i1 LALARNRYEY : A
| 201 YYPEALRDEY 1
221 ELAFER s
| 242 ISEREEAIGE s
| 262 ETEIEILEEL ﬂ
| 281 WHPCIIRIEN TFDAEDYYLV
| 301 LELMPGSPLF DEVYGNRRLE
| 321 EATCELYEVG MLIAVEYIHE G
| 341 HSIIMANIEE EMVILSSOEE i |
| 361 DCLIRITURG MSEILGETSL ot
| 382  METICOTETY LAPENLYSVG -
| 401 TASYNHAVDC WSLGVILFIC =
| 421 L8sYPPFIER RTOVSLEDDT &
| 441 2ASEYNPIPE VHAEVSEEAL
| 461 [LVEELLVVD PEARFTIEER
| 481 LREPHLGOED MEREFQDLLS .
Al ==
08 B0z c@a=
. #
56 3.2.5 BLAST Search



Step 1: Click on the search tab and select Uniprot from the drop down
menu. Enter the UniProt code. The sequence will be loaded directly into
ICM and you will seeit in the ICM workspace.

3.2.7 Search PDB by Ligand Code

To find structures containing a particular ligand in the PDB.

{# POBSearchBesults Molsoft iomm 3.7-3¢ [NewPregect *] (1 table)

1. Select Ligand Code

o8 MOz @

| Search by PD3 ligand code.

ERe i fE mBwdBbD09% 8 TE§&2414

i search
lgwitode =] ap - H
IHZeREDa0E, [ .r’“m CTRY
o seled 2. Enter code e N PO Sanrch remts for ‘ADVARCED SEARCH'
2 §H tabwes EEFTTT date
POBSsarehRmefs 3. Click here or press e
z enter key 20050103
3 F008-01-04
4 b H'fDﬁWSE 2009-01-05
S Qo STRUCTURAL PROTEM 2003-01-67
6 1322 STRUCTURAL PROTER 2004-01-07
P A0 STRUCTURAL PROTED 2003-01-08
8 13ip TRANSFERASE(PHOSOHOTRANSFERASE) 15930104
] 1nmd STRUCTURLL PROTEN 20030109
10 Zoax HETAL BBMDING PROTEM 2007-01-0%
11 ghS STRUCTURAL PROTERM, RMA BIDING PROTEM 2007-51-09
12 ZohiE Structural Proten, RIA bindeg seoten 2007-31-09
13 Zgh7 Structusal Proten, R28 fyding peoten 2007-01-09
14 foby TRAWSPORY 2006-01-10
13 Qi LIGASE 2005-01-11
16 Zogh CELL CYOLE 2008-01-16
17 | (CELL CYOLE -01-16
|| gL AL 4. Double clickte [ "
a8 ] load structure
: LICM startup file executed.. - - - -
J.rmfde}aneralSearchFromGUI "L.L gand Cod "atp" "proteinname
Info>» PDB index loaded from /Users!hndrew! icmfinx/PDB.tab
E icm/def>H

>
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Step 1: Click on the search tab and select Ligand Code from the drop
down menu. Enter the Ligand code and a table of hits will be displayed.

3.2.8 Search Drug Bank

To search Drug Bank ( htt p: // www. dr ugbank. ca/)

3.2.6 Search UniProt
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el 17 3 MiewPreioct 1 0 e Search Drug Bank by key word.
1.SelectDrugBank | oo, sy pm mmam@I00s TESE8EL2
epch £y Fu
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H‘armmm_/’/\\ TN o
nosuiel 2, Enter search text ; o . O P
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enter key =) % |
1 P i -
h__'/ = -
3 a .
; g | B
FET 30 Clobenpeopit [
; < 3
\b .
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4 1 :
4. Double click to e
load structure -4
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)
Al IE]
oB 5Boe caswu

Step 1: Click on the search tab and select Drug Bank from the drop down
menu. Enter a search string and atable of results will be displayed.

The table contains the original activity data without merging or
aggregation. For instance,

Chemical 1, Protein 1, Activity 1

Chemical 1, Protein 1, Activity 2

Chemical 1, Protein 2, Activity 1

Chemical 2, Protein 1, Activity 1

Click on the button Get Ligand Summary to display alist of chemicals
with all activities found in Drug Bank. The button islocated in the
extrapanel (click on hammer - top right of table panel). For instance,
Chemical 1, Protein 1, Activity 1

Protein 1, Activity 2
Protein 2, Activity 1
Protein 3, Activity 1
Chemical 2 Protein 1, Activity 1
Protein 2, Activity 1
Protein 2, Activity 2

3.2.9 Search PubChem

To search PubChem (https://pubchem.nchi.nim.nih.gov/):
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b, Search PubChem by keyword and
= wyg 2 Keywordsearch. ™ = o 1 Chemical substructure.,

3 2 L
search 4 gt
Pt %] selbutarmol Ei. * £ Appand To Remdt "‘4——{ 4. Click here to run search. ]

Workspace P. # =

3a. Substructure \’

Lﬂhuﬂstj search. J-;ce.ua o @ 8|
PubCham in
the Search b @ EERE S e By & Dﬁ%l_ﬁ
\ tab. C12H10 -
& 3b. Sketch and
# then close
window,
LA
O

2

e

o
4

0l (EHME S 6 e

Do 2

&%

ke w g |

* Click on the search tab and select PubChem from the drop down
menul.

» Enter asearch string and atable of results will be displayed or
click on the chemical sket ch button and sketch a substructure.
When you close the chemical sketch window the smiles string will
be added to the keyword search panel.

* Click on the "binocular" button and run the search.

« A tableof hitswill be displayed.

3.3 Create New Objects

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro |l CM Chem st

In the File menu there is an option called New. This option can be used
to create new objects of the following types:

Peptide

Unusual Peptide
Compound
DNA and RNA
Sequence

Script

HTML

Table

Arrow

Box
Sphere/Ellipsoid

3.2.9 Search PubChem
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2= 0. Use the option File/New to create new |

eay Chemsty Docking MeMlachanis Hin phlects such as peptides, sequences,
L% o P G P [ o B DNA

.File/New |-
? o Dk &

=
- L
PO Samch = | i‘ = i il Fadds - H pdofieadtarriipoel | af = | proupancylaplay | Done * || gl
Werkspacs Parel @ M 4
| 2.Selectthetab | +
no selechion e b
i
{ Papade ™/ hususl Pepide \/ Conpeurd |/ TRAENA 1 Sequence 1/ Saipt 3 Himl \f Tebie A/ Amow A/ Box \f Sphere Plipacd | 4
-
Ora Lether Code EACARVALKCEAAARD - -
)
HSmrrenis Fangal HHT w  C-srminus [a's's s -
" Display Mdpody o Ay & Halie .

3. Enter details
about new object

; icm/def>y r :
icm/def>d 4. Click OK ' = i

E icm/def>R . d

im

N BRI

3.4 Open and Read Files

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro |l CM Chemi st

Any filethat ICM can understand can be opened by:
» Selecting File/Open.
A file with an extension .ich isan ICM binary file and can be viewed in

the GUI. A .icb file can contain many objects such as sequences, meshes,
protein objects, alignments, tables etc...

3.4.1 Open with Password

To open afilethat is password pr ot ect ed:

 File/Open with Password
3.4.2 Extract from icb file

Anicb fileisani cm proj ect fil e,insomeinstancesyou may want to
take objects saved in an icb file and load it in your current ICM

session. This option allows you to view atabulated list of what aich

file contains and load individual object files from it.

File/ Extract from ICB.

Locate the saved icb file.

A table as shown below will be displayed

Double-click on any of the entry to extract that object from the
icbfile.
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x|/ exarnple_alignment_.

nare | tupe zize
2 openFilePRJMAME | zhing 9
3 [1TKLA 4 | sequence 431
4 10194 17 sequence ]
5 TwWFC_5 sequence h3s
B TIaM__23 sequence 415
7 T0LE_A_4 ZEOUENCE 413
3 TqlE_a EgUENCE 07
9 2phk_a EqUEnCeE T8E
10 |alig alignment 10927
11 |1qg6E ohject 231820
12 | Z2phk ohiject 235471

3.5 Saving Files

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro || CM Chem st

Anything you have displayed in an ICM graphics session can be
conveniently stored in asinglefile called an .icb file. To do this:
» File/Save Project
or
» File/Save Project As
A .icb file can be password protected by:
File/Save with Password
Enter afile name or browse for a previously saved project.
Enter a password

Determine whether you want the file to be Fully Protected, read
only or Read Only and Allow Comments .

Any object (e.g. protein,table, alignment...) insidethe ICM GUI can be
saved by:

* Right click on the name of the object in the ICM Workspace.

+ Select"Save As’
» Choosethefile format from the "Save as Type" drop down dialog.

3.4.2 Extract fromicb file
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3.6 Making Selections

Availablein the following product(s): | CM Br owser || CM Br owser - Pro

[ CM Pro |l CM Chem st

Note: Click Next (top right hand corner) to navigate through this
chapter. Headings are listed on the |eft hand side (web version) or
by clicking the Contents button on the |eft-hand-side of the help
window in the graphical user interface.

There will be many occasions when you will have to make selections. For
example, if you want to display a particular region or molecule

contained within your protein structure or if you want to select

residues around a binding pocket. If you have a molecule displayed in

the graphics window, then selections will be displayed as green crosses.
The selection you have made is also displayed at the top of the ICM
Workspace. It is aways a good ideato keep an eye on what is selected
and what isnt.

There are four basic levels of selection

1. Object (eg aPDB structure or ICM object)

2. Molecule
3. Residue
4. Atom

Y ou can make selectionsin:

The Graphics Display

The ICM Workspace (Selections are highlighted in blue)
Tables

Sequences

Plots
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» Alignments

3.6.1 Graphical Selection Tools

The following buttons can be used to make a selection once a structure
is displayed.

Rectangular FPropagate selection to all
ﬁL atoms in residue
& |
T E ! , Te— Lasso R ef 0 W
""""" He—Pick atom
A5

Residue label

’ 2 Residues
_g_ Molecules

ﬁ. Objects

NOTE: All selection tool buttons are colored green. Graphical
selections are represented as green Crosses.

3.6.2 Quick Selection

To make a quick selection the following buttons can be used.

4 ™
Rectangular Selection = 3

| | O — Lasso Selection
Select Atom = =

=T
Al

Select Residue
\. J

To select partsof your structure:

» Click on the Rectangular selection icon and click and drag around
the part of the structure you wish to select.

OR
» Click on the Lasso selection icon and click and drag your mouse
around the area of the structure you wish to select, forming a
lasso around it.
To pick individual atoms:

» Click onthe’pick atom’ button

3.6 Making Selections 63



3.6.3 How to Change the Selection Level and Mode

It is possible to change the level of selection before or during the
building of a selection. The selection level drop-down button can be
used to do this (see image below).

For example, a C-apha of aresidueis selected but one would like to
select all atomsin the residue. Y ou can change the level to Residues.
This selection can then be changed into all atoms of the residue by then
selecting the Atoms level again. Or you can use the Propagate Selection
to all Atoms button (see image below).

» Click on the Select objects, Select molecules, Select residues,
or Select atomsicon, depending on which part of the structure you
wish to be highlighted.

. < (i object S
| Change e Prepz?gate
. gl selection level f"@pi «% g| selectionto
“display \[ight \/ labels \/ meshes \/"seart i Atoms all atoms in
M| 4 2@ @B rese residue
ﬁ Molecules
- ﬁ Olbjects l & X

Change
selection Rl 8w

mﬂde ikl New k
LA r’ﬂﬂf_ﬁ_’ﬁ Add i

It is also important to observe the selection mode that is being used.
There are four modes:

» New: new selection replaces everything selected before

* Add: new selection is added to previous selection(s), if any

» Remove: previoudly selection (part or whole of it), if included in
the new selection will be unsel ected.

» Toggle: within the new selection, everything that has been
selected is unselected and everything that hasn ¢%ot been selected,
wilbe selected

3.6.4 How to check what is selected.
All selections are displayed as green crosses in the graphical display

and blue in the ICM Workspace. All green selections are returned to a
variable called as_graph.
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| Selections are displayed as green

e B ::: o ""”"“;.W“m’ - “"‘E““‘“E crosses in the graphical display and
e 280 Rl BB S E o iehted in blue in the ICM

Workspace.

S | [ G e )
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Here the selection
irformationis reported

i‘19ﬂeall-!oliﬂh
i i

nEOD D o+

Selecti’un shown as

- green cross in graphics
. window

A =

%
: % ﬁ'_i,’q
% icm/1xbb>display xstick as_graph
il |icm/lxbb>as graph = Atom( Res(Sphere( a_lxbb.asti/1 (Mol( {a_*.*/D
icm/1xbb>undisplay store a_
iem/lxbb>display wire a lxb All green graphical
icm/ 1xbb}und15play StDIE a selections are returned

icm/1xbhedisplay.x atick to a variable called £
as_graph

Selecﬁon are
highlighted in blue in
the ICM workspace

b"‘.. i

GHREE [

3.6.5 Orange Selection

Sometimesit is necesary to have two different selections. The Orange
selection allows you to do thisit is useful for such operations as
superposition and more technical procedures such as designing a protein
loop. The orange selection isreturned to avariable called as2_graph.

3.6.4 How to check what is selected.

65



i

; 3] Db Moksolt icm 5.0 Perabrojact 1 1 clsect] . _ Orangeselection aliows you to copy a
§: b; o iew :"; "g C‘M! “""“’;’ ““““‘9’ m]@mmaﬂlﬂ green selection to another selection.

2 E

s e - This allows you to have two different

L Be o el mem o |gselections.

Click here to transfera

i)

+

i i'-js‘ Res 1 '-‘0:1‘ Oty green selection to an i
] ﬂg s [I'IJXR; orange selection ol

[ 7] 363 s B [0

383 EEVVETY B

$03 =N _ﬁ o

428 B‘JP‘I’I RHIG ICEAEIWHI 1
448 T...'i EYLOCNRHVE i i

468 DENIIELVED VIMGMEYLEE
488 EN!'.'ZLH::_A_A ¥
508 ART PHLAE
528 AFMFVENTAR
352 EADVWARGYL
$72 PYRGMEGSEV
392 oo BEM
§12 ODVENRPEFAR VELRLPNYYY
$32 DYYHEGHH
£ ses {5 dems
+ n asti M d-(d-methyl-piperazn-d -\,all'neli’v,al;-n.[-i-r
) byrosine-profen kinase syl chain a) synerym: sf
+ D W (35T waler moleciudes)

S

O 50 5 s [ A ek e o

. AT '
‘-“’ﬂ[_?

3.6.6 Clear Selection

To unselect everything you have previously selected:

e Simply click on the Clear Selection button on the selection
toolbar.

OR
¢ Right click and drag away from the displayed structure.
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3.6.7 Changing a Selection

Once you have made a selection you may wish to add or remove parts of
the selection. The buttons shown below allow you to accomplish this.

Propagate selection to all
atoms in residue

Click and o l
o LE XL

arch

e

L B
][+
=

Toadd or remove from your current selection:
» Click on the Selection mode: add or Selection mode: remove icon on
the toolbar.
 Click and drag around the part of your structure you wish to add
or remove.

You may also wish toinvert your selection in a specific part of the
structure.

The parts that are currently selected will become unselected, and the
unselected parts will become selected.

In order to invert a selection:

» Click onthelnvert icon on the toolbar.

3.6.6 Clear Selection



If you wish to select and unselect certain regions of a selection the
toggle selection button is very useful.

» Click on the Toggle selection button.
» Right click around the selections you wish to select or unselect.

NOTE: The selection you have made is recorded at the top of the ICM
workplace. Any selection is stored in the variable as_graph.

3.6.8 Filter Selection

Y ou may want to be very specific about a selection you want to make. For
example you may only want to select protein backbone atoms or you might
want to just select the charged residues.

The button shown below enables you to filter your selection:

o
Filter

Selection

Or

Right click on a selection and a menu as shown below will be displayed.

Advanced

Connect ko Malecule
Disconnect

Extract Sequencels)
Center

Six Frame Translation

“a Meighbors

Select 3

¥ Delete atom seleckion

» Select the Filter Selection option.
» A dialog box will be displayed as shown below.
» Select what level of selection you want e.g. atom or residue.

68 3.6.7 Changing a Selection



5 bbb Mol w380 Dieabegen f et 0 s Fiiter a selection by a variety of

fle fdt Wiew Binirdo  Tooh Hnmqhqy Charnistry  Oodiomg  MolMechenics  Wnd s 5
ool v [ = - o . e B 0 | t_‘ o B3 ielettiﬁn le‘.‘ﬁl propeﬂles.
1. Cllick on a tab to select ®
LH
1 desired selection level =
erispsos Pl & x wde
¥ 1 0Acd 1 Cibg P
L) a0 labels (3 fen I - b 4
& ] pocket_hbonds . b
{1 e & L
-@ by i o
e ™ i )
el asn H 4 | ]
i) tyrosine-prod i il 5
= [l meshes leny
| By gy
2. Click “+" to

by sterrates
expand and see

options ity by

+ | by formal charge
[ ] oy chiratity

& | by backbons idechoan

i
i by gragiic representson
| @

o WO 4
08 85Ms aﬁ

3.6.9 Workspace Selections

e b Sigh [ od e o =

In the default GUI layout the workspace panel islocated to the | eft of
the 3D graphics display. It isagreat tool for keeping track of al

your sequences, pdb structures, objects, tables and alignments. Asyou
will seein this section it also provides away of making selections.

B

Selected atoms and
residues

g3 106 Atoms 23 Res,1 Mol 42
E| . ||h|E'|:t 1 items)

[+ cdsg

E]:I E;Equences (2 items)

w-cffBd  |en=77 Amino
HcEE len=88 Amino
Workspace E] t alignments {1 itams) |

panel P lesx ID=23% pP=27
=- @ tables (1 items) !Expand _here for more
_ L.PDBESearchResults 13 | information.

Display all J

Objects

\— Tables

Alignments

hd
|TJ=JI ER

Sequences
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3.6.10 Workspace Navigation

Once you have mastered how to navigate the ICM workspace making a
selection will become easier. Each object is divided into 3 levels:

1. Object Level - Showninredif it isthe current object. Holds
details about the structure - name, X-ray, NMR, resolution etc.
Importantly it will state whether the structure is an ICM object
or astructure straight from the PDB. To learn how to convert a
PDB into an ICM abject go to the sectiononconverti ng a PDB.
2. Molecular Level - Showsthe individual subunits, ligands and
hetatoms of a molecule.
3. Residue Level - Shows the sequence.

Current object in red
F N

no selection

n ects 3|temsj
@J ICh4
nm =cd5d Fosx 77 Aming

E|x wFay, 9.90 &
|:|m == by t;sx 77 Amino .
E|1c:rn %-Pay: 1.50 & crambin ——— Objectlevel
m 4B Aming
‘1 TTCCPSIVUAR SHFHUCRLPG

21 TPEAICATYT GCIIIPGATC — |

41 PGDYAN Residue level

Molecule level

Object information
Click to expand tree

NOTE: You can expand each level of the |ICM workspace by clicking the
"+" button as shown above.

3.6.11 How to Select an Object

To select the whole object:

» Doubleclick on the object level.

no selection J .
—u ects (3 tems) Double click here to select ALL
mj IChd currently loaded objects.
HE nm == cdhY t;sx 77 Amino
=[x %Ray 990 A
wllm =cdsd FEsx 77 Amino
---H_ Tcm  ¥-Ray 1504 crambin Double click here at the object

=lm 46 Amino level to select the whole object
1 TTCCPSIUAR SMENUCRLPEG
21 TPEAICATYT GCIIIPGATC

1 PGDYAN

Use the CTRL button to select multiple non-contiguous objects or if they
are continuous you can use double click and hold the tab button.

3.6.12 How to select a Molecule

To select a molecule(s):
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* Double click on the molecule in the ICM workspace.

) Lot Mobioh i 3.8-2 [MewPrasect °] {1 sbject!
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Use the CTRL button to select multiple non-contiguous molecules or if
they are continuous you can use double click and hold the tab button.

3.6.13 How to select Residues

There are different options to select residues:

OPTION 1:

¢ Click and drag over the residues you wish to select in the ICM
workspace. Selected residues will be highlighted in dark bluein
the workspace and with green crossesin the graphical display.

3.6.12 How to select a Molecule
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Selection information is recorded here

ﬁ.‘& 1H-1Atums 35 Res1 Mol1 Oby
{1 itermns)
Click here to ) s
expand treeto ———— 336 Amino OPSD
hp . id MHGLIEGPHFY [JPFSEKTEHI
] '.?WaI'I'III'IOHCI | E] nPOYYRLAEPHOF S Hi
residues, T HFLLIML GFPINFLTLY
. 61 VTUOHKKLRT PLHYILLHLA
] | 81 UADLFHUFGE FTTTLYTSLH
Click and drag . 101 [1JFUEGPTGE NLEGFFATLE
over residues 121 GEIALWSLUY LATERYUUUC
i trt— KPHSHFRFGE NHAIMGUAFT
z:;glsmo 161 WUMALACAAP PLUGWSRYIP
. 181 EGLOWSCGID YYTPHEETHM
2081 ESFUIYMFUY HFIIPLIUIF
Selected | 221 ECYGOLUFTU KEARASATTO
i ; 241 HAEKEUTRMU IIMUIAFLIC
Ir_le_sm!.le; ""3" be 261 WLPYAGUAFY IFTHOGSDFG
ighlighted in - 281 JIFMTIPAFF AKTSAUYHPU
the workspace 3081 IYIMMHKOFR HCHUTTLCCG
and graphics 321 KHPSTTUSKT ETSQUAPA
window G i i " -
Any selection is highlighted in the workspace as well as in the
3D graphics window if the structure is displayed.
OPTION 2

» Click ontherectangular selection icon or lasso selection icon on
the tool bar.

 Click and drag around the residues you wish to select. Selected
residues will be displayed by green crosses on the graphical
display and bluein the ICM workspace.

e Usethepropagate sel ection to residue | evel hutton.

OPTION 3:

» Right click on the aresidue in the graphical display and amenu
as shown here will be displayed.

Selection Dialog

Advanced r

Residue atoms »
Open with kol dit
Connect to Malecule
Dizconnect

Eutract Sequence(s)
Center

Annotate zelection
Meighbars
Clozed Cavities

Select [

Delete residue selection

* Click on Select and afurther menu will be displayed.
* Click on Residue, Molecule or Object.
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Cloged Cavities

Fesidue

W Delete residue selection
Maolecule

Object

OPTION 4:

Usethesdectr esi due button.

3.6.14 Select All

Ctrl + A will select everything in the ICM workspace, and Ctrl + Shift +
A will unselect your objects.

NOTE: The selection you have made is aways recorded at the top of
the ICM workplace. If you are familiar with using the ICM terminal
(See language manual) the atoms, residues, molecules or objects
selected interactively in the graphics window are automatically s

3.6.15 Selecting Neighbors

In some instances you may only want to display or select only a subset
of astructure. For example you may only wish to display the residues
surrounding aligand (as shown below (ligand red; graphical selection
green crosses). The " Selecting Neighbors' option selects the residues
within a shpere of adefined radius.

There are two ways of selecting neighbours to a particular atom or
residue in ICM. Either by right clicking on the atom or residue in the
graphical display or by right clicking in the ICM workspace.

3.6.14 Select Al



3.6.16 Selecting Neighbors: Graphical

To select neighboring atoms or residues around a sphere of a certain
radius:

» First select the residue(s) or atom(s) around which you wish to
select neighbors. (Seethe Sel ecti on Tool bar Secti on)

* Right click on the selection and a menu as shown below will be
displayed or choose Tools/Geometry/Neighbors.

a_x1.mjafhdz1

Filter Selection
Colar
Edit
Advanced
Connect ko Molecule
Disconneck
Extract Sequence(s)
Center
Six¢ Frame Translation
“a. MNeighbors
Select
“ Delete atom

» Select the Neigbors option and a data entry box as shown below
will be displayed.

This option will allow you to make a spherical selection.

The window will open as displayed as below:

& select Meighbors @E

Select Meighbours For | % Graphical Selection (0 mal)
Radius g, v

by pe wisible -
exclude source

unselect water

[Undisplay Bevond Selectianl

[ (8] 3 H Cancel H Help

» Select the molecule you wish to select neighbors around. For
exampleyou can sel ect aligandinthel CM Wbr kspace and then
choose the Graphical Selection option in the " Select Neighbors
For" dialog entry box. Or alternatively you can select the object
by clicking on the drop down button next to the " Select Neighbors
For" dialog entry box.

» Enter the radiusin Angstroms for the neighbor selection. e.g. 5.

» Type-thisoptionisimportant. This option relatesto what is
going to be selected. For example if you leave this option as
visible and you only have ribbon representation displayed for your
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receptor (e.g. when selecting neighbors for aligand) then only
backbone atoms will be selected.

Selection Type option includes:

» visible- will select al atoms displayed within the radius
selected.

* visiblesidechainswill select al visible side-chains - not
backbone atoms.

» same object_other_chainswill select all atomsin other chainsin
the same object as the original selection.

» other objectswill select atomsin objects other than the origina
selection.

» same object will select atoms in the same object as the original
selection.

» all_objectswill select atomsin all objects

» choose from_list will allow you to select the object you wish to
include in the neighbors selection.

» exclude sourceif checked will not include your original selection
in the spherical selection.

» unselect water if checked will not select water molecules

» Undisplay Beyond Selection will only display the atoms selected.

NOTE: The selection you have made is always recorded at the top of the
ICM workplace. If you are familiar with using the ICM terminal (See
language manual) the atoms, residues, molecules or objects selected
interactively in the graphics window are automatically saved in the
variable as_graph. Graphical selections are shown in green (crosses) or
highlighted in blue in the ICM Workspace.

3.6.17 Selecting Neighbors: Workspace

To select neighboring atoms or residuesaround a sphere of a certain
radiusfrom aresiduein the |CM workspace:

» First select the residue in the ICM workspace around which you
wish to select neighbors. (Seethe Resi due Sel ect i on)
* Right click on the selection and a menu as shown below will be

displayed.

41 PGDYAH
Filter Selection
Color 4
. Advanced 3
Selection made here
Residue atoms 4

Connect ko Malecule
Disconneck

Extract Sequencels)
Cenker

Annotate selection

Six Frame Translation

y : Meighbors

Closed Cavities

Copy ChrlC
¥ Delete

3.6.16 Slecting Neighbors: Graphical
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» Select the Neigbors option and a data entry box as shown below
will be displayed.
» Follow theinstructionsin the pr evi ous secti on.

NOTE: The selection you have made is always recorded at the top of
the ICM workplace. If you are familiar with using the ICM terminal
(See language manual) the atoms, residues, molecules or objects
selected interactively in the graphics window are automaticaly s

3.6.18 Select by Residue Number

To select by residue number:

* Right click on the molecule you wish to make the selection in and
choose Select/Res Number...
» Enter the residue numbers e.g. 3,7:12,30 Colon indicates range.

3.6.19 Alignment and Table Selections

Descriptions on how to make selectionsin Alignments and Tables arein
the sections entitled Making Selectionsin Alignmentsand Maki ng Tabl e
Sel ecti ons.

3.6.20 Making Links

It is sometimes necesary to make links between sequences objects and
alignments. A link enables you to make selections in one environment
such as an alignment and then these selections are transfered to the
object such as the PDB structure displayed.

If alink is made then a symbol will be displayed next to the object in

the ICM workspace. In the example shown below subunit_a of the X-ray

structure 1916 is linked to the sequence 1g16_a and the alignment called
"dig'.

Linked to alignment 'alig’

I
unjec’cs (2 items)

Tglb  =-Ray 240 A; Jhusphorylase kinase
Bz =—1g6_a ¥F-alig 281 Amino
hatp | 1 Hetatm atp

bran | 1 Hetatm manganese +2

bmnZ | 1 Hetatm manganese +2

csod | 1 Hetatm sulfate-ion (504-)

Linked to sequence 1ql6_a

If an object islinked to an aignment a symbol as shown below will be
displayed.

_t ali'gnments (1 itermns)
Lalip S8 id=75nSeq=7

Alignment is linked to an object

To link a sequence from an object - extract the sequence from the
object.

* Right click on the object in the ICM workspace.
» Select extract sequence.
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To link a sequence and object to an alignment.
Use the extracted sequence as described above to build your alignment.
In addition alink can be made between a structure and alignment by:
» Bioinfo/Link to Structure.
» Enter aignment name.
+ OK
3.6.21 Tags

It is sometimes convenient to tag selections so you can come back and
use them at alater date. To do this:

B R RO e R { Select the region you wish to tag.

LEFHo a0 TR0 ERr FfIJH MEO«BREAGos TTEFEEE
¢ simciay i \/ Jabels \{ mesbes %/ wearch \/_loedt |
| EE N | [he| a2 | | (el

H A Bed ol
- e e
d‘!BRe-s1Mal_1Db|
4 e : '
CEY - bdbln (R 18 o g
* s 2HB A 5§ e

~ ash v
= tyrosne-gaoten kina

Osnm

w 8 : '
o6 B0 o o6 a9 2 WMol 0

ool So+de

T Y T

& 5

Step 1. Sel ect theregion you wish to tag.

3.6.20 Making Links
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Lt'f‘:“”:iw:r“mm R A ' | Right click on the selection and choose
s Ll Heomeclogy Hﬂ-'ﬂf)l' hdziiechanas
— AnnotatefAdd a Tag

_':nna e FRE HB:idE EEaED

Mt
vk Bl @ BEE s | e | ek 2 |6 | [@)e
= R - :
o 19 Res 1 kiol, 1 Oby
v | {1 item)
SE - tbbiE MR 1E
+0 - o
1 - @5t H 4-{4-mesl
tymsmpmmnm

meod > SO+ o

1. Right click on

[ +]
4 -
W
[ the selection

D 7 o4 0 o =

Radii
Cantar i H T

kiove/rotats rraleculs sepasataty ] = : s

Dalete | ] &

Anncate Add 8 Tag...
Fuggle Lygand Tag
Slake Se...

i & ‘ﬂ_ imlLe Q_ ﬂ_# ﬁp_ Rizks 3 tagy¥inid anncistion 1 8ol 1 Oy

Step 2. Right click on the selection and choose Annotation/Add a Tag.

B b Mook kn 391 MaPe A0 b J Enter a name for the tag along with
: PEED A THRO HB RS I PHN FEEeH the selection level e.g. atom )
f—‘%."'"‘-.""'“a!'—-‘xf__“.f“_‘i o
o | & 'd&a.” |EEEEEE | el | e 1n_m
. LA, “— T 4 ' +
£ 19 Res 1 Mol 1 Obj S
-8 {2 zem} 3
S - pabln []NR 18 &
P - o BEA S
v~ asti H d({dmeih |
g - tyrosine-protein kina o
[:]W B ypmbme o : :
A%
B
-
£
..... a
B
F
%-a
-
o TH ~ L .
G B B oo :&,.:Q_:H_:%__ 1 el 1 Obj

Step 3. Give the tag a name and choose the selection level (atom,
residue, molecule, or object).
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FEEO A0 TR0 HBr Il PHE MEaE

e —— s L The tag is stored in the ICM
workspace, Double click on it to select. )

g

Vdhagiyy g\ Tobels \f mestus A smardh 1/ femat |

ieriannc Paral # %
el 19 Res 1 Mol 1 Oy
-§ e
SE - bl [UPHRO16
. s EEA e
Wil » asti H 4 (dmetl

« fyrosme-gectendna |0 ERERHBE L

B - Ligand_Neghbomgmd Double click to

i select

Toggle the tag
on and off

" TEE =
G BE Nl Qe B TEBE Y

M| A @Eed B | R EEm: B | alades | 0] (ale

2 Mgl 1 O

nmegdp dsobad @

Step 4. You will see thetag in the ICM Workspace. Y ou can toggle the
display on or off or select the tag by double clicking onit in the ICM
Workspace.

3.7 Preferences

Your ICM preferences can be changed by:
» Select File/Preferences.

NOTE: Thereisa"Reset to Default" button in case you make any
changes you are not happy with and also a search option.

3.7 Preferences
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3.7.1 Bonds Preferences

To change Bond Preferences:

» Select File/Preferences.
¢ Choose the Bonds tab.

GRAPHICS.ballStickRatio - A default ratio of ball and stick radii. This
ratio is applied when the styles are switched from the GUI xstick
toolbar. Default (1.4)

GRAPHICS.hbond Ball Period - Default (3)

GRAPHICS.hbondMinStrength - parameter determines the hbond strength
threshold for hbond display. The strength value is between 0. and 2. By
changing 1. to 0.2 you will see more weak hydrogen bonds. Default: (1).

GRAPHICS.hbondStyle - determines the style in which hydrogen bonds are
displayed. Here hbond-Donor, Hydrogen, and hbond-Acceptor atoms will be
referred to as D, H and A, respectively,

GRAPHICS.hetatmZoom - The default ball and stick radii of aligand can
be different by the GRAPHICS.hetatmZoom factor. This makes a better
ligand view since the ligand stands out from the surrounding protein

atoms.

GRAPHICS.stickRadius - radius (in Angstroms) of acylinder displayed as
apart of stick or xstick graphical representation of amolecule.

Individual (residue-wide) control of stick radii.

GRAPHICS.xstick Backbone Ratio - Default (1.2)

GRAPHICSxstick Style- xsti ck style
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wireBondSepar ation the distance between two paralel lines representing
achemical double bond if wireStyle = "chemistry". Default (0.2

Angstroms).

GRAPHICS.distance Label Drag - enable distance label dragging
GRAPHICS.hbondAngleShar pness determines how the strength depends on the
D-H...A(lone pair) angle. The preference can be found the genera

Preferences menu Default (1.7)

GRAPHICS.hbond Ball Style even, by atom size, by energy or telescopic
GRAPHICS.hbond Rebuild

GRAPHICS.hbondWidth relative width of adisplayed hbond .

GRAPHICS.hydrogenDisplay determines the default hydrogen display mode
for the display command.

GRAPHI CS. hydr ogenDi spl ay = "pol ar"

1 ="all" # all hydrogens are shown
2 = "polar" <-- current choice # polar displayed, the non-polar hidden
3 = "none" # no hydrogens are displayed

GRAPHICS.wire Width - relative width of wire Default (1)
GRAPHICS.xstick Hydrogen Ratio - Default (0.5)
GRAPHICSxstick Vw Ratio - Default (0.6)

Wire Style - change the default wi r e style

"wre" # Just a line
"chem stry" # shows different types of chemical bonds.
"tree" # shows a directed graph of the | Cv nol ecul ar tree

GRAPHI CS. hbondStyl e = "dash"
= "aromatic" #

AWNEF

3.7.2 Directories Preferences

DIRECTORIESTAB:
To change Directory Preferences:

» Select File/Preferences.
* Choose the Directories tab.

Within thistab you can select the default directories for:

FILTER.gz, FILTER.uue, FILTER.Z, Filter.zip alowsyou to read
compressed files .gz, .uue, .Z, and, .zip files automatically leaving

the compressed file intact.

PDB Directory Style - The style of your Protein Data Bank
directory/directories. ICM will understand all of the listed styles,
including distributions with compressed *.gz , *.bz2 and *.Z fil es
BlastDB Directory - return directory with Blast-formatted sequence files
for ICM sequence searches.Y ou can download Blast formatted databases
fromhereftp://ftp. ncbi.nih.gov/blast/db/

Dock Directory - Default directory for storing docking files.

CCP4 Directory

Editor - Select adefault text editor

3.7.2 Directories Preferences
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Inx Directory - location of stored index (*.inx) files.

Log Directory - when you quit an icm-session, a_seslog.icmfileis
automatically stored. If the s_logDir variable is empty, it is stored to
the s userDir + "/log/" directory. However one can redirect it to the

current working directory ("." ) or any other directory.

Output Directory -

PDB Directory - directory containing the PDB database of 3D structures.
Thesefiles can a so be easily downloaded directly from the PDB site if
the variables are set as in the example below. PDB distributions can
exist in severa styles (all filesin the same directory, or divided

etc.).

PDB Directory FTP

PDB Directory Web

Projects Directory - Select the default location for storing ICM
projects. Save your datain an ICM project. It isaconvenient way of
keeping all your structures, alignments, tables, docking results etc...

in one place. A description on how to save an ICM project is described
inthe GUl Basi cs section of this manual.

Prosite Dat - location of the prosite.dat file a dictionary of protein
sites and patterns, (Copyright by Amos Bairoch, Medical Biochemistry
Department, University of Geneva, Switzerland).

Ps Viewer - Select a postscript viewer

Swissprot Dat - location of swissprot.dat file

Temp Directory - scratch directory for temporary files ( some montecarlo
fileswill be saved there).

Uniprot Dat - location of uniprot.dat file

XPDB Directory - Path to the ICM XPDB database of compact binary ICM
objects which are annotated with the site information. The advantage of

the XPDB database is the speed of reading and smaller size than PDB.
XPDB entries are read about 80 times faster!

TOOL S.default ChemDB

TOOL S.eds Directory

TOOL S.pdb Read Nmr Models

1. = "first" : reads only one nodel froma nmulti-nodel (e.g. NVR) pdb file
2. ="all" : reads all nodels froma nulti-nodel (e.g. NVR) pdb file and creates a separate
3. = "all stack" : creates one object and |oads all other nodels as a stored cartesian stac

3.7.3 Graphics Preferences

To change Graphics Preferences:

» Select File/Preferences.
» Choose the Graphicstab.

Atom Single Style - display style of isolated atoms in the wire mode.

1. "tetrahedron"
2. "cross"
3 "dot"

GRAPHICS.clash Style - choose clash length, strain or length.
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GRAPHICS.clip Grabs - enable grob clipping.
GRAPHICS.clip Static -

GRAPHICS.grobLineWidth - relative width of displayed lines of 3D meshes
(grobs). Also affects the interatomic distance display.

GRAPHICSlightPosition - X ,Y and Z posiion of the light sourcein the
graphics window. The X and Y coordinates are usually slightly@@ beyond
the[-1. 1] range where [-1.,1.] isthe size of the window, and the Z

position is perpendicular to the screen and is set to 2. (do not make it
negative).

GRAPHI CS.occupancyDisplay preference controlling if and how the
partical or zero atom occupancies are displayed. The abnormal
occupanices are shown as circles around atoms. These following values

are alowed.
1. = "none" # nothing is displayed
2. ="circle" # acircle is displayed
3. ="label" # a circle and a lable with the value (zero values are not shown)

GRAPHICS.quality - integer parameter controlling quality (density of
graphical elements) of such representations as cpk, ball, stick, ribbon
. Do not make it larger than about 20 or smaller than 1.

GRAPHICSruler Style- change ruler from center to side

GRAPHICS.stereoMode - 1. "up-and-down", 2. "line interleaved” 3.
"in-a-window"

» asimple hardware stereo mode for workstations with a horizontal
frame splitter.

* Inthe"up-and-down" mode alonger frame with two stereo images on
top of each other is generated and the two halves are then
superimposed with the splitter. This mode does not require
anything from a graphics card, but does require a frame splitter.

A frame splitter box was connected between a monitor and a
graphics card output. This mode has an unpleasant side effect, the
rest of the screen (beyond the OpenGl window) becomes stretched
and the lower part of the screen is superimposed on the top half.

e The"lineinterleaved" mode can be used with a new type of frame
splitter at the line level. In this case the odd lines from one
stereo-image are interleaved with the even lines of another. The
side-effect of this mode is that the intensity is reduced in half
since at each moment one sees only one half of thelines. The
splitter device for this mode can be purchased from Virex
(www.virex.com). This mode produces adark stereo image but is
easily available (requires stereo goggles, e.g. from Virex).

» The"in-aswindow" mode isused in SGI workstations and in a Linux
workstation with an advanced graphics card supporting a quad
graphics buffer. In this mode the hardware stereo regime applies
only to an OpenGl window. Thisis the best mode but it requires an
expensive graphics card (plus the stereo goggles).

GRAPHICS.surfaceDotDensity - Determines the number of dots per square
Angstrom on the graphical solvent accessible surface.

GRAPHICS.surfaceProbeRadius - An increment to the van der Waals radii
of atoms at thich the dotted atomic surface is calculated. It is used by

the display surface command to display dotted van der Waals surface. If

the GRAPHICS.surfaceProbeRadius is set to 1.4 the surface becames
equivalent to the solvent accessible surface with a probe of 1.4A

GROB.arrowRadius - areal arrow radiusin Angstoms used by the Grob(
"ARROW", R ) function. Default: 0.5.

3.7.3 Graphics Preferences
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GROB.contour Sigmal ncrement - area increment in the sigmalevel used
to re-contour an electron density map using the make grob m_eds add
r_increment command. This parameter is used in the GUI when plus and
minus are pressed.

GROB.relArrow Size - aredl ratio of the arrow head radius to the arrow
radius. This parameter is used by the Grob( "ARROW", R_) function.
Default: 3.0.

shineStyle - defines how solid surfaces of cpk , skin and grobs reflect
light. Possibilities:

1. "white" <- default
2. "color"

The first option gives amore shiny and greasy look.

GRAPHICS.center Follows Clipping - determine the function of center
button.

GRAPHICS.clashWidth - relative width of adisplayed clash .
GRAPHICS.clip Skin - enable skin clipping.

GRAPHICS.displayM apBox - controlsif the bounding box of amap is
displayed

GRAPHICSlight - ararray of 13 elements between 0. and 1. which
controls the main properties of lighting model in GL.

GRAPHICS.mapLineWidth - relative width of lines and dots of a displayed
map.

GRAPHICS.occupancy Radius Ratio - preference controlling the radius of
the partical or zero atom occupancies

GRAPHICSresize Keep Scale

GRAPHICS.selectionStyle - preference for the style in which the
graphical selection is shown. The preference may have the following
values.

GRAPHI C.store Display - maintains representation and coloring for an
object.

GRAPHI CS.surfaceDotSize - Determines the size of the dot on the solvent
accessible graphical surface.

GRAPHICS.transparency - Two parameters regulating the transparency of
grobs.

GROB.atomSpher eRadius - default radius (in Angstroms) which is used to
select a patch on the surface of a grob.

GROB.relArrowHead - ared ratio of the arrow head radius to the arrow
radius.

lineWidth - the real width of lines used to display the wire
representation of chemical bonds.

3.7.4 GUI Preferences
GUI TAB:
The options contained within the Preferences/Gui tab are described

below.
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GRAPHICS.alignment Rainbow - This option controls how alignments are
colored by defaullt.

GRAPHICS.NtoC Rainbow - Controls the coloring of structural
representation from the N-terminal to the C-terminal

GRAPHICS.rocking - Controlsdefault r ocki ng noti on.
GRAPHICS.rocking Speed - Controls rocking or rotation speed.

GUI.auto Save Interval - Controls auto save period (minutes)

GUIl.table Row Mark Colors- Controls colors used for mar ki ng t abl es.

GUI.workspaceT abStyle - Controls the style of ICM-object tabs created
inthewor kspace panel of ICM GUI.

M ovie.fade Nof Frames - Controls number of frames for the fade out
optioninscr eenshot mnovi e making.

Movie.quality - Controls the resoltuion of the movie
SEQUENCE.site Colors - Controls coloring of squence sites.

SLIDE.ignore Fog - Fog representations can beignored in sl i de
preparation if desired.

GRAPHI CS.discrete Rainbow -

GRAPHICS.rainbow Bar Style - determinesif and where the color bar will
appear after amoleculeis colored by an array.

GRAPHICS.rocking Range - real value of rocking range.

GUI .auto Save - auto save on or off

GUI.max Sequence L ength - maximum segquence length displayed in ICM
GUIl.workspace Folder Style- Wor kspace folder style.

MOVIE.frame Grab Mode - with scr eenshot novi e making you can choose
either fixed frame time or real time.

Movie.quality Auto - withscr eenshot novi e making you can alow ICM to
control the movie resolution.

SLIDE.ignore Background Color - Ignore background color when you are
making asl i de.

3.7.5 GUI Preferences

To change GUI Preferences:

» Select File/Preferences.
e Choose the GUI tab.

Quality - controls the quality (density of graphical elements) of such
representations as cpk, ball, stick, ribbon . Do not make it larger than

about 20 or smaller than 1. We recommend to make this parameter at least
15 if you want to make a high quality image. Y ou can a so increase the
number of image resolution by making the image window 2,3,4 times larger
(in the example below it is 2 times larger) than the displayed window.

Wire Style - Four different wire styles are available.
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Hydrogen Display - Select whether you always want all hydorgens
displayed or just-polar hydrogens or no hydrogens at all.

Rainbow Scale - determines if and where the color bar will appear after
amoleculeis colored by an array. Coloring by an array is one of the
options of the display and color commands.

"left" <- default choice
"right"

"no text"

"no bar"

PwnE

Ball Ratio - Theratio of ball and stick radii. Thisratio is applied
when the styles are switched to xstick from the GUI xstick toolbar.

Selection Style - Change the graphical display of your selections.
Default is agreen cross.

Clash Threshold - aclash is defined as an interatomic distance less
than a sum of van der Waals radii of two atoms of interest multiplied by
the clashThreshold parameter. For hydrogen bonded atoms, the distance
threshold is additionally reduced by 20% . Default = 0.82

DotSurfaceRadiusl ncrement - adius of a probe sphere used to display a
dotted surface of amolecule. All van der Waalsradii are expanded by

this value. vwExpand=0 corresponds to the CPK surface, vwExpand=1.4
corresponds to the water-accessible surface. Be aware of the difference
between the waterRadius and vwExpand parameters. waterRadiusisused in

show energy "sf"

show [arealvolume] skin

display skin while vwExpand isused in
show [arealvolume] surface

display surface

Defaullt (1.4).

H Bond Style - How do you wish your H-Bonds to be displayed by default?
Dashes, Bond Length, Bond Lenght and Angle.

grobLineWidth - relative width of displayed lines of 3D meshes ( grobs
). Also affects the interatomic distance display.

general linewith - the real width of lines used to display the wire
representation of chemical bonds. See also IMAGE.lineWidth parameter
which controls line thickness in molecular images generated by the write
postscript command, and the PLOT.lineWidth which controls the width for
the plot command. Default (1.0)

single atom as - display style of isolated atoms in the wire mode.

. "tetrahedron”
. "cross"
. "dot"

1
2
3
The size of the first two representation is controlled by the GRAPHI CS. bal | Radi us paraneter an

xstickhetatomzZoom - The default ball and stick radii of aligand can be
different. This makes a better ligand view since the ligand stands out
from the surrounding protein atoms.

solid shine style - choose either white or color

Stick Radius - radius (in Angstroms) of a cylinder displayed as a part

of stick or xstick graphical representation of amolecule. Individual
(residue-wide) control of stick radii.

Stereo Mode - Select adefault stereo mode
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Display Style - A default display style can be chosen using a
combination of styles.

Water Radius - radius of water sphere which is used to calculate an
analytical molecular surface (referred to as skin) as well asthe
solvent-accessible surface (centers of water spheres).

clashWidth - relative width of adisplayed clash.
hbondWidth - relative width of hydrogen bond display
mapLineWidth - relative width of lines and dots of a displayed map.

3.7.6 Image Preferences

To change Image Preferences:

» Select File/Preferences.
» Choose the Image tab.

IMAGE.color - logical to save color or black_and white ("bw’) images.

IMAGE.gammaCorrection - real variable to to lighten or darken the image
by changing the gamma parameter. A gamma value that is greater than 1.0
will lighten the printed picture, while agamma value that isless that

1.0 will darken it.

IMAGE.lineWidth - thisreal parameter specifies the default line width
for the postscript lines.

IMAGE.orientation - image orientation.

IMAGE.previewer - astring parameter to specify the externa filter
which creates a rough binary (pixmap) postscript preview and adds it to
the header of the ICM-generated high resolution bitmap or vectorized
postscript files saved by the write image postscript, and write

postscript , respectively .

IMAGE.print - unix command for printer.

IMAGE.scale - real variable. If non zero, controls the image scale with
respect to the screen image size.

IMAGE.stereoBase - real variable to define the stereo base (separation
between two stereo panels) in the write image postscript and write
postscript command.

IMAGE.writeScale - an integer parameter used to increase the image
resolutioninthe Qui ck 1 mage Wite tool .

IMAGE.bondL ength2D - real length of achemica bond (ininches) in
chemical 2D drawings upon the Copy Image command.

IMAGE.compress - logical to toggle simple lossless compression, standard
for .tif files. This compression is required to be implemented in all
TIFF-reading programs.

IMAGE.generateAlpha - logical to toggle generation of the alpha
(opacity) channel for the SGI rgb, tif and png image files to make the
pixels of the background color transparent.

IMAGE.lineWidth2D - integer thickness of bonds in chemical 2D drawing
upon the Copy Image command. Thisis useful for cutting and pasting from
ICM to external documnents.

IMAGE.paper Size - specify paper size.

3.7.6 Image Preferences
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IMAGE.previewResolution - integer resolution of the rough bitmap
preview added to the vectorized postscript file in lines per inch.

IMAGE.printer DPI - thisinteger parameter the printer resolution in Dot
Per Inch (DPI). Important for the write image postscript command.

IMAGE.stereoAngle - real variable to define stereo angle (relative
rotation of two stereo images) in the write image postscript and write
postscript command.

IMAGE.stereoText - logical to make text labels for only one panel or
both panels of the stereo diagram.

3.7.7 Label Preferences

To change Label Preferences:

» Select File/Preferences.
* Choose the L abels tab.

atomL abel Style style of atom labels invoked by clicking on an theat om
| abel button.

GRAPHICS.displayLinel abels - enableg/disables the display of edge
lengths (inter-point distances) of a grob generated with the Grob(

"distance" .. ) function.

GRAPHICS.font Line Spacing - Change the spacing between lines in labels.

GRAPHICSresLabelDrag - if yes, enables dragging of the displayed
residue |abels with the middle mouse button.

GRAPHICS. site Arrow - Highlight sites with an arrow yes or no.

Show Res Code I n Selection - When you make a selection the icm selection
language will be displayed when you right click on the selection.

ResLabel Style- Defaultr esi due | abel style.

SITE.label Style- Default | abel sites style

Var Label Style- Default | abel vari abl e style.
GRAPHICS.atomL abel Shift - a non-negative integer number of spaces
preceding an atom label. This parameter is useful for displaying labels
next to a solid representation,

GRAPHICS.fontColor - set font color

GRAPHICS.font Scale - set font size

GRAPHICS.site Labd Shift - GRAPHICS.resL abel Shift a non-negative
integer number of spaces preceding asite label.

GRAPHICS. site Label Drag - if yes, enables dragging of the displayed
site |abels with the middle mouse button.

Res L abel Shift - a non-negative integer number of spaces preceding a
residue labdl. This parameter is useful for displaying residue labels
next to a solid

SITE.labelOffset - (default 5. A) the real offset of the site label with
respect to the residue label atom.

SITE.wrap Comment - Number of characters per comment line.
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3.7.8 Plot Preferences

To change Plot Preferences:

» Select File/Preferences.
» Choose the Plot tab.

PLOT.color - logical to generate a color plot. Usually it does not make
sense to switch it off because your b/w printer will interpret the color
postscript just fine anyway.

PLOT.draw Ticslogica yesor no

PLOT .fontSizereal font size. Any reasonable number from 3. (1 mm, use a
magnifying glass then) to 96.

PLOT.lineWidth - real line width for graphs (not the frame and tics)
PLOT.markSize - real mark sizein points. Allowed mark types: line,

Ccross, square, triangle, diamond, circle, star, dstar, bar, dot, SQUARE,

TRIANGLE, DIAMOND, CIRCLE, STAR, DSTAR, BAR. Uppercase words indicate
filled marks.

PLOT .paper Size - preference to specify plor paper size

PLOT.rainbowsStyle - preference defining the color spectrum used by the
plot area command.

PLOT.Yratio - real aspect ratio of the ICM plot frame. Using link option
of the plot command is equivalent to setting thisvariableto 1.0. If
PLOT.Yratioisset to 0., the ratio will be set automatically to fill

out the available box optimally.

[PLOT.date} - display date on plot

PLOT .font - preference for the title/legend font.

PL OT .labelFont - preference for the data point label font.

PLOT.logo - logical switch for the ICM-logo on the plot.

PLOT .orientation - preference for the plot orientation.

PLOT .previewer - command to local ps viewer

PL OT .seriesL abels - preference to indicate position of a series/color
legend inside the plot frame.

3.7.9 Ribbon Preferences

To change Ribbon Preferences:

» Select File/Preferences.
» Choose the Ribbon tab.

Combo Display Style - select ribbon-cpk, atoms, ribbon-ligand, chemical

GRAPHICS.dnaRibbonRatio - rea ratio of depth to width for the DNA
ribbon .

GRAPHICS.dnaRibbonWorm - logical which, if yes, makes the DNA backbone
ribbon round, rather than rectangular. Default: no

GRAPHICS.dnaWormRadius - real radius of the worm representing bases in
DNA ribbon .
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GRAPHICS.ribbonWidth - rea width of the protein ribbon .

GRAPHICS.wormRadius - radius of coiled segments (i.e. those where the
secondary structureismarked as™_") of a polypeptide chain in ribbon
representation. Default (0.3).

Ribbon Style - specifies default stylewhen r i bbon is displayed.

GRAPHICS.dnaBallRadius - DNA basesin ribbon representation are shown
as balls controlled by thisreal parameter.

GRAPHICS.dnaRibbonWidth - real width (in Angstroms) of the DNA ribbon .

GRAPHICS.dnaStickRadius - real radius of the sticks representing bases
in DNA ribbon .

GRAPHICSribbonRatio - real ratio of depth to width for the protein
ribbon .

GRAPHICS.ribbonWorm - logical parameter, if yes, makes the ribbon round,
rather than rectangular.

ribbonColor Style -

ets the ribbon coloring schene.

3.7.10 Shell Preferences

To change Shell Preferences:

» Select File/Preferences.
* Choose the Shell tab.

Clash Threshold - aclash is defined as an interatomic distance less
than a sum of van der Waals radii of two atoms of interest multiplied by
the clashThreshold parameter.

Map Sigma Level - (in Rmsd values over the mean value). Margin value
used for making graphical objects contouring the 3D density map .

Mnconf - maximal number of conformations in the conformational stack .
The stack stops growing after this number is achieved and starts

replacing representative conformations with higher energy values by new
conformations with superior energies, if the latter are found.

Icm Prompt - defines the ICM-prompt string.

Select Min Grad - default minimal gradient vector length for gradient
atom selection (a //G). This parameter is also used by the montecarlo
fast command, which requires avalue of 2. to 10. for optimal
performance.

Map Atom Margin - Margin in Angstoms around selected atoms. The margin
is added to the positional boundaries to define a submap index box in
the Map ( map_source, as_) function.

maxColor Potential - local electrostatic potential in kcal/e.u.charge
units at which the surface element is colored by extreme red or extreme
blue. All higher values will have the same color. This absolute scaling
is convenient to develop afeeling of electrostatic properties of
molecular surfaces.
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mnSolutions - this parameter limits the number of hits retained by the
program after a search.

Real Format - format of real numbers

Water Radius - radius of water sphere which is used to calculate an
analytical molecular surface

3.7.11 System Preferences

To change System Preferences:

» Select File/Preferences.
e Choose the System tab.

FTP.createFile -

FTP.proxy - string path to the proxy server for connections through
firewall. Default: " (empty string).

GUI.max Nof Recent Files - maximum number of r ecent fil es stored.
GUI.splash Screen Image - path to splash image displayed on startup
HTTP. support Cookies - http support cookies yes or no

HTTP.user Agent - client application used within a particular network
protocol for www

Beep - warning beep yes or no

Max File Size Mb - Maximu file size in MegaBytes that can be loaded into
ICM.

USER.friends
USER.organization

FTP.keep File - (default no). If yes, the temporary fileiskept in the
s _tempDir directory. Otherwise the fileis deleted.

GUI.enumberation Memory Limit - memory limit for enumeration operations.

GUI.splash Screen Delay

HTTP.proxy - string for HTTP server for connection through firewall
HTTP.timeout - timeout in seconds

Http Read Styleicm or lynx

Force Auto Bond Typing - yesno

USER.email, USER.full Name, USER.phone

3.7.10 Shell Preferences
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4 Protein Structure

Chapter Contents:

Binding Site Display Tools.

Crystal | ographi c Anal ysis Tool s.

Pr ot ei n Super position.

Protein Structure Analysis.

Protein Structure Prediction Tools e.g. ICM Pocket Finder.

4.1 Convert to ICM Object

Availablein the following product(s): | CM Br owser || CM Br owser - Pr o
[ CM Pro |l CM Chem st

4.1.1 Load a Protein Structure

There are a couple of waysto read into ICM a protein structure.

1. Searchthe PDB using the Sear ch Tab.
2. LoadinaPDB file that you have saved on your computer using
Fi | e/ Open.

4.1.2 Converting PDB Files Into ICM Objects

If you are going to make any type of energy calculationin ICM (eg

docking, display H-bonds, display electrostatic and binding property

surfaces etc..) it is necesary to convert aprotein or chemical into an

ICM object. Be aware that upon conversion ICM adds missing side-chain

atoms (but wont try to build missing loops) due to the nature of the

internal -coordinate system. The list of residues/ atoms added is

presented in the command line shell and can be reviewed. For reference,

the original PDB entry is kept in the system. See the command line

manual for amoreconpl et e descri pti on of what the conversion process
does.

NOTE: Before converting a protein structure to an ICM object make
sure that the chemicals contained within the structure (e.g. ligands)
are correct. If an error is found you can edit the ligand as

described here.

Toconvert a PDB structureinto an ICM object follow the steps shown
below:

4 Protein Structure

How to Convert Proteins and Chenicals to | CM bj ects.
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» Right click on the name of the protein you wish to convert in the
| CM Wor kspace.

» A dialog box will be displayed as shown below.

» If you want to delete the water molecules select Delete Waters

« If you want to optimize hydrogen atoms (recommended for important
work) select Optimize Hydr ogens. This option performs global
optimization of hydrogens to find the best hydrogen bonding
network.

* If you want to optimize the orientation of His, Pro, Asn, GIn, Cys
residues then choose optimizeHisProAsnGInCys. The following
residues will be further optimized: His - three protonation states
and two rotations will be tried and the residue will be renamed
according to its subtype: hie (epsilon tautomer) or hip (+). Asn
and GIn - (a 180 deg. flip will be tried). Cys - in the vicinity
of Zn, Cu, Fe and Co to cym.

» If you want to keep a copy of your PDB file uncheck the option
replaceoriginal.

» The converted structure can be displayed immediately by checking
display the result

e Uncheck the box hide missing side chainsif you want ICM to build
missing heavy atoms that are not reported in the PDB (due to the
lack of density), they will be added according to the residue name
and assigned zero occupancies. Check this box if you want residues
missing heavy atoms to be hidden.
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If your object isan ICM object it will display ICM next to the molecule
in the ICM Workspace.
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4.2 Pocket Display

Availablein the following product(s): | CM Br owser || CM Br owser - Pr o
[ CM Pro

4.2.1 Receptor Pocket Surface.

Todisplay the Receptor Pocket Surface:

» Asan example we will use the PDB structure 1STP. Type 1STPin the
pdb search tab and pressreturn.

» Convert theproteintoan ICM object. If you do not convert a
generic surface will be displayed that is not colored by binding
property.

» Right click on the ligand "abtn" and select Pocket/Receptor
Pocket.

» Select whether you would like to display side-chain hydrogen bonds
and label.

» The receptor pocket will be displayed colored by binding property
- White=aromatic lipophilic, Green=non-aromatic other (mostly
aliphatic) lipophilic surface, Red=hydrogen bonding acceptor
potential, Blue=hydrogen bond donor potential.

» The surface can be toggled on and off by selecting in the ICM
Workspace in the meshes section.

4.2 Pocket Display
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4.2.2 Ligand Surface.

TheLigand Surface option allows you to visualize cavitiesthat are open
for ligand modifications. To display the Ligand Surface:

¢ Asan example we will use the PDB structure 1STP. Type 1STPin the
pdb search tab and pressreturn.

e Convert theproteintoanICM object. If you do not convert a
generic surface will be displayed that is not colored by binding
property.

« Right click on the ligand "abtn" and select Pocket/Ligand Surface.

¢ The Ligand Surface will be displayed colored by binding property -
White=aromatic lipophilic, Green=non-aromatic other (mostly
aliphatic) lipophilic surface, Red=hydrogen bonding acceptor
potential, Blue=hydrogen bond donor potential.
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4.2.3 How to Display Hydrogen Bonds

NOTE: The method by which hydrogen bonds are calculated is described
her e in the command line manual. The GRAPHICS.hbondMinStrength
parameter determines the hbond strength threshold for hbond display.
The strength value is between 0. and 2. By changing 1. to 0.2 you

will see more weak hydrogen bonds.

 Inorder to display energy related properties we need to convert
the PDB fileinto an ICM object. Convert 1STPintoan|ICM object.
In this example, the option "Replace the Original" was selected.

» Display the receptor in wire format and the ligand in xstick.

» Right click on the ligand and select "Neighbors" - Enter 3
Angstroms and Type = Visible. Do not exclude source (the ligand)
therefore remove tick from box entitled "exclude source'.

» Select the display tab and then select the Display H-Bond button.

4.2.2 Ligand Surface.
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NOTE: Different options for displaying the H-bond can be accessed by
clicking and holding on the H-bond button in the "Display" tab. The
coloring of the H-bonds are red (strong - thick spheres) to blue

(weak - thin spheres). Once the hydrogen bonds have been displayed
they can be displayed and undisplayed in the 3D |abels section of the
ICM Workspace (left hand side of graphical window).

4.2.3.1 Edit Hydrogen Bond Label

To edit a hydrogen bond label
* Right click on thelabel.

» Choose Edit Label.
» Make changesin the dialog box and press OK.

98 4.2.3 How to Display Hydrogen Bonds




(5 mwom em 373 Mg 11 st
&ﬂmmmmmmm i
: BEBO kil 'ﬁﬁD Y e Py PE R B

E@@ T e : s

Siae

| How to edit a hydrogen bond label.
“ Right click on the label and choose
“Edit Lahel"

& X
1E {1 2em)
1| | =@ rbondpars (118 hydrogen bonds)
i B objects (1 tem)
EgRbiotin  [17]ICH, 284 :
}gm H bin 30 bel Wbondpain i)
a 116A
L@ streptavidin complex win 1. Right click P
here V| distancein]
S solid kne
detted ling
Lo ¥ e
i e” et b
— Resat Labsi Position
& Sat Spheve Peviod..
- Change Cobos..
- K Delete
4 |8 |5 \

muolD Y l ._

@,

Tl

dem/bistin
‘

e icarbiotin>centar FERETE EE _graph
g iea/biotinset labsl hbondpairs selsetien “2.39%% size=40 foar="courisz®
] jemfbistin>display hbondpairs selection label
jem/biszin>set label hbendpairs seleetiom *2.35%% size=10 fear="courisz®
jemfbistinrdisplay hbondpairs selection label

G BEp g DDl [od i ol

egh={0,128,128}

eghe={0,128, 160}

loe mDncaals

1 Ch Ok

[ 8 biotin Motsoh icm 37-3a [Mewbroject % {1 obiect

b i Wi Baninbs o lonls

EsEo Ao

Hpesatag L

TR0 HErFIHH .luEAGi& IEEEER N

dsgiay \f dght 1S lgbek 4 meshes \J search W igedt |

{ieedking

Enter the label details and change font.

dlaibdechanes e

B EEEeR = 8| B EE 3 IEIIMvE@@D@IGi E|_J

[Werispacs Faned &

o 1 hborsipains .
=g 3D labelz  ({f am)
o fff hbondpairs {118 hydrogen bonds)
-l objects (1 tem)
Sf8 bictin {37100, 284
vl biotin  H bn
+Blla 15A
L iflh straptavidin complex with bictin

a | |

igEindoentery SbBELid 88 gra

iem/bistinsff
i

1. Edit label if 1
needed here

L

& iom/Bistin>set labsl hbondpairs select
iemfbistinddisplay hbondpairs selectio
icm/bistin»set label hbondpairs select
iem/bistind>display hbondpairs selection labael

2. Change
font

GHRLS DAHE-- moodd Wodh N " —

R NCY=ENCNCTENEN

L3084 02t

4.2.3.2 Move Hydrogen Bond Label

To move a hydrogen bond label

¢ Right click on the label.

¢ Click on the label using the middle mouse button.

4.2.3 How to Display Hydrogen Bonds



* Hold the middle mouse button down and drag.

B8 ot okt iom 21730 Bt 0 ket I To move a hydrogen bond label,

Bﬂﬂﬂ ¥ QQ’ !i J'Iﬂi [@Ekidﬂ‘l!& I EEEERN
m

ST E O S e :l | | el | G| = (o
:u:um. i \ '::Z_’ i"*x..ﬁ_\\/ s

= 3D labeis  {f tam)
i [ hbondpairs {118 hydrogen bands)

=l objects (1 tem)
= bictinn  [17]1CM, 284
S biotin H b
vflfa i5A
i streptavidin complexcwith 1, Click on the
middie
mouse button
and drag
R i s
a |98 | | s ) N l\-

af | femfBis¥in¥center static as _graph
# icm/bictin*set label hbondpairs selectiom "2.3%" sizewdl fomtw™cour
iemfbistinddisplay hbondpairs selesction label

isr” rgbw|0,128,1238})

iom/bictin>set label hbondpairs selectiom *2.3%" pize=l(0 fontw“courisr® zgbem|0,128,140}
djem/biscinrdispley hbondsairs selsction label 3
i iem/biotin> -
L) ]
el =Y CEYEN LKMo

v

GHBLED DM & o

&-unrnnﬂﬁa

4.2.4 Ligand Pocket Interactions

To view the ligand pocket interactions.
¢ Right click on the ligand and choose Pocket.

¢ Choose Ligand Pocket Interactions. Hydrogen bonds, key waters and
neighboring residues will be displayed.
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4.3 Crystallographic Analysis

Availablein the following product(s): | CM Br owser - Pro || CM Pro
4.3.1 Crystallographic Neighbor

Theory

Molecular objects and 3D density maps may contain information about
crystall ographic symmetry. It consists of the following parameters:

1. Crystallographic group eg. P2121 that determine N (depends on a
group) transformations for the atoms in the asymetric unit.
2. Crystalographic cell parameters A, B, C, Alpha, Beta and Gamma

To generate the coordinates within one cell one needsto apply N
transformations and then to generate neigboring cells the content of one
cell needs to be translated in space according to the cell position.

ICM has a function which generates crystall ographic neighbors for the
selected atoms. For large proteinsit isimpractical to generate
neighbors for the whole molecule due to the high number of atomsin all
neighboring molecules.

4.3 Crystallographic Analysis
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Thisinformation allows to generate symmetry related parts of the
density or molecular objects.

To generate symmetry related molecules around a selection of atoms:

» Read aPDB fileinto ICM. For instruction see the section entitled
Search PDB.

» Display the structure and select the residues around which the
symmetry will be generated. For information on how to select
residues seethe Maki ng G- aphi cal Sel ecti ons section.

» Select the menu Tools/Xray/Crystallograhic Neighbors.

A data entry box as shown below will be displayed.
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» Check that the selection is correct in the I nput Selection box.

 Enter the radius around your selction from which you wish to
construct the symmetry related molecules.

 |f you have made symmetry related molecules previously you can
select appendT oPr eviousNeighbor s otherwise leave unchecked.

* The extendResidueWindowsBYy option will allow awindow of residues
outside of the selection radius selected above to be displayed

* If you leave the keepEntireChain unchecked then a fragment of each
neighbor will be created. If you check this box the full neighbor
will be generated

» Check display symmmetry neighbors to display them in the graphics
window. The nearest neighbor residues will be displayed in xstick
representation and the each neighbor colored by molecule.

» Click OK.

The crystallographic symmetry neighbors will be displayed in the
Workspace. By default the object will have the object name + "Sym" and
each of the neighbors will be individual molecules.

For packing analysis and display you can color each symmetry unit a

different color asdescribed inthe St r uct ur al Represent ati ons Col or
sect i on. Thisisshown in the picture below.
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4.3.2 Crystallographic Cell

Theory

The crysta structure of a protein is often discussed in terms of its

unit cell. The unit cell isabox containing one or more motifs, a
spatial arrangement of atoms. The units cellsaretiled in
three-dimensional space to describe the crystal. The unit cell isgiven
by its lattice parameters, the length of the cell edges and the angles
between them, while the positions of the atomsinside the unit cell are
described by the set of atomic positions measured from alattice point.

To display the crystal cell of a PDB structure:

¢ Read aPDB fileinto ICM. For instruction see the section entitled
Sear ch PDB.

« Select the whole object. Y ou can do this by double clicking on the
name of the structurein the ICM Workspace (a selection is
highlighted blue in the ICM Workspace and green crosses in the
graphical display) or you can use the right-click button and drag
it over the whole structure in the graphical display.

¢ Select the menu Tools/Xray/Crystallograhic Cell and a data entry
box will be displayed.

e Click OK

The crystallographic cell will be displayed as a box as shown below.

4.3.2 Crystallographic Cell

O BE TR 2 b D0 e e e
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4.3.3 Biomolecule Generator

Theory

It isvery useful to know how a protein from the PDB may look in a
biological environment. The PDB entries solved by X-ray crystallography
and deposited in the PDB contain the information about the crystal
structure rather than the biologically relevant structure. For example,

for aviral capsid only one instance of capsid protein complex will be
deposited and only one or two molecules of haemoglobin that is a
tetramer in solution maybe deposited.

In some other cases the asymetric unit may contain more than one copy of
abiologically monomeric protein. ICM reads the biological unit
information and has atool to generate a biological unit. Not every PDB
entry has the biological unit information.

A gallery of images created using the ICM Biomolecule generator is shown
below:

Left: PDB: 1DWN Bacteriophage Pp7 From Pseudomonas Aeruginosa At 3.7 A
Resolution Right: PDB: 1C8E Feline Panleukopenia Virus Empty Capsid
Structure At 3.0 A Resolution
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Left: PDB: 1AL2 P1/Mahoney Poliovirus, Single Site Mutant V1160l At 2.9
A Resolution Right: PDB: 1LP3 Adeno-Associated Virus (Aav-2), A Vector
For Human Gene Therapy At 3.0 A Resolution

NOTE: Right click on a PDB structure in the ICM workspace to
determine whether a structure from the PDB has biological unit
information. If it does have this information then there will be an
option in the menu entitiled "Generate Biomolecules' if not the
option will be blanked out.

To generate a biological unit with ICM:

* Sel ect theobject or PDB file.
» Select the menu Tools/Xray/Biomolecule Generator.

» Tick the makeAllBiomolecules box.
» Click OK - with very large molecules the biomol ecul e generation
may take some time.

4.3.4 Get Electron Density Map

Theory

An electron density map is a representation of acrystal structure based
on the diffraction data. The map is constructed by a summation of waves
of known phase, amplitude and frequency using Fourier transform. The
electron density map of a protein can be viewed along with the pdb
structure. The easiest way to view the electron density map isto

contour and convert it into a graphical object (mesh).

A figure showing the electron density contours surrounding the ATP
moleculein pdb entry 1ATP.

4.3.4 Get Electron Density Map
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Toload an electron density map:

» Tools/Xray/Get Electron Density Map

» Enter the PDB code of the map you would like to view.

* Click OK and the map will be downloaded from the Uppsala Electron
Density Server.

The map will be represented in the ICM Workspace as shown below.

ICM Workspace

no selection u
-l objects (1 itern)
- mlTatp  [1] %-Ray, 2.204
=6 maps (1 item)

Ll latp size= 2471 K

I Name of map

Display and undisplay map here

The map can be displayed as shown below however a clearer way of
representing the density is to contour the map into a graphical object
(mesh) as described in the following section.
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4.3.5 Map’s Original Cell

Todisplay theoriginal cryst al | ographi ¢ cel | of an electron density
map:

» Toolg/Xray/Map's Original Cell

 Enter the name of the map or use the drop-down button to locate
it. If you do not know the name of the map the name can be located
in the ICM Workspace.

e Click OK and the cell will be displayed. The map can be displayed
and undisplayed in the meshes section of the ICM Workspace.

Generated cell

H- |a | 454
-l meshes | (1 item)
. =[EgCelMap  v=BI=1:
= maps (1 item)

L] m_ Zhdw size= 94

MName of map
4.3.6 Contour Electron Density Map

To contour an electron density map and display asa graphical object:

» Load an electron density map as described earlier inthe Load Map
section.

* Readinthe PDB file - File/lLoad PDB or use the PDB search tab.

e Toolsg/Xray/Contour Electron Density.

» Enter the name of the map e.g. m_1cdg - the name of the map is

displayed in the ICM Workspace or use the drop down arrow to
locateit.
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« If nothing is displayed then the whole map will be contoured. If
you only want to contour a particular region of the map then you
needto sel ect theregion to be contoured (e.g.the binding pocket)
and then select the option Trim to Selection Vicinity.
¢ Enter asigmalevel value for more information see:
http://ww. nol soft. conf man/ real s. ht Ml #mapSi gnalLevel . Oncethe
contoured map has been created the sigma level can be changed
manually using the +/- buttons in the ICM workspace. Two contour
levelsat 1 and 2.5 sigma respectively are generated for the 2Fo -
Fc map

o i et B L - How to Contour Electron Density ]
Eie Edt View Bioinfo Tooly Homology Chemistry

LEHo 9 NG00 EHAL: Al PH ExcBED400s TidsEil
(dhstsey gt "\ Takels \/ meshed '\ seardh \/ Toedt |

- o -
1. Tools/Xray/Get Electron Density Map followed ‘Lﬂ- ‘ 28 X el o ] 1 l @
by Tools/Xray/Contour Electron Density Map

TR PR L URAT = f.
=il obects (1 itern) _'."."'f
_urn fedg (1% ¥R, 2.04 8 ‘
& E Bl G
émamal H ma
o jamalz H oo
s Jamald H mafiose
{Jaca M ATy 42
Dal‘ilz I B 7,
ﬁtytmdexmngiycusﬂh

meGH P So+h 0

Migicdg2 250
=[Timeps {2 items
[m_1cdg T658HD [0.83
[Clem_tedg 1 S536Kb {0

m_Bedg
L s ey {1029
caors Cireton”, bt}
o | T 10 sslaction oty
Halp
MOTE: 28 BLT atoms of mterest

Com ] e ]|

GREEF S D Ol fed

m.llﬂngaﬁn"& ' _

The sigmalevel can be changed interactively in the ICM workspace as
shown below.

E B meshes (2 items)

{Jg_tatp_ 1 1.80:
- ~EXo tatp 2 16
=) maﬁs (3 items)

Click here to increase or decrease
the sigma level of the contouring

NOTE: Meshes can be cut away using thenesh cl i ppi ng t ool s.
4.3.7 Convert Xray Density to Grid

For some applications, such astrying to fit a structure to a density
map, you may want to extract a sub map and convert to agrid. Y ou can do
this by

» First read into ICM amap (eg File/Open or Tools/X-ray/Get

Electron Density Map)
¢ Tools/X-ray/Convert Xray Density to Grid
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» Enter the map name or use the drop down list
e Enteragridsize
* Click OK

4.4 Protein Superposition

Availablein the following product(s): | CM Br owser - Pro || CM Pro

e

$e

!

Superimpose
Button

One or more proteins can be superimposed. Simply select

the molecules or parts of the molecules you wish to superimpose and then

use the selection of protein superimpose tools described in this

section. A convenient superimpose button can befoundinthe Di spl ay tab
(seeimage of button (left).

Chapter Contents:

Sel ect Proteins for Superposition

Superi nmpose Button

Superi nmpose by 3D

Superi nmpose Miultiple Proteins

Arrange as Gid

Superinmpose Sites by Atonmic Property Fields

4.4.1 Select Proteins for Superposition

Before any superposition operation can be undertaken you need to select
the protein structures you wish to superimpose.

One way to do thisis by selecting in the ICM workspace. For other
selection tools please see the Maki ng Sel ect i ons section of the manual.

» Select both receptors by double clicking on the name of the
moleculein the ICM Workspace. To select two molecules use the
Ctrl button or use the shift button to select arange of objects
in the ICM Workspace. A receptor which is selected will be
highlighted in blue in the ICM Workspace and with green crosses in

the graphical display.

4.3.7 Convert Xray Density to Grid
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Once the molecules are selected you can then superimpose them using the
options described in the next section of this manual.

4.4.2 Superimpose Button

A convenient way to superimpose two moleculesis by using the
superimpose button in the display tab, ICM will calculate the Ca-atom,
backbone atom and heavy atom differences between the two structures.

More advanced superimpose options can be found in the Tools/Superimpose
menu.

To superimpose;

» First load the two structuresinto ICM.

» Select which parts or all of the two structure you wish to
superimpose (see the chapter on Sel ect i ons or the description
protein-superposition-select{ here} .).

» Select the display tab (previously called Advanced tab) at the top
of the GUI.

» Select the superimpose button.

i)

LY

Superimpose
Button

The rmsd will be displayed in the terminal window as shown below:
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LHTUS U dLUNS SUPET LNPpUSEU, FTNsU—1.90 104D

icm/1yé6> superimpose { Res{ as graph ) & a_./fca,c,n,0 ) & 0bj{ as _graph )[1]
Warning> [118] skipped 4 atom pairs with zero occupancies

Info> 64 atoms superimposed, rmsd=1.381643

icm/1y6>

4 |

RMSD displayed here

NOTE: You do not need to select the whole molecule, the superimpose
button will work on small selections e.g the loop regions or domains.

4.4.3 Superimpose by 3D

To superimpose proteins by 3D:
» Firstdi spl ay and sel ect the proteins you wish to superimpose by
3D

. Toéls/SJperi mpose/Proteins by 3D
* A window as shown below will be displayed.

€ Automated multiple structural superposition @@

Help

malecules must be SELECTED and belong to different objects. Ta
zuperimpose molecules in the same object clone it

i~ C alpha " Backbone " Heawy Atoms

Static Dbject |a_1qE. |
sequence weight |EI.5 j
zeed length | 15 ﬂ

Ok | Cancel

» Select by which atoms you wish to superimpose.
» Enter the ICM selection language description for the protein
structure you wish to remain static. Y ou can aso use the drop
down arrow button to select it.
» Enter the sequence weight Average local sequence alignment score.
» Enter the seed length Thisisthe similarity window size.

4.4.4 Superimpose Multiple Proteins

To superimpoe multiple proteins:

» Firstdi spl ay and sel ect the proteins you wish to superimpose by
3D

. Toéls/Superi mpose/Multiple Proteins
* A window as shown below will be displayed.

4.4.2 Superimpose Button 111



@ Align Residues () Match By Res Mumbers () Exact Match

@ Visible Atoms ) Caipha () Baddone (7 Heavy Atoms
Static Ohject a_glpl.

@ weighted iterative superposition (¢ single global superposition

{ Ck H Caricel H Help ]

» Select by which method you would like to superimpose

Align Residues - Residue correspondence is established by sequence
alignment using the ICM ZEGA aignment Abagyan, Batalov, 1997. Atom
alignment: by atom name.

Match by Res Number s - Residue alignment by residue number.Atom
alignment: by atom name for pairs of identical residues or pairs of
closeresidues (F with Y; B with D,N; D with N; E with Q or Z, Q with
Z), for other residue pairs only the backbone atoms ca,c,n,0,hn,haare
aligned.

Exact Match - Residue alignment is by the Needleman and Wunsch method.
Inside residue atoms are aligned sequentially and regardless of the
name.

» Select which atoms you would like to superimpose. Visible Atoms, C
alpha, Backbone, or Heavy Atoms.
» Select whether you would like to use weighted iterative
superposition as described here
http://ww. nol soft. conf man/ i cm comuands. ht nl #superi npose-m ni nm ze
or non-iterative single global superposition.

4.4.5 Arrange as Grid

To separate superimposed proteins:

» Tools/Superimpose/Arrange as Grid
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Superimpose

Arrange as grid

4.4.6 Superimpose Sites by Atomic Property
Fields

Here we describe how to superimpose and compare aligand binding site
using Atomic Property Fields. This method is described in more detail in
this publication.

In this example we superimpose the ligand binding pocket of thiamine
diphosphate in the binding sites of pyruvate dehydrogenase (pdb code:
1rp7) and pyruvate decarboxylase (pdb code:1pvd).Even though the
sequence identity between both proteinsis very low (19%) and the
secondary structure surrounding the ligand undergoes considerable
displacement you will see that the pockets can still be superimposed
very well using the APF method.

Some Comments about Selecting the Pocket APF pocket overlay works by
superimposing alayer of receptor atoms around the pocket using APF
chemical property fields of these atoms "pocket" of course is something

that is not uniquely defined and is somewhat subjective. One way to

defineit isto use the ligand inside, in which case alayer of receptor

atoms within a certain cutoff distance from the ligand is considered in
superposition. Thisis "around selected ligand” mode. It focuses on

atoms that directly interact with the ligand while largely disregarding
backbone fold, which can be helpful when comparing different pockets
binding similar ligands. The other mode uses input selections directly,
leaving it up to the user to define the sets of atoms that comprise the

two pockets. Depending on the system and degree of similarity, different
selections may work better or worse. For instance in the absence of

ligand one may want to detect pocket with pocket fi nder and then select
residues around the pocket "blob". Regarding the influence of ligand on
superposition, if pocket is defined viathe ligand it will of course

matter whether the ligands extend into certain regions or not. If

external pocket definition is used, ligands will have no direct effect

0N superposition process.

4.4.5 Arrange as Grid
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2) 1rpT Molsoft iom 3.7:-3c [NewProgect *] (1 object] Read in PDB ﬁle 1rp?

FEHD 90 TR LB e Ol MEEBBOA40%% TTFff#22L21
oty i haht \/ lebels [ meshes "\ search "\ igedit |

PDE Saarch = | 1pT b “ pdbflesdimrModels | &l Siack * | sdtupencylesplay | FONS "

Worlspace Panel [ ]

:n:- selection
B 1. Select the search tab and

il B enter 1rp7
a b

amg
atzd
birig
bizd

{5 pyruvate dehydrogenase
In"n"

« fields

eddr odn @

D i (4 o lod [

%
= -

o -

El

& liem/1rpT

o @ &= O O [ | | B | Welcome to KM & Mol 1 Obj

Step 1: Read in the pyruvate dehydrogenase (pdb code: 1rp7) structure.

Read in PDB file 1pvd

FEHO O RRD AV FIIN MEBqrEBLA09E% TTIifgssrl

&) lpvd Molzoft xm 3.7-2¢ [NewProgect "] (2 obpects)

| dsptay \/ ight \/ Tabels \/ meshes \/ search [ igedit ®
i PDE Seanch = | 1peed - H pabRleachimyModels | ol glack * | scoupancyDepley | o - a
[+
Werkspace Parel & x +
no selection Py
M b Sy 1. Select the search tab and z
i ]a enter 1pvd '5"
+ b O

amg
atrd o
bmg a
btzd i

14 pyruvate dehydrogenase
o |wW
ae

a - I
b i
amg -
atpp -
bmg -
+ I btpp =]
13 pyruvate decarboxylase; «
1w
b
« fields %
f‘-r
|
[ o« e Y
] =
-]
5|4
O | 'h_ mf @_ ﬂ_ F -‘.-;__ Welcorrse o JOM & Mel 1 Oky

Step 2: Read in the pyruvate decarboxylase (pdb code: 1pvd).
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% lpvd Malsoft icm 37-2¢ [NewProject ° 2 objects Delete waters and all molecules other
than the “a” subunit and Iigand
EEHEO A TRO qf-‘,n.;F-;.;Px Fi6| ) v EB W8

—— s
¥ desplay \/ ght \/f babels \/ meshes \/ rx---_.l-;ue-:b

&

DB Search = | 1ped » i | pbfeachimodels | ol stack = | sooupancyDesplay | Pong - .
x

[+

Wiorkspace Parel & x +=
P 945 Mol 2 Obi P
‘8 i )
v _|a et

+ o

atzd =

a

=n
=

pyruvate dehy ::Irc:t'enaqp 1. Hold “CTRL" kE‘jl" and select
4= moleculesto delete.

iv Ll

T "y
L]
BWw ip
ga[up
o
:. p.lu ate decarboxylase; «

[,.:h 2. Right click and choose delete,

Termind & X
|
*

@ e O O [ | | B | welcome te M & Mell Oy

Step 3: Delete unwanted moleculesin the b chain and waters.

e e I The two structures should contain the
: g “atzd” and “atpp” ligands.
FEHS A TR B e I [FEE e B

i desplay W ight W/ lebels " meshes \/" seanch LI igedit P
—n raEceE . - . e | = a | =
Hi| 24 e @ ot o= s RS e |L @ | nos e G| 8o
- s
Worlspaoe Pane ax +
no selection o]
- objects z
ﬂ'rﬂ 1r';'|' -
[
. ﬂarzn 3
{a Py -u-ale dehydrogenase D
- 1pvd
«[H a @
+ [ atpp At
-
18 pyruvate decarboxylase, «
« fields

D ) o4 e jof =

@ B O G 68 | | | Weicome to lM 7 mon-ICM Obj

Step 4: Y ou should have two objects containing the protein and ligand.
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3 1ovd Moksoltiom 37-2¢ [NewProjec ] (2 cbjects Convert each structure to an ICM object.

FHO N TR AR i SN MEBvyEGA0E TTIidssll

| Sty \ i\ T\ e\ smara \/ hgeat ) i -
v |2 @ie@ o | @ EEER: | e | a2 |G| [m]e) -
O
Workspace Parel & x +
no selection 5—-5
ﬂﬁ,j:‘; o 1. Right click here and choose z
1 s
convert object. &
nulzu O
\ p.lu aabe dehydrogenase

HE ?
9 - ]
. Eatpp b

10 pyruvate decarboxylase, « < [ rep—

« fields

« opGmize hydrogers. | opbmize HisProdsnGinCys

+| replace the ongral | deplay the result i
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O [ | || T | Welcome to I0M 2 non-1CM Okyj

Step 5: Convert both structures to an ICM object.

F) 1pwd Molsaft km 3.7-2¢ [MewPraject | (2 obpects, Note Each ob]m isan ICM ubjectl
FHO 90 TR0 HBrR Pl SN MMEvyEBODA0%% Tidgssll
¥ daciay gt \ Tﬁﬁ”? . < °
|2 e @ Eeas | E: 8 E N | e | s |G | (@]
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no selection 5-!'
- Il objects - 3
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F°T% : >
- [Ea L]
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{i pyruvate decarboxylase «
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i
:
&
B
s
-]
O B OO @& .| % 2 1CM Oty

Step 6: If the pdb is converted you will see"ICM" in the workspace.
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%) lpvd MolsoR icm 3.7-2¢ [MewProject | (2 objects Select one “gand and copy green

selectionto orange.
FEHO A TRO HB L QAN [FEE e B

T, ey e, e ey
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Step 7: Select one ligand and copy the green selection to orange.

el R Select the other ligand.
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Step 8: Select the other ligand (regular green selection).
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Step 9: Select the option Tools/Superimpose/Sites by APF. Note you can
also superimpose pockets - choose the appropriate tabs in the dialog
box.
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Step 10: Observe the superimposed site.
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4.5 Protein Structure Analysis

Availablein the following product(s): | CM Br owser - Pro || CM Pr o

In this chapter we describe the tools available for analyzing protein
structure. These tools include calculating RM SD, identifying closed
cavities, calculating contact and surface area, measuring anlgles and
distances, and generating Ramachandran plots.

Chapter Contents:

Fi nd Rel at ed Chai ns

Cal cul at e RVBD

Cont act Areas

Identify Closed Cavities
Surface Area

Measure Di stances

Pl anar Angl e

Di hedral Angle

Ranachandran Pl ot Interactive
Export Ramachandran Pl ot

4.5.1 Find Related Chains

This option allows you to search the currently loaded PDB files or ICM
objects and identify chains which are similar and/or related.

Y ou can do this by:

Sel ect theobjects or pdb files you want to compare.
Tools/Analysis/Find Related Chains

Click OK to confirm the selection you made

A table as shown below will be displayed.

2 jelated_sequences

namel  nameZ  lend len2 seoul | rsd CONSENsUs
dicba  Z2icbec 278 277 g 012 SWEKLAEDIKKIFEFKETLG TGAFSEVYLAEERATGELFA)
1 IENEIAYLRKIKHENIVALEDIVE SPHNHLYLYVMOLVS GGELF
Zicba  3bkkva 278 289 3 042 B HEEBRG H VL HTG HAHBKH  HeH HBEER
2 HER BEH NNV LD 8 BEYLVE LY GGELF- IV + Y E
DAS H OHL-AVEEHH MGHVHRDLEPENLLERS  #E
PGEYH PEVL Y KEVD#W #GVIHILLEGYPPFEDE
3 |2icBa 3bkhb 273 283 38 0.41 ﬂ :HtE IIG ﬂﬁ W ﬂTG ﬂAﬂ!‘i#l_ _ #t- 13 ﬂE Eﬂ
4  Zicha 3bhhe 273 285 37 0.44 g ﬂ # E Fl ti ﬁtt E A # KB p HE EIi ﬂﬂﬂ H#KH
) 2cba  3bkhd 278 286 37 043 It ﬂ 1# E It H 11# E A i K# II+ 11 ItE EH iﬂiﬂ #icH
S 2icBe  3bkbva 277 288 39 0.44 ﬁ ﬂ#E ﬂG ﬂ "JL HTE #ﬁﬂﬁlﬂ K - ﬁE Eﬁ ﬂ!-‘;F’
7 2itbe  3bhib 277 285 39 043 u ME HG hﬁ W HTG ﬂ,ﬁﬂrﬁl_ ¥_ ~ ﬁE E#
§ 2ichc 3bhhe 277 285 38 0.44 ﬁ # l¢ 41 Wﬂ ﬁTE marzm K #E_E_ﬂﬁltF%
ol @ a%

namel = Name of query structure molecule name2 = Name of hit lenl =

length of query len2 =
percentage consensus = Consensus sequence

4.5 Protein Sructure Analysis

length of hit seqid = Sequence identity
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4.5.2 Calculate RMSD

NOTE: Thisoptionisfor protein structures only not for chemical
compounds. Y ou can use the command line options RMSD
(http://mol soft.com/man/icm-functions.html#Rmsd) and Srmsd
(http://mol soft.com/man/icm-functions.html#Srmsd) for chemicals.

To calculate RM SD between two protein structure:

* Readinto ICM thetwo structures ( Fi | e/ Open or PDB Sear ch or Read

i n Chenmi cal ) you wish to compare.

* Sel ect one of the two molecules you wish to compare, you can do
this by double clicking on the name of the structure in the ICM
Workspace. Convert this selection to an Or ange Sel ecti on.

» Select the second molecule, and then you should have one orange

and one green selection in the graphics display.

9 Calculate cartesian RMSD @@
" Keptin place
f+ Mo aAlignment (" Align Residues i~ Ewmact Match

i+ Visibledtoms ™ Calpha (™ Backbone ™ Heawy Atams

Apply | Cloze Help

» Select whether you wish the atoms to be superimiposed onto one
another or kept in place. The kept in place option would be ideal

for comparing docked structures.

» Choose whether you wish to make the superposition by alignment or

exactly matching the atom names.
» Select which atom types you wish to superimpose.

The RM SD value will be displayed in the terminal window.
4.5.3 Contact Areas

Sel ect theregion you wish to analyse.
Tools/Analysis/Contact Areas

contacts with aligand will be displayed in thicker xstick
representation (and colored yellow) than those making less
significant contacts.

» A table as shown below will be displayed.The table lists the

contact area, exposed area, percentage of contact area compared to

exposed, the nearest atom of aresidue and the distance.
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Read in aprotein structure ( Fi | e/ Open or PDB Sear ch).

The xstick display in the region will be scaled according to the
atom/residue contact area. For example, residues making large

4.5.2 Calculate RMSD



AR EEREE R How to calculate contact areas.
fiz fdz View Biirdo Togh Homclogy Chemitry Docking MolMechenics ¥
REEe N TR0 AR i S OB 0EEes T3 825
MVWUMUWHUMIIHUW\ .
3 |‘: |l_‘n.|*J =

T g T

! 2. Tools/Analysis/Contact Areas ] et

o 1 BAcd 1 O

e
CEI b [ 1A
u s a 268A 5sdes KSY

meold HoEHO

A Contactiraa Exposedize Parcent Ciopest Atom Closast Dt £
1 [ibdasii | 05.1 5798 353 Lihalbic 392 bl
2 lubbaf*377 281 119.2 253 1t 3796 felid
3 |1abd.af~v3ss 2.2 714 33 1 astinye2s 3484 ;
4 Lubbaf~448 226 #.5 3853 lbh astiuiics 318 i)
e T et ] 0.8 ! T sl

SO ES DA e

loe mo=c@as

4.5.4 Identify Closed Cavities

Thistool will identify cavities within a molecule which are completely
closed,. If you are looking for buried and open pockets then use
i cmPocket Fi nder .

Read in aprotein structure (Fi | e/ Open or PDB Sear ch).
Convert the protein structureto an | CM obj ect .
Tools/Analysis/Closed Cavities

Use the drop down arrow to locate the molecule you are interested
in.

Enter the minimum volume of the cavities you wish to identify.

* Click OK

¢ The closed cavities will be displayed in the meshes section of the
ICM Workspace and atable of the cavities will be displayed.
Double click on arow in the table to jump to a particular closed
cavity and select the residues surrounding it.
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What isthe difference between Closed Cavity and | CMPocket Fi nder ?
Closed pocket (cavityFinder) is purely geometrical/topological - it

isapart of molecular surface that is completely disconnected from

the exterior surface. It means that a probe sphere of 1.4A radius

(representing a water molecule) can not passin or out of the cavity
(considering protein as completely rigid of course). icmPocketFinder

identifies pockets that are likely to contain ligands (not

specifically open or closed pockets). Pockets are defined based on

physical interaction rather than geometric criterion. Blobs of

"pocket density’ generated by icmPocketFinder represent continuous
regions of space where there is significant favorable van der Waals

interaction with the receptor.

455 Surface Area

This option calculates solvent accessible area of each selection in
multiple objects and storesit in atable. If amoleculeis specified in
amulti-molecular object, the surface area of an isolated moleculeis
calculated and other molecules are ignored. The areais reported in
square Anstroms and the probe radius is assumed to be the value set in

the variable waterRadius.

Output: the macro creates table AREA . The empty comment field is added
for user’s future use. If the table exists, new rows are appended.

To calculate a surface area:

Sel ect theregion you wish to analyse.
Tools/Analysis/Surface Area

along with the corresponding total surface area.
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Read in aprotein structure ( Fi | e/ Open or PDB Sear ch).

A table will be displayed listing the residues in the selection

4.5.4 |dentify Closed Cavities




4. 5.6 Measure Distances

There are two approaches to calculating and displaying distances between
atoms. Y ou can either use the optionsin the Label s tab or use
Tools/Analysig/Distance.

To display all to all distances:

» Select the atoms between which you would like to find the
distance. (Seesel ecti on tool bar)

» Toolg/Analysig/Distance

* Sdlectaltoal

To display intermolecular distances
» Select the atoms between which you would like to find the
distance. (Seesel ecti on t ool bar)
» ToolsAnaysig/Distance
» Select intermolecular
To display the distances between the same atoms in two objects.
* Select the atoms between which you would like to find the
distance. (Seesel ecti on t ool bar)

» ToolgAnalysig/Distance
» Select same atomsin two objects

NOTE: Distances can be displayed and undisplayed in the 3D labels
section of the ICM Waorskapce. Y ou can change the color of a distance
label by right clicking on it in the ICM Workspace. Y ou can alse
export the distance to atable.

4.5.7 Planar Angle

If you wish to find the planar angle between three atoms:

e Sdlect Tools/AnalysisPlanar Angle
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Find planar angle between three atoms E|rz|

First atarn | a_pep.m/2/ica j

Second atom |a_|:uep.mf'E.fn j

Third atam [ |

Help

To select atoms: Right-Click, shde down to atom name and release.
To zee the resultz: look in the terminal window

Apply | Close Help

» Right click on the each of the three atoms which you wish to use,
and select their name. The spaces next to First atom, Second atom,
and Third atom should now contain the name of your atoms.

a_pep.m/2

Selection Dialog
Edit 3
Advanced r

» Click Apply to display the angle measure in the terminal window.

Angle ( a_pep.m/6/hh21 a_pep.m/2/0e2 a_pep.m/3/0 ) = 74.72 deg.

4.5.8 Dihedral Angle

In order to find the angle dihedral angle between two sets of atoms:
» Select ToolgAnalysis/Dihedral Angles.

Find dihedral angle formed by four, atoms

First atom |a_pep.mi3/n x| Secondatom  |a_pepmidica v
Thidatom  |apepm&ic |  Fouthatom || xl
Help

To zelect atoms: Right-Click, slide down to atom name and releaze.

Apply | Cloze Help

» Right click on each of the four atoms which you wish to use, and
select the name of the atoms. The spaces next to Atom 1, Atom 2,
Atom 3, and Atom 4 should now contain the names of your atoms.

a_pep.m/2

Selection Dialog
E dit 3
Advanced r
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» Tofind the correct angle, select your atoms according to the
following diagram:

» Click Apply to display your dihedral angle measure in the terminal
window.

4.5.9 Ramachandran Plot Interactive

To make an interactive ramachandran plot:

* Readinaprotein structure (Fi | e/ Open or PDB Sear ch).

» Select the structure you wish to build the plot for. Y ou can do
this by double clicking on the name of the structure in the ICM
Workspace (a selection is highlighted blue in the ICM Workspace
and green crosses in the graphical display) or you can use the
right-click button and drag it over the whole structure in the
graphical display.

» Tools/Analysis’Ramachandran Plot Interactive

e Theinteractive ramachandran plot will be displayed in table
caled RAMA.

* You can view the Omega, Phi/Psi (Gly) or Phi/Psi angles by
clicking on the tabs at the top of the plot. Each point is linked
to the data in the table RAM A and a so to the graphical display.
Clicking on apoint in the plot will highlight the corresponding
anglesin the table and also center on thisregion in the 3D

display.
4.5.10 Export Ramachandran Plot

* Readinaprotein structure (Fi | e/ Open or PDB Sear ch).

» Select the structure you wish to build the plot for. Y ou can do
this by double clicking on the name of the structure in the ICM
Workspace (aselection is highlighted blue in the ICM Workspace
and green crosses in the graphical display) or you can use the
right-click button anddrag it over the whole structure in the
graphical display.

» Tools/AnalysigRamachandran Plot Export

A postscript viewer needs to be downloaded onto your machine in order to

view the plot. This can be downloaded from

http://ww. cs. w sc. edu/ ~ghost/. Oncethis software is downloaded you
need to tell ICM where it islocated by typing the pathname into

File/Preferences.

NOTE: You can aways export the plot as an image directly in ICM
without exporting. Y ou can do this by right clicking on the plot and
select save asimage. Another approach could be to export the RAMA
table to Excel and use the plotting tools there. Y ou can do this by
right clicking on the table name tab and selecting "Export to Excel"

or saveas".csv".
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4.5.11 Protein Health

Theory

The protein health option calculates the energy strain of a structurein
ICM. It isgenerally agood ideato investigate the energy strain of any
protein structure before undertaking such processes as docking. It is
also essential to use thistool after making a model (see Molecular
Modeling) to identify strained regions within your model and then some
optimization procedure can be undertaken to rectify the problems.

The protein health option calculates the relative energy of each residue
for a selection and colors the selected residues by strain. This macro
uses statistics obtained in the following paper Maiorov, V.N. and
Abagyan, R.A. (1998) Energy strain in three-dimensiona protein
structures Folding and Design, 3, 259-269.

To use the Protein Health option:

Read in aprotein structure ( Fi | e/ Open or PDB Sear ch).
Convert your PDB structureinto an | CM obj ect .
Makeasel ect i on of the residues you wish to analyze.
Tools/3D Predict/Protein Health and a window as shown below will
be displayed.
» The scale of the coloring can be changed by atering the value
within the trimEnergy data entry box.
» Click OK and the structure will be colored according to energy
strain (red - high) and atable of residue energy will be
displayed in atable.
» A tableand plot of Normalized energies for each amino acid in the
selection will be displayed. The tableis ranked and colored by
residues with poor normalized energies. Click on arow in the
table or plot to center in on the residue.

4.5.12 Local Flexibility

This option systematically samples rotamers for each residue side-chain
in the input selection and uses resulting conformational ensembles to
evaluate energy-weighted RM SDs for every side-chain atom. These are
stored in the'field” values on atoms and can be used for example to
color the structure by side-chain flexibility. Conformational entropy

for each residue side-chain is also calculated and stored in atable. If
|_entropyBfactor flag is on, the atom rmsds are normalized within the
residue to reflect itstotal conformational entropy. If |_bfactor flag

is set, the bfactors are reset to the same values that are placed in the
atom 'field', and occupancy is set to be inversely proportional to it (
O=1/(1+2*rmsd) )

* Read pdb file (File/Open or PDB Search Tab).
e Convert toanICM Object.
» Tools/3D Predict/Loca Flexibility

4.5.13 Protein-Protein Interface Prediction

The ICM Optimal Docking Areamethod is a useful way of prediciting
likely protein-protein interaction interfaces. If you do not have

mutational data or other experimental data which indicates the likely
protein-protein docking site this method will be useful. This procedure
can save you time during the docking procedure by focusing your docking
only on areas on the receptor and ligand most likely to interact.

Theory
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ODA (Optimal Docking Areas) is a new method to predict protein-protein
interaction sites on protein surfaces. It identifies optimal surface

patches with the lowest docking desolvation energy values as calculated

by atomic solvation parameters (ASP) derived from octanol/water transfer
experiments and adjusted for protein-protein docking. The predictor has

been benchmarked on 66 non-homol ogous unbound structures, and the

identified interactions points (top 10 ODA hot-spots) are correctly

located in 70% of the cases (80% if we disregard NMR structures). For a
description of the method see Fer nandez- Reci o et al Proteins (2005)
9632.

Todisplay the optimal docking area.

e Convert the PDB fileto an ICM object.

» Tools/3D Predict/Protein Interface by ODA

» If you select the Residue Table option the average ODA score for
each residue will be displayed in atable. The lower the number
the higher the chance the residue will be involved in
protein-protein interactions. Regions colored red represent low
ODA score and blue represents a high score.

4.5.14 Identify Ligand Binding Pockets

Theory

The ICM Pocket Finder method (1-2) uses only the protein structure for
the prediction of cavities and clefts. No prior knowledge of the
substrate is required. The position and size of the ligand-binding

pocket are determined based on a transformation of the Lennard-Jones
potential by convolution with a Gaussian kernel of a certain size, a

grid map of abinding potential and construction of equipotential
surfaces along the maps. The pockets are displayed graphically as a
surface and the dimensions of each pocket are presented in an
interactive table and plot.

Factors that can influence ligand binding to a pocket include the pocket
volume and area, buriedness, hydrophobicity, and how compact the pocket
is. All these properties are calculated using | CM PocketFinder and
tabulated. Scientists at Merck used Mol Soft.s |CM PocketFinder algorithm
to define away for quantifying "drugability” of a protein target (3).

The metric they used is called Drug-Like-Density (DLID), and this score
isalso provided in the results table. A good example of the use of the
icmPocketFinder method isin the database called Pocketome. The
Pocketome (www.pocketome.org) is an encyclopedia of conformational
ensembles of all druggable binding sites that can be identified
experimentally from co-crystal structuresin the Protein Data Bank (4).

1. An, J, Totrov, M. & Abagyan, R. Pocketome via comprehensive
identification and classification of ligand binding envelopes. Mal.
Cdll. Proteomics 4, 752 (2005).

2. Abagyan, R. & Kufareva, |. The flexible pocketome engine for
structural chemogenomics. Methods Mol. Biol. Clifton NJ 575, 249.279

4.5.13 Protein-Protein Interface Prediction
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(2009).

3. Sheridan, R. P., Maiorov, V. N., Holloway, M. K., Cornell, W. D. &
Gao, Y .-D. Drug-like density: amethod of quantifying the .bindability.
of aprotein target based on avery large set of pockets and drug-like
ligands from the Protein Data Bank. J. Chem. Inf. Model. 50, 2029.2040
(2010).

4. Kufareva, 1., llatovskiy, A. V. & Abagyan, R. Pocketome: an
encyclopedia of small-molecule binding sitesin 4D. Nucleic Acids Res.
40, D535.540 (2012).

To predict pockets:
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Read in aprotein structure (Fi | e/ Qpen or PDB Sear ch).
Convert the protein structureto an | CM obj ect .
Tools/3D Predict/icmPocketFinder
Enter atolerance level (4.6 isthe default value and we
recommended you to use this). The lower the tolerance value the
more pockets predicted and the higher the tolerance the less
pockets predicted.
» Check the box create sequence sitesif you wish the site to be
labeled.
» Check the box display results to see the predicted pockets as
grobsin the display panel.
» Check the box keep compoundsif you wish the compounds (ligands)
in the receptor to be included in the prediction. If you dont
check this box the pockets will be calculated based on the
receptor without ligands.
e Click OK to run icmPocketFinder and the results will be displayed
inatable.
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Results

» Click on arow of the results table to select the residues
surrounding the pocket.

» The pocket view can be toggled on or off in the meshes section of
the ICM Workspace. Right click on the name of the meshin the ICM
workspace to change properties such as color.

« A fully interactive plot (Areavs Volume) is also provided,
pockets that fall within the blue shaded region have a
"drug-like" volume and size.

About theicmPocketFinder Results Table

Factors that can influence ligand binding to a pocket include the pocket
volume and area, buriedness, hydrophobicity, and how compact the pocket
is. These values are reported in the results table:

* Volume of the pocketin”.

» Areaof the pocketin”.

» Hyrdophobicity - represents the percentage of the pocket surface s
in contact with hydrophobic protein residues (values can range
from 0-1)

» Buriedness - The buriedness parameter is calculated as follows:
One measures the solvent accessible surface area of the pocket
(proberadius, 1.4) in isolation. Then one measures the solvent
accessible surface area of the pocket covered by its shell. The
ratio of the second number to the first is the fraction buried.

The lowest possible value is 0.5; i.e. the pocket is completely
open and the surface flat. The highest is 1.0, i.e., completely
buried.

* DLID - Merck’s Drug-like density score (see Sheridan et al JCIM
2010). >0.5 is considered "druggable”.

» Radiusgivesan indication of how sprherical apocket is. ( 3/4
Volume/ Pi Y*1/3 , i.e. radius of an ideal spherical cavity of
the same volume as a pocket blob.

* Nonsphericity give an indication of how spherical the pocket is.
Area/ (area of ideal spherical cavity) . It is 1.0 if the cavity
is spehrical

4.5.14 | dentify Ligand Binding Pockets
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» Conservation Average conservation (%identity) of residuesin
contact with the pocket. Calculation is performed if multiple
alignment is present and linked to the protein chain being
analyzed.

» RelCons Above conservation, relative to the average over the
entire chain.

* Type- returnsthe ICM selection for the residues forming the
pocket.
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5 Molecular Graphics

In this chapter we describe how to
make beautiful graphical
representations of molecules and
mani pulate them in the 3D graphics
window. Thisincludes how to change
color, light, represenations,

clipping planes, and how to use
built in graphics effects. We also
teach how to label and annotate
molecules displayed in the graphical
user interface.

Chapter Contents:

Mol ecul e Representati on
Meshes- Sur f ace- G obs

Col ori ng

Li ghti ng

Label i ng and Annotati on

Di spl ay Di stances and Angl es
Graphics Effects

Graphi cs Shortcuts

Mol ecul e Move Buttons

d i ppi ng Tool s

Graphi ¢ Layers

H gh Quality Publication |Images
Movi es

5.1 Molecule Representation

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro

To change the molecule display representation:
» Sel ect theatoms, residues, molecules, or objects you wish to
change in the graphical display or in the ICM Workspace.
» Then use the molecule representation (e.g. wire, ribbon) options
intheDi spl ay Tab.

The display tab containstools for avariety of functionsincluding -
structural representations, coloring, labeling and superposition.

There are six main types of structural representation in ICM. They are
wire, ball and stick (Xstick), ribbon, skin, CPK and dot envelope
(surface).

To display one of these representations:

 Click on the representation button you desire in the display tab.
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wire cpk  skin ribbon

g

xstick  dot envelope

Toremove adisplayed representation or to toggle between display and
undisplay:

» Click on the corresponding representation button in the display
tab.

I dentify which representations ar e displayed: The button display will
change appearance (shaded blue) when selected. This makesit easier to
identify which representations are currently being displayed.

ribbon displayed
”; :a-:;: P
xsték displayed

Changethe display and size of the representations Many characteristics
of the graphical representation such as color can be changed by clicking
and holding on the button. The size can be changed by clicking the
plus(+) and minus(-) buttons next to them.

click and hold for more options
/e L}J @@ Qg
+/-tocha ﬂgzz size
5.1.1 Wire Representation

Click and hold on the wir e representation button. A menu will be
displayed as shown below.
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To changethewirestyle:

 Click and hold on the wir e representation button and then click on
wire, chemistry or tree.

To changethe size of the wire representation:

* Click and hold on the wir e representation button and then click on
thin, normal or thick.

NOTE: Clicking on the +/- next to the wir e r epresentation button also
changes the thickness of the wire representation.

Toundisplay representations other than wire:

» Click and hold on the wir e representation button and then click on
undisplay other representations.

If you make amistake or you are not happy with the way your structure
is displayed with the wire representation:

» Click and hold on the wir e representation button and then click on
reset to default.

5.1.2 Stick and Ball (Xstick) Representation

Click and hold on the stick and ball representation button. A menu will
be displayed as shown below.

5.1.1 Wire Representation
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transparert

To changethe style of the Xstick representation:

e Click and hold on the stick and ball representation button and
then click on style and choose either plain, chemistry, Chem Plus,
or Chem Plus Aromatic.

To changethe size of the Xstick representation:
e Click and hold on the stick and ball representation button and

then click on set thickness, set ball/stick ratio, set hydrogen
ratio, and set backboneratio.

NOTE: Clicking on the +/- next to the xstick representation button
also changes the thickness of the xstick representation.

In order to make some parts of your picture clearer, the xstick
representation can be set to transparent:

* Click and hold on the stick and ball representation button and
then click on transparent.

Toundisplay representations other than xstick:

» Click and hold on the stick and ball representation button and
then click on undisplay other representations.

If you make a mistake or you are not happy with the way your structure
isdisplayed with the xstick representation:

» Click and hold on the stick and ball representation button and
then click on reset to default.

5.1.3 Ribbon Representation

Click and hold on the ribbon representation button and a menu will be
displayed.

To changethe style of the Ribbon representation:
» Click and hold on the ribbon representation button and then click

on a style option: smooth, wide, wide smooth, cylinders, protein
worm .
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To assign secondary structure:

To accurately represent the secondary structure of the moleculein
ribbon representation you may wish to assign secondary structure:

» Click and hold on the ribbon representation button and then click
On assign sec. structure.

To make some partsof your picture clearer, theribbon representation
can be set to transparent:

» Click and hold on the ribbon representation button and then click
on transparent.

Toundisplay representations other than ribbon:

 Click and hold on the ribbon representation button and then click
on undisplay other representations.

If you make a mistake or you are not happy with the way your structure
isdisplayed with the ribbon representation:

 Click and hold on the ribbon representation button and then click
on reset to default.

NOTE: Alwaysusethe | CM assign sec.** structure tool in the ribbon
right click menu to get accurate secondary structure assignment. This
is particularly important when studying helices which may have
non-cannonical elements within them such as 3/10 or pi. To view
non-cannonical helix segments use the segment option in the ribbon
right click menu.

To change the display of chain breaks (dotted lines):

» Click and hold on the ribbon represenation button.
» Select the options Display Chain Breaks or Display Chain Break
label.

5.1.4 Skin Representation

Click and hold on the skin representation button. A menu will be
displayed as shown below.

meshes Y movie

Skin %’ﬂl lﬁ:l-l--!|!_ -

— | | |
@ color.
TS

tight

niormal

sparse

undizplay other representations

rezet to default

To make some parts of your picture clearer, the skin representation can
be set to tight, normal or sparse:

» Click and hold on the skin representation button and then click on
either tight, normal or sparse.

Toundisplay representations other than skin:

5.1.3 Ribbon Representation
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» Click and hold on the skin representation button and then click on
undisplay other representations.

If you make a mistake or you are not happy with the way your structure
isdisplayed with the skin representation:

» Click and hold on the skin representation button and then click on
** reset to default**.

NOTE: Sometimes due to singularity problems holes may appear within
the skin surface. To cure thisinfliction select atoms nearby and
right click select Advanced->RandomizeAtoms

5.1.5 CPK Representation

Click and hold on the CPK representation button. A menu will be
displayed as shown below.

b ¥ meshes ¥ movie

EEE |
— HEN
@ color.

by s 4

undizplay other reprezentations

reset to default

Toundisplay representations other than CPK:

* Click and hold on the CPK representation button and then click on
undisplay other representations.

If you make a mistake or you are not happy with the way your structure
isdisplayed with the cpk representation.

* Click and hold on the CPK representation button and then click on
reset to default.

5.1.6 Surface Representation

Click and hold on the surface representation button. A menu will be
displayed as shown below.
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B

---
i@ color.

by 3
tight

riormal

sparse

zet dot denzity 3
zet probe radiug 3
zet dot size 3
undizplay other representations
rezet to default

select

To changethe style of the surface representation:

» Click and hold on the surface r epresentation button and then click
on tight, normal, or surface.

Toundisplay representations other than surface:

» Click and hold on the surface representation button and then click
on undisplay other representations.

If you make a mistake or you are not happy with the way your structure
isdisplayed with the surface representation:

» Click and hold on the surface representation button and then click
on reset to default.

5.1.7 Display and Undisplay Hydrogens

To display and undisplay hydrogens. Click and hold on the " Change
Hydrogen Display" button shown below. Multiple single clicks will toggle
through the hyrogen display options.

» Display Tab

» Click and hold on the " Change Hydr ogen Display" button shown
below.
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5.1.8 Display Hydrogen Bond

NOTE: The method by which hydrogen bonds are calculated is described

her e in the command line manual. The GRAPHICS.hbondMinStrength
parameter determines the hbond strength threshold for hbond display.

The strength value is between 0. and 2. By changing 1. to 0.2 you
will see more weak hydrogen bonds.

In order to display potential hydrogen bondsin your structure:

e Converttoan ICM Object
» Makeaselection - if you are trying to display the H-bonds

between aligand and the receptor make sure the ligand is part of

the selection.
» Click the Display Tab.
» Click onthe Toggle H-bondsicon in the display tab.

Select the display tab
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|al|'ud00':ns
x|
. no selection ]
Display and e T
Undisplay __| ; niliznd::lallrsm]
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Click and hold on the H-bond button to get
access to other display options
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» Click the +/- on the right of the H-Bond button to change
thickness of H-bond representation.

 Click and hold the button to change representation or use the
hbondpairs option in the ICM Workspace.

Click and hold
e | A

text label

zolid line
dotted line
zpheres
Set Sphere Period...
Change Color...

Diwnamic Hbonds

What do the default coloring of the H-bond represent?

Longer and shorter H-X distances in the hydrogen bond are color-coded,
from red to blue, respectively.

NOTE Dynamic hydrogen bonds can be set by clicking and holding on the
H-bond toggle button in the Display tab. Hydrogen bonds will then
respond to any changes made to the ligand.

5.1.8 Display Hydrogen Bond
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5.1.9 Display Formal Charges

You can display formal charges by clicking and holding on the " Change
Hydrogen Display" button in the Display tab.

5.1.10 Ca (carbon alpha) Trace

To generate a carbon alpha (Ca) trace:

* Right click on the object in the ICM workspace and select
Tools/Make Ca-Trace object.
» The Ca-Trace object will be displayed in the ICM workspace.

sl Bodlde

%) Lobb_ce Moluoh km 18-3 [NewPrect *] (2 cbjects) [Generate‘a ca_Trace
FHEEHOo N TRO HBr Ui ME«cHGE@D® s TT§§288
A AT e e T
H 2 Be@ @ | @ =2 0K |Pe | axades | 6| [ele
Verispace Parel 8 X
mio selechon P
; ' f"‘ab“-‘”‘: - 1. Rightclick here and select
o : Tools/Make Ca-Trace object
e - ast H s - . =)
i) = wrosne-protein kinase 5 | . el Fi —_— ;
| H[jw'o A e 2. Ca-Trace object will be displayed |
L - b 2654 here in the ICM workspace >
SRl oasti H o ke
i ~ hyrosme-protein kinase 5 & ”ﬁ* o
L s
X v
e 7
/ /-
¥ /i—'—-\\: P - -
P A |
QNS RN
-y i e, i}
;JrJ %, H
s £ -~
& 1 ‘\.‘ e,
M S
S8 5o s aan 1 neneiCM Oy

5.2 Multi-Windows

To display more than one window click on the buttons shown below.
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5.3 Meshes - Surface - Grobs

Availablein the following product(s): | CM Br owser - Pro || CM Pro

Click on the tab button entitled 'meshes and more graphics tools for
surfaces are available. In ICM surfaces are sometimes referred to as
meshes or graphical objects (Grobs).
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Macroshape Solid Macroshape Transparent

5.3.1 Surfaces

The surface of your structure can be displayed and colored by
electrostatics or binding properties. To do this:

Load a structure into ICM Fi | e/ Open or tab-pdb{ PDB Search}
Convert thestructure into an ICM object.

Select the ’meshes’ tab button.

Click on the drop down arrow menu shown below and select which
surface you wish to generate.

¢ Click on the generate surface button next to the drop down arrow.

Fodisplay W labels Y analysis W pdb zearch ¥ meshes  movie

(T CW clechiostatic (_ﬂl ‘ I-aII- 'l ¥| M IS 3: step ID_ 'I|7 color  MacroShape |

surfaces meshes macroshape

5.3.2 MolSkin

Mol Skin is a new macro that instantly makes publication quality graphics
and it gives each molecule a color and colors contact patches. It

5.3.1 Surfaces



undertakes the following:

¢ Molecular surfaces are generated with those assigned colors and
occlusion shaded.

¢ Carbons of each molecule are colored by its own consistent color.

¢ Labels, ribbons, are colored accordingly.

« Surfaces are gradually cross-colored by each other to mark the
contact patches.

¢ Thelabels are brought to the surfaces.

To use Mol Skin:

* Right click on the object in the ICM workspace and choose
Shapes/Make/Molecular Shapes and Contacts.

¢ Once the surfaces are made they will be listed in the ICM
workspace where they can be toggled on or off.
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5.3.3 Color Surface by Proximity

To color asurface by proximity to neighboring molecules:
* Make asurface.

¢ Right click on the molecule you want to color by proximity and
choose Shapes/Make/Color by Proximity.

5.3.4 Color Surface by Selection
To color asurface by a selection:

* Make asurface.

e Make asdection.

« Right click on the molecule you want to color by selection and
choose Shapes/Make/Color by Selection.
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5.3.5 Meshes

A variety of shapes can be constructed automatically using ICM. These
shapes are referred to as meshes. The types of shapes you can build are
shown in the drop down option in the meshesh tab

earch ¥ meshes ¥ movie

| |

l

meshes

To make a shape select it from the menu by clicking on the down arrow
and then click the button next to the menu. The shape will then be
displayed in the 3D graphics window.

membrane |+ ﬂ— click here
Iqu:u:k -

‘membrane
zphere
spiral
shar
tarus
triangle
wire_zphere
Wire_zeppe
- all -

select here

5.3.6 Macroshape

A macroshape can be constructed and allows easy viewing and manipulation
of the structural representation. A macroshape representation is ideal

for large structures which allows the user to easily identify important
regions of the structure and facilitate the return to the ' standard’

view of aparticular molecule. All the buttons needed to display a
macroshape structure are shown below in the ' meshes’ tab.

Y
‘ M| El: step [0 | color  MacroShape

macroshape

To construct a macr oshape:
e Load amoleculeinto ICM Fi | e/ Open or tab-pdb{ PDB Search}
» Select the amount of detail required in the shape by increasing
thevaluesin’'N’ or 'step’ data entry box (note the default
values are usually sufficient).
» Check the’color’ if you wish your molecule to be colored.
* Click the button labeled ' MacroShape' .

Macroshape can a so be used from the View menu: View/Macro Shape

5.3.7 Google 3D Objects (Sketchup)

Toread in a 3D Mesh from Googlein KMZ or COLLADA format:
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e File/Load/ 3D Mesh in KMZ or COLLADA Format from Google
« Search for the object you would like to view and download it.
¢ Toread thefile go to File/Open

5.3.8 Display or Undisplay Meshes or Surfaces

To display or undisplay the surface click in the box in the ICM
workspace as shown below:

ICM Workspace

no selection
E ects
=J1c:rn

: -l m
- ﬂ rmeshes
. q_electro_Term_

=

check here to display
or undisplay surface

NOTE: All surfaces, meshes and macroshapes come under the one heading
of meshesin the workspace panel.

5.3.9 Mesh Options.

A number of options relating to meshes can be found by right clicking on
the mesh in the ICM Workspace. This section describes some of these
options.
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5.3.9.1 Resize Mesh

Once a mesh has been created you can move it and resize it. To do this:

» Locate the mesh in the ICM Workspace and right click on it
» Select the Resize/M ove Mode in the menu.
» A purple box as shown below will surround the molecule.

To resize the mesh click on one of the corners of the box and drag to
the required size. The number displayed on the edges of the box
represent the dimensions.

5.3.9.2 Move Mesh

To move amesh:

» Locatethe mesh in the ICM Workspace and right click on it

» Select the Resize/M ove M ode in the menu.

 Click on the mesh in the graphical display with the middle mouse
button.

5.3.9.3 Mesh Representation

There are five different display modes:

Dot

Wire

Solid Rugged

Solid Smooth
Smooth Transparent.
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5.3.9.4 Mesh Color and Lighting

There are anumber of optionsto color and change the display of the
mesh. These options can be accessed simply by right clicking on the mesh
name in the ICM Workspace as shown below.

5.3.10 Mesh Clipping

Clipping tools can be used to adjust the frames of the mesh
independently of other objects.

The buttons shown below can be used for this purpose.

+— Clipping tools

Sl b [

Clip meshes —

Lock mesh clipping

The buttons used for clipping are described in the section entitled
C i pping Tools.

To clip the skin independently of the object as shown in the image
above:

¢ Display object and mesh.

¢ Click and hold on clip meshes button(red button) and select Reset
Clipping to Default and check the option Clipping enabled

e Clickonthefront clipping plane button.
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» (Optional) To lock the mesh clipping click on the yellow lock mesh
clipping button.

5.3.11 Save Mesh

Y ou can save a mesh as awavefront object by right clicking on the mesh
in the ICM Workspace and selecting SaveAs.

5.3.12 Occlusion Shading

The occulusion shading option provides better representation of depth
within a cavity. The color of each surface element of agrob (mesh) is
changed by mixing its own color with the background depending on the
burial of the surface element.

To add occlusion shading:

* Right click on the mesh in the ICM Workspace and select Occlusion
Shading. The occlusion shading value can a so be changed before
generating the mesh in the meshes tab.

» Enter adepth value - default is 0.8. Higher values will generate
amore dramatic shading.

See example her e.

5.4 Coloring

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro

To change the coloring of molecules:
» Sel ect theatoms, residues, molecules, or objects you wish to

color in the graphical display or in the ICM Workspace.
» Then usethecolor optionsinthe Di spl ay Tab.

5.3.10 Mesh Clipping
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5.4.1 Coloring

To changethecolor of astructural representation such as CPK, Xstick,
wireor ribbon.

» Sel ect theatoms, residues, molecules, or objects you wish to
color.

» Click and hold on the structural representation button for the
representation you wish to color (e.g. wire, ribbon etc...) in the
Display tab.

» Select acolor by clicking color.

Tocolor by a particular parameter such as atom type, b-factor,
secondary structureetc...

 Click and hold on the structural representation button for the
representation you wish to color (e.g. wire, ribbon etc...) in the
Display tab.
» Select ..by-> option
To changethe color of everything displayed :

Click on the color paletteinthe Di spl ay Tab.
5.4.2 Color Background

To changethe color of the background:

» Select View/Color background.
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Color background

Color

bioc =] M| B
Ok, | Cancel | Help ‘

OR

Click on the square of your desired color. If you are not
satisfied with the color palate, click on the arrow next to the
colorsto customize acolor.

Right click on acolor in the colors panel in the display tab.

R T Q)

Right click here in the display panel to
set the background color.

5.4.3 Background Image

A background image can be added to the graphical display. This can be
useful for making cool images or for comparing structures (e.g.compare
displayed object with background image of object).

To add a background image from an imagefile (png or jpeg):

File/Open Image

Right click on theimage in the ICM Workspace and select "Set as
Background in Graphics."

Choose one of the following: (1) Origina Resoution, (2) Original
Resolution Centered, or (3) Scaleto Fit

Enter the Scale (%)

Enter whether you want to keep existing background.

To move and resize a background image: Version 3.7-2b and higher.

File/Open Image

Right click on the image in the ICM Workspace and select "Set as
Background in Graphics."

Choose the option Original Resoution.

Click on the drag atom button (looks like a hand).

Click and drag image.

Remember to deselect drag atom button.

5.4.2 Color Background
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To set current display as background image:

¢ Click and hold on the "Copy Image to Clipboard" button at the
bottom of the gui and select the " Set as Background" option.

Toremove a background image:

¢ Select the display tab and then click and hold on the color sphere
button and select "Remove Background Image"
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OR
* Right click on theimage in the ICM Workspace and select "Set as

Background in Graphics."
» Choose the option Remove From Background

5.5 Lighting

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro

These optionsareinthel i ght tab

Iigh|t tab Save light settings
J display %y Tight " labels % pdbsearch % meshes %Y mawie l
Shine Ambient Diffuze Spec Alpha A-Bright ® b =
— = | B
Drag to Change settings Set default I|ght Settings

CLick and drag the dliders to change the lighting. Y ou can also save
your preferred lighting settings and return to default.

Shine - shininess property of the solid material

Ambient - ambient light intensity of RGB for ambient light
Diffuse - diffuse light intensity of RGB for diffuse light
Spec - specular light intensity of RGB for specular light
Alpha - transparency setting for grob

A-Bright - light intensity shinning on grob

X and Y - Change the position of the light source in the graphics window

5.6 3D Stereo

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro

Click and hold on the stereo hardware button (see image below).

Docking MolMechanics Windows Help
FH MECEBAPes TFfsiil

% up-and-down i

line interleaved .‘.| G 3,65 5 ey 'Q:

-

it~ g-winidow
Sharp
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There are 5 different options available which are described here
http://nol soft.com man/icmtabl e. ht Ml #GRAPHI CS. st er eoMode .

5.5 Lighting
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up-and-down
line interleaved
in-a-window
Sharp
Anaglyph

The Anaglyph option is the easiest to used with inexpensive 3D glasses
and and without any expensive 3D compatible hardware or monitors. The 3D
effect is better with alighter background.

grLONE

5.7 3D Printing

Y ou can save surfacesin the STL format for 3D printing. To do this:

» Makeanesh eg. goto the meshestab - plain solid.

» The mesh (surface) will then be displayed in the ICM workspace
(left hand side).

* Right click on the mesh and choose Save as.. and choose stl from
the format option list

5.8 Labeling and Annotation

Availablein the following product(s): | CM Br owser || CM Br owser - Pr o
[ CM Pro

To add labels or display or undisplay pre-defined annotation:
* Sel ect the atoms, residues, molecules, or objects you wish to
label in the graphical display or in the ICM Workspace.
e Thenusethelabel optionsintheDi spl ay Tab.
To add new user-defined annotation:
* Sel ect the atoms, residues, molecules, or objects you wish to

label in the graphical display or in the ICM Workspace.
» Right click on the selection and choose "Annotate Selection”.

5.8.1 Labeling

Labeling options are contained within the Labels or Display Tab. In many
cases clicking and holding alabel button will allow you to view more
options.
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5.8.2 Labeling Atoms

Select the atoms you wish to label (seedi spl ay structure orsel ection

t ool bar).

Select the display tab.
Click the label ATOM button.

Click and hold to change label options

2

arom +|  wam

1l | W
@ Chooze Color.
. by 3
Font...
Label style chi

cbl -0.3 [charge]

Fe +3 [farmal charge)

all properties

chl <mmff_type> charge
Element

Element+box

To changethelevel of label detail:

Click and hold the label ATOM button and select the desired level
of label detail, color or style.

5.8.3 Labeling Residues

To labd residues:

Select the display tab.

Select the residues you wish to label (seedi spl ay structureor
sel ection tool bar).

Click the label RES button.

5.8.2 Labeling Atoms

155



Click and hold for more options
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To changethelevel of label detail:

» Click and hold the label RES button and select the desired level
of label detail or style.

5.8.4 Move Residue Label

To changethelocation of your residue label:

» Select View/Drag res labels.

« If your mouse has a middle mouse button, then click on handle (as
shown) of the label you wish to move, and drag it to your desired
area

Click on B )
this area _tj’”‘b( !

to drag
your
label.

* If your mouse has no middle mouse button, then click on the
Trandation icon on the toolbar, and click on the handle (as
shown) of the label you wish to move, and drag it to your desired
area.

The +/- buttons on the side of the Residue and Atom buttons will shift
the label. There are also other residue label move options available
when you click and hold the residue label button. These options include
Shift to Sidechain Tips, Shift to Calphas, and Restor e Positions

5.8.5 Label Variables
Tolabel variable angles (dihedral-torsion, planar and phase angle) the
molecule needsto be converted intoan | CM obj ect .

» Convert the molecletoan | CM obj ect .

e Select the atoms for which you would like to display the variables
(seedi splay structureorsel ection tool bar).
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» Click onthetoggle variable label button shown above located in
the display tab.

» Change the font size by using the +/- buttons.

» Change the font and color by clicking and holding on the variable
atom label button.

To change the variable label style click and hold the variable atom
label button as shown below.

Click and hold

o

@ | X LS | BB

P

x ﬂ Choose Culor

phi

£z
Ereray

‘ ¥ Ringz Only

Rings of varying diameter and color are superimiposed on rotatable
bonds. Green rings with large diameter are considered less constrained
than rings with small green rings. Red rings are highly constrained.
When the L abel Style/Energy option is selected the first number
displayed represents the bond angle, the second the energy and the third
the worst energy that could be achieved by rotating the bond.

5.8.6 Sites and Annotation

5.8.5 Label Variables
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Individua sites can be displayed or undisplayed in the ICM workspace.

TRO EER.F!JH ﬂl«aﬂtt I BB ERER!
u L& Lgl-*JtI: = | e -
p— - 1. Make a selection and then

. _ right click and choose
DENI TPLYEQ =" , 1 Annotation/Make Site.

VIMGMEYTL.EE

megiE g

E"‘I HYTEESE

HUEArEY J-\.F
PYRGMEGREY

TAMLERGERM i n 1 & Add the descripbion o 1. ? =
392  GCPAGCEEEM - =
6§02 YDLMMLOWTY 4 St e Alphat -

612 DVENEPEFRR
$22 YVELRLRWYYY o S Fiiie 1
DVVNEGHHE e There ane § residuss missing Betwsen
Dﬂﬂs—f i - ' that Bata 3 grdl dipha C.
2. Enter your :

annotation

Tt

& RAHE R

Pt
3

(83
-5013 k
1 4-{4-methyl-pipe:
4 tyrosine-protemn kinase syk
wf W (357 water moleculas «

P
m-i_l[_@ cq:.«.

To create your own annotated site:

& 8 5

Sel ect theregion you wish to annotate as a Site.
Right click on the selection.

Choose the option Annotate/M ake Site

Enter the annotation into the text box and select ok
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To edit or delete asite:

* Right click on the site in the ICM workspace.
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5.8.7 Changing Label Colors

To changethecolor of any label:

 Click and hold down the required label button and a menu as shown
below will be displayed.

display abels ar

’?ﬂ AMH (FA!I

") choose color..

» Select color.

5.8.8 Customized Label 2D or 3D

To generate a customized a label:

* Select thelabelstab.
» Select either 2D or 3D button.
» Enter your label and select the desired color, font and size.

Select2D or

3D label Undisplay label
£ di Ia_l,l il labe pdb search ' meshes ' movie
FEPY % o O

€3 New Label

Type your custom label here

o 1 Add custom text

Faont
Farnily: | times ﬂ
Size: |20 3
[~ italic [~ bald
=
Help:

& |

OF. | Cancel |

To edit or delete alabel - right click on the label in the graphical
display as shown below.
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Right click here to Edit or Delete label

Structure of ZCJ
e s L I label 1: Crpsta.,

¥ Delete

€ Edit Label

Crystal Structure of 2CHM

Color: =-- .--l Muore

Farik

Family: | courier ﬂ
Size: |20 4
[ italic [~ bald

Ok | Cancel ‘

To move a custom 3D label you need to right click on it in the ICM
workspace (under meshes) and choose Connect/Move independently. Press
the Esc key to disconnect when you have finished moving it.

5.8.9 Undisplay Customized Label

Undisplay Residue, Atom, and Variable Label Any label that is displayed
can be undisplayed by selecting the region of the molecule related to

the label and clicking on the corresponding label button in the labels

tab. For example if you wish to undisplay an atom label - click the atom
label button. If alabel isdisplayed the coresponding button in the

display tab will be shaded blue. When you del ete the button will return

to grey. 2D and 3D labels have an undisplay button (red cross on the

button seecust oni zed | abel section).

Undisplay 2D or 3D label Click onthe undisplay label button in labels
tab.

NOTE: A label can also be deleted by right clicking on the label in
the graphical display and selecting delete.

5.8.10 Labeling Distances

Within the labels tab there are tools for calculating and displaying
distances. These tools can also be found in the Tool s/ Anal ysi s menu.
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Select Iabels tab Show distance from one atom to many

r Iabels " pdb se rc:h Ymeshes Y movie

“Jﬂl_ ¥4 [0 ]_ J ‘ Delete all distances

Threshcrlds

Show distance between two atoms

Show corresponding distance between two objects

To display distance between two atoms:

» Click onthelabelstab (previoudly called advanced tab).

* Select the atoms between which you would like to find the
distance. (Seesel ecti on tool bar)

» Click on the’ Show Distances Between Two Atoms' Button

* Thedistance will be displayed in angstroms, in green.

Tofind the distance from one atom to many:

» Click onthelabelstab (previoudy called advanced tab).

» Select the atom from which you wish to measure the distance from
(Seesel ection tool bar)

 Click on the’ Show Distances From One Atom To Many’ button.

» Thedistanceswill be displayed in green.

The maximal and minimal distances can be selected by entering valuesin

the boxes shown here (below) in the labels tab (previously called
Advanced tab).

o ¢ ol

NOTE: Distances can be displayed and undisplayed in the 3D |labels
section of the ICM Workspace. See image below.

5.8.10 Labeling Distances
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To changethecolor of thedistance label

* Right click on the distpair s under the 3D labels section of the
ICM workspace and select Change Color.

5.8.11 (Un)display Origin

Todisplay and undisplay the axis of the coor dinate frame (origin):

» Select the labelstab and select the toggle origin button.

Display or undisplay origin button - located in the
labels tab

S| G| [

5.8.12 Displaying Tethers

Theory

A tether is aharmonic restraint pulling an atom in the current object
to astatic point in space. This point is represented by an atomin
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another object. Typically, it is used to relate the geometry of an ICM
molecular object with that of, say, an X-ray structure whose geometry is
considered as atarget. Tethers can be imposed between atoms of an
|CM-object and atoms belonging to another object, which is static and
may be anon-ICM-object. Y ou cannot create tethersin ICM-Browser,
however, if the project that you have loaded contains tethers between
two objects, then they can be displayed:

» Click onthedisplay tab (previously called advanced tab).
» Click onthe’Toggle Tethers' button.

5.8.13 Displaying Distance Restraints

Theory

A distance restraint imposes a penalty function on the distance between
two atoms in the same object. Y ou cannot create distance restraintsin
ICM-Browser, however, if the project that you have |oaded contains
distance restraints, then they can be displayed:

» Click onthedisplay tab (previously called advanced tab).
» Click onthe’Toggle distance restraints’ button.

5.8.14 Display Clash

Todisplay aclash thefileneedstobean| CM Obj ect .

» Sel ect theregion around which you would like to identify clashes.

» Select the display tabs and the "toggle clashes' button shown
below.

Labels tab
£ labels  pdb search Y meshes % movie

N P e e “j

Togygle clashes buttun

5.8.15 Display Rainbow, Box, Ruler
To (un)display arainbow scale, box or ruler use the buttons shown below
located inthe Label s Tab.

box

SIBIA e

rainbow (click and hold to change colors)

5.8.16 Display Gradient

This button islocated in the display tab.

5.8.12 Displaying Tethers
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Toggle energy gradient button
EJ ﬁgg

This option is described in detail in the language manual
htt p: // ww. mol sof t. conf man/ i cm commands. ht m #di spl ay- gr adi ent

5.9 Display Distances and Angles

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro

5.9.1 Display Distance Between Two Atoms - the
quick way

Click on the Display tab

Click on the Distance between two atoms button shown below.
Click on the atoms you wish to measure.

Distance will be displayed in the graphical display. Y ou can turn
this on and off in the ICM Workspace panel under the heading 3D
labels.

4|l G

Display distance

5.9.2 Display Planar Angle

» Select the display tab.
* Sel ect three atoms.
» Select the button shown below.

< wlaAl| G
Display plarLar angle
5.9.3 Display Dihedral Angle

» Select the display tab.
* Sel ect four atoms.
» Select the button shown below.

ﬂﬂ,ﬁﬂ K

Dihedral angle
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5.9.4 Delete Label

To delete distance or angle labels

e Select thedisplay tab.
» Select the delete distance or angle label button shown below.

Delete distance or angle labels button in display tab

| L] ~ |3 %
5.10 Graphics Effects

Availablein the following product(s): | CM Br owser || CM Br owser - Pr o
[ CM Pro

All the visual effects tools can be accesed by the Vi ew Menu or click on
the corresponding button in the View Tools panel shown below.

View Tools

B« EDAPSE & =
5.10.1 Fog

Fog Toggle(Ctrl + D) : this feature creates a fog-like environment for
your object, so that the part of your structure that is closer appears
clear and the distant parts are faded asif they arein fog. The
cl i ppi ng pl anes control the point at which the fog begins.

* View/Fog

5.10.2 Shadows

* View/Shadows
OR
select the shadow button shown below.

Toggle shadow

- I Qla

5.9.4 Delete Label
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5.10.3 Sketch Accents

To make images as shown below use:

* View/Sketch Accents

5.10.4 Elegant Ribbon & Ligand Sketch

» Display Tab
» Click and hold Hydrogen button
e Select Elegant Ribbon+Sketch

5.10.5 Occlusion Shading

Occlusion shading is for surfaces and meshes to give a perception of
depth.

To add occlusion shading:
* Right click on the mesh in the ICM Workspace and select Occlusion
Shading. The occlusion shading value can a so be changed before
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generating the mesh in the meshes tab.
» Enter adepth value - default is 0.8. Higher values will generate
amore dramatic shading.

5.10.6 Perspective

Toggle perspective Ctrl_P thiswill add perspective to your structure,
enhancing depth in the graphical display.

* View/Perspective
5.10.7 Animate View

Learn how to build fully interactive and interruptable animations.

Smooth Animated Yransitions

5.10.7.1 Make Animation

To quickly produce an ICM Molecular Animation:

* Click and hold down the "Begin rocking/rotation" button shown in
the picture below.

» Choose from the following options - X-Rock, Y-Rock, Xy-Rock,
XY -Rock, X-Rotate, and Y -Rotate.

t} s-Rock Q_ Click and HOLD DOWN the
Q \Bock :;':_'i Begin rockingirotation button
Fy-Rock s
v dT-Rock 3
&- *-Rotate L
Q, Y-Rotate [ t
&, SetSpeed/Range... —l__
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NOTE: Default rocking representation can be changed in the
Fi | e/ Pref erences/ Gui menu.

5.10.7.2 Change Speed, Range and Cycle Length of
Animation

To change the speed, range and cycle length of the animation:

* Click and hold down the "Begin rocking/rotation" button shown in

the picture above.

» Choose the set speed range option and change the speed and range

using the drag bars. Any change will appear in the graphical
display behind this box.

« If desired you can change the number of cycles of the animation.

Thisisanideal tool for scr een- shot novi e nmaki ng.

9 Rocking Preferences @@
Range Ji 1.00
Cycles

" Endless movemnent

-

f* Mumber of cpcles 4 >

Ok | Cancel ‘ Set Defaults |

NOTE: Thereisareturn to default button in the Rocking Preferences
dialog box shown above and defaut values can be changed in
Fi | e/ Preferences/ Gui .

NOTE: Default rocking speed can be changed in the
Fi | e/ Pref erences/ Gui menu.

5.10.7.3 Interrupt Animation

AnICM Animation or Transition isfully interactive and is interrupted
by asingle click of the mouse.

To stop or change an animation or transition:

» Click the "Begin rocking/rotation" button shown in the picture
below.

To temporarily halt an animation or transition:

* Click inthe graphical display. Once you release the mouse button

the animation will start again.

NOTE: If you click on the graphical display during an animation the
animation will beinterrupted. Whilst clicking and holding the mouse
button other operations can be performed such as zooming and
selections.
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=

B #Fock

& vRock =
Hy-Fock Eﬁ'

v WV-Fock X

{‘5- ¥-Rotate L

&, SetSpeed/Range...

Click in the graphical display window to
temporarily interrupt an animation

5.10.7.4 Saving an Animation

An animation can be saved in an ICM project:
Fi | e/ Save Project
Or

asasl i de.

5.11 Graphics Shortcuts

Availablein the following product(s): | CM Br owser || CM Br owser - Pr o
[l CM Pro

The left mouse button can be mapped onto different graphics tools which
can be selected from the right hand tool bar.

Note: (1) You can access many non-rotation modes directly from the
rotation mode by using Middle and Right-mouse buttons, aswell as by
using theright, top and left margins of the graphics window. (2) Y ou
can access the rotation mode from non-rotation modes by pressing
Ctrl.

 rotation ( the default , press Ctrl if you in the non-rotation
modes)

* trandation ( the middle mouse button in the rotation mode)

» zooming in and out by dragging the mouse up and down (the left
margin in the rotation mode, or use the mouse wheel)

» Z-rotation ( the top margin in the rotation mode)

» selecting by box ( the right mouse click in the rotation mode )

 selecting by lasso ( Ctrl-draw lasso in the rotation mode )

» picking out atoms ( atoggle)

» picking out and labeling residues (atoggle)

« moving the front clipping plane ( the top section of the right
margin in the rotation mode)

» moving the rear clipping plane ( the bottom section of the right
margin in the rotation mode)

» moving the slab ( the middle section of right margin in the
rotation mode)

e unclipping ( Ctrl-U )

* rotating torsions (Ctrl-left-mouse-click in the rotation mode)

5.10.7 Animate View

ke . . .
(&2 — Click here to stop an animation
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 connect and unconnect separate molecules to movement controls
Many useful graphicstips are summarized her e.

NOTE: Key mouse controls are summarized in the command line manual
hereht t p: / / ww. nol sof t. conl man/ gr aphi cs-control s. ht ni

5.12 Molecule Move Buttons

Availablein the following product(s): | CM Br owser || CM Br owser - Pr o
[ CM Pro

To move your structure it must first be displayed in the graphics window
(for instructions on how to display a structure seethe Di spl ay Tab).
All of the following options are displayed in the Move Tools toolbar

(shown below).
— Center
Rotate — ' — Click and hold custom rotate options
4 — Translate
Zoom — &

s — Z-axis rotation

5.12.1 Rotation

In order to achieve the best pose for a picture or to enable the study
of a certain region of your structurein moredetail you may need to
rotatethestructure:
» Click on therotation icon on the toolbar.
Rotate — C
& -
£
=

* Click and drag on your structure in the display window until it is
in the desired position.

5.12.2 Custom Rotation

An option is provided to customize the rotation of the molecule. This
allows exact rotation by a specified number of degrees.

Rotate — G: — Click and hold custom rotate options

<+
£
%
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* Click and hold down the rotation button and a data entry box as
shown below will be displayed.

» Enter the number of degrees of rotation you require and in which
X, Y or Z coordinate.

9 Custom Scene Rotation @@
Rotate around:
{* X -5 Z
Rotate by 180, degress
45, | 90. | 180. | 270 ‘
soey [ ok | caneal |

To continuously rotate the picture:

* Click on the continuous rotation icon on the toolbar.

» Click, hold, and slightly move your mouse anywhere on the
graphical display window. The point at which you hold your mouse,
is the direction to which the object will turn.

* Positioning the mouse towards the center of the display will move
the object slower than if the mouse is positioned towards the edge
of the graphical display.

In order to rotate your picture around the Z-axis:

* Click on the Z-axisrotation icon on the toolbar.

Bodq @

— Z-axis rotation

» Click and drag your object around the Z-axis until itisin the
desired position.

5.12.3 Translation

To tranglate your structure up, down, left, or right:

» Click on thetranslation icon on the toolbar.

— Translation

Ho+q ©

» Click and drag on your structure in the display window until it is
in the desired position.

When you are displaying more than one object and you wish to trand ate
one object in relation to the other on the Z-axis:
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» Right click on the name of the object you wish to movein the ICM
workspace and select connect to object. This object is now
independent from the other object and can now be manipulated
separately.

» Click onthe Z trandate icon on the toolbar.

» Click and drag your structure along the Z-axis, moving it closer
or further from your unconnected structure.

» Onceyou are finished, right click on the name of the object which
is connected, and click on disconnect.

5.12.4 Zoom

Tozoom in or out of your structure:

» Click on the zoom icon on the toolbar.

— Zoom

ot @

» Click and drag your mouse up to zoom in and down to zoom oui.

Y ou can also zoom in and out directly with the right-mouse-button
without explicitly switching to the zoom toal, if you use the left
5% -mar gin of the graphics window.

5.12.5 Center

Torestoreyour pictureto the center of the graphical display window or
to center on a selection:

* Makeasel ecti on of theregion you wish to zoominto - if no
selection is made the whol e structure will be centered.
» Click on the center icon on the toolbar.

— Center

5.12.6 Torsion Angles

To alter thetorsion angle of certain residues of your structure
manually:

e Convert your pdb structure into an ICM object.

» Click on the change torsion anglesicon on the toolbar (see image
below).

 Click on the bond until you see the torsion angle displayed in
yellow (see image below). Click and hold on the bond around which
you wish to rotate aresidue. The changing torsion angle will be
displayed in orange.
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NOTE: This option can be used more effectively in conjunction with
thevari abl e | abel option.

To alter torsions by entering specific angle values:

» You can edit torsions by specifically defining the exact angle as
described here.

5.12.7 Connect (Move)

When there is more than one object displayed in the graphical display
window the objects are connected to one another. If you wish to move or
mani pulate one object independently from the others you need to connect
toit

Todo thisfrom the ICM Workspace:
» Right click on the name of the object you wish to movein the ICM

workspace and select Connect to Object. The object will now be
colored yellow.

5.12.6 Torsion Angles
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» Theobject is now controlled separately from the rest of your
objects by your mouse.

 Disconnect your object by once again right clicking on the name of
the object in the ICM Workspace and selecting disconnect in the
drop down menu or Pressthe ESCAPE key.

Note: you can temporarily switch to the global rotation in the
connected state if you press Shift

Note: usethe Escape button to disconnect

5.13 Clipping Tools

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro

t —— Move Front Clipping Plane
T — Move Rear Clipping Plane
L Slab

+ —— Unclip

The clipping tools allow you to adjust the frames of the ICM window,
changing the clipping planes.

Clipping planes can aso be moved without switching to the clipping
toal, if you click the right hand margin of the graphics window:

e Thetop section of the right 5% margin of the graphics window:
moves the back clipping plane

» The middle section of the right 5% margin of the graphics window:
moves the slab (both clipping planes)

* The bottom section of the right 5% margin of the graphics window:
moves the front clipping plane

In order to move the front or rear clipping planes of your screen:
e Click onthe Movefront clipping plane or Moverear clipping plane
icons on the toolbar.
» Click and drag the respective plane frontward or backward,
depending on how you wish to clip it.

Y ou can aso move the slab of viewing window, keeping the distance
between the front and back clipping planes. In order to adjust the area
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of the structure where your viewing window is located:
* Click on the Slab icon on the toolbar.
» Click and drag the dab frontward or backward, depending on the
desired area of the structure you wish to see.
If you have made changes to the clipping planes which you do not wish to
keep or you wish to automatically fit your entire structure within the
clipping planes:

 Click onthe Unclip icon on the toolbar. Thiswill automatically
set the clipping planesto fit your object.

5.13.1 Mesh Clipping

Clipping tools can be used to adjust the frames of the mesh
independently of other objects. Thisis described her e.

5.14 Graphic Layers

Availablein the following product(s): | CM Br owser || CM Br owser - Pro

[ CM Pro

To display and undisplay layers of a structure you can use the buttons
shown below. Seven layers can be created and within each layer different
structural representations can be displayed.

Right click on one of the layer buttons and a number of options can be
chosen as shown below.
Tisgsean
FE [off]
Rename

Mernarize

Clear
=
ustick
CPE.

kake Current

To change the display in one of the layers:

» Right click on one of the layer buttons.

» Select arepresentation wire, xstick or CPK.

* You can do thisfor each of the seven layer buttons.

 Click on the layer button to display and undisplay. If the layer
button is shaded red then the layer is not displayed. If the layer
button is shaded light blue then it is displayed. Y ou can switch
between layers by clicking on the button or using the. Y ou can use
the memorize button to store a particular representation and clear
to remove a memorized representation.

5.15 High Quality Publication Images

5.13 Clipping Tools
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Availablein the following product(s): | CM Br owser || CM Br owser - Pr o
[ CM Pro

5.15.1 High Quality Image
To make high quality publication images:

Thefirst step isto improve the quality of the image using the High
Quality Image and Antialias buttons shown below.

antialias
EA?&
high quality image

Tosaveand write an image:

» Select File/Write Image and the following window will be
displayed:

= Write image to a file 7 P4

" Antialiasing -"\f High resclution PNG 4/ High resolution '/ Vectorized Postscript &
Image Filz Name  icm Browse

@ ong () 6F (O rgh O targa () eps

{ Ok H Cancel H Help

Choose one of the tabs depending on the image type you require:

» Antialiasing allows you to make png, tif, targa, epsor rgb file
types.

» High Resolution PNG Allows you to specify aresolution increase
and transparent backgroun.

* High Resolution Allows you to specify aresolution increase for
tif, targaand rgb files.

» Vectorized Postscript This creates a vectorized postscript model
of the screen image. Instead of the bitmap snapshot this command
generates lines, solid triangles and text strings corresponding to
the displayed objects. Since the postscript language is directly
interpreted by high-end printers, the printed image may be even
higher quality than the displayed image. The final resolution is
limited only by the printer since the original image is not
pixelized. Warning: there may be inevitable side-effects for some
types of solid images at the intersection lines of solid surfaces
(i.e. large scale cpk representation, hint: use display skin
instead).
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**NOTE: With some graphics drivers the high resolution image may be
distorted or multiple representations of the image in one frame.
Please see the FAQs for a solution to this.

5.15.2 Quick Image

A quick image can be saved using this option. The image will be saved as
icm1.png in the current directory in which you are working. Each
subsequent image produced will be incrementally numbered.

Thisoption is also available via a button as shown below:

hSEG O

Quick Image Button

5.15.3 Image Options

Click and hold on the image button at the bottom of the GUI to:

e Copy image to clipboard (single click on the button also does

this).

Resize image (Write Image Advanced)

Transparent Background Write Image Advanced)

Store an imagein ICM (Write Image Advanced)

If you aremaking an| CM docunent you may want to store images
inside ICM (Add Image to Album).

et b el For additional image options — click
fide  Edit View Buoido  Tooh Momelogy LChewusty Docking  Bloldechonics g .
FEEO AR TR0 BB JISE EcED and hold on the image button at the
ey L\ o\ e \/ i\ i\ E—— bottom of the GUI.
H 4 @led gyl EEEEE N o= :
Wortapace Panel DE‘
no selection 5
S obiects (1 iter
ﬂmmm i

e @l P B0+

(v] g_skin_ beh a s';hbb ¥

{3 Copylmageto Chpboard
Write Image v
Write Image Advanced ... -
Add Image to Album...

Set as Background
YEIEIEY

1. Click and hold _

o [l o

' IQV

(o8 m0m (04

135 Agonns 16 Fiedd Mell Oy

5.15.1 High Quality Image
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5.16 Movie Making

Availablein the following product(s): | CM Br owser-Pro || CM Pro

B v =

BREA e Forie o A movieisan excellent way of
communicating 3D structural data.
The resulting movie can easily be
transfered into other applications
such as Microsoft Powerpoint.

| st T ]

— °066¢ =

There are two ways to make amovie:

» Makeamoviedirectly from aseriesof sl i des.
» Makeamoviedirectly fromscr eenshot s.

An dternative to amovieisafully interactive 3D document embedded in

Windows PowerPoint or a Web Browser, this can be undertaken using slides
andthe Act i vel CMplugin.

5.16.1 Making a Movie from a Set of Slides

To make amovie from a set of slides:

i MMk bon 27 3 Pl VQotint s R D W - Make a series of slides using the camera
‘button at the bottomof the screen. 0 |
CEEHO 90 TR0 AR PIAE EEDD P e e
o daginy "\ A S Tobefs \/ reshes Y/ starch 4l | &
BB vl b = i ptasadimoden |8l * | scmgancylinplyy | |t =
vsorkspacs Paned & L g
o seleckon . 2
-y shdes b
= shdeshow
4 Slide 1 [
2 Shide 2 ]
3 Shide 3 pal
4 Slide 4 ]
= ffl objects i
= - | R Wi 6A
L Ba 268 g
o ast ¢ 1 e
i tyrosine-| pfmen Iunase s‘,‘k cham i
HCIW (357 wate v
L4
]
&
i
" & K] ?:
- 1cm/1xbb>add slide display="-layout™ 3 1a
1cmflxbb>add slide dlspldy“‘ula,uu "4
E icm/1xbb>2
5 @ ‘!E_‘E] e &_‘Q_Ijﬁ_:.c' |1 [aged =] d‘.D 2 Mot O 1 ps. D= 00%)

Make aseriesof sl i des using the camera button.
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w88 R
;1cmflxbb>add sIide display="~layout™ 3
icm/1xbb>add slide display="-layout™ 4
iicm!lxbb}l

©® MO 0enala » [ Jue @)

Right click on the dlideshow in the ICM Workspace and choose the option

"Export as Movie".

& irbh Moholt iom 1730 [MawBrojct ] (1 chisct)
NEEO 9 TG0 AU L ILHE FHECB0
bty "\ S S s (g '\ vearch e |

FOE Zesrch *! latb

iwkapaos Pane
1 sakection
fam {1 dem}
= shdeshow

1 Sligde 1

2 Slide 2
3 Shde 3
4 Shoe 4

a4 |= N ]
x1cm/1xbb>add slide display="-layout™ 3

icm/1xbb>add slide display="-layout"™ 4
iicm!lxbb}l

o6 Woj= Dlalais)e) - ()8 e

HeYOD Bo+n O

& DBl

=
et

o B 5

R e e e

meCld Wosh g

Enter the filename for your movie and set the movie effect parameters.
Press OK and the movie will be written to afile.

5.16.1 Making a Movie from a Set of Sides
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5.16.2 Screenshot Movie

@; @ =’=l*—$creenshot movie making

To make a Screen-gr abbing M ovie follow these steps:

» Resize the graphical display to the screen size/resolution you
need. Y ou may also want to select thehi gh qual i t y image button
and antialiasing to improve the quality of the movie or add visual
effects such asshadows.

» To begin making amovie click on the movie making button at the
bottom of the graphical user interface (as shown below).

» Enter afile name for your movie and select the movie format
(-.mov, .avi, mpeg).

Enter filename

. . ¥
File namne: |||:mmm-'

Led Lo

Save az lype: |DuickTime filesz [*.movw “.gt)

QuickTime files [* mow * gt]
Wwindows video files [*.aw]
ool El_ NOMPEG videa files [*.mpg *.mpeq]

Choose movie format

By

Screenshot movie making button

NOTE: If you want to make a movie to include in a PowerPoint
presentation you need to save the moviein AVI format.

» To begin recording the screenshot movie click on the red Record
video button. Anything displayed in the graphical display will be
recorded, for example you can record ani nat i ons and transitions.
Specifying the nunber of cycl es intheanimation (rocking,
rotation) isan idea tool for screen-shot movie making. If you
have afast computer you can use Realtime screen grabbing which
can be selected by clicking and holding the Recor d video button.
Thereal timeoption canalsobesetinFi | e/ Pref er ences/ Gui menu.

& @)%

Record video button

» Thelength of the movie in minutes, seconds and millisecondsis
displayed in the top right hand corner of the graphical display.
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0:04:800

* You can pause the movie and fade out by clicking on the button
shown below. The number of frames for the fading out option can be
controled using the option in Fi | e/ Pr ef er ences/ Gui

Pause and fade out

|
& 11)m
Pause recording

* You can record a smooth transition from a previous frame by
clicking on the button shown below.

Smooth transition from previous frame
ORCKF

NOTE: Anything you do in the graphical display will be recorded in
the movie. For example you can change representations, lighting, add
new molecules etc. This can be achieved in a more controled manner
using the pause and record smooth transition button.

e Once you have paused the recording the viewpoint and
representation of the molecules can be changed and a smooth
transition from the previous frame can be generated by selecting
the Record smooth transition from previous frame button.

» To stop recording avideo press the button shown below.

Record smooth transition from previous frame
. @ 4 g

Stop recording

5.16.2 Screenshot Movie
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In this chapter you will find a
description of the tools available
to create files (.icb) containing
fully-interactive three-dimensional
(3D) molecules and two-dimensional
(2D) data. These files can contain
multiple interactive views and
animations of molecular structures
and objects in conjunction with
ittt related hyperlinked text, chemical,
o — biological sequence, alignment and
= | dataviews. The files are small and
easily transferable and
downloadable. The files can be used
for Molecular Presentation and Documents inside the ICM browser or
displayed on the web and in PowerPoint using the Act i vel CMplugin. For
examples of ICM Molecular Documents please see Mol Soft’s Activel CM
product page at www.mol soft.com/activeicm.html

= :ﬁ:_;t.fiz. -

EEN - -

Chapter Contents:

Maki ng Mol ecul ar Slides

How to Vi ew and Navi gate Slides

How to Edit Slides

How to Add Snooth Bl ending and Transition Effects Between Slides
How t o Make Mbl ecul ar Docunent s - Link HTML Text to Slides

Act i vel CM- Activel CM enables you to view and display ICM

graphical slides and animations interactively inside Windows

Microsoft PowerPoint and web browsers such as Internet Exporler

and Mozilla Firefox.

e | cmis isaJavaScript/HTMLS5 version of the Activel CM plugin.

6.1 Making Slides

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro

A dlide enables you you to store alarge number of different 3D
visualization along with text and window layout.The following
information can be stored in adlide:

» Viewpoint (e.g. rotation, translation, zoom, lighting and depth
effects)

» A set of atom-specific graphical representations such as surfaces,
which can be represented as smooth, transparent or wireframe,
ball-and-stick models, CPK (space-filling) models.

* A set of atom, residue or distance labels on any of the atomic
items

* A setof arbitrary 3D textual annotations assigned to apoint in
space

e A set of arbitrary 2D annotations assigned to specific 2D

coordinates on a screen

Parameters of the parametric ani mat i on

Window layout - for when the slides are viewed in the browser.

Current table(s)

Sequences and Alignments

HTML text with hyperlinks

2D images

For each grob (mesh): representation and colors.

A slide can be made by clicking on the Camera button at the bottom of
the GUI.
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e T e ”“’"‘“"”"’"’“‘”"‘{ Make a slide by clicking on the camera button.
EEFEO N TR0 ARSI SN MO«DBl@Ees TTEEERL
V" Gy "\ i\ Tabels 1 mesbus A seanch \/ ekt ) _ ®
| e R e | (B E & o e X2 | @] @la) g
icrkamot Faral 8% q’
no selection . P
.umt‘s (3 Besris) :
g - 2R &
L - ds06R (213732
H - ool ]R3 =
+-am SEQUBNCES } dem ]
: t;mﬂs -]
i
x
-
¥
-
&
%
bt
1- :SI’
} 1. Click on the camera |
s 4 0 I@ {-;] ;
o ® & i button to make a slide. S L o

Slidescan bevi ewed inthe GUI, can beedi t ed and gr aphi cal effects can
be added to them. Slides can also be embedded into the web, or
Power Poi nt using ActivelCM or viewed in ICM-Browser (or ICM-Pro).

Thistutorial takes you through the steps to create a series of fully
interactive 3D dlides. Another t ut or i al can befound here. To begin
making ICM Molecular Slides:

 First load the structure or structures you wish to display in your
first side. Additional structures, labels etc and text can be
added at any point during the slide making process. In this
example we will load the PDB file IXWS aPIM1 kinase.
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Load a kinase structure from the PDB.

“a 3. Click on the search button
8 . and a table of hits will be
2. Enter displayed
search string
lllst"

4, PDB stucture is

automatically listed
in the ICM
Workspace and
displayed

* Next, we will convert the PDB fileto an ICM abject so we can make
dlides of the ligand-receptor hydrogen bonds and binding pocket
surface.

Convert the structure from PDB format
=HE = "2 N | EEED A @ K . -
R oV into an ICM object.

a
-8
-a
1. Right click
here and
select
“Convert
PDB"
2. Enter the
options as
shown and
press OK.
s Bl ERE]——

* Now we are going to prepare the first slide by rotating the
protein structure to an orientation which allows the viewer to see

6.1 Making Sides
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the key features of the kinase. For example the bulge in the hinge
region (between the N- and C- lobes) which is unique to PIM
proteins.

Prepare the 1% slide: Orientate the
structure in the graphical display. ~

4. Undisplay the
default molecule
annotations by

3. Undisplay
the default
molecule

1. Use these
buttonsto

labeling by clicking here p
; clicking here rotatean
2. Undisplay move the
it Sinats structure.
molecule by
clicking here
-
J u L[] T

» Next, makethefirst slide by clicking on the camera button at the
bottom of the graphical user interface.
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e — : Make the 1% slide: A view of the first
*EE = Fim wEBER 49 %
o\ s bunit with li d displayed .
B subunit with ligand displaye y&
L= 2. Note: Slide is
s listedin the ICM
{5 Workspace
8.
1. Click here
to make a
slide
e |5 2

Click to add slide

» Onceyou have clicked on the camera button you will see that the
first slide has been generated. Thefirst slide is shown in the

CM Workspace window as shown below.

no selection

@ slides (1 items)

;"S'EidehDW The number and name of the

first slide is displayed in the ICM
= ohjects (1 iterns)
SBiom xReyis  Workspace
2 m 46 Amino

» Slidescan consist of Static viewsor Transi ti ons and Ani nati ons.
Here we will zoom into the flexible glycine rich region of the
kinase which lays across the roof of the ATP-binding pocket. Click
on the camera button and make the second slide
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) Vs b et 17 Ra [Pewragect 7] [1 s jeet)

ind & »
1. Click here to Make the 2™ slide: Center on the

glycine rich loop and color.

expand display to .
sequence level. =
=
4. Click on the color o
panel. 3. Click on the center =
B e g button.
2. Click and drag over .
400 glycine rich residues P ) .
" sl ‘ to select them. i
5. Click here to add
rocking and or rotation.
6. Click here
to make a
slide
LR =IEN OO
* Next, wewill make adlide of the surface of the ligand binding
pocket colored by binding property.
- = Make the 3" slide: Ligand binding
FEE = PN wEEDASE
SO S — - pocket surface colored by property. o
F =
HE' :‘:
a

3. Right click here
and select
pocket/receptor
pocket.

2. Right click
here and
select
center.

1. Display
ligand.

4. Click here
to make a
slide

* Now save the document as anicb file. Go to File/Save as...
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6.2 Make a Movie from a Set of Slides

Availablein the following product(s): | CM Br owser - Pro || CM Pr o

Please seethe novi e chapter on how to make a movie from a set of
slides.

6.3 How to View and Navigate Slides

Availablein the following product(s): | CM Br owser || CM Br owser - Pr o
[ CM Pro

6.3.1 View Slide Show

To view adide show select the buttons shown below:

b Loy o — = — . _macro
o T ted. ..
icmfd - ocdh Y icw browser exsmple.ich”
Info % Hernl Documents- =Main ogene serinef/threonine-protein kinase pi
Info 52-: graphic modes read from C:/FProgram File
w | Info zad (skipped 1) frow V:hicmd)icw browser
E|licm/ 1] B Default Layout lideshow.slides index=1 add
& icm/ 1 Toggle Slide Layout

€4 6D

EIEI G@]=]8] « [= ][] *@‘]

Click and hold and select Toggle Slide Layout Run Slideshow

NOTE: Slides are associated with the objects currently loaded into
ICM. Thereforeif you del ete an object then the slides will not work.
However if you delete an object and then re-read the same object with
the same name and structure the slides will be ok.

To save adide show

» File/Save Project
6.3.2 Slide Navigation

Y ou can make as many slides as you wish as described in the Maki ng
Mol ecul ar Slides section.

To navigate through the slides you can use the buttons shown below, the
cursor keys for some operations or the right click optionsin the ICM
Workspace.

6.2 Make a Movie from a Set of Sides
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Previous Slide Jump to Selected Slide

C RN g
I
Next Slide

Add a Slide Final Slide

The dlide currently displayed is highlighted in red in the ICM
Workspace.

- slides (1 items)
=-slideshow

Currently displayed slide

To jump to another sideright click and select "Set Slide".

All sides are displayed in the ICM Workspace. Y ou can hover the mouse
over aslide namein the ICM Workspace and athumbnail sketch of the
dlide isdisplayed as shown below. This can be used for slide navigation
purposes.

€8 slides (1 items)

4-slideshow
-
3 -"h
d]
5 Hover mouse over slide name in the
- ICM Workspace and a thumbnail
-7 sketch of that slide will be displayed.
.8
..
-1

= obje .

BN - R == mn i
S m 46 Amino

Or you can right click on the name of the slide in the ICM Workspace and
select the option "Preview".
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no selection B €3 ICM Slide Preview [test] ?X]

-5 slides (1 items)
L slideshow This is a test

Select

Set Slide

Set Shide Smooth
Codisplay Slide
Edit Slide. ..

LR s B I e B o B SR RN

Prewigw. . —  1a

- ¥ Delete
—u DbjE:L.t [T TETITS])

S 1o %-Ray 150

Pl 46 Amino

6.4 How to Edit Slides

Availablein the following product(s): | CM Br owser || CM Br owser - Pr o
[ CM Pro

Y ou can jump to the slide you wish to edit by following the sl i de
navi gati on instructions.

6.4.1 Edit Slide

Edit slide contents: To edit the content of a slide the procedureisto
add a new dide and then delete the old one or use the "overwrite
current slide" option as shown below:

» Click and hold down on the camera button.

Save Slide...

Owenarite Current Shide
Edit Shde Descrption...

Maove Current Slide. .
@ ale] o o/

Click and hold

To edit aslidedescription.

* Click and hold down on the camera button and select the option
"Edit Slide Description”.
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@@ 3 FIiN =EEDAIE
i el #x

- Hoodpf Aodn O

2. Edit the slide
name and
description

1, Click and hold
here and select
“Edit Slide

Description

 Enter the name of the dlide

» Enter adescription of the slide.

* If you wish to keep the current window layout or active tabs check
the boxes provided

Todeleteadide:

* Right click on the name of the dlide in the ICM Workspace and
select Delete.

To change the name of a dide

* Right click on the name of the dlidein the ICM Workspace and
select Edit Slide.

6.4.2 Move Slide

To change the slide' s position in the slideshow use the Move Current
Slide option and select the new position from the list.

* Click and hold on the "make dide button"”.
» Select Move Current Slide.

a a

Save Slide...
Owenarite Current Slide " laYOL
Edit Slide Descrption...

Click and hold
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» Select the position in the slide show where you want to move the
dideto.

5 Wove Shide in Siideshow

Move to position:

Ok Cancel ‘

Co-display morethan one dlide

* Right click on the name of the dlide in the ICM Workspace you wish
to co-display with the curently displayed slide.
» Select the option co-display slide.

6.5 How to Add Smooth Blending and
Transition Effects Between Slides

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro

How to add smooth and blend transitionsto a slide.

* Right click on the name of the slidein the ICM Workspace.

» Select Edit Slide.

» Select the desired transition effect - smooth or blend as shown
below.

» Select the length of the transition in milli seconds.

Add smooth transitions and
transformations between slides.

FEE T PN mEERADE
- o —

1. Right click "
" hereand |~
b choose Edit i
- Slide :
G
3, Enter the
2. Check the transformation
Smooth i
phapiel timein
an fnl'_ en milliseconds
option
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6.6 How to Make Molecular Documents -
Link HTML Text to Slides

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro

An ICM Molecular Document contains text and images which can be
hyperlinked to the graphical display. Click on the hyperlinked text and
then afully-interactive 3D dide will be displayed. The hyperlinks are
usualy linked to a set of slides but can also be linked to a series of
commands in a script, aweb page, atable or alignment. Once a molecular
document has been made you can view it in the ICM-Browser (File/Save
Project .icb file) or download Act i vel CMand view it in aweb page or
Powerpoint.

Tobegin creating an ICM document

» File/New/ and click onthe HTML tab.

» Enter sometext. E.g the Name of the HTML document. Formatting can
be changed as described in the edi t section below.

* Click OK

Prepare HTML text for the molecular
document,

im wWEEGAR

C - AR T

. _ 2. Click on the
g e Html tab.

= & S

3. Enter name
ofdocument.

e A HTML text panel will be displayed in the graphical user
interface.

NOTE: You can add multiple documentsinto asinglefile. The
documents will be accessible viatabs at the top of the HTML panel.

6.6.1 How to Add Text or Edit a Molecular
Document
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Toedit the HTML text in the graphical display

» Firstcr eat e an HTML document and the text panel will be displayed
in the graphical user interface.
* Right click in the body of the text display panel and select Edit.

To oo Add text to the Html document (1).
) 'ﬁ,:_. _:LI _:'_:‘]]EBB.U.I "
: m.f @ alEas | BEED (B S | R | b 2|n

EsoDr AD+n O EI

T 1. Right click in the
o= white space select
L
: o
: oot ok 1
8

- [w] ADDOOE

» Enter text and use the formatting tools provided in the panel
above the text editor. Make sure you have selected the Edit tab in
the HTML editor. Y ou can see your pagein the View tab or write
directly in HTML in the Sour ce tab.

6.6.1 How to Add Text or Edit a Molecular Document 197



Add text to the Html document (2).

o it Ak SPGB CEIDER X

- EeCDF Bot+ne E

BlIUcid =« BEEDE EEa@
The Crystal Structure of the Pim1 2. Use t!"IE
b e N e e formatting
’_' Lo | =L N T Ty tools here.

1. Type text
here. Make
sure you are
in Edit mode
(see below)

3. Toggle between View,
"1 Edit and Source mode.

AT g 573 o i1 04

| Zoom |[insert External Link e.g http!

1 Insert Comment f Insert CheckBox
. 1 Remove Formatting

2 e == w
Insert Table| | Insert Special Character |

y of iPage proferd raed i the semby ane of the ol e therelors Lapgerg iPace
re gl s b gorsd ey Ui harard, The dryg Carsched (i o9 2 bada |

Write in HTML using the Source Tab |

! Italic | !Sub,z‘SuperSr:npt| [ Text Format I
£ @
Cy | B i | = 2§ |ryzen
q‘-% List Level |
- el TE}Ct AHgnmEﬂt et . The drag Carssodsl (bnosen 45 a beta

of ths vell sind Ehewrefone bergating Ehese

BT OLRANTSTES £ ART A
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6.6.2
Slide

How to Make a Hyperlink Between Text and a

To makea hyperlink between thetext and the graphical display (dide)

Make adlide or set of dlides of the graphical display you wish to link

to. See

created:

Maki ng Mol ecul ar Sli des for help on this.Once dides have been

File/New/Html

Right click in the body of the text display panel.

Select Edit.

Highlight the text you wish to link to a graphical display - you
can do this by left clicking and dragging over the text (selected
text will be highlighted in blue).

Click on the "Camera button" in the HTML editor formatting tool
panel.

Select the Slide tab.

Select which number slide you wish the text to be linked to from
the drop down menu.

Thereisan option to display the slide as a thumbnail image in
the text document panel. Check if appropriate.

2. Click on
the camera

button
et | [ e
down button to find
websites or add an the slide
ICM script

| Add a link from the text to a slide.

" I DB AR

BAe S oarBE0B0E R ¥
BT (ujc ¢ T '.,:'.;;..Esi- ” . 1. Click and drag over
. Leetilaw | the text you want to

make into a link

6.6.3

Insert Image

NOTE: The easiest way to add images (PNG or JPEG) into an ICM
Document is to use drag and drop. Y ou can drag and drop the image
into the ICM Workspace or go to File/Open. Once theimage isin the
album in the ICM Workspace you can then drag it from the ICM
workspace into tthe HTML editor.

6.6.2 How to Make a Hyperlink Between Text and a Side
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F display % Tight “‘t" labels “‘y"pdh zearch “‘{me&he& Womavie

| no hydrogens J | H ’_j ‘luﬁ.- &3 HTML Source Editor

< @ |G| 8| | ulHw
} docT
ho selection Ill f khtuls
oy images (1 itern) |”§":') & | # " R <headr<titlex
- Ealbum Insert an gji%u =< fheads
Lemgdels browser’ . SeETin e
E@html “ ”Em) |mage. <hody text=hlack hgocolor=whitex
""" doc <hlxInsert an image.< hl>
< /body
</htmls

Drag and Drop from the ICM Workspace to the HTML source editor

Another way toinsert a pictureintothe HTML text panel

 First read theimage into the ICM photo album File/Open OR Drag
and Drop from directory into the ICM Workspace.

Theimage name and preview will then be displayed in the ICM Workspace.

=gy images (1 item)
- album

----- =1 guil.png
----- .2 guiZ png

* Create HTML text - File/New/HTML. Add text.

* Right click inthe HTML window and select ' Edit Source'.

* Right click on the position in the ICM Script Editor where you
would like to insert the image.

e Select 'Insert Image

Image source:

—image Size
Width: I1ﬁﬂ Heset Qriginal!
Height: 1123

W Keep original aspect ratio

oK Cancel

- £

» Select the image name source.
» Choose the desired Width and Height.
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e Click OK.
e Click Saveinthe ICM Script Editor.

6.6.4 Insert Script

How toinsert a script to the text panel
There are 3 ways to add a script - described in more detail below
1. Drag and drop script from ICM Workspace

2. Inthe HTML Source Editor - right click and select Insert Slide or
Action

3. Create an "inline" script
These methods are described below:
Drag and Drop Method

» Create a script File/New/Script

» Thescript will be displayed in the ICM Workspace.

e Right click inthe HTML Text Panel (for instructions on how to
create this panel seecr eat e nol ecul ar docunent ) and select edit
source and the HTML Source Editor will be displayed.

 Click-Drag and Drop the script into the HTML Source Editor

A line as shown below will be added.

<a href="#icm script/scriptl">text placed here will be displayed as a link in the docunent</a>
Another way to add a script to the document isto Insert Action:

* Right click in the body of the text display panel.
» Select Edit Source
» Highlight the text you wish to link to a graphical display - you
can do this by left clicking and dragging over the text (selected
text will be highlighted in blue).
* Right click and select ’Insert Slide or Action’ or select the
button in the HTML Source Editor and a window as shown below will
be displayed.
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9 CreatefEdit a 5lide or a built-in |[CM Script

Internal Link Mame |Linking toa m:ripd

Highlighted text |Link ket ko & script

Help: start script from fdialog!'name" to generate a dialog)

™ Dizplay Slide : slideshiow1] W Az Thumbral - Smooth Trangtion:  |2000 El: MEec

f* [Arguments and] ICH commands

Ldd wour script here

0K | Cancel

» Select the option [Arguments and] ICM commands
» Add script in the editor provided
» Select ok

Inline Script
A script can be added to the HTML text in the following way

* Right click in the body of the text display panel.
» Select Edit Source
» Enter script in the format as shown below.

<l--icnscript nanme="script2"

#di al og{" Test"}

# i _nunberl (2)

# i _nunber2 (3)

print $1 + $2

--><a nane="script2" href="#_">script2</a>

6.6.5 Insert a Dialog Box

Dialog boxes are provided to enable a viewer to interact with a
presentation or document file. The dialog box will be a gui data entry
box. For an example here is a script to prompt the user of the fileto
enter a pdb code;

#di al og{"Read PDB File"}
# s_pdbcode (1lcrn)

read pdb $1

ds a_ 1.
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Please Enter PCB Cods |1erm j

ok Gancel I

The code above can be saved as a script or inside the html text. To do
this:

1. Rightclick onthe HTML text display and select "Edit Source".

2. Highlight the text you wish to link to adialog box and then
select theright click and select ' Insert Slide or Action’ or
select the button in the HTML Source Editor and a window as shown
below will be displayed.

hd Create/Edit 2 Slide or a built-in ICM Script

Internal Link Name IExamplescriptE

Highlighted text I

Help: start script from #dialog{"name”} to generate a dialcg.

" Display Slide : E ] r ] 3:

& {Arguments and] ICM commands

8] 4 Cance| l
b o

OR.

1. Right click onthe HTML text display and select "Edit Source".
2. Addalink to ascript as shown below.

<a href="#icnl script/scriptl">Exanple Script 2</a>

6.6.6 How to add a check box.

To add a check box:

 Click on the check box button in the HTML editor tools panel (see
below).

* You can choose the check box to toggle an object or molecule on or
off. Or you can be more specific about the toggle actions using
the ICM command line. Y ou can choose different actions for On and
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o Pasts D K x 3 > EEEHE g Action

(i@ Open HTML Fie B I U G Body text ¥ BEE 3y cide

ﬁ Ingert Checkbox 7 W

Obgect Type [objects =] [a_nam, e

¥ Customize Togge Actions

User 351 o refer i the object name albove., For exsmpls: “display %1
OnCheck | Oniinchedk |

d% &pk n_;bc}::.u:t.l

6.6.7 Document Navigation

The following buttons shown below aid document navigation. Also remember
that more than one document can be stored and the header of each

document file will be displayed in multiple tabs in the text panel

window.

/ENNOT_FOFS
‘IH« XA
|

View Previous / Home |Zoom Out Search Text Tools
View Next ZoomIn

6.6.8 Protect Shell Objects From Deletion

When making a molecular document you can protect objects from deletion
by the person who reads your document by:

* Right click on the object in the ICM Workspace.
e Select the Protect option.

6.7 ActivelCM
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| Activel CMenables you to view and

d|splay ICM graphical sl i des and ani mat i ons interactively inside Windows

Microsoft PowerPoint and web browsers such as Internet Exporler and
Mozilla Firefox.

Chapter Contents:

How to Enbed in M crosoft Power Point 2003
How to Enmbed in M crosoft Power Poi nt 2007
How to Enbed in M crosoft Power Point 2010
How to Enbed in a Web Browser

How to Use Activel CMin Power Poi nt

How t o Change Activel CM Conponent Properties

Background | nages

6.8 How to Embed in Microsoft PowerPoint
2003

Setup
» Download ActivelCM from www.mol soft.com/support
» Savean ICM file (.icb) containing dides. Click her e to see how
to make slides.

Embed icb file

» Open the Insert menu from the top bar of PowerPoint and select
Object
» This opens up the Object dialogue. Select Activel cmCtIClass:

¥ Creste new MCEFClage | B

W ndmbﬁ Arohat 7.0 Document | ancal E
= Bitrnap Image i

Calendar Contral 11.0

DatePicker Contral I :

Group'Wise Secure Mime Control I Display a5 icon

W amposeCt] Class

Microsoft Equation 3.0 ;I

Result

i , Inserks a new ActivelocmChl Class ohject inko wour
Mm prasentation.

» Click on OK. A file dialogue will then be opened. Open the ICB
file you wish to use viathis dialogue. IMPORTANT: To avoid later
problems, make sure the ICB fileisin the same folder as the
PowerPoint file.

» A low-resolution snapshot of thefirst didein the ICB file will
be shown in the activel CM control you created. Y ou can change the
shape of the control by dragging the corners of the control with

6.7 Activel CM

Advanced use of activelCM Macros to direct visualisation changes



the mouse, once selected.
¢ Right-click on the activel CM control and select the Properties
menu item

T

] e EBR yew Iest Foema ook Shgethow  Wrdow el

af e £ 3 EOA W e ek BXQ P @es mEs g
W% '. 3 2 vepeadlacrca@eacpader-qondeaaop@enea pdl noaca@eoncacagoasagoropoatoronerdleaonea i@
) e

Click o add riotes £

A=w = =
- {i ] mpttges- S A OO AGHE #-L-A-===8 ]

S 14 1 ekt Devign, Enghish {12.8.) <3 e

¢ Savethe PowerPoint presentation

6.9 How to Embed in Microsoft PowerPoint
2007

Setup

¢ Download ActivelCM from www.mol soft.com/support
¢ Savean ICM file (.ich) containing dlides. Click her e to see how
to make dlides.

NOTE: Here are the instructions for Activel CM in Microsoft Office
2007, for older versions of PowerPoint see her e.

Enable the Developer Menu:

¢ Click the Microsoft Office Button (button top left), and then
click Power Point Options.

¢ Inthe Power Point Options dialog box, click Popular.

¢ Under Top optionsfor working with Power Point, selet the Show
Developer tab in the Ribbon check box, and then click OK.
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1, Click the
Microsoft Office
Button and
then Click
PowerPoint

Options : | 2. Enable Developer Menu

Insert Activel CM into Power Point:

Select the Developer menu.

Select the M ore Controls button in the Controlsfield.

Select Activel CM Ctl Class from the list of controls and click OK.
Click the mouse anywhere in the white PowerPoint space and a
diaog box will be displayed asking you to select your ICM (.ich)
file.

¢ Click and drag at the corners of the image to resize the normal

way you would resize an object in PowerPoint.

o el e s . -
= s i i g - s .
Ty AR N E— _k C 2

g:#‘ el i 1. 5elect Developers Menu

3, Select "Activel CMGt) Class!

4, Click anywhere here and select
ICM (.ich) file.

6.10 How to Embed in MicroSoft
PowerPoint 2010

Setup
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» Download Activel CM from www.molsoft.com/support . Please always

check you are using the latest version.

» Savean ICM file (.icb) containing dides. Click her e to see how
to make slides.

Enable the Developer Menu:

 Click on the File tab, and then click Options menu.

» Select the Customize Ribbon option and then check the Devel oper
option in the right hand side panel (see image below).
» Click on the Developer Menu.

* IMPORTANT! Click OK and then you will see the Developer Menu in
the Ribbon at the top of PowerPoint.

Select the Devel oper menu.
Select the M ore Controls button in the Controlsfield.

Select Activel CM Ctl Class from the list of controls and click OK.
Click the mouse anywhere in the white PowerPoint space and a

dialog box will be displayed asking you to select your ICM (.ich)

file.

e Click and drag at the corners of the image to resize the normal

way you would resize an object in PowerPoint.

Generat
Proafing
Sove
Laniguage
Advanced
{ Craeaiee Rikbar
Quick Access Toolbar
Add-dng

Trust Center

6.11 Embed in Web Browser

=
*ig Customizs the Ribbon

Lhoose comenangds from:
Papudar Commands

Agfinn

Add Lnisglian
Animation Pane
Animaiion Shydes
Bring Forward
Bring to Frard
Bullets

Copy

Lt

Decrease Font Size
Doy Takide
Dugplicate Selected Slides
£l

Fank

Font Cobor

Font Ske

Formsl Badkgrownd...
Farmst Chisd...
Frmsd Painder
From Baginning
From {urrent Slide
Hooup

Hyperhink...
imgresse Font Sige
Layout

Macros

Hew

Hew Side

Open

Dpen Recent File...

L ~i=mEieEladrsy » DOLm=wiifgseds

Customize the Ribbor:
Baln Tabs

#ain Tabs
= [ Hodng
= Cligboard
= SHaes
= Fant
& Paragiaph
& Crawing
& Editing
& [ Insart
& & Design
[ [ Transitions
[ o] Animations
[ [5F Stide Show
£ [ Review
- N

4] [ Mbeage
3 [ Grayicals

3 [ Black And White

# [ Slide bAaster

# [ Handewt kastes

4| [ Mokes Master

4 [ Background Remoesd
# [ Home Blaster Views)

[ henae... |

[ mamran | | pew Group |
Customizations: Rgset * i
[ impectEmpont ¥
——

NOTE: Thereis now aplugin-free version using JavaScript/HTML5 - click
her e for moreinformation.

To embed in aweb browser.

1. Download ActivelCM from here
http://ww. nol soft. conl get browser. cgi ?product =acti vei cn&act =l i st

(itisfreel).
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2. Creat e anHTML pagein ICM (File/New/Html).
3. Addaseriesof sl i des.
4. File/Export As ActivelCM Html..

NOTE. Thereis an issue with FireFox21 because it disables the Activel CM
plugin. The workaround at the moment is:

 typeabout:config in the location (address) bar and press the
"Enter" key to open the about:config page, just like you open a
website by typing the URL in the location bar.

* if you see awarning message then you can confirm that you want to
access the about:config page.

* inthe Search bar at the top of the about:config page type
"load_appdir_plugins

» double click on the preference to set value to true

e restart FF

6.12 How to Use ActivelCM in PowerPoint

**MPORTANT There aretwo waysto open a presentation:

» Doubleclick on the ppt file in windows folder. (in this case
PowerPoint will set the current directory to the one which
contains the file and there should be no problems with both
relative and absolute paths)

e Open ppt through the "File-Open™ or recent files. (in this case
PowerPoint DOES NOT SET the current directory to the one which
contains the file -> relative path might not work and user will be
prompted to locate the ICB file unlessfile is found in absolute
location)

Toview thedidesyou must bein Slide Show mode

» Pressthe F5 button to start the Slide Show. In edit mode (i.e.
not presentation mode), the control is shown as a static image ¢%o
it isnot possible to interact with the ICB file. Therefore, to
prepare the presentation so that the control shows the correct
initial visualisationsiit is necessary to run the PowerPoint
dide(s) in presentation mode

Change Slides
» Usetheleft and right cursor keysto change slides.

A number of other options can be accessed by right clicking on the
dide. These optionsinclude:

Select Slide

Auto Play

Set on/off rocking
Center

Load anew ICM File

6.11 Embed in Web Browser
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ICM Embedded Into PowerPoint
in Slide Show Mode (F5 button)

You can also add multiple Activel CM 3D displaysin one dlide:

e Todisplay mutliple ActivelCM 3D displaysin one slide just copy
the original display or repeat the steps described above. All
powerpoint slides should point to the same ICM file (.icb) but
they can point to different dlides.

6.13 How to Change ActivelCM Component
Properties

A number of properties of Activel CM can be changed once embedded in
powerpoint. The optionsinclude:
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Select thefirst dide to be displayed.

Set slide auto play.

Set auto play of ascript.

Embed the powerpoint file and the icb file all into one file.

To change these options:

¢ Right click on your embedded activel CM in Powerpoint.
¢ Select Properties and click on the button shown below.

o W0
e S v WY S g — -

0 Ty AR S il 2

""-'-' ""‘- F e 1885 fosiem

[ —

1. Right click here '
3 2. Select properties
3. IMPORTANT — CLICK HERE

ik s el b I
B o | s W ELA i o]

* A Property Pages window will then be displayed as shown below.

Airow lem Componeni Propeet: |

Filo Mame
Cumerd ICM Shde

sty Plag Sikdon
T ke Play Sides. Aute Py Interval [1se] =]

=
Flange To Pla:
Mo Play Scogh
# Mone O Chck ™ D Side
SopitoPuy | :

I Embed Fil into Corbol
2. Make changes

[on ] coel | doo |  Heo
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To changethe file name of theicb filelinked to activel CM: Simply type
in the path to the file or use the browse option.

To changethecurrent ICM dlide: Use the drop down button next to
Current ICM Slideto select the slide you wish to display first in your
presentation.

Toauto play dlides: Check the Auto Play Slides box and select the
interval between slides option. A range of dides can be played by
entering the number of the slides separated by a comma.

Toauto play a script: Select whether you want the script to run On
Click or On Slide then select the script from the script to play drop
down button. Y ou should first save your script in theicb file.

To embed theicb filein the ppt file Click the Embed Fileinto Control
option. Important - Please save your PowerPoint filein thet 1997-2003
ppt format not pptx.

6.14 Advanced use of activelCM: Macros
to direct visualisation changes

Documentation kindly provided by Dr. Brian Marsden (SGC Oxford
http://ww. sgc. ox. ac. uk/ peopl e/ bri an/ )

It is possible to write simple VisualBasic scripts to avoid having to

use the right-click menu approach to changing activel CM control slides
within the control itself. This allows one to place buttons outside of

the activel CM control, but in the same PowerPoint slide, which controls
the control’ s behaviour. Below are a couple of useful examples of this
approach.

Creating a button to set the control’s active dide:
Insert a button Office 2003
* In edit mode, make sure the control toolbox toolbar is shown by

right-clicking the blank area at the top of the top bar and
ensuring Control Toolbox isticked.
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¢ Click on aniconin the Control Toolbox which correspondsto the
sort of button you wish to use. Then click and drag in the
PowerPoint slide to generate the button.

Insert a button Office 2007:
¢ Inedit mode, click on anicon in the Devel oper menu or ribbon

which corresponds to the sort of button you wish to use. Then
click and drag in the PowerPoint slide to generate the button.

Frasepiaticn] - Microrolt PoasrPoas

;y e

Homa e Dasign  Ankmptions  JgaShow  Bavew View | Developer | Afddm

Al 2 Prmpann
F oo s @ R Gfview Soda

Lontrads

i

Visil Mporen Maere
Bissiz Sacuity

The SGC has solved
the structure of PIML
with different
inhibitors and
peptides bound

| Clickto add notes

G Segh Ay
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* Double-click on the new button to open the VisualBasic editor with
two empty functions pre-defined. The first one pertains to the
control itself and can be ignored in this context * For the second

function (which isfor the newly-created button), copy the

following into the editor, between the two lines of function code:

ActivelcnCtl1l.currentSlide = 2

» Thissetsthe current activel CM control’ s slide to be number 3
note that the value placed in this code needs to be 1 less than
the actual slide number (confusing, no?). Obviously, use avalue

here that makes sense in the context of your ICB file.
» Thisshould leave the editor looking like this:

| 4 Microsoft Visual Basic - Presentation? - [Slide? (Code}] okd
(M FEe fet wiew  nsert  Format  Dedug  Bun  Jook  Adddas v . B X
BaE-d s L 0 pono@ b B | iné, Col3
X |cammamaumn1 :j
] 3 ol = Private Jub ActivelcomCtll MouseClicked(}) ".“'
- # VBAProject (Presentatio
= 25 Microsoft PowerPunt OB End Sub
1] shde2
BErivat
Recivelemiell . eurs
End Sub
£ > 1= v

» Closethe Visual Basic editor

» To changethe physica properties of the button e.g. text, colour
e.t.c.right-click on the button and select the Properties menu
option. This opens up a dialogue as below, where many properties

of the button can be changed:

Properties [:}
;Commandﬂuttanl CommargiButton _-J

Alphabetic Ic.;tegm'zgd |

| {Blame) CommandButtonl ™

Aecelerator [

AutoSize False

SackColor [ smso000008 %

BackStyle 1 - fmBackStyleOpague

Caption CommandButtonl

Enabled Trus

Font Arial

ForeColor B =+300000128

Height 35.75

Left 53.875

L ocked False

Mouseloon {(Mone}

tMousePointer 0 - fiiMousePointerDefault

Piciure {(None}

FicturePosition 7 - fmPicturePositiondboveCentar

TakeFocusOnClck Trug

Top 321

isible True e

Width 153 >

» Using thisdialogue, it should be possible to disguise the button
to look like normal text (for example) which can be clicked on

during the presentation to change the visualisation of the
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control, apparently magically. Note that the button will only work
in presentation mode.

* IMPORTANT: In Office 2007, remember to save the PowerPoint
presentation now as a pptm file that is, a macro-enabled
PowerPoint file otherwise the macros will not work next time you
load the presentation.

Other code examples: Just copy and paste the example of interest inside
the function for the button in the Visual Basic editor. Code that

enables a button to cycle through the ICB files didesin order

(including wrap-around)

currentSlide = ActivelcnCtl 1. current Slide
nunsSl i des = Activelcntl 1. nof Slides

If currentSlide = nunSlides - 1 Then
ActivelcnCtl1l.currentSlide = 0

El se

ActivelcnCtl l.currentSlide = currentSlide + 1
End I f

6.14.1 PowerPoint Cache Errors

PowerPoint caches some information about active controls. Sometimes
after an Activel CM upgrade you may get an error when trying to access
some property or method: "Wrong number of arguments or invalid property
assignment" or something similar.

In this case you need to close PowerPoint and remove all files from the
location below:

C:\Documents and Settings\sevalLocal Settings\Temp\PPT11.0

6.15 Background Images

In Activel CM version 1.1-5 and higher you can add background images to
your icb file and display in PowerPoint and the web using ActivelCM. The
documentation on how to insert background images can be found her e.

6.16 ICM JavaScript (IcmJS)

IemJS (formerly known as ActivelcmJS) is a JavaScript/HTML5 version of
the Activel CM plugin. Y ou can read more about IcmJS her e.

To make afully interactive 3D molecular web page from ICM and embed
using lcmJs:

* UseICM vesion 3.8-5 or higher. If you do not have access to this
please contact Mol Soft to request it.

* Makeasetof slides.

» Goto File/Export as Activel CM Html and then select the IcmJS
check box.

e ThelcmJSfile will then be saved to your computer which you can
open in any modern browser e.g. Chrome, FireFox or Safari.

6.14.1 Power Point Cache Errors
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7 Cheminformatics
Chapter Contents:

Read Chemi cal Format Files

Save Chemical Structures and | mages
Chemi cal Spreadsheets (Chenical Tabl es)
Sket ch Chemi cals - Mol ecular Editor
Chemi cal Search

Convert Chemicalsto 3D

ToxScor e

CGenerate Chenical Fragnents

Fi nd Bi oi sostere

Mol Cart - Chenical Cartridge

Cal cul ate Properties

St andardi ze Tabl e

Annot at e Chemnical by Substructure
Align and Col or by 2D Scaffold
Set Fornal Charges

Enumer ate Formal Charge States
Convert

Build Prediction Model

Predi ct using Model

Generate 3D Conformers

Generate Tautoners

Cenerate Stereoi soners

Cal cul ate Ligand Energetics
Chemical Custering

PCA Anal ysi s

Vi sual i ze Chemi cal Space

Conpare Two Sets (tables)

Merge Two Sets (tables)

Sel ect Duplicates

Mul ti Paraneter Optinzation

Conbi natorial Chem stry

SAR Anal ysi s

Chemical Superposition

APF Superposition

APF Tools

7.1 Read Chemical Structures

Availablein the following product(s): | CM Chemi st || CM Cheni st-Pro
[l CM VLS

| Vi deo

Chemical structures can be read into ICM from MOL/MOL2, SMILES, and SDF

files or you can construct your own structures by drawing them in the

| CM Mol ecul ar Edi t or . Chemicals can aso be searched and downloaded via
theSear ch Tab using the PDB Cheni cal Substructure Search, search by PDB
Li gand Code, or by searching Dr ugBank, ChEMBL, Sur e ChEMBL or PubChem

Toread achemical format file:

» Select File/Open.

» Select the chemical structure file you wish to open: MOL, MOL2 or
SDF.

» Once selected the file will be displayed as a chemical table (See
| CM nol ecul ar t abl es section).

If you know the chemical smilesstring for the compound you can build
the 2D molecule by:

* Select Fi | e/ New.
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* Click the Compound tab at the top of the window.

 Enter aname for the compound.

» Typeinthe Smiles String in the Smiles String data entry box.
Remember to delete the previous string.

» Check the boxes Display Molecule Delete Other Objects according to
your preference.

* Click the OK button.

Smilescan beread from atext fileintoacheni cal tabl e by:

» File/Open and select Files of type: Smilesformat
» Then you can convert SMILES to 2D sketch using Cheni st ry/ Convert .

Smiles can beread directly intothel CM Mol ecul ar Edi t or:

* Openthel CM Mol ecul ar Edi t or window.
* Select Edit/Add Smiles

Multi mol2 3D files can beread by:
» File/Open and select Files of type: mol2 format.

Chemicals can beread directly from ChEMBL, SureCHEMBL, PubChem, and
DrugBank

e Click onthesear ch t ab and find the database you wish to search
in the drop down diaog box.

7.1.1 Extract 2D structure from PDB Chemical

To extract a 2D chemical representation from a PDB fileinto a chemical
spreadsheet.

Read the PDB file.

Right click on the ligand and choose Extract Ligand.

Choose whether you want to extract the 3D coordinates.

Choose whether you want to append to an existing table (chemical
spreadshest).

7.1.2 Read Large SDF Files

The ability to read large SDF files (e.g. >100K chemicals) depends on
the memory of your computer. A work around for thisis available in ICM.

» File/Open and in the Filter Section choose "MDL sdf format as
SMILES'

e Thetable header will contain an"S" symbol representing that the
table contains a SMILES column rather than mol. Each cell will
also be labeled "Smiles'.
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Filie narme: | COM_2 inhibitors \_\-_‘:ﬂ i format as SMILES {*.sd

=

,c___,_,—'—:“‘ Oipay Lance

T/ /g/L

1> dm_temp@atg“}j THA_inhibitors_2D_1 \
> . I"‘A

similes ;V\N W Molecule Name 13

;;s-miles (s;‘ thyropropic acid

7.1.3 Extract 3D coordinates from 3D Chemical.

To extract the 3D coordinates of a chemical into achemical spreadsheet
e.g for 3D QSAR or after chemical superposition.

» Select the 3D chemicalsin thel CM wor kspace. One or more can be
selected by clicking holding the CTRL key and clicking. A range of
chemicals can be selected by holding the keyboard tab and
clicking.

* Right click on any of the selected chemicalsin the ICM workspace
and choose Extract Ligand.

» Select "keep 3D coordinates.

» Append to an existing table if needed.

7.2 Save Chemical Structures and Images

Availablein the following product(s): | CM Chemi st || CM Chem st - Pro
|1 CM VLS

There are avariety of ways to save chemical structures. Chemicals can

be saved in mol, sdf and smilesformat fromachem cal table
(spreadshest), nol ecul ar edi or or from the ICM-Workspace. Ani mage of
the 2D sketch can be saved as an image from a chemical table.

7.2.1 Save Chemical Spreadsheet Workspace

If you wish to save your chemical spreadsheet and plots and setup.
» File/Save As- ICM Binary Format (.ich)

7.2.2 Saving Chemical Spreadsheet as SDF

To save all the chemicalsin atable asan SDF file:

» Right click on the chemical table header.
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» Select Saveas..
e Sdlect Save astype: (SD file, Mol file or comma separated value -
csv)

Right click here

ncinligands
ricinLigandz2D

mol — ohweight| MoPSa | MollLogs |
elee 7026 157.205 -1.44554

Clone

¥ Delete

a Fename...
ITN“: & save
N “F Sa

3229 114.926  -4.43000

I\ﬁu
N
0 J“N

To save selected chemicalsin atable as an SDF file:

» Select the row(s) of the chemicals you wish to save in SDF format.
Row selections in tablesis described in the Tabl es chapter.

* Right click on any of the selected rows and select Save Selection
As....
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! rlctlnl:lganEIQD 1]

mol

Calar By 3

Clustenng...
Learn...
Plat. ..

Analysis 3

[ & ra

Fiow Selection (2] 3

X

Delete Raws
Select rows here —

Copy Selection to [CM Table

Save Selection Az Cev+Headers...
]
4@[\1 @y Edit Molecule...
2 = Huery Molecule
'\Il/\u Ty Query

M )
fLIN Cherniztry 3
5

o M Mark Selected Rows 3
Select Marked Rows 3
Copy B ow(z) Chl+C
. Fazte Chel+
3 a Print T able... Cl+P

Right click here

7.2.3 Export to Excel

To export to Excel:
¢ Right click on the table header and select "Export to Excel".
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7.2.4 Saving Chemicals in the Molecular Editor

Chemicasdrawninthel CM Mol ecul ar Edi t or can be saved:

» File/Save or File/Save As...

or Edit/Copy asSMILES

7.2.5 Saving Chemicals 3D Chemicals

If you have converted a chemical sketch into 3D, the 3D structure will
be displayed in the ICM Workspace. To save this structure in mol format:

* Right click on the name of the chemica in the ICM Workspace.

» Select Save As..

ICM Workspace
|

no selection * |

-l ohjects (11t . .
n_“irf ® [1](|C|h§m) Right click here and

. G@m 1H select

Save As...

7.2.6 Saving Chemical Images

To save an image of a chemical sketch:
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» Thechemical needsto bedisplayedinachem cal tabl e.

» Right click on the 2D image

» Select Save Molecule AsImage

7.2.4 Saving Chemicals in the Molecular Editor



NOTE Using theright click options you can also save the image to the
clipboard or copy the moleculetothel CM | mage Al bumfor usein

Mol ecul ar Docunent s.
no selection |_|
3Ly images (1 itern)
ICM photo album - | eZ-album
easy transfer of t-chem
images to ICM

Molecular Documents

7.2.7 IUPAC Name

The I UPAC nomenclature for a compound can be generated on the fly for a
chemical. Y ou can view the [UPAC nameinthe Mol ecul e Edi t or or you can
i nsert acolumninto achemical spreadsheet with the [lUPAC name.

7.3 Working with Chemical Spreadsheets.

Availablein the following product(s): | CM Cheni st || CM Chemi st - Pro

|1 OM VLS

When an sdf fileisr ead into ICM it is displayed as a chemical
spreadsheet. Many of the operations you can perform on chemical
spreadshests (Molecular Tables) are described inthet abl e section of
this manual. Some useful chemical-only options are described in this

section.

An example of an ICM molecular table:

Chamical Spreacsest |

Grid, Form and Table views.

rReme  Afmnginl 466, 2

FRCEE  fdatopeody 257.2

428 __}—f {:}_/_

rageome  Batinciol 3972
@ ® ~
racemmic  Emmaolol 65,2

T
438 [ Fully editable and linked to rich set ]

of cheminformatics tools.

7.2.6 Saving Chemical Images

il deght *

Ef:‘[ Filtering and Searching tools. ]

mod oghP
:"c . ® @
- @ -13
B T ae 13
E : i 'D' @7
i ‘ ]
e
E_ 'g

moflags

2

v,

{ Piots and trees are fully interactive ]

and linked to spreadsheet.
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7.3.1 Read and Display Chemical Spreadsheet

When an sdf fileisr ead (File/Open SDF) into ICM it isdisplayed asa
chemical spreadsheet.

7.3.2 Chemical Spreadsheet Template

| Vi deo |
To create a chemical spreadsheet table template:

Chemistry/Create Empty Chemical Table

Enter aname for the table.

Choose whether you wish to add an ICM column and the prefix.
Enter the number of empty roads you would like to insert.

Click Next to select property columns.

You can add pl ot s and hi st ogr ans to the template.

Y ou can apply the template to new data by:
 Cut and past e or append the new datainto the template or double
clickinacell and edi t the chemical. The chemical properties
will be automatically calculated and the plots/histograms
populated with data.
Y ou can save atemplate by:
* Right click on the template listed in the ICM workspace (left hand
side).
» Select Save As.. and choose Save astype ICM binary .icb
Y ou can open atemplate by:

» File/Open filetype ICM Binary .icb.
7.3.3 Molecular Table Display

| Vi deo |

There arethree built-in table views.
e TableView (Default)
» Grid View - sel ect the columns you wish to display in agrid.
* Form View

Y ou can toggle between each view using the buttons on the right hand
side of the table shown below.
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7.3.4 How to add Property Columns into a

Chemical Spreadsheet.

| Vi deo |

To add chemical properties (e.g. MW, LogP, PSA etc...):

e Chemistry/Cal cul ate Properties

7.3.5 How to sort a column(s) in a chemical

spreadsheet.

7.3.3 Molecular Table Display
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7.3.6 How to copy, cut and paste columns and
rows in a chemical spreadsheet.

For large data it is recomended to use Tool s/ Tabl e/ Append rows.

LEAR AN RAC R raw nENER DB E
Y

) sehechon = —

e 0 ' T Doy s e How to copy, cut, and paste columns
and rows in a chemical spreadsheet.

1 +
S e [ o (LU E TR T L2l 2 el teal 2 ) z
wnbeitracky 10000 1o o .

L

QO

> 2b. To copy, cut and
1. Select a column or row paste rows — right click
by clicking on the header. here on a selected
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i e
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7.3.7 Add New Data to Chemical Spreadsheet

To add new datato achemical spreadsheet:
e UseTool s/ Tabl e/ Append rows.
7.3.7.1 Highlight New Data

To highlight new data added to chemical spreadsheet.

¢ UseTool s/ Tabl e/ Append rows.
¢ Choose the option to Select New Rows.
e Mar k the selected rows.

7.3.8 How to show and hide columns and rows in a
chemical spreadsheet.

e 4 em T G s e How to hide rows in a chemical
LCHFEEAR AR RRO RSN nENED P E
et spreadsheet.
ol AN H = ] A
- W st | . : i TV bl Ll 1. 1%m EALL soal e JRalitesl et 2 =‘_ '|_
ety vi e "ij‘--(': % :
I @ 2. Right click here and gle
select “Hide Rows” |3
E|w
a1
H b 4
e o
[ ]
I
P T s T A e L 4
[
-
- k- |
[
r
E-]

amamm L R L I L -

1. Select row(s) (click and LJ:J
hold CTRL key for non-
contiguousselections or ] TR M TR AN ARSI :
SHIFT key for range) |

R

N T P P T - ———— e —

1wt ]
o0 i/ njmale)
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7.3.9 How to save a chemical spreadsheet in sdf
format.
e How to save a chemical spreadsheetin
CFEAR AN RQC KR rIm nENED BB R
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7.3.10 How to export your chemical spreadsheet
into Excel.
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7.3.11 How to print a chemical spreadsheet.
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7.3.12 How to filter columns in a chemica

spreadsheet.

NOTE: You can also use thefilter slidebarsinthet abl e t ool s

panel. | Vi deo |
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7.3.13 How to use find and replace in a chemical
spreadsheet.
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7.3.14 How to mark and label rows in a chemical

spreadsheet.
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7.3.12 How to filter columnsin a chemical spreadsheet.
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7.3.15 How to insert hyperlinks to the PDB,
PubMed, and Uniprot.
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7.3.17 How to edit data inside a chemical

spreadsheet.

i 08 Vew Toc Cramssy ‘widse b

How to edit data inside a chemical

PEEAR AN RRD .."!l'l MENED A BWE spreadsheet.
"’".‘:: i 2 - - [ — ah _-.Tn. T R T =5 i EE = I
f {}I i
o e
m T s A =
O 3
: ¥e 1. Click I
o here -~
- - o 3 Tl L 4
r,:\'@. 2. Edit data by 2
i & double clicking -
] onthedata. | L H
L] ir},:'i
or
N (%] 1) M AEn aw B ny [ 3 A
oy *
: i
L)
4 (1] nr 1ME A as e - e 3 il
et
i Y]
L
H| e m s AaTm e mas K [+ 1 3 AR5 =
=
doenSeuplone deTeirert sreld=b o Li/es™ mame="" coleg="""'" LI
7.3.18 How to remove salts, explicit hydrogens
and standardize chemical groups.
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7.3.16 How to copy and paste 2D chemicals.
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7.3.19 How to calculate chemical properties in a
chemical spreadsheet.
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7.3.20 InChi

To convert acolumn containing an InChi key to 2D structure or
vice-versa 2D structure to InChi key:

¢ Right click on acolumn and select | nsert Col umm
¢ Choose Function -> Chemical -> Select 2DfromInChi or Inchi

7.3.21 How to identify duplicate chemicals in a
chemical spreadsheet.

7.3.18 H@B40 remove salts, explicit hydrogensand standar dize chemical groups.
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7.3.22 How to compare two chemical spreadsheets.
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7.3.23 How to merge two chemical spreadsheets.
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7.3.24 Display and Convert Molecule

To display and convert a molecule from a molecular tablein the 3D
graphics display window:

¢ Select the molecule image or imagesin the molecular table.
¢ Right click and select the Chemistry/ Convert to 3D option.

Edit DB Record...
@“ Quemn Molecule

Enumerate Stereoizamers [zelected rows]

Copy Row(z) Crl+C
. Paste Chrl+4
a Frint Table... Chrl+P

Enumerate Tautomers [zelected rows)

Femave Salt [zelected rows)

30 and Optimize
Load and Pregerve Coordinates

Confarmation Generator [selected rows)

Chemical Template Superposition [relected rows]

7.3.25 Copy Molecule

To copy a moleculeto paste into another application or into the ICM
Molecular Editor:

¢ Right click on the molecule and a menu will be displayed.
¢ Select the option "Copy Molecule"
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To copy a molecule or imageto pasteinto another row within an ICM
tableor into thel CM Molecular editor:

Right click on the molecule and a menu will be displayed.

Select the option "Copy Molecule"

Right click in the cell into which you wish to paste the molecule.
Select the option "Paste Molecule"

NOTE: To learn how to insert arow read thei nsert r owsection.

Molecules drawn in ICM can be cut and pasted into I SIS-Draw and
molecules from 1SIS-Draw can be cut and pasted into ICM.

To perform thes functions the correct settings need to be turned on in
ISIS-Draw so that the compound drawing is saved in the clipboard.

IN ISIS-DRAW - Go to Options/Settings/General/Copy Mol Rxn file to the
clipboard.

Compounds drawn in | SIS Draw can be cut and pasted into the | CM
Mol ecul ar Edi t or andinto ICM tables. Compounds can be copied in ICM by:

» Right click on the compound in the chemical table and select Copy
Molecule.

7.3.26 Edit Molecule

To edit a molecule:

* Right click on the molecule and a menu will be displayed.

e Select the option Edit Molecule and thel CM Mol ecul ar Edi t or will
be displayed.

» Edit the molecule.

» Click Exit inthe ICM molecular editor.

7.3.27 Color Table Column

You can color your table based on values within a column by: You can
also color the compound according to specific values see Col or Chemi cal
Structure.

» Selecting the column.

» Right click on the column header and a menu will be displayed.
» Select the option "Color By"

NOTE: You can remove the color from the table by right clicking on
the column header selecting Clear Selection Color.

Linksto other coloring options:
» Rows can be colored by marking them as described her e.

» A 2D chemical sketch can be colored according to specific values
(e.g. pharmacophore features) see Col or Chemi cal Structure.

7.3.28 Chemical View Options

Different chemical view optionsinthel CM nol ecul ar t abl e can be set.
» Right click on the "mol" column header.

» Select Chemical view options... and the following data entry box
will be displayed
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9 Chemical View Options

[~ iHetero-atom hypdrogens!

[ Teminal hydrogens

[ Atom stereo labels

[~ Esplicit hydrogens

[ Aromatic rings

[v Show racemic’ flag

[ Do not show 30 az 2D
[ Urnigue atom classes

[ Atomn numbers

[~ Additional abom labels
[ Monochrome atom labels

[~ Matext aton labels

Atom labels font

[ il =] [a =

™ Fixed size i+ Adustable size

Ok | Cancel ‘

Options can be changed by checking the appropriate boxes or by entering
the desired font and size.

7.3.29 Chemical Table Side-by-Side View

Chemical tables can be visually compared by placing them side-by-side.
This can be done by:

» Double click on the table header for side-by-side view.
+ Double click on the table header again to remove side-by-side
view.

Double click here for "side-by-side” view

J nicinligandz2D Y ncin_infubitor® Y,

mal Mofweight] MolLogP | MolLogs |
) 142118 -0.509686 -1.70292
u] ul
RS
i |
H M

150141 0070753 211729
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7.3.30 Zoom, Translate and Z-rotate a Chemical
in atable.

Sometimes you may want to get a better view of achemica inaan| CM
nmol ecul ar t abl e you can do thisinside the chemical table by:

» Double clicking on the chemical drawing and the background will
turn yellow.

Left click and drag here to zoom

L Left click and drag here to

D%\@\ rotate in the Z-axis
M

+—1 Middle mouse button to translate

M
T — .
IL/U\ Left click to select

chiral

3 ov 3N
NII,-'L
M
W u} Nf:"L‘N

Double click for yellow background to enable changes in
chemical display

NOTE: You can also browse your structuresin 3D. See section entitled
"Set Chenical Table 3D Browse Mde".

7.3.31 Set Chemical Table 3D Browse Mode

To browse the chemicals contained within a Chemni cal Spr eadsheet inthe
graphical display:

Right click on the "mol" column header.

Select the option " Set 3D Browse Mode".

Use the box in the column "L" to toggle the 3D display on and off.

Multiple chemicals can be displayed by sel ecti ng t he rows and then
checking the box.
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To remove 3D browse:

ricinligandsZ0 ™ TAUTOMERS
mol | L | NAME_|
;hifa' Double click here to rotate the molecue in 3D in
O.p.
} Fo he cell.
H
,j, i
o e
|
T“;L“f
2 . L
*IIQN D
f“lrﬁ
e T
chiral N
a
D,
3 n’“jflf”?:ri |ﬂ«\H
”f“n . Toggle the display of the chemical in the 3D
o n“’/J“N graphics window using the check box.

Right click on the "mol" column header.
Select UnSet 3D Browse Mode.

7.3.32 Chemical Find and Replace

Chemical Find& Replace tool allows you to find an arbitrary chemical
fragment with one or more attachment point(s) and replace it with
another fragment with the same number of attachment points.

Tofind a substructure and replace it with something else:
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Right click here

ncinCigands2D Y, ‘
mol [ |
1-column zelection
5 o Hide
On ~"C Copy Column(z) Chl+C
1 M “ % Cut Column(z)
EJ‘:N . Fazte Caluran(z] Chrl
I Rename...
¥ Delete Column(s]
o Calar Atams by Contribution 3
04\@\ f_.J Ingert Column...
M f .
s Column Statistics...
2 | 1
\IN{J\ Sort
:[ Filker b
o]
Agzzign 20 Coordinates. .
Rotate for Best Fit
[u] Clear selection
0., .
| Find and Replace. .
3 (ol Chemizal View Options...
Moo

» Select the column in which the molecular structures are displayed.
The column isusually called "mol".

* Right click on the "mol" column header and select Find and
Replace. A data entry box as shown below will be displayed.

bl Chemical Find dnd Replace

Find What: | EERRT0 %
Replace With: I-:emptyb C’,l

- -

» Click on the Molecular Editor button at the end of the Find What:
data entry box.

* ThelCM Molecular Editor will be displayed. Draw the substructure
you wish to search for and replaced.

» Draw the pattern and mark attachment points with R1,R2....
R-groups can be added by right clicking at the attachment point
and selecting the R-group from the drop down options.

» Closethe ICM Molecular Editor and the string will be displayed.

* Repeat with the "Replace With:" data entry box. Make sure the same
number of R1,R2... |abels are drawn.

» Click the Find Next button and then Replace or Replace All. When a
substructure to replace is identified it will be colored red.

NOTE: There are anumber of keyboar d short cut s which can be used to
draw chemicals. Also please note that an aromatic bond in the source
molecule will not match a double bond in the replacement pattern.
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Hereisan example:

L‘].’"\‘N
ka,, Define R1, H2 " /
fe] -H';l‘rl \(/
chiral Find Substructure /
o /7
Di/\N Che ‘/4
+d Chemical Find and Replace
s
Nji\ FindWhat  [ICATIcTnc2CH-CINHeZol |0 2
L Replace With: [[CATJICH]cTnc2CH=0INNe2el =0 G,

\("I [ FidNew |  Fessce | Resisceat | Close \‘\?

N Replace with attachment to R1

7.3.33 Split Chemical(s) into Fragments

Chemicalsdisplayedinan | CM Mol ecul ar Tabl e can be split into
fragments. Thisis useful for generating a series of R-groups to be
added to ascaffold (Seesecti on descri bi ng reactions.

To generate fragments:

» Sel ect the column or row(s) you wish to generate the fragment
from.

» Right click on the "mol" column header and select " Split Into
Fragments".

* A new table of chemical fragmentswill be displayed. Each fragment
is assigned an attachment point which is flagged with an asterisk

*)-
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Right click here Split Imto Fragments

q Find and Replace...
“erloandizD v, I Set 30 Browse Mode

Chemical Yiew Ophions...

il - 1
chiral
a
i O.p.
o ®
1 0w o
M
0T
M

MNew table is generated containing fragments

[ icinligandsZ2D Y F_RT 7

rmal cht | n_apn|
1 1

Attachment Point

chiral |1 2

RS

- —

7.3.34 Rotate Chemical for Best-Fit

To improve the display of achemical withinan| CM nol ecul ar t abl e you
can choose an option called "Rotate for best fit".

This option can be found by:

* Right click on the "mol" column header.
» Select "Rotate for Best Fit"

7.3.35 Color Chemical Structure
To color the structure of achemical inan| CM ol ecul ar t abl e by
fragment of pharmacophore frequency:

* Right click on the "mol" column header.

» Select Color Structure By
» Select "By Fragment Frequence" or "By Pharmacophore Features'

7.3.34 Rotate Chemical for Best-Fit
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Right click here
/ ricinLigands2D ‘

mol | Calor Structure By By Fragment Frequency
chiral ;
2 Clear Selection Color By Phamacophare Features
0 ifp:n e Irizert Calumn... 0ff
; om{ ﬁ% Column Statistics.. Edit Bainbaw,
: |
&-h .
ey
i €3 Rainbow Editor @

Cllck and Drag |

T T T T T T T T ™
00 10.20.30_40_50.60_70_30_% 1

Cancel |

NOTE: The coloring can be controled using the "Edit Rainbow" option
and the coloring can be removed using the "Off" option

7.4 Molecular Editor

Availablein the following product(s): | CM Chemi st || CM Chemi st - Pro
|l CM VLS

| Vi deo |
Draw new compounds by using the ICM Molecular Editor.
Themolecular editor can be activated by:

 Clicking on the Open ICM Molecular Editor button shown below.

SO B 90
search \/ ligedit \
‘3B Search "J

OR

» Select Chemistry/Molecular Editor and the editor as shown below
will be displayed.
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7.4.1 Drawing a New Chemical Structure
To draw a new chemical structure the ICM Molecular Editor should be
loaded.
To do this:
e Select Chemistry/Molecular Editor
Now you can start drawing your structure.

» First select an atom, bond or ring and then click in the white
Molecular Editor Workspace to start skethching.

G M Melsule Edibor [new Bl )

7 & @~ K| 8 5%
]
(| Foredla
Gmdes
Haree MBS
4 Inlh

Bond Types ]

k-

LY

InChiey
Malvisight

Rolg
10 Onagémness
AF  Mclirea

L e B s B = R+ N

13 Mollof

Atom Types 4 oS

§7 s Aariy

i@ Gnupgs

Click anywhere
in the canvas to
start sketching

EF @ w ¥

[ Chemical Sketching ]

L= {’::l
P

- ]

]

@]

T

* You can extend your structure by selecting another atom, bond or
ring.

» Select where on the structure you would like to add the new group
by hovering the mouse over the desired position. The position you
will add to will be highlighted in ared box.

7.4 Molecular Editor
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Hover over an atom and new bonds or atoms will be
added from the position highlighted by a red box

I
i

7.4.2 Stereo Bond

To set the stereo bond type:

* Right click on the bond and a menu as shown below will be
displayed.
 Select which bond direction you desire from up, down or either.

. / *«\\;“3,: . .
- W Single - -
Double
U Down
Triple P
Aromatic ..
B
Apy e
JRSERY . o
Aftributes B U
jul "
. /
¥ Delets Do A
Either Either

7.4.3 Right Click Options

There are anumber of different options available when you right click
on abond or atom. These can be used for editing bond and atom types and
there are additional optionsfor Chemi cal Sear chi ng.
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Element 3
Hydrogens 3
Ring membership  »
Fing size 3
Charge 3
’T Single |zotope 3
D ouble Hybndization »
Triple Connectivity 3
Aromatic Attachment point
Ay X Delete
Stereo b
Atibutes b Right-click options for atoms and bonds
¥ Delete

7.4.4 Chemical Dictionary

There isan inbuilt chemical dictionary which enables you to import a 2D
sketch quickly. To useit:

¢ Click on the chemical dictionary button.
e Start typing the name of the chemical.
¢ Select the chemical from the drop down list.

©ICM Meclscule Edior [new fle | BREGRECRRRE R e 8 Chemical Dictionary
X R

DE R S HE B oo
1. Click here for diﬂlﬂﬂﬂl’?

2. Type and select chemical name
fr

K4

Jr

mmum{ngr
Dbbydronybenzaidetyde, . Salioylic..
Ltydroxybenayd aloohol, salicylic.,
Ibiydroaybanacec aod. . Saboyle.,
S-biydroaybenzes: acd. . Salicylic. .
I-marosaboyic acd. . Salicylic..
Ethyt saboylate. Saboylc. .
Isobnstyd sabodiate. . Sallcydic .
S-Sulfosalicylic acd. . Salicylic .
Amd sabcyiate.. Salboylic..

Berunyd saboviate. Saloyle..

ool sabcviate. . Saloylie .
1-5afcyiate ghnronde. Salioylic. .
W Dbydroony-S-{8-trdecenylbenzos add. . salicylic

7.4.3 Right Click Options
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7.4.5 Dictionary of Chemical Groups

The ICM Chemical Editor has adictionary of chemical groups. These
groups are stored in atable stored in CHEM_GROUPS. csv file. Thisfile
can be manually edited to remove or add new definitions. The group can
be selected using the Gr p button of the Editor.

D Ktttk e LY ! Chemical Groups
5 B{G_‘_Kmmsmimmbnmﬂwmaﬁmm e g - p % Wi |
i 2 3 4 5 2] i1
s |5 o
o o
& o . se 0 | n—, R B
& 1 ”"f:’ - / A =
L&
i Fitrat Dot Bgipec= Sutf o Ereancl [T Tree ey Lo bewtnta
c s ¥ [:j
M S ,.:;J’ " . A M o ;--- =g G
0 2 ) ’—r )J\ ] PEE . Bap
F | ,,%H ) ! ~" | 1.Clickand hold s
p Drratty ot famatt ] Hypoasiyens heatirtdriaores i s oy M-
0 =, - TN #
- W 0 \ ~ |
W /d P
al ~ | 0 =¥ -
hs HO N N — ; AN T
M e 1 4 N
i Bedtals Fooiairg Forrazadoi Huntharg Feasman
7 P Qf, s - .
H j\ \ _/_( 5 L]
A \ ! j ’ \LJ \L‘l__ ,{‘—J’(—
o T
e ] ottragnsg Batazza Halenid dpckicruttaraa
F—l.] e il

7.4.6 Template Menu

A set of chemical templates are available for:
e amino acids
* bases

» bicyclics
* rings
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7.4.7 Set Free Radical Type

Toset afreeradical type (singlet, doublet or triplet) to an atom:
¢ Sket ch theligand in the Molecular Editor.

¢ Right click on the atom and select the free radical type.
¢ Convert to 3D or add to a chemical table if needed for docking.

7.4.6 Template Menu
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File Ed View Templstes Help

- Set Free Radical Type

B E f s EE O By jﬂh% ® s & G, 86

;ﬁ .
,7' CIHZZMN20

|z

M

[ 1. Right click on atom JT}I :

Hydogens ¥
Ring mernhershen

»
Himgy szm >
Thamge *
Isotcpe &
Hybrdization »
Harnuticity ¥

¥

#

Conmctivity
Radhegd
Atachenent point o 1 simglet
Edit Sboen Labsd * b
Edit Stem Yalws A% apeded

T Delste

7.4.8 Adding and rotating a fragment in
molecular editor by
clicking-holding-and-dragging.

The Chemical Editor allows one to add bonds (click the bond button), or
chemical groups (the Gr p button), Often one needs to re-orient the added
bond or fragment. In this case press on the atom to which you are going
to append the bond or the fragment and hold-and-drag the mouse it until
you see added fragment rotating around the attachment point. While you
keep the mouse button pressed you can rotate by dragging in the
preferred direction.

If you add templates (the Tenpl at es menu, or paste fragments, the
mechanism is somewhat different because the group is added in its
default orientation. In this case you can press Ctrl to rotate the
fragment to to be able to attach the fragment in the desired
orientation.

7.4.9 Property Monitor

When drawing a compound in ICM you can monitor important ADME-Tox and

drug-likeness properties.
To view the monitor
e |CM Molecular Editor/View/Chemica Monitor or click on the

Chemical Monitor button and a window as shown below will be
displayed.

Owve

4

2, Select free
radical type
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€5 M Moleoule Editor [new Se =) Thupraien

O w @ ¢ & E S N0 60D

ibuprofen

1. Click here to
open chemical
maonitor panel

C

'l

0

F

P

8

T, =
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Br

1 7 .
B
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3. The properties are calculated
on the fiy as you sketch

|

B A W@ W B Am

{ Chemical Monitor ]

nB %

"elret [E

Forsia CaNHE O

Sriles SR W e [ a O
M [TILPAL 2-{ okt et -progure
Inikd InChi= 150 1301803/ 1-5008-
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HEA 3
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B2 4

Onuglimness 953908

Moldrea X272
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rorprs 338837
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MPSA 6465

phume 14,58

Thesn Barrts

Greupe Fhargl

Carbonyie acid {Carbonoyl)

2. Chemicai
monitor panel
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here

coOvVe

The following properties are monitored.

Chemica Formula

SMILES string

Name/I[UPAC Name

InChl

InChl Key

Molecular Weight (MolWeight)

Number of Hydrogen Bond Acceptors (HBA)
Number of Hydrogen Bond Donators (HBD)
Number of Rotatable Bonds (RotB)
DrugLikeness value Druglikenessis not based on other properties,

thisis separate model built using Bayesian Classifier (See:
http://ww. nol soft. conm npropdesc. ht nl ). Normaly Bayesian
classifier returns either 1 ot -1 (positive ot negative) therefore

positive values means drug-like, negative - not.

* Molecular Area(MolArea)

 Prediction modd build for 'delta Hf in gas' property using public

NIST database (description can

be found here:

http://webbook. ni st. gov) . Alow dHf value means that the compound

ismore’'stable’.

LogP (MolLogP)

LogS (MolLogS)

Polar Surface Area (PSA)
Volume

groups.

» Groups option highlights chemical groupsin the sketch.

Chem Alert will flag any reactive group, PAINS or Bad ADME-TOX

The rows in the monitor window are colored from green (good) to red
(poor). You can right click on the table to copy avalue or add your own

prediction model.

7.4.9 Property Monitor
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7.4.10 Editing structure using keyboard

You can select afragment or simply position your mouse cursor over a
bond or atom and use the following keystrokes for editing:

» Changing atom properties

» d set/unset heavy atom connectivity as drawn to avoid additional
branches in chemical searches. Toggle.

r set/unset the"in-ring" property of atoms. Toggle.
y set/unset atom hybridization type ( spl,sp2,503 ). Toggle.
A set atomic property to be aliphatic

a set atomic property to be aromatic

* (asterisk) set atomic property to be any atom

C Carbon

H Hydrogen

N Nitrogen

OOxygen

F Fluorine

P Phosphorus

S Sulfur

| lodine

Changing chemical bonds

1,- (dash) single bond.

2,= (equal) double bond.

3# (hash) triple bond.

4.: (column) aromatic bond.

0,~ (tilde) any bond

Changing R-Groups

Pr ess 1to mark an atom as R1

Pr ess Ctrl-1to preserveitstype and create [C;R1]
Pr ess Ctrl-0 to remove the mark.

7.4.11 Chemical Editing Options

Tools are provided to help editing your chemical sketch. These include
buttons for selection, erasing, copy and paste.

redo cut erase  lasso selection

3 ?(b if‘ . T y{%l;]*ﬁ ® ws
uﬁﬂm copy  paste  recrangular selection

7.4.12 Paste SMILES or InChi String

Topastea SMILES string into the Molecular Editor:
e OpentheMbl ecul ar Editor.

* |nthe Molecular Editor window select Edit/Add Smiles/InChi.
» Click on the canvas.

7.4.13 Save Chemical in Mol/RXN Format

TosavethestructureasaMOL or SDF fileon your machine or server:
» Select File/Save As... in the Molecular Editor window

» Enter afilename and select where you wish to save thefile.
» Saveastypemol or rxn
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7.4.14 Save to Chemical Spreadsheet

Tosavethechemical toachem cal spreadsheet:

 Click on one of the buttons shown below. Y ou can append to a new
table or an existing one.

append molecule to a chemical spreadsheet

O H ¢ 8 8 B 9 &

append molecule to 8 chemical spreadshest
and convertto 30

7.4.15 Save as SMILES or InChi

To savethechemical in SMILES format
 Edit/Copy as Smiles
To savethe chemical in InChi format

* OpentheChemical Mbnitor.
» Right click on the InChi row and choose copy.

7.4.16 Convert Chemical to 3D or Generate
Conformers

To convert the chemical to 3D or to generate conformers:
* Click on the buttons shown below to convert to 3D or generate
conformersin the Merck Molecular Force Field (MMFF)

» The 3D chemical will be listed in the ICM workspace. If conformers
are generated a table showing the conformers will be created.

Cnmert ta 30

)

N e ) % % B B O O

Generate Conformers
7.4.17 Isis Draw Copy and Paste
Molecules drawn in ICM can be cut and pasted into | SIS-Draw and

vice-versamolecules from 1SIS-Draw can be cut and pasted into ICM.

To perform these functions the correct settings need to be turned onin
ISIS-Draw so that the compound drawing is saved in the clipboard.

7.4.13 Save Chemical in Mol/RXN Format
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IN 1SIS-DRAW - Go to Options/Settings/General/Copy Mol Rxn file to the
clipboard.

Compounds drawn in I SIS Draw can be cut and pasted into the | CM
Mol ecul ar Edi t or andinto ICM tables. Compounds can be copied in ICM by:

» Right click on the compound in the chemical table and select Copy
Molecule.

7.5 Chemical Search

Availablein the following product(s): | CM Chemi st || CM Cheni st-Pro
[l CM VLS

Chemical similarity searching can be used to screen a database of
compounds for structural similarity to a query chemical structure. The
chemical similarity search window is shown below. To access this window
use the Tools/Chemical Search menu or select the button shown below.

Chemical search

L " El“n Q?F_

|3 ntng._su1a_miay Tre——prary

T e T . | How to setup a chemical search.

L
FER AN TR W SN wENED PWE

o | e

- [T [RrR— e g ——— | S——— T -
L R ¥ ® T n 1 =

1. Click here

P 8 Ve Dol Hop

ta
ol An une 7 O &8 §=m §F O Taiie: | i | bmian

#

E
L ~

o e
: .

B

2. Chemical search o | |

windowwill be =" =
g T © Conbnek P—p—
displayed R
— = R e

—
(T [rearar— e

o et |

R =L

i

TI X

NS¢ PAHSHH =2

7.5.1 Query Setup

To set up aquery first you must have either drawn or loaded a chemical

structure into ICM. Instructions for this are described in the Readi ng

Chemical Structures and Ml ecul ar Edit or sectionsof this manual. If for
example the query molecule you want to search isin achemical

spreadshest you can right click on chemical in the spreadsheet and
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select Query Molecule.

At this point your query can be modified as described in the Mol ecul ar
Edi t or sections of this manual. However, there are a number of waysto
specifically modify your query and filter your search. The way to
accomplish thisisto right click on abond or atom and a menu as
displayed below will be displayed. The menus differ depending on whether

you right click on abond or atom.

If you wish to specify afilter at an atom.

* Right click on the atom and the menu shown below will be

displayed.

. ICM Chemical Search: [new file *] Molcart not connected

File Edit Wiew Templates Help Data Source
Ded a0 bal 2 LG @ K| G Table | Fie | Moicar |
Cl11H14

% Q|| | =
7 >

&

O

;C O Query Options

N O Sealch ype Substructure 5
0] O Maw: distance 0.4 vl
F Mumber of matches | ary =]
P . ;

- Right click on atom Mt S e | {icraak

I~ Selected ol

Cl CRTI

Br Element " Iz 3 of hits 10000 =
I Hydiogens Resulls

B Qi Count hits onky " Select in sousce
H Fing size k AsDravn R Hide unmatched (% Save results to:
Chage 3 RO sble |Fie ] Molcart I

“"E Isotope » .

[ Hybridization b A2 el w | v Overwrite

z Aromalicity 3 A3 ¥ Highlight match | Rotate by match
e )

i Connectiviy » Display as grid [ Slore query
= Attachment point

¥ [~ Append

. Delete
FieldH [Aelafion — [VaiE
LEDE: = LI Hide aiter Seach seach |

4| | 2]
Exchds fragment list
Test zeaich |

If you wish to specify afilter at abond.

» Right click on the bond and the menu shown below will be

displayed.

7.5.1 Query Setup

255



- ICM Chemical Search: [new file *] Molcart not connected

File Edit View Template: Help

DEE O hem 2 LG @rs | K| G

C11H14
7 @
4 >
d O
c <
N Q
L2 O
F
P
s
cl [CA]
Br ﬂ,':f/ . -

Single

I Right click v Dousie
B onbond Trigle
A Aramatic
. oy
lpv Steren ]
""_ Abiriates  »
e ¥ Delete
—
-

{ | FisldName Relation | Value D
4| | »]

Exchude fragment list

Twaaafch[

@IX)

[ ata Source
Table |Fk | Molcant |

I El

Guesy Options

Search type ’m
Max distance 04 -
Mumber of matches  [any =]
[~ Malch stereo [~ lgnose sak

[ Selected only

M awirraarn 8 of hits 10000 -
Resuks

™ Court hitz only (™ Select in source

" Hide unmatched & Save results ta:

Tatle |Fk|udm|

fegidt w| ¥ Ovenante

[v Highlight match [~ FRotate by match
[” Display a2 giid & Stare query

[ Append

[™ Hide after Search

Search I

To specify a particular atom type, aromatic, aliphatic or R-group at a

particular atom site.

* Right click on the atom and select the "symbol™ option as shown

below.

» Select the desired atom type, aromatic, aliphatic or R-group and a
symbol will be displayed as shown below.
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P - || 0 Max hitz 1000 -

s /m“ C tax Distance 0.4 -

Cl Hydiogens g N Matches number | any x
Br Ring membership ¥ ]

I \“\ Ring size » F Result

Chaige ¢ P [lesutz x| ¥ Auto numbering

; Isotn.p.a . > ; ™ Select in origin

y l:o; R A B' v Highlight substructure
\{}} Attachment point I Search |

¥ ﬂ | K Delete Any

Any aromatic

. o
__ Any aliphatic
Any not carbon

For example:
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Query:
M

3
Right click atom - Symbol -N

L

Selection of chemical substructure search results

1 2 E |4 |
_ S
N A 0 \
—/ U | P
A o:? o S l
I

|’}j’ij{'—k|\i W ) /f
S ey C:hr-

To specify a particular number of hydrogen atomsat a particular site:

» Right click on the atom and select the "Hydrogens' option as shown

below.
* Select how many hydrogens you wish to specify and a symbol will be
displayed as shown below.
p — - | | %EI b ax hits 1000 =
bl »
] ol ! tax Distance 0.4 5
Hydrogens i
Cl . . v tatches number | any -
Fing membership  » HO
Br U
I e Ring size ¥ H1 — Fesult
Charge » HZ m v Auto numbering
v
Isotope ' H3 [ Select in origin
7 Huybridization 4 Ha 7 Hichicht sub
v t truct
/// Connectivity . " ighlight substructure
<
¥

Attachment point - Search
1 ¥ Delete _LIJ

To specify the number of ringsa particular atom will be a member of:
* Right click on the atom and select the "Ring membership" option as

shown below.
* Select whether the atom should be part of 1, 2 or 3 rings.
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p 'l q Ma hits 1000 =
Symbol 4 .
= /'/ Max Distance 04 -
| Huydrogens 3
c . - Matches number | any A
Br Ring membership
I T Ring size k RO Result
Charge 4 F1— m Iv Avuta numbering
e
lsatape ' R2 [ Select in arigin
% Hybndization 3 =E] T TR T
ighlight substructure
/" Cannectivity 4 i
ﬁ Attachment paint Search
¥4 ¥ Delete
For example:
Query:
I:::
\‘\\
Right click atom - Ring Membership - R3
Selection of chemical substructure search results
1 |2 E L4 |
SRR
e —r .0
SR T e Do
= — fl N - i
Il o = = 0 =% P
2 | = 0 = T ST “JC< _J
2T [ Ol | N e T

e
- ~ S L i =& —

To specify the ring size connected to an atom:

* Right click on the atom and select the "Ring size" option as shown
below.

» Select the size of the ring the atom should be connected to and a
symbol will be displayed as shown below.
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p . [ q Ma hits 1000 =
mbo 4
9 / Ed bl an Distance 04 4
Hydrogens 4
cl : : Matches number | any hd
Ring membership  »
Br —
I Ring size Rezult
Charge ' 13 resulta | v Auto numbering
e
lsotope ' i4 [ Select in arigin
o Hybridization 4 5 W Highliaht sub
v Highlight substructure
& Connectivity 4 6 e
@ Attachment point 7 - Search
¥ |4 ¥ Delete It} r
3
o
M
n2
For example:
Query:
C.
Right click atom - Ring size - R7

Selection of chemical substructure search results

1 2 E |4
D
Cl o o0
0 W OH) > j R/Jh-.;,\} _\ //,f\r}_\\\\ ff r‘/}}H rS\N

bz/

M

To specify the charge at a particular point:

* Right click on the atom and select the "Charge" option as shown
below.

» Select the desired charge and a symbol will be displayed as shown
below.
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P

) ot
cl

Br

I NS
e

o

&
S

¥ A

Il
Symbal 3

Huydrogens 4

Ring membership  »

Ring zize 4

|zotope 3
Hubridization 4
Cannectivity 4

Attachment point

¥ Delete

bz bits [1000 =

tax Distance 04 ~
tatches number | any i
Rezult

resulkd | v Auto numbering

[ Select in origin
W Highlight substructure

Search

To specify an isotope at a particular atom

* Right click on the atom and select the "Isotope” option as shown

» Select the desired isotope from the list and a symbol as shown

bel ow.
below wil
P
S il
Cl
Br
I 2
e
&
&
G
¥ |4

| be displayed.

[
Symbol 3
Hydrogens 3
Ring membership  »
Fiing zize 4
Charge 3
Hybndization 4
Cannectivity 3

Attachment paint

¥ Delete

v O

EC
C

aC ~
ac t

bz hits 1000 4
bl an Distance 04 4
Matches number | any i
Fezult

rest1d | W Auto numbering

W Highlight substructure

Search

1ac
1C

1w —+——

14C

To specify the hybridization state of the atom:

* Right click on the atom and select the "Hybridization" option as
shown below.
» Select the desired hybrization state and a symbol will be
displayed as shown below.
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p - |l : Ma hits 1000 z
Sprmbal »
= // ye / tax Distance 0.4 -
I Hydrogens »
C : : Matches number | any -
B Ring membership  »
r
I \\ Ring size » Fiezult
Charge » resultlls o+ | W Auta rumbering
e
lsotope d [¥ Highlight substructure
o Hybridization
// Cannechivity 4 1=y Search
@ Attachment paint cpa
¥ |4 ¥ Delete

To specify the number of atoms you wish an atom to be connected to:

» Right click on the atom and select the "Connectivity" option as
shown below.

» Select the number of atoms you wish the atom to be connected to
and a symbol will be displayed as shown below.

I - -
P I ax hits 1000 =
Symbol 3 //::.«D
= // b ax Distance 0.4 -
cl Hydrogens 3
Ring membership  # Matches number | any b
Br o
I \\\ Firg zize 3 Fealt
Chaige g reslld | W Auto numbering
A |zatope 4 L
e [v Highlight substructure
2 Hybridization k
//ﬁ Cohnectivity v Off Search
@ Attachment paint o1
¥ (A W Delete Dz
03
D4
[l
DB

To specify an attachment point - ie the position at which substituents
will be added

» Right click on the atom and select the "Attachment point" option
as shown below.

» An asterisk representing the attachment point will be displayed
next to the atom.
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Attachment point —* ~

An attachment point means that the atom can be attached to zero or more
bonds to heavy atoms.

7.5.2 Filter Search

How tofilter your query
Tofilter your query:

» Right click in the box shown below and select ' Add Condition’

e B2

[ | FieldName Relation Value |

| 2]

Teuxt zearch |

Right-click here and select Add Condition

To add conditionsto your filter:

» Doubleclick in the fields labeled "Name" and "Relation" and
select the options from the drop down arrow or type in values.

[ |FieldName | Relation | Value )

rrolid

MOLSOFT_TABLE |
1 | final_num J L |
Text zearc |ntl_num

orig_numm

To remove afilter, right click on the filter and select ' Remove
Filter'.

To exclude a fragment from your search
Click on the option Exclude fragment list:
» Enter the SMART string of the fragment or use the Molecular Editor
option to sketch the fragment.
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* Click OK and the fragment will be listed at the bottom of the
chemical search window as shown below.

', ICM Chemical Search: [new file *] connected as andy@samba

File Edit View Templstes Help Data Souce

DR N el 2 LG &8s A G Table | Fie | Mokcat |

~ Cl11H14 @ | =]
7 >

' 4, To edit or remove right click D

4 — Query Opi

C 1 Exclude List )/ S

N — Seaich lype Substiucture =

cleedeet b "=u] 71k dictance 0.4 -|

0 Celeceect |1E|

F ber of matches m
P atch stereo [ lgnore salt

gl L elected urfy i
Br # of hits 10000 =
I Rlesults

B Ok Cancel | ot o 15 ekt i o
L L " Hide unmatched * Save results bo:
/ Table | Fie | Molcat |

o 2. Enter SMART

> string or click result =] ¥ Ovemie

- editor button and [ Highight match [~ FRiotate by match
+t sketch [~ Display sz gid [ Store query
—

¥ [~ Append

[ | FieldName | Retation | Value I [~ Hide afler Search Search |
1. Click here 3. Excluded fragments are
/ listed here

Euclude adment st cleccec]; Lol cecdEl
Teat search |

7.5.3 Query Processing

To begin processing your query first you need to decide which database
to search. The options are listed in the Data Sour ce section of the ICM
chemical search window.

Data Source

You can either searchaTabl e- Chem cal Spreadsheet aFile - Local
Dat abase or Mol Cart .

If you select MolCart you first need to setup the link to the correct
database.

¢ Enter the Server Name in which the database is stored.

¢ Enter the database name.

 Enter your username and password for the server.

¢ You can save these details so you dont have to re-enter this
information each time you use the chemical similarity search.

If you are searching a Table, click on the Table tab and then select the

drop down button where the names of your currently loaded tables are
stored.
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If you are searching a File click on the File tab and then locate your
| ocal table database file.moltor if it isaready loaded into ICM you
can locate it with the drop down button.

Query Options
Now select a sear ch type:

 Click on the drop down arrow next to the "Search Type" optionin
the Query Options panel.
» Select the search type you want to use.

A substructure search is a search whereby only the defined moleculein
the query will be searched against the database. Whereas, a FP
similarity search which stands for fingerprint search enables any
fingerprint within a structure to be searched for in the database. The
similarity method cal culates tanimoto distance using chemical
fingerprints (1. -most distant, O. - closest). The similarity = 1. -

distance.

The Max distance option is available for use with the FP search and the
Matches number option isfor use with the substructure search. The
option you do not require based on your search method will be blanked
out. A "Max distance" value of 0 means that the search will only

identify matches exactly the same as the fingerprint - the default is

0.4. The "Matches number" option allows you to stipulate how many times
within a structure in the database your query can be found.

Additional optionsinclude:

» Match stereo option. With this option chirality will be taken into
account in substructure and similarity searches.

e Ignore salts.

» Keep ring membership.

» Search tautomers. If this option is selected ICM will use
different tautomeric forms of the query chemical during the
search.

If you make a selection of your query ICM can use that selection to

search. How to make selectionsin the Molecular Editor are described
here. Enter the Maximum number(#) of hits you would like returned.

Results

Before processing the query determine how you would like your results
displayed in the Results section of the Chemical Sear ch window.

Count hits only - this option will count the number of hits and display
this number in awindow once the searching has been completed.

Select in source - If you are searching atable you can select and
highlight the query in the source table that you are searching.

Hide unmatched - Hide unmatched will hide the compounds that were not
matched from view.

Saveresultsto: - this option gives you the option to save the output
resultstoaTabl e- Chemi cal Spreadsheet aFile -Local Databaseor
Mol Cart .

Append - this option will allow you to append to current table, file or
Molcart database.

Search

» Click on the Sear ch button to execute the search. Y ou can choose
to hide the window after the search.

Data Source
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7.5.4 Search a Database by Text

To search adatabase by text enter the text you wish to search in the
Text Sear ch data entry box at the bottom of the ICM Chemical Search

window.

- ICM Chemical Search: [new file *] Molcart not connected

@I

File Edit View Template: Help Data Souce
DEE O hem 2 LG @rs | K| G Table | Fie | Mokcat
C11H14
e 2| | =
7 >
&
f/. D
c 7 Guery Options
N E.:] Search type Subsbiuchune -
O O Max distance 04 -
F Humber of matches any -
P [T Malch stereo [ lgnose sak
S [~ Selected only
cl [CR1]
Br o - Masdmum B of s [10000 z
o Single
I Double Resuks
: Trile  Comilizoly  ( Sslactinsouce
Aromatic ™ Hide unmatched + Save resulls to:
iy Table | File | Molcar |
]
z el ' Tesult w| [ Ovenunte
L Atirbates  » :
= ¥ Highlight match [ Rotate by match
o ¥ Delete . )
[~ Display as grid v Skore query
—
¥ [~ Append
{ | FieldName Relation | Value D )
[~ Hide after Search Search I
< | 2]
Ir list
Testsearch [
\\‘\
Enter text here

7.5.5 Pharmacophore Drawing and Searching

Pharmacophores can be drawn in 2D in the ICM Molecular Editor or in 3D
in the Graphical Display. 2D pharmacophore sketches can be used to
search chemical tables (spreadsheets) containing 2D or 3D coordinates. A
3D pharmacophore can be used to search chemical tables containing 3D

coordinates only.
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7.5.5.1 Pharmacophore Draw 2D

A 2D pharmacophore can be drawn using thel CM Mol ecul ar Edi t or or if you
are going to use the drawing to search it is more efficient if you draw
itinthe Chemi cal Sear ch window.

Use the distance bond button and the add pharmacophore group button to
sketch the pharmacophore. The distance bond button represents the number
of bonds between each pharmacophore point. Y ou can edit the distance by
right clicking on the bond and selecting edit. Other groups such as
aromatic can be added using the standard molecular editor buttons.

Distance bond —e~
C
™
O [IC:1HO]
i 12
P
5
Cl
Br
I 12
B RE
H [Qa]
G
Add pharmaﬁophﬂ're — Hydrogen bond acceptor
group v Hydrogen bond donor

NOTE: Do not mix the 2D and 3D pharmacophore environment. For example
do not edit a 3D pharmacophore in the 2D editor.

7.5.5 Pharmacophore Drawing and Searching
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7.5.5.2 Pharmacophore Draw 3D

The easiest way to begin drawing a 3D pharmacophoreisto draw a
chemical inthel CM Mol ecul ar Edi t or which contains the key
pharmacophore groups you want and then convert to 3D and extract the

pharmacophore groups.
To draw a 3D pharmacophore this:

e Oncetheligand is converted to 3D, right click on theligand in

the ICM Workspace.
» Select the Tools/Copy as Pharmacophore and choose the pharm

centers option.

» The pharmacophore groups or centers will then be displayed in the
graphical display and can be displayed and undisplayed in the ICM
workspace.

To move a pharmacophor e group:

» Usethedrag atom button (picture of a hand. See below)
 Click on the pharmacophore group and then drag.

Y AT REEEIEE

«— Click and drag using
this button

&

NOTE: Distances between groups can be monitored using the atom
distance measurement tool. See Cal cul ati ng the di stance between two

at omrs.
To change a phar macophor e group:

* Right click on the pharmacophore group in the ICM Workspace or in
the Graphical Display.

e Select Pharmacophor e/Edit Point

» Choose the group from the drop-down list shown below.

» Enter the desired radius.
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hd Edlit Phaimacophore Point -

Type
Hadius
aromatic
]: hydrophohic
positive

L- negative J

To make a new pharmacophore group:

The easiest way to make a new pharmacophore group isto clone a
pre-exisiting one. To do this:

* Right click on the pharmacophore group in the ICM Workspace or in
the Graphical Display.

» Select Pharmacophor e/Clone Point

» You can then move the new group as described above.

To change thedirection of a phar macophore group:

» Right click on the pharmacophore group in the ICM Workspace or in
the Graphical Display.

» Select Pharmacophore/Assign Direction

* You can then move the new group using the drag atom button
described above.

Toremovethedirection of a pharmacophore group:
* Right click on the pharmacophore group in the ICM Workspace or in

the Graphical Display.
» Select Pharmacophor e/Remove Direction

7.5.5 Pharmacophore Drawing and Searching
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Pharmacophore right click options

a_pharma.p3/9/0h15

Filter Selection

Edit 3
Advanced i
Label 3

Center

Connect to Molecule

Dizconnect

Ewutract Ligand|z)...

¥ Delete Atoms]
Annotate Selection...
“a. Meighbars...
¥ Select 3
Pharmacophore Edit Paint
Clone Point

Azzign Direction

7.5.5.3 Pharmacophore Search

To perform a pharmacophor e sear ch using a 2D pharmacophor e

» Dr awthe 2D pharmacophore as described earlier in the Chemical

Search window.

» Read in amolecular table to search or search atablein MOLCART.
» Select the chemical search options as shown below.
» Once the search has completed a new table with the results will be

displayed.
2
[IC::HO] [>
| []

Draw pharmacophore 1%
<
O
12
1z -
L]

Guery Options

Database l—_|

Table LD Tle—Select the table you
Search Type [Substuctwre = | Wish to search here
Maximal # of Hitz 1000 =

Max Distance ’h

Murnber of Matches ’m

[ Match steren [ lgnore Salt

[~ EwSelection [ #0f Hitz Qnly

To perform a pharmacophor e sear ch using a 3D phar macophor e:

* Right click on the pharmacophore in the ICM Workspace

» Select Sear ch Pharmacophore
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¢ Usethe drop-down button to select the table you wish to search.
The table must contain 3D coordinates.

Right click here

E|= pha;ﬂa Clear Default Display...
- pa Edit Description. ..
Bes 1 .
- p—ll,- 1 [ 3
- pg 1 Search Pharmacophore...
‘]@ tables (1t Advanced 3
-t 30 9894
=-script - (1 item Center
et LN Connect to Object

B i v Vi Dty oipuleoms ek

f!_]‘::ﬂli e Tee R Fim wBwFRAQ%: TTFEE2L

6 Search Pharmacophore

[2][%]

table To Search In I 3D

o |

o

Cancel |

Enter name of table containing 3D coordinates

How to send a 3D pharmacophore
search query.

L r—

2] | I @) & cal oneld | TH T3 P | mrEem @) | et |

1. Right click on the
pharmacophore pointsin

]
(-]
+
2 P
P =
L the ICM Workspace and :;
i select “Search 5
- Pharmacophore” m
o )
[ +
e x
:'.' a8
HH g s
I:_-;: . ' ;
L | r
B G
A Lo ey
»
||
SRR e
Fla 2 = ]
- L] W L] pE
mh—.p_ n ) - _J
=
o 2.Search a table with !
~r : : chemicals that have o
& ", .
2 O 3D coordinates
(a
n -
L =0 DL ]

7.5.5.4 How to extract a 3D pharmacophore from a ligand.
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How to extract a 30 pharmacophore
froma 3D figand.

{B: Fim wElEB B R
2l P 158 brieemee Rne e Bl R | ]| 8|

e 1. File/Open
T "1 3Dligand or +
1o read in PDB «©
e -
B o B
f - 2. Right click on ""»h ; el : a
f 3D ligand and - T T :
|5 select s S
£ Tools/Copy as /...:.“ a
& muﬂ_pharmamphcre ¥ il .1, ; H
‘m“nﬂ_ﬁ . ."s.._...f‘ :
5 ‘K""h %
3. Display and undisplay N -
pharmacophore types \
&
L™

R =L T

7.5.5.5 How to color a 2D chemical sketch by
pharmacophore feature.

How color a 2D chemical sketch by
pharmacophore feature.

o)| AR @l idedd | TTH o | e @) |

e
u'l': : ;
8 . z
B - &
[ o vanente | =

i 2. Select Color

i Structure By/

o ) By
i : Pharmacophore

Features
L=
L
=
[EE——., -+
e 1. Right click :
o on column
header
el 1D
b | ,l'.1h b
D=k b =T
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7.6 2D Ligand Interaction Diagram

(]; 2 54_‘:';1

CTD)

.,
@)
ar

(1278 )

To create a 2D interaction diagram between aligand and receptor:

Read into ICM aPDB file containing the ligand and receptor. For
correct hydrogen bond assignment you will needto convert toan
ICM object.

Right click on the ligand and choose Tools/Ligand 2D Diagram.

A dialog box will be displayed. Select the receptor object from

the drop down button and allow ICM to Auto Detect the ligand if
needed.

The Hydrophobic Distance Cutoff is <= to the minimum distance
between ligand and the closest atom in the residue. The Hydrogen
Bond Strength is based on the GRAPHICS.hbondMinStrength parameter
so lowering the value will identify weaker hydrogen bonds.

An option is available to match the 2D representation to a
pre-calculated one saved in achemical table loaded into ICM.

A guide to the coloring and representation of the 2D display:

Green shading represents hydrophobic region.

Blue shading represents hydrogen bond acceptor.

White dashed arrows represents hydrogen bonds.

Grey parabolas represents accessible surface for large areas.
Broken thick line around ligand shape indicates accessible

surface.

Size of residue ellipse represents the strength of the contact.

2D distance between residue label and ligand represents proximity.
Covalently bound residue represented with thick black line around
elipse. (C25 in the picture above)

To edit the 2D image (e.g. rotate a group):

Right click on the image and choose Edit Molecule and edit using
the Mol ecul ar Editor.

To save the 2D interaction diagram to an imagefile:

Right click on the image and choose Save Export/Molecular Image

7.6 2D Ligand Interaction Diagram
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7.7 Generating Chemical Fragments

Availablein the following product(s): | CM Chemi st || CM Cheni st-Pro
[l CM VLS

Chemicalsdisplayedinan | CM Mol ecul ar Tabl e can be split into
fragments. Thisis useful for generating a series of R-groupsto be
added to ascaffold (Seesecti on descri bi ng reactions.

To generate fragments:

* Sel ect the column or row(s) you wish to generate the fragment
from.

* Right click on the "mol" column header and select " Split Into
Fragments".

* A new table of chemical fragmentswill be displayed. Each fragment
is assigned an attachment point which is flagged with an asterisk

(*)-
Right click here Split Inka Fragments
1 Fird and Replace...

“TerCoandizh %, B 5et 30 Browse Mode

Cherical Yiew Options...
= T

mo

chiral
]
o O.p.
& or
] 0w o
M
noT s
W

MNew table is generated containing fragments

[ ncinligand:2D " F_RT

mol chit | n_ap0|

1 1
NR\ §
TS
e

1| M ey

Attachment Point

chiral 1 2

=

- —

7.8 Find Bioisostere

| Bi 0i sostere Webi nar |
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In drug design bioisoster es can be used to reduce toxicity, change
bioavallability, alter metabolism and change activity of lead compound.
Bioisosteres are chemical substituents with similar chemical or physical
properties which produce broadly similar biological propertiesto
another chemical compound.

7.8.1 2D Bioisostere

To find 2D Bioisosteres:

P SRR RAARCAS e 5 Bpact 1 S [ Find Bioisosteres for a Group.

File Tocls Edié View Bisiwdo HMomolegy Chemistry Docking Moldechanics Windipws Help

DEBO B OC RGO AW X Yl ~Eaili @00 EETES

BRI bkt %

|78 sanen =] ‘U:]ﬂ-_'“ A Ficts :.]FWQJ
Warkepacn Parad &% m
no selecton = Maocuie Hama ha
- tablesme [ 14HIIMION5T &
#
' 7 =
[EETLS |I \ g
7; HE
. | k=
; 5 :
1. Right click Chemistry/Find
gy, Bivisosteres for a Group.
&
% [E]
glel B = olme]sl

Step 1: Read in achemical into achemical table. Right click
Chemistry/Find Bioisosteres for a Group.

7.8 Find Bioisostere
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Download bioisostere group database groupsubst.molt and save it into your ICM directory.
0o Bo e | Fine Buoisostirs for selected Ragment kH # 'i o
e =]
Imsﬂm - H /:f g
——
erlapcs $aned ax f i
na selection _/_ \ ) E
= tables (9 e B4 Byt M e
= vy Table YO é
a
B8
O (4] o
3
=
ol
- R #
win
-
9 =
™ Matrh Seadfinid Athachemant [5
& Gerawate Pl Molendes | Ol Bgrougs 7
R Fd
Eﬂqu«wwmwm, - 1. Click here to o
s oy 10 IHHE derwciry, - save database. -3
! L
p
. T Lo | o= |
o B =] Ol o
Step 2: Download Database If you do not seethislink it means you
already have the database in your ICM directory. If yo do not haveit -
download bioisostere group database groupsubst.molt and save it into
your ICM directory. Thereisalink at the bottom of the dialog window
which will direct you to the correct place to download.
© { Run the search.
D & m G b a {#) Find Bicisosbers for selected fragment 7 ko ]:I'_ i ﬁ
Foowrch \ Tgwat ‘
08 Lewrch =] 4}) &
o —— #x ‘ z
ro selection_ ?\‘_/— \, i Ay
[l labdes (7 e e =
- myTable \\r/’o §
o
"
] Q o
3
1k
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...... " G
- 1. Left click and %
s drag over group :
o to select it. -
I Match Scaffeld Attchament ! 5
2. select Full or
1 Generats Full Mzleades T Only B-groups y
R-group Only L
it zi
Sasheet group far regllacemant sing oot rechangilie sdectinn, e
Mghe e you dowrinaded oaotter group detsbee @opstetmolt fom here s
e Capy A B IR L e
| 3, Click OK }-—-T il O

=

ot |

(BT

olel 5 e 0)ae

Step 3: Setup the Search
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Select the tab for 2D Database at the top of the dialog window.
Left click and drag over the group you wish to find a bioisostere

for.

Select if you want to "Match Scaffold Attachment". It matches the

attachment atom from the R-group which you' re trying to
substitute with the the database. In this exampl e the attachment
is C"3 (SP3 Hybridized), so if you select this option it will
only return hits where scaffold attachment column contains C"3.

Results table,

e Select if you want to generate Full Scaffold or just show the
R-group.
* Click OK to run the search.
3¢ Dipisostere guamipleich Mpisodt Chemestivo 31.8-6 [HOsomdiman' biciscstere exampleich *) (2 talbles
File Tocks Edt Veew Chemistry findows Help
DaBo 6 O0CR O
VE myratin ) B mtobie_|_soates |
e Hl biosterlist | Soowre BAH
s . Y ™
i L)
el
1 W & "‘ I‘ -
y /_/_( P T —0OH o L
r‘ S ¥ T
) Sol Spec HED HEA Vol
" 1416 i s e
), < g A J:"’ ‘{2:\,”
: A > A H Tetrazole top hit J
Pa's J/“—-N . O
Sel Spec HBD HBA  Va

,_.f_<|( _{_: H'O“"'“\// - H

HEA

2 el

REEOE

Step 4: Results Table In this example we find tetrazole which isa
classic isostere of carboxylic acid. The data in the columns represent:

Mol isthe query chemical with the bioisostere attached.
R1 isthe bioisostere.

bioster Dist Bioisoster distance’ is calculated on the basis of

five terms, two are knowledge-based and three are

physicochemical. They are aso reflected by the corresponding

bars in the column Score BAR.

Score BAR: For the bar display the terms are transformed into 0-1

range so that 1 corresponds to best match/identity.

Sel - selectivity, as estimated from frequency of replacement of

query R- group by aretrieved substituent relative to total

number of cases where this substituent replaces any -R group in

the database
Spec - specificity, as estimated by the differencein activ

ity

between a database compound with a retrieved substituent and
least active example of adifferent substituent (on the same

scaffold and target) in the database

HBD - factor reflecting difference in the number of HB donor
functionalities of the retrieved substituent and query -R group

HBA - factor reflecting difference in the number of HB acceptor

functionalities of the retrieved substituent and query -R group

Vol - factor reflecting difference in volume of the retrieved

substituent and query -R group

7.8.1 2D Bioisostere
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» scfldAttach indicates the atom(s) and it’ s hybridization in the
original group attachment. It can be used to filter solutionsin

the query.

If you double click on arow in the table it will show specific examples
of aparticular substitution from ChEMBL.

7.8.2 3D Bioisostere

The receptor/ligand complex structures from the PDB contains rel evant
(bioactive) 3D conformation and the environment of the isosteric

moieties. This can be used to find 3D bioisosteres. Y ou can watch a

Bi oi sost ere Webi nar which explains how the 3D database was constructed.

To find 3D Bioisosteres:

e ey Takde Moisolt lom 386 [NewProject *[ {1 fadde]

Fie Tocds [d# Yiew Bioiedo Homology Chemistry

LeBo B o0 Rad

Werlapcn Pared LENEDE Y
rid SEdChon -
- i tabdes I rrs
= myTable &
]
" [ H

Docking Molldechanics Yindows Help

E l et
N

i
0

( Find 3D Bioisosteres for a Group.

Mplacuss

Harma

ek

P

1. Right click Chemistry/Find
Bioisosteres for a Group.

|

iQJ;-J L __IEJ._ 53| e | tabde 1 s, 2 cotum

Step 1 Read in achemical into achemical table. Right click
Chemistry/Find Bioisosteres for a Group.
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i
& Find Bioisosters for sebected fragment 7 H4
Eﬂﬂ‘ EQ{WQ g { 1. Choose 3D Database. ] e
| @2 gl| m[[®
D e ox g
/ o
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> =
C :
= o =
’ = 2. Left click and x
I drag over group | / ¥
to sefect ) -
e
- = I
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L
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&
O
3. Click 0K o I Cancl
o) @) B ] O e ki T Tran A Bh
Step 2: Left click and drag over the group you wish to find a3D
bioisostere for and then click OK.
® ' = [Sart by Npoc (number of pockets) ]
DeBo 00 RGQE
VY ki 4 omoster D
Mpars W Hgoo Rl Frag gl w2 ﬂﬂ
14 4309 400732360 B03n22,023,004 Sy I1IE03C0E g
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from PDB -
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‘ e
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4] a i .'_Jﬂ

QJ !J 5_;[ ]| 8 l 0|‘|@|ﬂ| tatdes 50 et 13 cotuming {7 peitcked colurrn, B0 non-emply el

Step 3: The results table will be displayed the nPocs (number of
pockets) column is a good indicator of a good bioisostere. Asthisis
the number of times this replacement is seen in the PDB.
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Step 4: Click on any of the hitsto view specific pair examplesin 3D.

7.9 Molcart

Availablein the following product(s): Mol Car t

Molcart is an enterprise wide chemical management system. Compound
databases of any size can be stored in MolCart and analyzed and searched
using ICM cheminformatic tools.

7.9.1 Molcart Installation

In order to run MolCart it is necesary to install the Free Open Source
MySQL database on your machine. Please see your systems administrator or
seehttp://dev. nysql . conl downl oads/

Linux Installation

Mysqgl: Check if mysql daemonisrunning :

/etc/init.d/ mysql status

If you see that the MY SQL serviceisunused (not r unni ng) , you need to
start themmysqgl deamon. Becomer oot and do the following:

/etc/init.d/ mysql start
Download and install Molcart files.
The Mol Cart package is a self-extracting executable file.

Installation Instructions:
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» Download the Mol Cart file ( molcart-version-platform.sh ) from the
Mol soft website.
* Typeinashel window: . / mol cart - versi on-pl atf orm sh
- p=THE_PATH_YOU_WANT_TO_DOWNLOAD (NOTE: You must be logged in as
"root’ to install the ' molcart-version-platform.sh’ to
' Jusr/mol cart-version-platform’
» Thefollowing question will be displayed: Do you want to install
the molcart-1.6-6 to "/usr/molcart-1.6-6" now? (y/n) [y]
Answer Y ES and the unpacking process will begin
Y ou will now be prompted for a password.
Select which default databases you wish to install.
Make a note of the HOSTNAME, DATABASE NAME and USER NAME
MolCart is now fully installed.

Mac Installation
System requirements. * Mac OS 10.3 * MySQL server for Mac OS 10.3
Toinstall Molcart on the Mac just run this:

sudo /some/path/mol cart-1.6-6-darwin.sh
7.9.2 Molcart Getting Started

To start Molcart:
Tools/Connect Molcart

Once you have activated Mol Cart the loaded databases and users will be
shown in the ICM Workspace as shown below.

no selection ‘
_@H MolCaryl 66 (3 items)

LEHtest (0 items)

S demodb (0 items)

S users (2 items)
-raot@maon.malsoft com

All the records and fields contained within each database can be viewed
by expanding the tree structure in the ICM Workspace.

7.9.3 Creating Databases and Importing Data
To make a new database:

» Right click on the top of the Mol Cart tree and then choose New
Database

7.9.1 Molcart Installation

281



& Mew Mabsedt iom 3.8-5 [MewProject *]
file Took fdR View Bioinfo Homology Chemistry Docking MoiMechanics Windows He
IhBos A Rae AR Ll 0 wsR«BD

{ search \f dgedt

lmhd! :”:e-!crwes Qjﬂ“l"m li'—m
Workspace Pansl 8 x

no selection { -

+ 6 Molcart V2.7 5 on mars malsoh com e 1. Right click here

2. Select New
Database

Toupload SDF, csv, SMILESor MOL filesor an ICM table:

¢ Right click on the database where you wish to add thefile.
¢ Select Import.

) Mew Motsol iorm 385 [MewProject *}
file Tooks [dit View Bisinde Homology Chemistry Docking MolMechanics Windows H
IDFBG N RQO | BB P FAHE | mBaBD

soarch |/ dgedit

[Po8 Search "] [ et o s | _l_lJn MFeids |l Appenc
\Warkspace Parel a8 x

o selection 2

+ 48 « GlobaiCompoundsViews (7 tables)
w8 - Winston (53 tables)
- - andy (0 tables)

208 - chembl_14 (28 tabies)
448 - chembl 15 (43 tables)
8 ~ chembl 18 (0 tables)

<G - chemk ™ hic) e 1. Right click here
B« act 2

v act Seleer

biotherapeatics  rw -1
cell dictionary rw -1

3 [ B e O B B B WD
L} & L] L] L 4 & L} 4

7.9.4 Molcart Search

How to sear ch the databases contained within MolCart

Click on the button shown below.
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a0

MolCart and Chemical Search
Tools

To begin processing your query first you need to decide which database
to search. The options are listed in the "Data Source” section of the
ICM chemical search window.
Data Source
Table i File — Molcart ]
Database Itest LI ﬁJ

Table  |chembl |

You can either search alocal table (molecular table) or you can search
Mol Cart.

If you select MolCart you first need to setup the link to the correct
database - described earlier. Click on the button shown above (yellow
pencil) and the Connect to Mol cart window will be displayed as shown
below.

5 Connectto Database ? it

Server Mame |m.ars.rr;c=|s-:|1°t,cc:m

Database |bast

User | molcart]

Passyord | ””””

[~ Reconmectatstartup  Port | 53306

QK i Cancel

Enter the Server Name in which the database is stored.

Enter the database name.

Enter your username and password for the server.

Y ou can save these details so you dont have to re-enter this
information each time you use the chemical similarity search.

Seethe Chemi cal Sear ch section of this manual on the many different
search procedures.

How to perform atext search

To perform atext search on one of the databases contained within
Molcart you first need to index the text within the database and then
search using the query option.

To make the database index, see text and picture below:

» Expand the tree of the database in the ICM Workspace.

» Select the column headers you wish to search which contain Full
Text or Partial Text(the data type for each column islisted next
to the column name). Multiple column headers can be selected by
clicking and holding down the CTRL key. A range of column headers
can be selected by holding down the shift key and clicking to
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select.

e Next, right click and select Create Index.

» Select 'Full Text’ and you will notice an additional header in the
ICM Workspace called 'indices . The value in the items category
represents the number of columns you have chosen to text search.

'Oh MolCartwl 66 (2 iterms)
.4 guesthome

----- in_hibitors

(1 items)
v 23
(FRInt113)
mediumblob)

(MUL mediumte:xd)

ndices

oS cherm

(4 illSIIIClJI
{13 items)

To perform the text search:

» Right click on the database name in the ICM Workspace.
» Select 'Query’ as shown below.

;i_-..@h MolCartw1 66 (2 iterns)

Zdd guesthome (1 items)
=-inhibitors w23 Seiick
malid (PRIt
ol (mediumble S A
E""MOLSOFF—TABLE _f% Add Colurnn..  mediumtesd]
final_nurn  (MUL _
nt_num  (MULve Rebuild Keys...
otig_num [wvarch ¥ Delete
m-indices (4 items)
w58 chem (13 itermns) Open Records
Cloge Records

The ICM Chemica Search query window will be displayed as shown below.

Type your query text in the space provided and hit the enter key or
click on the search button.
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i |ICM Chemical Search: connected as guest@www

File Edit “iew Help iE SR
[ 4 B 1|
m CEEHAOC R2al % ¢ Local Tables §i & MolCart
&
@ — Huem Optiong
N
0 [} Database guesthame - ]
F (]| Tabe inkibitors -
P '(:}‘- Search Type Substructure 'i
5 CJ Maximal # of Hit: 1000 =
£t b & Drist 04
ax Distance : -
Br Oi
I ) Murmber of Matches | any v]
H [~ Match sterea [ # Of Hitz Only
[~ Search by Selected Fragment
i —FResult
o resultd vi v Auto Mumnbering
-
Add to DB -
(| Fiskame Relation Value ] | ndde grashon:
v Highlight Substructure
I~ Dizplay az Grid
Search
Text zearch || |
2 |
Type text search query here Filter your search here

How to add conditionsto your query

* Right click in the box shown below and select ' Add Condition’. You
can add as many conditions as you like.

e B2

[ | FieldName | Relation | Value |

| |+

Tewxt zearch |

Right-click here and select Add Condition

» Doubleclick inthefields|abeled "Name" and "Relation” and
select the options from the drop down arrow or typein values.
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[ |FieldName | Relation Value )

1| | ol = s

oid

MOLSOFT_TABLE |
1 | final_num J ’I
Text zearc |ntl_num

orig_numm

To remove a condition, right click on the filter and select ' Remove
Filter'.

7.9.5 Molcart Administration

Edit Password

* Right click on the MolCart header in the ICM Workspace and select
Change Password.

Add aNew MolCart User - Root Only

* Right click on the User Section of MolCart in the ICM Workspace as
shown below.

;-;;..@h MolCartw166  (4items)

~Elltest (0 items)
S demadh (Ditems)
-l fsdfd (0 items)

w-fFusers (2 itemns) T
elec

Invert selection

e Select the New User Option.
* Add new username and password in the data entry box.
* New user will be displayed in the ICM Workspace.

Edit User Privileges - Root Only

* Right click on the user in the ICM Workspace.
» Select Edit Privileges and a data entry box as shown below will be

displayed.

€ Molcart: Edit User Privileges 'root@... @E|

DE Marne v
v read v maodify recards v create tables

v delete tables [+ add/delete columns

Apply | Cloze I

» Select the database name.
* Edit the privileges by checking or unchecking the appropriate
boxes.

Add a New Database

* Right click on the MolCart Header in the ICM Workspace as shown
below.
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no selection ;J

42, MolCatwvles 0

'.T.'"Ch sy Select
EEB test (0 |tem5.: Irwert selection
S demadb (0§

@ fscfd (O item v Show Al Databazes
;@ users (2 iterr Mew Database...
F-rootE@moon.
L-admin

Change Pazsword...

Open Records

Cloze Records

Select the New Database option.

Below).
Add New Datato Database

» Right click on the database name in the ICM Workspace as shown

below.

Enter a unique name for your new database.
The new database name will appear in the ICM Workspace.
Now you need to add data to your new database (See I nstructions

Mew Table..  »

X Delete

no selection _._J
5;..@“ MolCartw1 BE (3 items)
@ test (0 items)
-G demadb (T

H . Select
;}_}--QE users (2 ite
Inwert zelection

Import from S0 File...

|mport from ICH Table...

* Select New Table.

» Select either Import from SD file or Import from ICM table.
» Select the appropriate file and the records structure of your sdf

or ICM table will be displayed as shown below.

7.9.5 Molcart Administration
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9 MolCart Import

Table name |melanin

¥ AE |Sting | |2763
¥ APP [Sting =] [0
¥ CAS |Sting =] |16
¥ o |Sting =] |145
¥ COMB_PREP |Sting  =| |1638
¥ COMMENT |Sing | [0
A [Sting x| |472
WV INN |Sting = [0
V1L |Sting =] |750
WA |Sting | |1082
¥ MF |Sting | |38
¥ MOLMAME |Sting  «| |24
¥ MOLSOFT_TABLE HEADER |Sting | [192
W MOL_WEIGHT |Rea  =| |2

» The database name can be changed at this point and the fields
contained within the database can be altered. Certain fields can
be excluded by checking the boxes - thiswill help in minimizing
the size of adatabase. Caution must be taken if you want to
change the field type or length.

» Click OK and your sdf file or ICM table will be added to the
database. This can be seen by expanding the tree structure in the
ICM Workspace.

Delete a Database or User

» Right click on either the database or user in the ICM Workspace.
» Select Delete.

7.10 Calculate Properties

Availablein the following product(s): | CM Cheni st || CM Chemni st - Pro
|l CM VLS

| Vi deo |
To calculate chemical propertiesfor compoundswithin a chemical table:

* Read in the chemical table.

e Select Chemistry/Calculate Properties and awindow as shown below
will be displayed.

» Arguments - usualy the column with the chemical structureis
called mal. If thisis not the case click on the drop down button
and select the correct column.

* New column location - select where you would like to insert the
new columns.

» New column name - This option isusually greyed out but the column
name will be the same as the property name.

» Select the properties you wish to calculate using the 'tick’ check
boxes.

» Click OK and the properties will be added as new columnsin the
chemical table.
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6 Calculate Chemical Properties

Furecticn c
£, Actions =
Funchion = IHdi'ple Funclions = —I
Function [Mome  [Categow [ Desciiption [«]
Frm— B Matwieighilmel Mobeght Chemcal  Mokcular weight
O solFormdalmol] MoFoimula  Chemical Chernical fomruda,e g C2HBO
Main aigument: | mol - O MelLogPimel) Molog?  Chemical Octancl water parttion, Log..,
B4 MolLogs mal) Mologs  Chemical ‘water solubity -Log(C_aggi
FrEmE——— O MolPSAfmal] MoPSa  Chemcsl  Polar nsface sres
O Mob/olimol) Mahicl Chemical Micecudas wolume
lnsest & siter (" before  iplace D aldHi[mel) _— e aldHE Chemical HBNIUMMHM elem.,
g (Duglikeness{mol] Dipuglikcen., Empincal dugkensss
S | rode=rcemal] Senles Chesmical SHILES/SMARTS: siring na...
colnn | mal ﬂ O BadGioupsimol] BadGroups  Chemical Urwearded of ieactive chemi .
O Mof_Atomzfmel atom=""") Mof_ftoms  Chemical Mumbes of aborms
Mt columin name O boé_Molecules(mol] hot_Muolec... Chemical Mumbes of indbvidual molecd .
[name O Mef_Chicals{mollype=-1) Mof_Chitsls  Cherical Mumbes of chial centers, F,..
Hed_Rings{mall Mot _Rings  Chemical Mumber of rngs in the $55F = |
Add To List ok | caca |
|
Select properties here
Actions Button Helps with Selections
If you click on the drop down button labeled Actions you will see 3
selection options:
* Select All properties.
* Uncheck selected options.
» Remove unchecked.
7.10.1 Number of Atoms
Y ou can calculate the Number of Atoms using:
e Chemistry/Calculate Properties
» Choose the Function Chemical from the drop down list and then
Nof Atoms.
» Addthe SMARTS string for the atoms you are trying to count (e.g.
sp3: [*;73] halogen : X or [F,CI,Br,l])
Nof SP3 example:
i1
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7.10.2 ToxScore

7.10.1 Number of Atoms
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Availablein the following product(s): | CM Chemi st || CM Chemi st - Pro
|l CM VLS

The ToxScor e gives a prediction for how reactive or toxic achemical is.

How the ToxScore is Calculated

Around 1000 SMARTS strings associated with toxicity/reactivity were
collected from various sources. They were assigned demerit score based

on their perceived toxicity and frequency of appearance in approved

drugs. The toxscore of any compound was calculated by summing up all the
matching SMARTS strings. A toxscore >= 1. indicates likely toxicity

based on substructure match.

How to Calculate ToxScore

* Read into ICM an SDF file. A chemical spr eadsheet will be
displayed in the GUI.

* insert acolumninto the chemical spreadsheet. Right click ona
column header > choose insert column > choose the chemical
function > select Tox Score.

* A column containing a Tox Score and Tox Names will be displayed.

7.11 Standardize Table

Availablein the following product(s): | CM Cheni st || CM Chemi st - Pro
|1 CM VLS

NOTE: Before standardizing a chemical you may want to make a copy of
the original so you do not lose any information. Y ou can do this by

right clicking on the name tab of the table and selecting clone or

save as.

Toremove salts, explicit hydrogens and standar dize groupsin a chemical
table:

* Chemistry/Standardize

e Select the table from the drop-down list. Thiswill also work for
selections made on the table.

» Select option - Remove Salts, Keep Salt Info in Extra Column
(NOTE: option availabe in 3.7-2b and higher), Remove Explicit
Hydrogens or Standardize Groups

* Click OK.

Batch mode

€ Standardize

Local Tables

Molecular Table resulk w
Opkions
Remove Salts [ keep salt Info In Extra Column
Remaove Explicit Hydrogens Standardize Groups

Ok H Cancel ” Help
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Standardize chemical groups will apply rules from
ICMHOME/CHEMNORMRULES.tab For example some chemical groups may have
different representations e.g. [N+] (=O)O versus N(=0)=0

Torun in batch mode:

* Chemistry/Standardize

» Select the Filestab

 Enter the path and name of the sdf file you wish to standardize or
use the browse button.

 Enter the path and name of the output file or use the browse
button.

Toremovea salt from an individual row in a chemical table:

» Selectther ow or rows.
* Right click - Chemistry/Remove Salt (Selected Row)

7.12 Annotate By Substructure

Availablein the following product(s): | CM Chemi st || CM Cheni st - Pro
[l CM VLS

Thisfeature allows you to annotateachemi cal spreadsheet according to
functional group. It also allows you to flag substructures which may
have poor ADME properties.

Qnmmtam?

f Exisking Fragmernts -\,f Draw Fragments
Molecular Table resulk «— Choose table

Choose annotation option
{5 Funckional Groups £ Substruckure Alerts ) Custom Fragments P

Hink

Default bable with functional group will be used for annotation: C:fProgram Files/Molsoft LLCSICM-Pro_21) FUNCGROUPS, sdf

Cik, ] [ Cancel

First read in a chemical spreadsheet or sdf file you wish to annotate.
Todothis:

» Information on how to read into ICM chemical spreadsheets and
structure can be found her e.

To annotate functional groups:

» Chemistry/Annotate by Substructure.

» Enter the name of the Molecular Table (Chemical Spreadsheet) or
use the drop down button to locate it.

» Check the Functional Groups option.

» The functional groups will belisted in a new column in your
chemical spreadsheet called funcgroup. The default table with
functional group will be used for annotation called FUNCGROUPS.sdf
inICMHOME.

To annotate potentially poor ADME groups (Substructure Alert).
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» Chemistry/Annotate by Substructure.

 Enter the name of the Molecular Table (Chemical Spreadsheet) or
use the drop down button to locate it.

» Check the Substructure Alerts option.

e Thealertswill belisted in anew column of your chemical
spreadsheet called alerts. The default table with substructure
alertswill be used for annotation called CHEMFIL TER.sdf

To annotate by custom fragments

£ Annotate by Substructure

f Existing Fragments \f Draw Fragments

Molecular Table |result v|

() Functional Groups () Substructure Alerts  (8) Custom Fragments

Table With Fragments result e-Read in atable containing your custom fragments
Hink

a column called ".LABEL" or ".LABELS" in either upper ar lower case.
Molecular formula will be used if no label column is Found

Ok l [ Cancel

* Read into ICM atable with annotated fragments. The fragments
should be labeled in acolumn called ".LABELS" or ".LABEL" in
either upper or lower case. If not "LABELS" column is found the
molecular formulawill be used instead.

e Chemistry/Annotate by Substructure.

» Check the Custom Fragments button

Todraw afragment and annotate.
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£ Annotate by Substructure

[ Existing Fragments \/ Draw Fragments

Molecular Table result w

Select checkbox

Click here to sketch to use fragment

% C{z{)=0)clccoocl b é label |1 » v|

Click here to label

T label 2 |0
©. Jabel 3 |0
T label 4 |0

[ First Fragment Match

[ ok ] [ Cancel

Click on the Draw Fragments tab.

Enter the SMILES string of the fragment or click on the ligand
editor button in the dialog window to sketch the fragment.
Enter alabel name.

Click the check box next to the label name.

Click OK

7.13 Align/Color by 2D Scaffold

Availablein the following product(s): | CM Chemi st || CM Cheni st - Pro
|l CM VLS

This option aligns a set of sketchesin achemical table in the same
orientation according to a defined scaffold or color by acommon
substructure.

Read in achemical table.

Chemistry/Align-Color by 2D Scaffold

Choose aloaded molecular table from the drop-down arrow.

You can callow ICM to auto detec the common scaffold or draw a new
scaffold using the molecular editor or choose the scaffold from a

table (Index = row number).
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7.14 Set Formal Charges

Availablein the following product(s): | CM Chemi st || CM Cheni st-Pro
[l CM VLS

To set formal charge:

Read in achemical spreadsheet Fi | e/ Open SDF

Chemistry/Set Formal Charges

Enter the name of the chemical spreadsheet (table).

Choose the option to either make Char ge, M ake Neutral, or Charge
according to ICM pKaModel

» Select the groups you want to charge or neutralize.

» The charges will automatically be added to your table.

7.15 Enumerate Formal Charge States

To enumerate formal charge states.

Read in achemical spreadsheet Fi | e/ Open SDF

Choose Chemistry/Enumerate Formal Char ge States

Enter the name of the chemical spreadsheet (Molecular Table)
Choose the pH at which you wish to evaluate the charge
Choose awindow value.

Click OK and anew table"_charge" will be displayed with the
enumerated charge states.

About the Method
For basic charges the logic is following:

» atomswith pKa> pH+window is always charged
« atomswith pKainside the range [ pH-window : pH+window ] will be
enumerated as charged and uncharged.

For example if you have two centers with pKawithin the range then four
states will be generated ([0,0] [+1,0] [0,+1] [+1,+1] )

For acidsit issimilar.

7.16 Convert

Availablein the following product(s): | CM Chemi st || CM Cheni st-Pro
[l CM VLS

7.16.1 3D to 2D Depiction

If you have achemical table displayed containing 3D coordinates or you
wish to reassign the 2D cooridnates in an sdf file you can use this
option.

Read achemical table (sdf file) into ICM.
Chemistry/Convert/2D Depiction

Enter name of loaded chemical table.

Choose In Place if you want to overwrite the table.
Choose the Files tab to run in batch mode.

294 7.14 Set Formal Charges



Table contains 3D coordinates

ol

D20

7.16.2 Convert Smiles or InChi to 2D

To convert smilesor InChi stringsto 2D sketches

* Read in atable containing the smiles or InChi strings in separate
rows. For example the smiles strings maybe in an Excel file and
you can load thisinto ICM by saving the Excel file as
comma-separated (csv).

» Select Chemistry/Convert/Smilesor InChi to 2D.

» Select the table you want to convert using the drop down arrow and
the name of the column containing the smiles string.

» Select whether you wish to keep the smiles column in the new
table.

» Click OK and atablewill be displayed containing the 2D
structure.
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7.16.3 Convert Structure to Smiles

To convert an sdf file of 2D or 3D chemical coordinatein Smiles:

* Read achemical table (sdf file) into ICM.

» Select Chemistry/Convert Structureto Smiles.

Y

X

A

By

» Select the table you want to convert using the drop down arrow and

the name of the column containing the 2D sketch.
» Select whether you wish to keep the 2D sketch column in the new

table.

» Click OK and atable will be displayed containing the smiles

string.

7.16.4 Convert to Racemic

To remove stereo bonds and make all chemical centers R/Sin a chemical

table:

e Chemistry/Convert to Racemic
» Select the Molecular Table

» Sdlect In Place if you wish to overwrite the table.

e

A

= .
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Clears UP/DO%W M bonds and makes
all chiral centers R4S, *ou may
uze GHenerate Stereoisomers’ after
that.

Molecular Table ricinLigands20 30 Jid

[v InPlace

Ok | Cancel

NOTE: To reassign stereo bonds usethe Gener at e St er eoi soners opti on

7.17 Predict

Availablein the following product(s): | CM Cheni st - Pro || CM VLS

To make a prediction using amodel you need either ICM-Pro + Chemistry
or ICM ChemistPro.

Read the table of datainto ICM from which you wish to predict. Make
sure the table contains the same columns used for the learn model.

Tools/Table/Predict

Select which table you wish to make the prediction on.

Select which model you wish to use.

Check that the required columns arein the table. If they are
absent ared mark will appear against the column that is missing.
» Click Predict.

7.18 Generate Tautomers

Availablein the following product(s): | CM Cheni st - Pro || CM VLS

Theory

Tautomers are formed by an interconvertible reaction called
tautomerization whereby there is aformal migration of a hydrogen atom
along with a switch of a single bond and an adjacent double bond. A
common example is the keto to enol tautomerism:

H

D// n}
tautomerism
H
H H
enol form keto form

During tautomerization a chemical equilibrium of the tautomers will be
reached based on several factors, including, pH, temperature and
solvent. Tautomerizations are catalyzed by: bases (deprotonation,
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formation of adelocalized anion, and, protonation at a different
position of the anion; and acids (protonation, formation of a
delocalized cation, and deprotonation at a different position adjacent
to the cation).

ICM will only generate energetically favorable tautomers. Generally
tautomers that have a change in hybridization state are less stable and
so ICM will not generate these thus reducing the number of scaffolds
generated. For exampl e the keto form shown below is more stable by ~14
kcal.mol than the enol therefore ICM will not generate the enol form.

keto o 0 enol

Acetaldehyde Vinyl alcohol

P el

Stable

The tautomer generation MoldHf (heat of formation) was trained on the

datafromht t p: / / webbook. ni st. gov (e.g.

htt p: // webbook. ni st. gov/ cgi / cbook. cgi ?I D=000050- 00- 0&Uni t s=SI & TG=0n) .
We used PLS regression and our custom fingerprints to train the model.

To generate tautomeric confor mations of your compound:

» Select the compound(s) in the molecular table. Selected compounds
are highlighted in blue.

* Right click in the table and select the option Chemistry/
Enumerate Tautomers. Or select the Chemistry menu/Generate
Tautomers,

 If you select Chemistry/Generate Tautomers a dialog box will be
displayed. Thereis also an option to run in batch mode (click the
Files Tab).

» Choose the table containing the compounds using the drop-down
list.

e Filter Unwanted Groups option will filter results from patternsin
the TAUTOFILTER.tab file provided in the distribution. If results
match any row from that table then the it will be excluded.

e Preserve Hybridisation Although generally achangein
hybridisation state will generate less stable compounds in some
cases thisis not the case and so you can choose to change
hybridisation for asingle atom.

* Group RowsWith Color option will color tautomers from the same
compound with the same color to visually highlight groups.

e The compounds will be displayed in a separate molecular table
caled TAUTOMERS.
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How to generate tautomers.
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7.19 Generate Stereoisomers

Availablein the following product(s): | CM Chemi st - Pro || Cvt VLS
Theory

I|somers are molecules which have the same chemical formula and sometimes
the same kind of bonds but in which the atoms are arranged differently.

Structural isomers have different atom-to-atom connections e.g. propanol
(C3HB80 or C3H70H) has two isomers Propan-1-ol and Propan-2-ol.

Diastereomers are not mirror images and have different internal
dimensions (e.g. dihedral angles and distances between non-bonded
atoms). They can be configurational diastereomers (which can be
interconverted only by breaking bonds or by changing the configurations
of stereocenters) or conformational diastereomers (which can be
interconverted by rotation about bonds - including chair flips or by

lone pair inversion .

Enantiomers have identical internal dimensions, and are

nonsuperimposable mirror images. Enantiomers can be configurational and
conformational.

7.19 Gener ate Siereoisomers
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tirror
Image

0 0
I |

C(5) CiR
j "’H H'j K

Enatiomers are distinguished based on the Latin terms for left
(sinister) and right (rectus). In some cases where the handednessis
unknown a chiral center can be labeled "RS"or unknown.

To enumerate and display in a separ ate table the ster eoisomer s of
selected compounds.

» Select the compound(s) in the molecular table. Selected compounds
are highlighted in blue.

» Right click in the table and select the option Chemistry/

Enumer ate ster eoisomers. Or select the Chemistry menu and choose
Gener ate Stereoisomers. If you generate stereoisomers viathe
Chemistry menu you will get a dialog box whereby you can run the
process in batch mode. Thereis also an option to color

stereoisomers from the same compound with the same color.

» Group RowsWith Color option will color stereoisomers from the
same compound with the same color to visually higlight them.

o Skip if Number of Centers Greater than option can be used to
filter out compounds which have a defined number of stereo
centers. If you do not wish to filter just use the default No
limit option.

» The compounds will be displayed in a separate molecular table
called STEREOISOMERS.

NOTE: Stereoisomer generation will keep pre-defined stereo centers

and only enumerate racemic ones.
From the Chemistry Menu:
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From a chemical spreadsheet:

7.19 Gener ate Sereoisomers
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£ ricinLigands2D STEHEDISDMEHSA\

mol MaME_|
chiral Results will be in the table
o ficinLigands2D entitled "STEREOQOISOMERS"
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NOTE: Only centers with unknown chirality will be enumerated.

7.20 Prodrug

To generate adrug from a prodrug:

* Read in achemical table (sdf file) into ICM.

e Choose the menu Chemistry/Generate Drug from Prodrug and adialog
box will be displayed.

» Enter the name of the Chemical Table.

» Select the reactions you wish to use to generate the drug. Y ou can
choose "Prodrug", "All", "Hydrolysis' "Reduction". Y ou can choose
the option "all" to use all the available reactions. Y ou can see
the reactions in each subset by clicking on the tab labeled "L oad
Reaction Panel". A chemical table containing the reactions will be
displayed and the reaction islebeled in a column called "subset".

» You can choose to output the resultsin the "in-addition" mode
where the converted drug will bein the row below the prodrug or
"replace original" whereby the prodrug will be replaced with the
converted drug.

To generate a prodrug from a drug:

* Read inachemical table (sdf file) into ICM.

302 7.20 Prodrug



» Choose the menu Chemistry/Generate Prodrug from drug and a dialog
box will be displayed.

 Enter the name of the Chemica Table.

» Select the reactions you wish to use to generate the prodrug. You
can choose "carboxylate", "hydroxyl", "aming", "diol" , "sulfide".
Y ou can choose the option "all" to use al the available
reactions. Y ou can see the reactions in each subset by clicking on
the tab labeled "Load Prodrug Panel”. A chemical table containing
the reactions will be displayed and the reaction islebeled in a
column called "subset".

 You can choose to output the resultsin the "in-addition" mode
where the converted prodrug will be in the row below the drug or
"replace original" whereby the drug will be replaced with the
converted prodrug.

7.21 Ligand Energetics

Availablein the following product(s): | CM Cheni st-Pro || CM VLS
7.21.1 Conformational Entropy

Entropy of the conformational ensemble is calculated according to the
regular thermodynamic formulai.e. kT log(Sum(Exp(-Ei/kT))), Ei isthe
energy of thei-th conformation over the ground state, summation is over
all conformations.

To calculate the conformational entropy of chemicalsin an SDFfileor a
chemical spreadshest:

e Chemistry/Ligand Energetic¥Confor mational Entropy
* Choose either the Local Tables (loaded chemical spreadsheet) or
{Files} (SDFfile) tab.
 Enter the maximum number of conformations you wish to generate.
» Enter avicinity value. For moreinformation on vicinity please
see the command language manual
http://ww. nol soft.conminan/reals. htm#vicinity
» Enter aeffort value. Thisrelates to the length of sampling time.
» Check boxesfor Sampling Rings or Systematic Search (instead of
Monte Carlo).
» Click OK.

The calculation will then run and you will see a progress bar in the
bottom right hand corner of the GUI or you can check the progress of the
job go to Windows/Background. When the job has finished:

» A tablewill be displayed called entr opies with a column called
Conf Entropy. The energy isin kcal/mol.

7.21.2 Strain

To caculate the conformational strain of chemicasin an SDF fileor a
chemical spreadshest:

e Chemistry/Ligand Energetics/Strain

* Choose either the Local Tables (loaded chemical spreadsheet) or
{Files} (SDFfile) tab.

» Enter aeffort value. Thisrelates to the length of sampling time.

» Check the Systematic Search option if you do not want to use Monte
Carlo search.

The calculation will then run and you will see a progress bar in the
bottom right hand corner of the GUI or you can check the progress of the
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job go to Windows/Background. When the job has finished:

» A tablewill be displayed called strain with a column called
Strain. The energy isin kcal/mol.

7.22 Cluster Set

Availablein the following product(s): | CM Chemi st || CM Chem st - Pro
|1 CM VLS

Clustering is described in more detail inthe Tabl es C ust eri ng section
of this manual. To undertake chemical clustering choose:

» Chemistry/Cluster Set

7.22.1 How to perform chemical clustering.

M_ How to perform chemical clustering.
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7.22.2 How to select representative centers from
atree.
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7.22.3 How to reorder branches and change the

distance of trees.
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7.22.2 How to select representative centers froma tree.
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7.22.4 How to edit the tree - labels, spacing
and coloring.
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7.22.5 Auto Close Tree Mode

To make working with large cluster trees alittle easier you can
activate the auto close mode which will close downstream clusters and
make them more compact.

To do this:

* Right click in white space on the cluster and choose Preferences.
» Select "Auto Close Clusters Downstream".

7.22.6 Calculate Maximum Common Substructure for
Nodes

To calculate the Maximum Common Substructure (MCS) for nodesin atreee:

Chemistry/Cluster Set

Select the option Cal culate Maximum Common Substructure for Nodes
Hover over anode to view the MCS.

Right click on anode and choose "Extract Maximum Common
Substructure” to extract it to atable.
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7.22.7 R Group Decomposition from Clustering

Node

To perform R-group decomposition directly from a cluster node:

Chemistry/Cluster Set

3. Hover over
node to view
MCS

I |

B
4, Right click on
‘é a node to extract

MCS to a table
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Select the option Cal culate Maximum Common Substructure for Nodes.
Hover over anode to view the MCS.
Right click on a node and choose "R-group decomposition for node".

The resulting table can be used for R- G- oup Enuner ati on or SAR.

7.22.6 Calculate Maximum Common Substructure for Nodes
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1. Chemistry/Cluster Set and choose the calculate
f Maximum Common Structure option.

2. Right click on
node

. - 3. New chemical
' table

7.23 PCA Analysis

Availablein the following product(s): | CM Cheni st || CM Chemi st - Pro
|1 CM VLS

PCA analysisisdescribed in the tables section her e.

7.24 Visualize Chemical Space
There are two options to visualize chemical space:

e Maxi mum Conmon Substructure (MCS) Dendrogram
 Self Organized Network

7.24.1 Maximum Common Substructure (MCS)
Dendrogram

The MCS method is K-greedy algorithm which simultaneously grows K
different common substructures applying scoring and resorting on each

step.
To display the interactive MCS dendrogram:

Read in a chemical spreadshest.

Chemistry/Visualize Chemical Space/MCS Dendrogram

Enter the name of the table you wish to analyze.

Enter the name of the column you wish to use to label the points

in the dendrogram.

» Choose Optimize M CS to minimize overlapping by branchesin the
tree.

e Click OK and the dendrogram will be displayed on the right hand

side panel.
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Y ou can display and undisplay the points and labels by using the check
boxes in the columns "visible", "showName" and "showStr". Y ou can right
click on the column and choose (un)check all. Points in the dendrogram
are fully interactive and linked to the table. Y ou can zoom and

trang ate the plot around the space. The points are colored by > blue =
common substructure, green = original compounds pink = root (most
common)

7.24.2 Self Organized Map

A Self Organized Map (SOM) is away to represent higher dimensional data
in 2D (or 3D) such that similar data is grouped together. Nodesin 2D

map are called neurons. Each neuron is assigned aweight vector of the
same dimensionality as input space - you can read more her e.

In ICM theinitia placement can be either 1). random or 2). find four
mutually remote points in the input dataset and put in the corners and
uniformly distribute the rest. The training is undertaken in the

following way: avector is chosen at random from the training set, then
ICM finds the node with the closest distance to the chosen vector. Next
the radius of the Best Matching Unit (BMU) neighborhood is calculated
and then the weights of the BMU neighborhood nodes are adjusted - this
isrepeated for N iterations. The final mapping stage assigns input
vectors to their closest nodes.

To run the Self Orgnanized Map method in ICM:

Read asdf fileinto ICM.

Chemistry/Visualize Chemical Space/ Self Organized Map

Enter the name of the chemical table.

Y ou can choose to color the nodes by a particular column value and
adjust the coloring by the Aggregate method (e.g. all members of
the cluster will be colored by average, min or max).

» You can chooseto sel ect one or more columns of datato use as
Descriptors.

7.24.1 Maximum Common Substructure (MCS)Dendrogram
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» The map dimensions can be changed from 'auto’ by adding an integer

e.g. 4 will make amap size of 4x4
* If you do not check randomize - the method will use the four

mutually remote pointsin the input dataset and all other initial
points will be generated so they spread uniformly between these

four.

» Connectivity edges option is for visualization purposes only to

show ’close’ clusters.

A map containing the nodes be displayed as shown below. Each node
contains a stacked cluster of input compounds. Sequential clicking on
the node loops through the representatives.
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7.25 Compare Two Sets

Availablein the following product(s): | CM Cheni st || CM Chemi st - Pro

|| CM VLS

To compar e two chemical tablesfor similar compounds:

* Read thetwo tablesinto ICM.
* Chemistry/Compare Two Sets...

e Sdlect thefirst table from the drop-down list and then select the

second table.

» Choose whether you want to use exact or similarity comparison. If
the similarity option is selected a Distance value needs to be

entered. The distance value should be decreased below 0.5 (0
0.3 or even smaller if you want to find "strong" similarity
differences. The distance relates to the Tanimoto distance as
described her e

.2 or

» Choose whether you want to Select Matching Recor ds or Show Only

Different Records.
* Select OK

» Similar compounds will be highlighted blue (selected). A selection
can be transferred to a new table by right-clicking on the table

and select Copy Selection to ICM Table.
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First Table conformers - ] Second Table [mnf‘ormers - ]

@ exact () similarity Distance 0.5

@ Select Matching Records () Show Only Different Records

Hint

Double-click on the tab of the second table to see them side by side

L [ ok || cancel || Heb
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7.26 Merge Two Sets

Availablein the following product(s): | CM Chemi st || CM Cheni st - Pro
|l CM VLS

To mergetwo tables:

* Read thetwo tablesinto ICM.

e Chemistry/Merge Two Sets

» Select the first table from the drop down list (Table A) and the
column you wish to use to merge the table by.

» Select merge method 1. inner - only molecules present in BOTH A
and B tables are kept; or 2. left ALL rows of A are kept ; or 3.
right ALL rows of B are kept.

» Select the second table from the drop down list (Table B) and the
column you wish to use to merge the table by.

» Enter aname for the output table.

e Click OK and anew table will be displayed.

(5] Merge Two Sets @

Table A ricinLigands 20 tauto 1 tauto Jd by Colurnn rnal -
f* inner " left " nght
Table B | ricinLigandz2D_tautao ﬂ by Calurnn ol hd
Rezult Marne |T_ioin ﬂ
Hint

ihner - only molecules present in EOTH & and B tables are kept
left - ALL rows of & are kept
night - ALL rows of B are kept

Ok | Cancel Help

7.27 Select Duplicates

Availablein the following product(s): | CM Chemi st || CM Chemi st - Pro
[l CM VLS
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NOTE: Gui option is availablein versions 3.5-10 and higher. The

command line options for this function are described in the ICM
Command Language manual at

http://ww. nol soft. coml man/i cm functions. ht M #l ndex- chemi cal

This option alows you to select and remove duplicate chemicalsin a

table.

analysis.
* PressOK

Read achemical tableinto ICM.
Chemistry/Select Duplicates

Enter the table name you want to check for duplicates
Enter whether you want chirality or the saltsincluded in the

» Duplicate compounds will be highlighted bluein the table. Y ou can
delete them by right clicking on the row header ans selecing

Delete Rows(s)

o Find duplicated entries in set E]@

Table licates
v Use Chirality [ Use Salt
Ok | Cahcel ‘
chiral
u}
O.p.
E'|= n} P o
. Yol
% Cut Row(s)
Copy Row(z]
. Fazte Faowlz]
¥ Delete Rowl(s)

Right click and select
Delete Row(s)

Ihzert Empty Fow Before

Inzert Empty Row After

Duplicate rows are highlighted in blue

7.28 Multi Parameter Optimization

Multi Parameter Optimzation (MPO) is a method that can be used to derive
ascore for the relative importance of a number of different chemical
properties. For example Lipinski Rules (LopP, MW, Nof(HBD) , Nof(HBA)
and CNS (LogP, PSA, MW, pKa, MW, Nof(HBD).

To run MPO:

* Read inaChemical table.
* Chemistry/MPO/Create New MPO Score
» Select theinbuilt Lipinski or CNS parameters or make your own by

choosing Empty.

» Choose whether you want to assign property colors and click OK.

* You will then see a panel on the right hand side of the
spreadsheet under the table Tools tab.
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* If you chose "Empty" you will need to add parameters either from
Mol Soft’ sinbuilt functions or from an existing column.

¢ |If needed Adjust the High, Low, Slope, Value and Weight columns by
clicking in the cell and editing.
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[ 4, Calculate Score ]
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* Click on Calculate MPO Score and a results table will be displayed
containing a Score and the parameter bars.
 Sort the Score column (myM PO).
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7.29 Combinatorial Chemistry

Availablein the following product(s): | CM Cheni st || CM Chemi st - Pro
|1 CM VLS

7.29.1 Sketch Markush Structure
Tut ori al |Video
Tocreateor modify a Markush Structure:

 Usethe Mol ecul ar Edi t or to sketch the scaffold as shown below.
Right click on an atom and choose -> Element-> R1,R2....
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» Save the sketch to a chemical table by clicking on the " Append
Moleculeto Chemica Table" button in the Molecule Editor.

* Closethe Mol ecul ar Edi t or window by clicking on the crossin the
top right hand corner and the changes will be submitted to the
table.

7.29.2 R-Groups

ICM has an inbuilt local database of R-groups generated from ChEMBL
data. To open thisfile:

» Chemistry/Combinatorial Chemistry/ Load R Group Database

» A table of R-groupswill be displayed - attachment points are
represented by asterisk. The'fregq’ column represents the number
of pairsfound in ChEMBL for that scaffold.

Y ou can sketch your own substituents:

e OpentheMol ecul ar Editor.
 Sketch the substituent and use > right click > attachment point to
assign the attachment point.

You can aso split achemical table into fragments as described her e.

You can read in an SDF, mol, smiles file containing fragments. If you do

not want the first atom of the substituents to be the attachment point

you need to define the attachment point. Attachment points are

automatically assigned when you ext ract fragment s or you can define them
manually by using the molecular editor (as described above).

In many combinatorial chemistry options thereis an option to use

LigEdit Mofifiers. These are the substituent groups you see in the edit
panel in the 3D Ligand editor.

7.29.1 Sketch Markush Structure




7.29.3 Create Markush

To create aMarkush structure:
-2
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* Read inthe R-groups for your Markush structure.
* Chemistry/Combinatorial Chemistry/Create Markush
 Click on the editor button and sket ch the Markush structure.
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» Usethedrop down arrow to select a R-group table for each of
your R-groups.

* You can choose to associate labels from the R-group table if
needed.

* You can add filtersif needed (e.g. ISAliphatic(R1) &
IsAromatic(R2) & MolWeight(mol)Click Create/Modify.
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e The Markush structure will then be created with embedded R-groups
and filters.

* You can extract the R-groups again to separate tables by: Right
click on the Markush structure in the table and choosing the
option "Extract Markush/Scaffold R-groups”.

NOTE: Once aMarkush is created you can right click on it in the
chemical table you will see two convenient options 1. Edit/Markush
Scaffold Properties and 2. Extract Markush Scaffold R-groups.

7.29.4 Enumerate by Scaffold

Tutorial |Video
Toenumeratealibrary based on R-groups:

» Sket ch the Markush structure and saveitinachemi cal
spr eadsheet .

* Readinthe R- Gr oup substituents you wish to use to enumerate the
library.

» Right click on the structure and select Chemistry/Enumerate
R-groups or use the Chemistry/Combinatorial Chemistry/ Enumerate
by Scaffold-Markush menu. If you use the menu option you will need
to choose the table containing the scaffold from the drop down
list of currently loaded tables. The index number refersto the
row number in the scaffold table. Click OK.

* SdecttheR1, R2... table, labels and filtersif necesary. Asan
example of afilter you could use R1 '=R2, OR MolWeightA new table
will be produced called T_enum with the Template structure
highlighted in red.

S B BB LA
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7.29.5 Enumerate by Reaction
Additional Resour ces: Tut ori al |Video|Command Li ne Docs

Resactions can be drawn using the| CM Mol ecul ar Edi t or . Reactants should
be drawn side-by-side (no + sign is necesary) and separated from the
product using the arrow. See example shown below:

R PR RN T L TR o
Fiie Edit View Templates Help

edlonuveels BK[G

c REACTANTS ~ PRODUCTS e
Pl H3 o
o \ V4 >
F & 0 /! A1 O
Draw Reactants Seperately ) ¢
[ l Add Arrow \1 / L
5
= g o, i \
i P e N P W - ,:}‘ % O
=k - [ H1 =0 4 ,
m | F’QE _{:\ f/ Y D
1 4 iy \,
3 Wi (Y
H Right click menu for ‘1,\ = !
R-groups .

g

+

b Chemical Reaction Arrow

fla s N4
L

This exampleisavailable in the ICM distribution as
example_reactionl.ich. The reaction is the Hantzsch Dihydropyridine
(Pyridine) Synthesis. This reaction allows the preparation of
dihydropyridine derivatives by condensation of an aldehyde with two
equivalents of a beta-ketoester in the presence of ammonia. Subsequent
oxidation (or dehydrogenation) gives pyridine-3,5-dicarboxylates, which
may &l so be decarboxylated to yield the corresponding pyridines.

In this example we have two reactants therefore it is necesary to have
two reactant substructure tables loaded into ICM. ICM will match the
substructure drawn in the reaction with the chemicals in thereactant
table.

Reactant Tables

. I
Reaction — 1} han_pyr '/ reactant1 Y reactant2 ',

xXn

2 O
o o R
1 qu‘v’u“Q + R0+ N —— o ) o
R3 N oR3
Rz

reactant 1 table:

7.29.5 Enumer ate by Reaction
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r_han_pyr V reactant1 V reactant2 \

Substructure search: Found 88 hits of 'O=C([C;D2]C{=0)O[R3])[

molid MolW | maol vendors
65236 170.094 ‘ asdi:500028335
o
18 ™
L]
o]
87804 174.053 apolloscientific:12582
asdi:500014701
<O
I &) o o
65360 182.058 apolloscientific:13718
keyorganics:11X-0925
[
o
20 o natl
Q o
gvs22 179.058 apolloscientific:2865
o o interchim:616
=
21 | 9
M
3341 194.058 asdi:500016383
o
o
#]
O

To apply areaction:

» Chemistry/Enumerate by Reaction.

* Inthis example (example_reactionl.ich) we already have the
reaction drawn in a chemical table. Therefore select the Choose
Table With Reaction. If you would like to draw a new reaction
select Draw New Reaction.

» Enter the name of the table containing the reaction. If you have
more than one reaction drawn you can select the row using the
index option.

* Click OK and then you will be asked to enter the Reactants. Select
the reactant tables from the drop down arrow for Reactant 1 and
Reactant 2.
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* You can transfer information to the reactant table by selecting
columnsin the L abels section.

 Unused reactants can be marked.

» Select what you want to do with multiple matches.

A table of Productswill be then displayed in atable called T_out.
Columnsin T_out labeled "rct" display which reactants were used to
build the product.

Table of Products

r_han_pyr ‘\cf' reactant1 ‘\,f' reactant2 VT_out \

mol rct1 rct2

1 1

Mumbers indicate which reactant
was used for the product

7.30 SAR Analysis

7.30.1 R-Group Decomposition

Tutorial |Video

To decompose a library into fragments based on a Markush scaffold
(opposite of R- gr oup ( Mar kush) enuneration):

* Read the sdf file you wish to decompose into ICM and it will be
displayed as a molecular table.

» Sket ch the Markush structure you wish to use to decompose the
table by and saveit in achemical table.

7.30 SAR Analysis
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* Chemistry/SAR AnalysigR-Group Decomposition.

» Choose the table containing the Markush scaffold. Index refersto
table row if you have more than one Markush structure in atable.

» Use the drop-down option to select the table you wish to decompose
and the column containing the 2D chemical (usually called mal).

* If you have more than one R-group ICM can either generate a
different table for each R-group or it can merge it into one
single table whereby column will represent R1 and column two R2...
Thisoption is useful if you want to generate a SAR table with a
column of activity data next to the R1 and R2 columns.

« If you check the box "Auto Add Missing R Groups' then unique
R-groups will be extracted from the scaffold where hydrogens can
be attached.
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¢ The decomposed table will be reported in a new table with new
columnsfor the R groups (R1,R2...). If you have an additional
column with activity data you can sort the table by R-groups and
see the effect of an R-Group on activtiy. Thistable can be used
to build an additional SAR table as described her e.
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7.30.1 R-Group Decomposition
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7.30.2 SAR Table

| Tutorial |
To generate a SAR table you first need to deconpose the table into the
R-Groups.
Is) exarmple_soamich Molsol iz 3.8-6 [READ OMLY] [T/ Prograrm Fles/Misduafy LLCAIRA-Py Fim demmpose 'fﬂu!’ table intﬂ H__Gmups
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- ;_tnr 1320 rov | o Ej ®
e {2 Bams a 7 ®x
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Decompose your library. Deconpose thelibrary to extract the R-Groups

or read in adecomposed SDF file.

324 7.30.2 SAR Table



.
@ cxampie < - . LChemistrnyAH Analysis/Generate SAR Tables
D®Eo wa cardi o8 ~Eelll @0 E1iE0
g et | 1. chemist SAR Analysis/Generate SAR Tabl |
ﬂﬁlﬂ'il'i”ﬁ“* - m‘ ry/ 1 Ivss} ene es |1]@
\skrimpace Panal LR B R [5 B A suos ok WY T ser :;
o seigGion -] 5 u = s i34 i B
8l tablas (8 demg) [ g
- scaffold 1oWs o
- A1 Hru:vs}c c . \) D ‘”t{}ro é &
-R2 185rowsidc B -
- B3 Browsdco = 'g‘l fu—ﬁ:' - E 2
- anum_result 12 by
= T_sar 1320 nov " E ®
=i scriph (2 iBerns) a HE
- SpitR ® Generate SAR tables T x Q o | &5
- Enpmsnmts Ot =
2. Select Zor %
more columns 2 o
for analysis. e —oo  3.Selectthe <
3 | Commv | bl Colma ‘ label column E:
F ooty Cister By [aze =
F senby  setmy [icsaret =] [ desness . 1’;
Hit 4
Reqgreugs Uadis sy 15 8 rond of Fogrop desomyatise, {'_ e
4 C =" Salect bep or maen H-cobimng for SAR pratess o .
e N 2
E i 5 %
a [ ]7] | a.clickok | =
ole] L e 0a el L J
Generate SAR table. Chemistry/SAR Analysis/Generate SAR Tables. One or
more columns can be chosen for analysis and multiple tables will be
generated. Color the table by a selected column e.g. activity.
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SAR table. The SAR table will be displayed with an activity scale and
R-group scaffold in the first cell (A1) and the R groups along each
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axis. Y ou can use the table to investigate which R-group(s) contribute
to activity.

7.30.3 Plot R-Groups

Y ou can make a plot of R-groups from library decomposition. Thisis
described in the pl ot s section of the manual.
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7.30.4 Generate SALI Table

[ Tutorial |

Structure--activity landscape index: identifying and quantifying
activity cliffs.

This method produces a SALI score as described inthe publ i cat i ons by
John Van Drie and co-workers. It will identify "structure-activity

cliffs": pairs of molecules which are most similar but have the largest
change in activity.

Read in a sdf file containing "mol" and "activity" column.
Chemistry/SAR AnaysigGenerate SALI table.

Y ou can choose to use the Log of the Activity Column.

The method will try to find pairs based on defined distance cutoff
(0.15isagood threshold for larger datasets).

326 7.30.3 Plot R-Groups



* A resultstable will be reported containing the pairs, tanimoto
fingerprint similarity and SALI index.
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7.30.5 Matched Pair Analysis

| Tutorial |

Matched Pair Analysis (MPA)can be used to study changesin chemical
properties based on small well-defined structural modifications to the
chemical structure. The method tries to find the Maximum Common
Substructure and clusters by similarity. The analysisis performed in

two stages: clustering and then Maximum common substructure on each pair
in each cluster. The output issimilar to SALI output plusit givesthe

actual R-group pair variation. The pair table is sorted by score so top

hits should show small variations and big score difference. To run MPA:
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. { Chemistry/SAR Analysis/Matched Pair Analysis
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* Read in achemical spreadsheet containing a’mol’ column and
activity data.

e Chemistry/SAR AnaysigMatched Pair Analysis.

 Enter the name of the Input Table.

« If the table has activity data or some other property use the
gption use Activity and select the column name from the drop down

utton.

« Enter acluster split distance for determining similarity.

e Thes )ze of the R-groups for comparison can be set (default is 12
atoms).

» R-groups can befiltered from the analysis. or a custome filter
using SMARTS.

 Chirality can beignored in the comparison if needed.
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Theresults table (tableName _pairs) isfully interactive between the
plot and the original table. The hits are sorted by the score column,
so top hits should show biggest activity change with smaller groups.
The plot is displayed activity 1 versus activity 2 colored and sized by
score (red is better).

e ix1 - index number (row number) of first chemical whichis
hyperlinked to original table.

e moll - 2D structure of first chemical.

e R1 1- group difference between first (ix1) and second chemical
(ix2).

e ix2 - index number (row number) of second chemical whichis
hyperlinked to original table.

* mol2 2D structure of second chemical.

* R1 2- group difference between second (ix2) and first chemical
(ix1).

* <cfl - common scaffold

» dvisible('d’ delta’visible' - delta of your activity column:
'd’ + original_column_name)

» scoreiscalculated as normalized dActivity + (1 - normalized
weight of both groups).
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8 Working with Tables and Plots

One of the easiest ways to store, sort and display datain ICM isby the
use of atable. In most cases tables are automatically created, for
example, if you search for a PDB file or when you load a compound
database (SDF file). It is also possible for you to create your own
table. Once atable is created, ICM provides easy to use tools to sort,
add, edit and plot data.

Here we will concentrate on describing the actions you can perform on a

table once it has been read into ICM. We will start by describing a

simple table. Actions which can be performed on chemical tables are

described in the section entitled Wor ki ng wi t h Chemi cal Spreadsheets.

Standard | CM Tabl es

Chemi cal Spreadsheets

Insert Interactive hjects into Table Cell
Plotting Tabl e Data

Princi pal Component Anal ysis

Learn and Predict

Cl uster

A standard ICM table:

= ppBSearchResuls | HITLIST }

I MAME| Score | Matom| Nfles| Hbond | Hphab | Wwint i‘ Took |
1 [fosee ml  -33e0 37 2 662 557 3875
2 101623 m 32890 42 0 E7& 762 3836 I display Hbonds
3 |1076e2 ml 3412 % 1 777 608 333 G sy s o
4 10167 ml 317 48 4 590 684 4293
5 |01 ml 3470 3% 0 797 645 3144 caloulate distances
5 |17 ml 3665 54 3 655 737 4609
7 1m7ed ml |07 3@ 2 711 626 3498
g 1792 ml 251 32 0 61 684 307
g 10813 m 4730 3 0 188 623 98B _
g0 ) T T e MMLH |

8.1 Standard ICM Tables

Availablein the following product(s): | CM Chemi st || CM Cheni st - Pro
|l CM VLS

8.1.1 Generate New Table

NOTE: To generate anew chemical table use the optionsin
Chemistry/Create Empty Chemical Table.

To generate a new empty table:

» File/New and select the Table tab and a window as shown below will
be displayed.

» Enter the number of rows and columns you wish to include in your
table and whether you wish to add a column with chemical data.

» If youwishtomakeacheni cal tabl e (chemical spreadsheet) select
the Chemical Column box.
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9 New molecule/sequencefgrob @E|

Peptide ] Compound l DMA/RNA ] Sequence l Script l Himl | Table lAerw ] Box ] Sphere l BEJL

Table Mame |rn_l,JTabIe j Rows E =
[v Chemical Column

String Columng |2 il

Integer Columns |D il

Real Columrs |D il

[ Chemical Column

Ok | Cancel Help

8.1.2 Reading a Table

A table can beread and saved asa*.csv , *.tsv or a.tab file. Saving
or reading your table as a csv (comma separated value) file enables the
table to be transfered or loaded from other applications such as
Microsoft Excel. A chemical file such as an .sdf file can aso be viewed
asachem cal spreadsheet.
A table can beread into ICM by selecting:

 File/Open and then selecting the table you have saved (e.g. csv,

sdf, tab).

NOTE: If you have loaded atable and it is not displayed it may be
because the table window is hidden. To display the table, select the
window menu and select table seethe W ndow Menu Secti on .

8.1.3 Saving a table

To save the whole table;

» Tosaveatableright click on the table header tab and select
Save As..

To save arow selection:
» Sel ect arow(s)

* Right click and choose Save Selection As or Save Selection AsCsv
+ Headers

8.1.4 Basic Table Navigation

To view the contents of atable you can move the table up and down using
the scroll bars on the side and bottom of the display.

NOTE: If you have loaded atable and it isnt displayed it may be
because the table display isnt selected. To select the table display,
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select the window menu and select table (See W ndow Menu Secti on).

If you have read more than one tablein ICM you can select atable by
clicking the tab on the top of the table (See Below).

If you have more than one table loaded use the tabs here to navigate

between each one.

Table tab ——=lwyTisT | PDESeachResults |

POB Search results for ™

ID | head date | hed ithe
1zbt |HYDROLASE [SERINE PROTEIMNASE) 11 Aug 1972 Atomic coordinates for subtiizin BP
|2 Tmbr OYGEM STORAGE 05 Apr 1973 The Stereacheresty of the Protein |
E 2dhb (YGEN TRANSPORT 01 Mow 1573 Thiee dimensional founer swthesis
4 |3 CADOREDUCTASE, CHOH DONOR, MAD ACCEPTR 06 Jun 1974 A comparison of the shuctures of a
[5 [2cha HYDROLASE (SERINE FROTEINASE) U1Jan 1975 The Structure of Cystaline Alpha C

" i

.

. I . I table: 22700 1ows. 10 columns

Mumber of rows and columns in the displayed table

NOTE: Double clicking on the tab allows two tables to be displayed at
once. Double clicking again returns to the default table layout.

NOTE: Information regarding the number of rows and columns within a
tableis displayed at the bottom of the table.

If you would likethetableto be the main window in the graphical user
interface:

* Sedect Windows/Table->Main

8.1.5 Table View (Grid Layout)

To change the table view (layout):
» Select the columns you wish to display in grid view. No selection
will place al columnsin grid view
» Right click on atable row and select Table View
» Youcanview thetablein Grid View and toggle between grid and
standard view. Y ou can define your own grid using the Custon Grid
option or display thetable in Form View.

NOTE: You cansave atable view.
8.1.6 Change Row Height
To change the row height:

* Click and drag on the row separator
» Hold the Ctl key to change the height of all rows.

8.1.7 Table View Save

Onceyou haveat abl e vi ewthat you want to keep. You can saveit by:

8.1.4 Basic Table Navigation

Scroll here
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* Right click on atable row and select Store Views

» Select Save Current View

¢ Enter aname for the table view and you can return to that view by
repeating the first two steps above.

» You can rename, delete or restore view by right clicking on the
name of the table view.

8.1.8 Table Search

Tosearch atable:

¢ Right click on atable row and select Find and Replace. Y ou can
alsouse CTRL F.

e Enter asearch string.

e Pressthe Find button.

8.1.9 Table Color

You can color your table based on valueswithin a column by:
Single Color

* Right click on the column header and select Format,Color ,Action.
¢ Inthe Background panel select the color you desire using the
option Single Color.

Color by Rainbow

* Right click on the column header and select Format,Color ,Action.

¢ Inthe Background panel select the option rainbow. To edit the
range of values relating to each color click on the pencil (edit)
button as shown below.

FUE Lowct ot b b

ady -5

eI 0¥ Sapabartan, 4 Taban. 141, 8800 Y e serncron [
Heliband, 5. Wi L 1B, L. Msnabishaan, /A, ARV DRTRATTIN [IERE

o BT Usaty, 1. wah 1 Fnoewss, 3 Dot 6 lioottw sy oevmucron (RN

iakon £ 8 Lt VR Fomip o 70 Mokimmse F | %S SETRACETH (IR

e $idad
B
KT T
FPTI_a
b1 sasean

B oo, Sheman A, ta, 80}

® BAHE MM b

- 2.select rainbow. -

Color Range - Advanced

* Right click on the column header and select Format,Color ,Action.
» Inthe Background pane select the option Range/Advanced
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Column Format: molCLogP 3

Font

0 [ Italic

Font Size [0 |%l
Background

) No Color

O Rainbow -
@ Range/Advanced _

Alignment

@ Default O Left O Right O Center O Justify

Floating Number

O Decimal O Exponent ® Mixed Precision

Link/View/Action l Mo Link

<»

Html Format

%.4g |

Display Name [ l

Comment

Ok H Apply H Cancel

¢ A dialog as shown below will be displayed where you can specify

ranges and colors for each range. If two colors for range are
equal then the whole range will be colored with single color,
otherwise color will be interpolated within the range.

8.1.9 Table Color
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(i

Color Editor for 'molLogP'

Color Range

Color Formula ‘

|

| | C

| | €

LU

|

LU

|

LU

|

LU

|

U

||

||

LU

8.1.10 Table Font

* Right click on the column header and select Format.
» Change the font using the optionsin the Font panel.

[ Cancel H

8.1.11 Table Alignment

Rows can be colored by marking them asdescribed her e

8.1.12 Mark a Row
A row in atable can be marked and grouped by alabel which enables the

» Right click on the column header and select Format.
» Change the font using the optionsin the Alignment panel.

row(s) to be selected easily at alater time.

Tomark arow

336

* Right click on the row in the table you wish to mark. Or sel ect

multiple rows and then right click.

» Select Mark Row/ and then choose a number. In the GUI the number
of rows that can be marked is limited to 5 but this can be

8.1.10 Table Font



increased using the command line command.
* A row that is marked will be colored - each number is assigned a
color. The coloring can be changed in the gui

tab in preferences.

| FOLECE

[] Cellhesd3] , |
o orowas
Select Maiked Riows 3 1
ID | head B CopyCel CulsC
1 Thto | LIGASE o’ e :
2 1kl RNA POLYMERASE & Piint Table. CulsF 4 leeiophage
3 1htg [LIGASE . d ghalarire
4 1hky HORMOME AGROWTH FACTOR DA | capstal structune of Dt o e
5 Thew STRUCTURAL GENOMICS, UMENDWN FUNCTION 09401/07  complex of ROOES with adp and maghesim
B Tkpn HYDROLASE oA 02 et slm_l.:.udcvifi;umq of upccl!c. nhh‘mnf )
7 1wlla TRANSFERASE A0 S04  stuchure of hydnonpethykthiazole kngee protein fom
8 1¢0p MEMBRANE PROTEIN O1/01/04 | elrachis of thvs reterrinal dormsie of flve aderghi
3 2dcc Hydrolase 0101/06. | oray cyetal stictune analysis of bavie spleen calhepsin

Right click here and select Mark Row

To select marked rows

» Right click on the table and choose Select M ar ked Rows and choose
anumber which relates to the marked rows as described earlier.

» Selected rows will be highlighted blue - once rows are selected a
number of right click options are activated such as copy selection
to new ICM table.

8.1.13 Table right click options

Right-click options vary according to where you click and what is
selected. The options are intuitive, for example options that are
performed on the whole table (eg Save and Delete) are performed by
right-clicking on the Table tab. Other right-click options vary
according to whether the row or columnissel ect ed or not.

8.1.14 Rename a Table

Torenameatable:

* Right click on the table tab and select rename.
» Enter anew name and select OK.

Right click —V PDBSeachResuts

FDESearchResults

Select
ID | he: Clone
Thto | LIG:

Delete
Thil FIN#x

Fename...

Thtg | LIGe
Thtw  HOF

| DO | |

Savebs .

8.1.15 Clone a Table

* Right click on the table tab and select clone.

8.1.16 Delete a Table

» Right click on the table tab and select delete.

8.1.12 Mark a Row

MYCOBACTERIUM TUBERCULOE
BACTERIOPHAGE PHIE
MYCOBACTERIUM TUBERCULDE
HOMD SAFENS

HAEMOPHILUS IMFLUENZAE
DABOLA RUSSELLI PULCHELLA
FYROCOCCLS HORIKOSHI
CICTYOSTELIUM DISCOIDEUM
BOS TAURLS

Coloring relates to numbers
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8.1.17 Page Setup

Beforeprinting a tabl e youcanchangethe orientation and scale.
Todo this:
* Right click on the table header and select Page Setup.
8.1.18 Print a Table
A table can be printed by:

* Right click on the table tab and a menu will be displayed.
» Select the "Print" option. Y ou may want to change the setup of the

table (eg orientation and scale. You can do thisusing Page Set up

option.

8.1.19 Export to Excel

To export atable to excel.

* Right click on the table header.
» Select the option to Export to Excel.

8.1.20 Save a Table

* Right click on the table tab and select Save As..

NOTE: You can save your table in comma separated format if you want
to read it into another program such as Microsoft Excel.

8.1.21 Change Column and Row Width

To change the width of column and rows:

Y ou can change the width of arow or column by clicking on the
separating line and dragging. Y ou can make each row the same width by
holding down the Shift key and dragging one of the row edges.

8.1.22 Making Table Selections

To select one column of atable:

» Click on the column header

338

8.1.17 Page Setup



Click here to select a column

2 HTLST | PDESearchResults

PDB Search results for ™"

ID | head date | hel tile
1 1zbt |H¥DROLASE [SERIME PROTEIMASE] 11 Aug 1972 Atomic coordinates for subtilizin BPN
2 Tmbr 0¥ GEN STORAGE 05 Apr 1973 The Stereochemizty of the Pratein b
3 2dhb 0¥ GEM TRANSPORT 07 Mo 1973 'Il'hreel dimenslinln_al fmiriEr Is_l,lnthesi$ 4
4 Sidh OxIDOREDUCTASE, CHOH DOMOR, WAD ACCEPTR 0B Jun 1974 .‘I’-'«Icnrlnparisun of thnla:structwes. of ap
h 2cha HYDROLASE [SERIME PROTEIMASE) 01 Jan 1375 T_he Strgptun_a of E[_I.Jfltalllirlulal.f-\llphi-lEh_
1
|

. . table: 22700 rows, 10 columns

To select onerow of atable:

» Click on the row header

= yTUsT | POBSearchResults

PLE Search results for ™=

<

ID | head date | he title
1 Tzbt |HYDROLASE (SERIME PROTEIMASE) 11 Aug 1372 Atomic coordinates for subtilizin BPF
2 Tmbr OxYGEN STORAGE 05 Apr 1373 The Stereochemistry of the Protein b
3 2dhb OXYGEM TRAMSPORT 01 Moy 1973 Th[EF'.: dimenslialn_al faLiriEr Isynthesis
4 Aidh  OXIDOREDUCTASE. CHOH DOMOR, MAD ACCEFTR 06 Jun 1974 A companzon of the:stluctures- of &
L] 2cha HYDROLASE (SERIME PROTEIMASE) 01 Jan 1975 Tlhle Sltlgcture of E[_l,llf-tal-lipnlal.-’-\llphi-lﬂ}

.| . | table: 22700 rows, 10 columnz [1 selected records)

To select arow click here

To select morethan onerow or column:
» Click on onerow or column whilst pressing the Ctrl key

 Select multiple number of rows or columns whilst still pressing
the Ctrl key

8.1.22 Making Table Selections
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2 HTUsT | PDESeachResuls

FPDE Search results for ™

ID | head date | hel e
1 1:zbt |H¥'DROLASE [SERIME PROTEIMASE] 11 Aug 1972 Atomic coordinates for zubtilizin BPR
2 Tmbr O GEM STORAGE 05 Apr 1973 The Stereochemisty of the Protein b
3 2dhb O#YGEM TRAMSFPORT 01 Mow 1973 'Il'hreel, dimenslinln_al fmiriEr Isynthesix
4 3ldh OxIDOREDUCTASE, CHOH DOMOR, WAD ACCEPTR 06 Jun 1974 ;I’-'qlu:orlnparisnn of thnla:xtruu:tures. of af
L] 2cha HYDROLASE [SERIME PROTEIMASE) 01 Jan 1975 '!'_he Strgptun_a of E[yfltalllipglﬁllphi-llil’
d |

. . table: 22700 rows, 10 columnz [3 selected records)

Select multiple rows and columns by clicking
and selecting whilst pressing the Ctrl key.

NOTE: The Ctrl key acts as atoggle enabling select and unselect.

To select arange of columnsor rows:

» Click onthefirst row or column in the range whilst pressing the

Shift key.
e Click onthelast row or column in the range whilst pressing the
Shift key.

To select arange of columns or rows - click on the
first member of the range and the last whilst pressing
the shift key.

2 WTUST | PDBSearchResults

PDE Search results for ™=

ID | head date | hetl title

7 3wz HYDROLASE (0-GLYCOSYL) 01 Feb 1975 Realspace refinement of the struch
a 1wz HYDROLASE [0-GLYCOSYL) 01 Feb 1975 lHeaI-space refinement of the struch
9 Blyz HYDROLASE [0-GLYCOSYL) 01 Feb 1975 lHeaI-&pace refinement of the struch
10 Blyz HYDROLASE [0-GLYCOSYL) 01 Feb 1975 lHeaI-&pace refinement of the struch
11 2lyz IHYDFEDLASE [0-GLYCOSYL) |D1 Feb 1975 lHeaI-Space refinement of the struch
12 1chg HYDROLASE ZYMOGEN [SERINE PROTEIMASE] 01 tar 1975 ll:hymn_trypsinpgen: 2 B-angstrom =
13| |2cna LECTIN [AGGLUTININ] D1Ap1975  The covalent and thres-dimensions
14| || 1hip ELECTRON TRANSFER (RONSULFURPROTEIN) 01 Apr1375  Twoddingstiom cuystal stucture of o
15 1gpd OXIDO-REDUCTSEALDEHYDE/DOMA MAD/ACCPT] 01 Jul 1575 ISItu!:Iieéc-fllasymljn:etlryl in the three-di
< |

ﬂ .J able: 22700 raws, 10 columns [6 selected records) 1 nioh-ICh

Click here hold the shift key

Click here hold the shift key

Toinvert a selection:

* Right click on the original selection and a menu will be

displayed.
» Select the Row Selection/Invert selection option.

NOTE: Invert selection can only be used on rows.
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To select the whole table:

* Right click in the table and a menu will be displayed.
» Select the Row Selection/Select All option.

To remove a selection:
e Click anywhere within the table.

A selection can aso be made from a plot select(‘ table-plot{ See Select
plot section}).

8.1.23 Editing a Table

To edit atable: Click on the Edit Cells by Double Click button on the
right hand side of the table. Y ou can then edit each cell by double
clicking on it.
1<
Edit Table wem &
[

. oo

Juee
L]
L1113

3

OR

To edit thetext or valueswithin a cell:

* Right click on the table and select Edit Cells by Double-click .

8.1.24 Rename Column

To edit the name of a column:

» Right click on the column header and a menu will be displayed.
» Select the option "Rename Column..." and enter the appropriate new

text.

8.1.25 Inserting Columns

Toinsert acolumn:

¢ Identify the position within the table where you wish the column

to be inserted.

» Right click on the column header and a menu will be displayed.

» Select "Insert Column®

8.1.23 Editing a Table
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39 Mdict Molzoft icm 3.8-3a [MewProject *] {1 table sl
Eide Tools Edit View Bioinfo Homology Chemdstry Docdng Modddechanics ﬁmdtg( Cut Cohamn
EE{}&OC’ H:G ﬁi Hﬁ-}l‘t”r Ii' b 4 ﬁ """‘_;-.{.um-r_uumn Citel _‘u
{ wenrch ) Bgaddt i
704 Sengs =l Fizl b m [ Fwids ~]] Append
. Copy/Append sefection to B0 Tabda *
1. Right click on 7 :
;m
column header el
225 /L\}):,/ 2. Insert Column
#
HO » [Edit Mode
Renamne Colurnn..
o et Compound Names From _
W
226 # Color Structure By ¥

A dialog box will then be displayed as shown below.

Select the mew calumn vou wish to Parform actions on the list
add from the drop dewn menu.

D 1ersert Column

Enter arguments 1B R "
related to "Function” §———= Swng |sevpd =] | |8 sergr™ Sarineg Herwe
|8 Serglesargie"] Sared Hew

Pless ol locafion ——t+When you select “Add To List”

Whre do you 8| OOSS [p=memms the columns will be listed here
WaNT yoUT new
column located sk [ -
I the table? =
Mess colime, rame
[tng
ecm?ﬂ | s Hip |
|
| ]
Use Add To List to add mors than one column Click OK to add celumn(s)

» Select the function you wish to add to the new column. Functions
can be applied to many columns e.g. add etc..

» A set of arguments related to the function selected will then be

displayed.

Enter the appropriate arguments related to the function selected.

Select where you want the new column to be located in the table.

Enter the new column name

If you wish to add multiple columns then use the Add to List

option.

Many different functions are available:

* New Add anew column containing areal number, integer, string,or
random number.

» Transformations A number of transformations can be selected and
applied to atable column as shown below.

* Mathematical A number of mathematical functions

e Text Apply anumber of different functionsto thetextina
column.

* Chemical Calculate anumber of different chemical properties.

» Convert Units Radian to Degrees and Degree to Radian

Oncethe function and the correct arguments have been entered:
» Select whether you wish the new column to be added before,after or

in place of this column.
» Enter the name of the new column.
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NOTE: If you want to add more than one column choose Add to List and
the action will be added to alist on the right hand side of the

dialog box.

8.1.26 Increment ID Number

To add and Increment name ID in cell as a column (e.g. mol1, mol2,

mol3 f):

* Right click on a column and choose | nsert Col umm.
Select Function New -> | D.
Enter name and starting number and press OK.

8.1.27 Column Visibility

To hide acolumn:

Right click on any column header and choose "Manage Column
Visibility and Order"

» A dialog box as shown below will be displayed.

Click on the arrows to move a column from hidden to visible and
vice-versa. Multiple columns can be selected by holding the Ctrl

key and clicking.
B Manage Column Visiblity and Order 7 x
Vicible Hiddan
f = <] I %
‘ 1. Select col } rriol Synonym
. Select column(s} e Pl P
to hide, ) molArea -
-
NAME_ _I
Glsg i 2. Move from
i et visible to hidden.
mollogs
mollogP ]| ‘
OK I Cancel
i Manage Column Visiblity and Crder ? *
Visshle Hidden
| ¥ & 2. Move to visible,
miol SYTIONYTT)
molPsA cﬁmm'eht::::::::::::::::::::
=
AME_
Class A 1. Select columns
molWeight s s
mo,wgg hd to make visible.
mollogP ;I
0K l Cancel

8.1.28 Column Order

To re-order the columnsin atable:
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* Right click on any column header and choose "Manage Column
Visibility and Order"

» A diaog box as shown below will be displayed.

* Click on the arrow buttons to re-order. Multiple columns can be
selected by holding the Ctrl key and clicking.

B Manage Column Visindity and Order 7 *
Wisibie Hiiden
' Kl -
ol 5 'Spnny"ﬁ
. moiFs A Commeant
1. Select columnis) | L] =
( t (<) NAM i 2. Click on order
O move. ] C
b 4 - button
moiWeight :I
maoilogs
moilogh é]
K Canced

Wrake column visible mi]
§ | e Hizhe column

Wi selerted visle columng 1o th top e P

Whove selected wisible columns up = ﬁ'—|
W e Biove selected visible columns down

M e Wi selpcted visible cobumins to the botiam

8.1.29 Freeze Column

NOTE One application of Freeze column isto rename rows.

To freeze a column:

» Right click on the column you wish to freeze and select Freeze
Column.

To unfreeze a column:

* Right click on the column you wish to unfreeze and select Unfreeze
Column.

8.1.30 Freeze Row

To freeze arow:

* Right click on the row number of the row you wish to freeze and
select Freeze Row.

To unfreeze arow:

* Right click on the row number of the row you wish to unfreeze and
select Unfreeze Row.

8.1.31 Column Statistics

To calculate various statistics describing columns and inter-column
relationship:
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Right click on the column header and a menu will be displayed.
Select "Column Statistics"

The output is printed into the ICM Terminal window and the Column
Statistics Window.

8.1.32 Inserting Rows

Toinsert arow:

I dentify the position within the table where you wish the row to
beinserted and sel ect therow.

Right click on the row name (eg the number of the row) and a menu
will be displayed.

Select Insert Row Before or Insert Row After.

A blank row will be inserted. Y ou can add data to this row by following
theinstructionsintheedit tabl e secti on.

Select row
&al e3us
PDE Search results for ™
D | head l date | tille
|1hh LIGASE 01/msm mmmi:mmm;mm
Right click — syrilhetaze from mycobactesium lubsiculosis
here | By Cut Rowls]
B Copy Row(s) 01/01/01  ma dependent ina palymerase from dana bactenophage £
phifi plus bound ntp
W Faste Fo
01/00/01  muillicopy ciystalographic sttucture of a ielased glulamine b
Delete R
. Do il syrilhetase fram mpcobactetium Wbeiculosis
Inzern Emply Row Before
(B Inzei Emply Row Afle: FACTOR O01/00/01  crpstal structure of destripeptide (b28-b30] insulin

4

8.1.33 Insert Image

Toinsert an imageinto atable:

First create an image column in the table. Usethel nsert Col un
option and choose Function > New > Image.

Right click on acell in the new image column you have created and
choose Set | mage and choose the image you wish to import.

8.1.34 Copy Cut and Paste Row

Copy, Cut and Paste Row:

Select therow(s) See tabl e sel ecti on secti on.

Right click on the row header

Select Copy Row(s).

To paste arow select the row header under which you wish to paste
the row. Right click and select Paste Row(s)

8.1.31 Column Statistics
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Select row

PDE Search results for ™

D | head date | tille |
|1Hn LIGASE 01/ crystallographic: stiuctuee of & relaned ghutamine ]
Right click — 4! My CutRows) synilhetase from mycobacterium luberculosis
L — &2 Copy Row(s) 01401701 ma deperdent ina polymerase from done bacleiophage  E
phit phas bound ntp
WL Faste Fow
¥ Delete Rowis) Q1/001  mullicopy ciystalogiaphic stucture of a relaxed ghilamine b

syrilhelase from mpcobaclesium lubeiculosis
Inzert Emply Row Before

Insed Emply Row Afle: FACTOR |01/01/01 | crystal stiucture of destripeptide [b28-b20) insulin b

4

Lt ATRLIATIIRLL SERAE AT T e I L T Y ¥ T T N S .

8.1.35 Copy Cell

To copy atable cell:

* Right click on cell.
» Select Copy Cell - you can then paste it into a new table.

8.1.36 Copy Selection to an ICM Table

To copy a selection to a new table:

» Select therow(s) See tabl e sel ection section.

* Right click on the row header

» Select Copy Selection to ICM Table and then choose Auto (ICM will
name the table or New and you can enter a new table name.

8.1.37 Deleting Columns and Rows

To deletea column or row:

» Select the column(s) or row(s) you wish to delete. Seethesel ect
t abl e section for information on how to make table selections.

* Right click on the row number to delete arow or right click on
the column header to delete a column and select the delete option
from the menu.

8.1.38 Hide and Show Columns

If you have alarge table you may wish to only show and display certain
columns and hide others. By default any loaded table will have all the
columns displayed.

To select which columnsyou wish to hide:
» Select the column(s) you wish to hide. Seethesel ect tabl e

section for information on how to make table selections.
» Right click and select the hide option from the menu.
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1% | NAME| Score | Natom| Nflex| Hbord | Hphob [ Wit | Eind

103476 il 35.47 3 0 43 -4.97 33 1.49
103485 il -44.18 36 1 -10.40 -1.35 -34.44 561
103522 il -36.40 45 1 -6.74 .44 -38.20 1.1
103526 m1 A 3 1 -11.60 032 34,65 326
103547 m1 33241 a6 0 -7.53 -5.89 3312 1.13
103566 m1 3513 43 4 A13 -7.93 -44.10 4.43

able; 12923 rows, 13 [of 14] columnz

[ T

Hide:

b Column histogram

*

Renarme ...

Delete column(z)]

Calar By

Ingert column after ...

Ingert column before .

Sort
Filter

-

Select column(s), right click and then select the hide option.

To show hidden columns:

» Right click on the column header and a menu will be displayed.
e Select the Show Columns options.
»  Select which column you wish to show from the drop down list.

-
I | NAME| Score | Natom| Mflex| Hbord | Hphab [ v Hfd"' S

=] Ide
103476 m -\47 1[0 AN 497 D

— Rename ...
103485 1 4418 ® 1 1040 73/ 34

—i m ¥ Delete column(z)
103522 ml 3640 46 1 674 744 38

— Color By
103526 m 3720 W 1 1160 B3 M
103547 ml 3321 3% 0 753 68y 33 meeteshmnafer.
103566 ml /13 43 4 513 793 44 Imeertcolmn before
103592 ml 301 4 2 433 783 43 Sot
103614 m 325 a5 871 547 29 ol
103615 ml 3495 43 1 784 7B8 38 Fiker S
103621 ml 3448 3 0 687 G013 208 ghi

— mfScore
103626 ml 3270 34 0 700 472 3559 215 6l L
103848 m 311 N 3 740 BE3 3808 493 293 nos
103707 m 3211 850 4 591 783 4316 212 1618

table: 12923 rows, 10 [of 14] columns

Note: In versions 3.8-6 and higher thereis an option called "Manage
Column Visibility and Order" as described her e.

8.1.39 Column Format and Custom Actions
To change the column for mat, font color or size, the alignment of the

column data, the background color, add hyperlink, or script:

* Right click on the column header and select For mat

8.1.38 Hide and Show Columns

347



S LI JLauEss. ..

Sort

Filker 3

= (g Learn...

Group by Column...

Farmat....
3,

2.4 ‘ AMP.CIT MN GLMAT_MTCT

Right click on the column header

» A window as shown below will be displayed.
» Makethe desired changes and click Apply

Column Format: A

Fonk

[ gald [ 1talic
Font Size ||3 = |
Background

() Single Color m

Alignment:

() Default (O Left O might (O Center (3 Juskify

Hyper Link |Nn Lirik, V|

Formak | |

Display Mame | |

I ok H Apply H Cancel ]

Toadd a hyperlink to PubMed, PDB or Uniprot:

» Click on the drop down hyper link button.

 If thedatain the column isaPDB, Uniprot/SwissProt or PubMed
code then choose the built in format from the menu.

» Click Apply and the datain the column will become blue
hyperlinks.

To add a user-defined hyperlink:

 Click on the drop down hyperlink button.

» Choose"Simplelink" See below for details on how to access cell
data.

e Click Apply and the data in the column will become blue
hyperlinks.

Toadd an internal ICM link:
 Click on the drop down hyperlink button.

» Choose"Internal ICM link™ See below for details on how to access
cell data.
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» Enter ICM scripting language in the panel that opens (see image
below).

» Click Apply and the datain the column will become blue
hyperlinks.

The value of the clicked cell is accessed as %1. To refer to the other
cells and/or table itself the following shortcuts can be used:

* %@ # table name

» 9# # clicked row number

* 99" # clicked column number
Example:

To add aan internal ICM link that reads a pdb dile and then displays it
you could use the following ICM commandsin the link:

Column Format: 1D

Faonk

[ Bald [ 1talic

Font Color ==- --j
Faont Size ] Ex
Background

& single Color ==- —
Alignrment

(%) Default (O Left O Right (O Center () Justify

Hywper Link Inkernal ICM link. v
A % d Format | <a href=#_»%1<fa=
read pdb %@, %o [Yoit]
shles caol
k POE
ID hiead
1 1hil RIMA,
2 1hto LIGA,
4 1hty HOR
= 1ty STRL
B 1kpm HCH
7 1s0p MEMA Display Marme
2 pca il [ Ok ] [ Apply l [ Cancel
<

8.1.40 Column Table Annotation

* Right click on the column you wish to annotate and choose For mat,
Color Action.

» Enter the comment in the bottom panel |abeled Comments.

e The commentswill be displayed when the user hovers the mouse over
the column header. Other table comments can be added using the
HTML panel .

8.1.40 Column Table Annotation
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8.1.41 Table Sorting

Tosort atable by a column value:

* Right click on the column header.
» Select the Sort option.

| PDBSeachResuls lhitlist ]

PDE Search results for ™=

I | head

Tuot REGULATOR OF COMPLEMENT PATHwAAY

e ELECTROM TRANMSFORT

To5) UMKENOWN FUNCTION

ToSh STRUCTURAL GEMOMICS, UMENDWM FUMCTION
To5i OxIDOREDUCTASE

Tozr ISOMERASE

Tawg LUMINESCEMT FROTEIM

Tqyo LUMINESCENT PROTEIM
Tewn | Thdkd] IMF SETF b

date her| hHe

ASep 203 Hide 54

3 Sep 2003 [t] Calurin hRistograr EISA o
95ep 2003 Rename ... F PEHIELASH@LEPJEAL
7 5ep 2003 % Delete columnis) F F'UT.-’-'l.TIVE SEHINE E
7 Sep 2003 Insert column after ... F 3 DXDAE‘.\').L ,[AE:KL

7 Sep 2003 Insert column before .., TH.E. &THE&SHEHHE._GP

e -
S0rk
1 Sep 2003 " R OM INTERMEDIATE
M San A2 Filker hd 252 TTORARPL F%'F T

ler 22700 rows, 10 columns

Right click in the column header

8.1.42 Table Filtering

| Vi deo |

1 non-:

L The arrow represents ascending
or descending order.

There are two ways to filter table content one is via the table panel or

by using theright click column header options.

Tofilter atableusing the extra panel diders:
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SR R AR R How to apply filters to a table.
BB O S8 "8ad H B 1. Click here | HD 4 3% « TEH &4 8 8
s to view extra g &
0 Search - Y ow . = |peo ety rone |
panel (right} a
R - T
= By e 2. Ciuck on the ¢
-] T g;;_! riof HBA | nof 1 Filter tab i b 4
i & ol Ftars
A ™ - .
[ 2 3
6. Symbol & \ i -
5 " o oo M =
indicates - s i w i =
65 column has 3. Click here 4. Drag to 3
been filtered DNt M make changes :
- filters .
7 B’ :
chirgl 2 z 150 500 1
\ 7N :
&6 | F1
\':_/ 5. Click to =
\ apply or i)
removefilters | |
ichirgd 4 4 g
\ »
. /“‘R_L"_F/"—"'\
~ % ‘ ]
06 BOE s 6 e R

Open the extra panel and choose the filter tab. Click and drag on the
dlidersto conveniently choose the filtering values or enter the values
directly. Click on the green 'tick’ to apply filters.

Tofilter atable using the column header:

» Select the column you wish to filter. Seethesel ect t abl e section
for information on how to make table selections.

* Right click on the column header.

» Select the Filter option.

= HiTUST | PDBSearchResuts | hitist |
FDE Search results for ™
ID | head e~ el

1 1sht HYDROLASE [SERIME PROTEINASE) 1 Hide tes for subtilisin BPI
2 Tmbr| OX¢GEN STORAGE ot [l Column histagram jstry of the Protein t
3 2dkb| 0¥ rGEM TRAMSPORT o Rename ... lal fournier synthezis
4 3idh | 0XIDOREDUCTASE, CHOH DOMOR, MAD ACCEPTR  0F % Delete column(s) the:sFtLrL:cltures. of &
5 Zcha HYDROLASE [SERIME PROTEIMASE) E Tnsert calumn after ... Ciystaline AlphaTl
5 4z HYDROLASE (0-GLYCOSYL) B 1nsert column befors . flEment of the struet
7 Alyz |HYDROLASE [0-GLYCOSYL) Sark erment of the stuct
g 1lyz  HYDROLASE [0-GLYCOSYL) o " s

a Flo= H%TBEO ASE M= S T0Ss1 FI' (Clear)

</ (Clear Al

(Custom ...}

.| . | table: 22700 rows, 10 columns

» Select the "Custom" option and a data entry box as shown below

will be displayed.

» Enter the appropriate operations and filter values for your

search.
» Click OK.
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-, Custom filter on, ‘date’

2%

|equals ﬂ ||
{* And " 0r
|equal3 ﬂ |

W Case Sensitive

Ok | Cancel

NOTE: When a column has been filtered a symbol as shown below will
appear in the header of the column.

k| HITLIST | POBSearchResults lhitligt l
PDB Search resulks for ™
ID | head =r date het| titlle
21260 [Tnio RIBOSOME 012 Jan 2003 | PPL THE CRYSTAL STRUCTURE OF -
21261 |Tnit HYDROLASE 02Jan 2003 ACE COMPLEX STRUCTURE OF HCMY
21262 |1nis TRAMSFERASE 02Jan 2003 HUMAN GAR TFASE IN COMPLE>
21263 |1nig METAL BINDING PROTEIN 02.Jan 2003 ACE NMF STRUCTURE OF THE SING
21264 |1nip RIBOSOME 02Jan 2003 FPL THE CRYSTAL STRUCTURE OF -
21265 |1niu HYDROLASE 02Jan 2003 | DNI COMPLEX STRUCTURE OF HCA
21266 |10a7 HYDROLASE 02Jan 2003 STRUCTURE OF MELANOCARPL
21267 |1oab HYDROLASE INHIBITOR 02Jan2003  THE SOLUTION STRUCTURE OF
:1|".|E‘0 1-~=FR H“MEMOI ACE IMHIPITOR N2 1 zw 20072 TI-IE erl ||T|nh| C‘CTl:!lll—"Tl ||:!E I-I|:

. . table: 1441 {of 227000 rows, 10 calumns

To append thefiltered information into a new table:

This symbol means that the table has been
filtered according to data within this column.

» Select the whole table either by right clicking or pressing Ctrl

A.

* Right click on the table and select "Append to other table".
» Enter anew name for the table you are appending with your filter
results.

OR

Selected rows can be appended to a new table by:

* Right clicking on the selected rows and a menu will be displayed.

» Selecting the "copy selection to ICM table" option.

A table can befiltered by a cell value:

» Byclickingonceinacell.

» Right click and amenu will be displayed.
» Select the option "Filter by cell value®

A filter can be cleared by:
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* Right clicking on the column selection and selecting Filter/Clear
or Filter/Clear All

8.1.43 Append Table

To append rows to anew table:

e Sel ect therowsyou wish to copy to anew table.
» Right click on the table and choose Copy/Append Selected Rowsto
table.

Or you can use the Tools menu option her e.

8.1.44 Mark and Select Rows

A row in atable can be marked and grouped by alabel which enablesthe
row(s) to be selected easily at alater time.

Tomark arow

* Right click on the row in the table you wish to mark.
* Select Mark Row/ and then choose a number. In the GUI the number
of rows that can be marked is limited to 5 but this can be
increased using the command line command.
* A row that is marked will be colored - each number is assigned a
color. The coloring can bechanged inthegui tab in preferences.

|4 Cell hesd(3) v I

PP Ty
Select Marked Riows 3 1
10 [ head Bty Copy Cel CukC | souce
1 Tho LIGASE [ 3 WYCOBACTERIUM TUBERCLILOE
2 1hil | FN& POLYMERASE & Piin Table.. Culep i ssiophage | BACTERIOPHAGE PHIG
3 1hea [UBASE o Ty—— d ghilasiire | MYCOBACTERIUM TUBERCULOS
4 Thtv HORMONE AGROWTH FACTOR 1A/ | cpstal strunctune of 08t pmpmsepme] HOMO SAPIENS
5 Thiw STRUCTURAL GENOMICS, UNKNOWN FUNCTION 01401/01  complesc of KOOGS vith adp and maghesium HAEMOPHILUS [NFLUENZAE
& Thpn HYDROLASE OLANI/OZ | st stmachurad evidence of a specific [rhibdion of DABDI RUSSELLI PULCHELLA
7 1vBa TRANSFERASE 0101704 stnuchure of hycravpethykhiszole kindke protein from FYRODOECUS HORIKOSHI
8 140p MEMBRANE PROTEIN 0101 /04 | smachurs of the rtererinal demain of (1 aderyhd DICTYOSTELIUM DISCOIDELIM
9 2doc Hydrolase 0101706 | etay ciyetal shichuns analysis of bavine spleen calhepsin BOS TAURLS
Right click here and select Mark Row Coloring relates to numbers

To select marked rows

* Right click on the table and choose Select M arked Rows and choose
anumber which relates to the marked rows as described earlier.

» Selected rows will be highlighted blue - once rows are selected a
number of right click options are activated such as copy selection
to new ICM table.

8.1.45 Group View by Column

To group a column by value:
 Right click on the column header and choose "Group View by

Column". Chemicalsin the same group are grouped in the same row.
Y ou can expand the view by clicking on the "+" sign”.

8.1.43 Append Table
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3 Mchet Molioht s 38-3 [MewProgect <] {1 table)

[Gmup by column. ]

BERo 90 TR0 HEeFiEE Bl s08% F184281
starch e £
FOE Saa o - D v i [A8reds = PR _)
) 1. Right click &
and choose
ol Molenue farme i dam &, . o
e Group view by 5
column®, &

Hetamane

HiM

Barntrigging 3z
+ 50 {1 of 33
]
2. Each group can be 8
Pyraznamide 3 4
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To remove grouping:
» Right click on the column header and choose "Undo the Group View"
8.1.46 Mouse and Cursor Actions on a Table
The actions resulting from a mouse click or cursor on atable can be
changed by:
* Right click on atable and select Table View/Show Extra Panel
» A pand as shown below will be displayed.
PDB Search results for kinase'
| SOLTCE ﬂ ﬂ Headet |
I_Piamle kinaze protein Fiom PYROCOCCUS H_I Wame Value
wagine kinase domain of the HOMO SAPIENS 1 abde Tithe PDE Seach iesuls foe 'chekinasa's/,
_bac;e_ﬁrn b.ben'_.'ubs!s ﬂ'r,!rnﬁ:_la!e MYCOBACTERIU doubleClick e 1 0 1D PO D
1 ndp kinase DICTYOSTELIUK — o :“—_d’;af";'ﬂ .
eta HOMO SEPIENS :ep?,;mﬂh ;’:;"" _
g8, mukation iBSg SACCHARDMYCI
ine monophosphate kinase|thil]  AQUIFEX AEDLIC
Right click here and select Table View to display and Double click here to edit actions

undisplay extra panel

» Doubleclick in the Value column and the column can be edited. Add
ICM commands for the action you want. A value in a column can be
referred to using "%" e.g. column two would be referred to as
"%2". In the example shown above the function nice is acting on
the contents of column one for the double click action.

NOTE: The action associated with cursor and double click is placed in
avariable name TableName.cursor and TableName.doubleClick
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8.2 Molecular Tables

Availablein the following product(s): | CM Chemi st || CM Cheni st-Pro
[l CM VLS

An ICM molecular tableis created when an SDF or Mal fileisread into
ICM. To read and open amol or sdf file go to File/Open ( See CGpen an | CM
file section) All of thetable functions described in the previous
section St andard | CM Tabl e can be applied to molecular tables. Molecular
tables are described in more detail inthe Chemi nf or nat i ¢cs chapter.

An example of an ICM molecular table:

Cramicall_Spraacenest g : " i -
; Grid, Form and Table views., .’ﬂﬂ[ Filtering and Searching tools, ]
e asight
FRCEme  Atandisl 286.1
K,k meLoghP
425 : . 1%
i _}—‘/ m o 13
[ ®
_{“ or &9
raCermes  feetoprok 267.2 o :F
/
- _(_1
426 . _}_f g)_/_ a
__i :
10
racams  Batunciol 7.2
w et @
D>
racamm  Eemoiol 295,23
Sl L
438 Fully editable and linked to rich set Plots and trees are fully interactive
: of cheminformatics tools. and linked to spreadsheet,

8.3 Insert Interactive Objects into
Table Cell

Availablein the following product(s): | CM Chemi st || CM Chem st - Pro
|1 CM VLS

NOTE: Thisoption isavailablein Version 3.7-2b and above.
To store objects in atable please use the following:
Example:
read pdb "lcrn"

display a_
add colum t Parray( object a_ preview)

Viewing Objects from the table can be dragged and dropped into the ICM
Workspace to display them again.
How to makethe objectsin thetable fully interactive

* Right click on the column header and select "Live Rotatable View"

8.1.46 Mouse and Cursor Actions on a Table
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8.4 Plotting Table Data

Availablein the following product(s): | CM Chemi st || CM Cheni st-Pro
[l CM VLS

The data within a table can be plotted graphically. A histogram can be
made for the data within one column or a plot can be constructed for the
data within two columns.

Vinual Screening Data

Scare

T T T T T T T T T
200 300 400 £00 EO0
Maoleight

Tomakeapl ot , hi st ogr amor heat nmap:

* Readinacheni cal spreadsheet or other dat a in spreadsheet form
(e.g. cov).
» Click on the plot button at the side of the table (shown below).

Sl Nl (M

o
2E

Plor, Histogram, Heatmag =

o |E

8.4.1 Column Histogram

To plot a histogram of the data within one column:
» Select the column by clicking on the column header.

* Right click on the column header.
e Select the Column histogram option.
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Click here to select the column and then right click and
select column histogram option

¢ dock_examplz
il Mol'w:n'aight |Scu:|re i‘
403 738 -46.19
cl
0N | jul
Sl
1 0 .\I Il "
e
" a

E

~0 ] a
O O ov© @

K I

436.920

530660

A plot will then be displayed next to the table.

3

@”@;“@

Y I—

8.4.2 Histogram Options

Once you have created a histogram you can change the following

meol Motweight | Scare i‘
403738 -1615
[=]
= 0
Q M =
1 0. A
4 0
-44.81
2
BI0EED 44

44,81

44

Frequency

Moleight

parameters by right clicking on the plot and selecting options

Options:

8.4.1 Column Histogram
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¢ Changeplot title.

¢ Change the data source using the drop down button and select
another column in the table.

¢ Change the histogram bin size.

¢ Change the bars positioning from vertical to horizontal.

¢ Change the bar relative width compared to bin size. Bigger values
give thicker bars.

¢ Color the bars

3 i eas e bbisvsatn Malsnt) I 3. 8.1 [Mewt®rapeet 7] [} tabb)
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% [oz =]
S
* Vesiecal Bant  Horizarial B
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Oghors Li
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o Il T 2 3 4 5 6 7 8 9 W00 17 13 015
o @]
O =T

8.4.3 Histogram Bins

There are two ways to change the bin size. 1. Using the opt i ons dialog
box or 2. interactively by left clicking and dragging at the top of the

plot as shown below - thiswill allow you to find the best density
estimation picture.

H Pouteshiets |
= T Click and Drag Here to Change
3 Ty T T g —— s Bin Size Interactively
2 G5 Eomrbmg, 0, TH Stuchasl Gerimci L [ ——
1 GRLHS. Puegl OM_Eoertw D TEShuchudl  JRAY DFFRACTION 0004+
] Yol Coarg W L 0 KRAY DIFFRACTEON 11 oo
5 Toghealrd. A GBlard G L, St 2 Funiten Prgst XAKY DFFRACTION I.‘|
[ Chaedia V. Jask | Koa, P Betiel, €. Sewvanan A,  SFUY DEFRACTION 11 Em'
7 I"Mmi:].ﬂll'“H Buael L Bowsnkey G P J0RAY DFFRACTION .1J L5 i i BO
(e Jopab-aribun, 3 Tabnoe, T 1 RIEEN Snichas XUk DEFFRAL TION u EI-:G-
5 Wtsrahe 0 HAWY DFFRACTION x i
n | VWataabe, WA COFFTALTION 1 e
1 tarate. D XAy CFFRACTION n 1000
12 watanabe. 0 JCRUAY DFFRACTION H ol
13 Kosbra R, Rn Pbu I Margngth GF. Dot 5. CRAY DOTRACTION u : . ’
1 Blaich_ M, ool Wik WERLAY DEFFRALTIOMN !-,... a 1 2 3 4
il; Cobs BR Ta il D U LB FD W IDAA PEEDD AT I lli_l et
B 8] WO = ) 6 % ratse 51155 . 10 cosens

8.4.4 Plots

To construct a scatter plot from data within two columns:

¢ Click on the plot options button (right hand side of table).
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» Select the data from the drop down options in the Data section of
the dialog box. There are additional optionsto changethe col or,
mar k shape or size,andgrid and axi s display.
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8.4.5 Multiple Curves

Multiple curves can be added to aplot:

Makeapl ot of thefirst curve.

Right click on the plot and choose Options.

Select the "+" button next to Curve data entry box.

Enter new X and Y datafor the second Curve.

Shading as shown in the image below (red shading) can be achieved
by selecting Plotting Style > Vertical bars.
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8.4.6 Heatmap

To generate a heatmap:

Read in atable containing the data.

Click on the Plot/Histogram button on the side of the table.

Click on the heatmap tab at the top.

Add the data sources you want in the heatmap based on the column
headers in the table.

» Check how you want to label the rows.

 Edit the color gradient if necesary.

e Click OK.
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8.4.6.1 Heatmap Example

This example shows how you can place a fully interactive heatmap next to

atree.

Read in table d.tsv from here:

ftp://ftp.mol soft. com pub/workshop/ (1. cut and paste the address
into aweb browser. 2. Right click on d.tsv and choose "Save Link
As'. 3. Openthe.icbin ICM File/Open).

Select numerical columns by clicking on the column header and
holding CTRL key.

Right click on the column header and choose " Reorder by
Clustering".

Click onthecl ust er button on the right hand side of the table
and use the default options.

Right click in the cluster and "Change Record Labels'

Check color check box and click ' Add All Numerical’

Remove cluster related columns from theend ('cl’ "ord’, etc ...)
Click OK atree and heatmap as shown below will be displayed.
CTRL +/- allows you to zoon in and out.

8.4.6 Heatmap
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8.4.7 Pie Chart

To generate a Pie Chart:

* Read in atable containing the data.

¢ Click on the Plot/Histogram button on the side of the table or
right click choose Options on aplot.

¢ For Histogram choose Plotting Style > Pie radio bin. Number of
bins/sectors can be controlled the through the 'Bin Size’
parameter. For Plots choose Points > Plotting Style > Pie’ X’
should be discrete (integer or string column with categories), 'Y’
- any numerical column.

Wiost Common Cause of Cancer Death

X% Plots:
e L TP
e I | Boim - L’;ﬂ
&W"'ﬁwyw
Histograms:
Sz
27 ypetical Sy r e
‘ <
Lo T

8.4.8 Add a title to a plot

Toadd atitletoaplot:

¢ Right click on the plot and select Edit Title or choose Options
8.4.9 Axis Options

Each axis has a set of options which can be accessed by right clicking
on the axis and selecting Options.
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To changethetitleof the X or Y Axis:
* Right click on the axis and select options
To changethedatarange:

» Right click on the axis and select options
e Change the From and to values in the Range box

To changethe Grid steps (ticks) on the X or Y axis:

» Select either afixed step e.g. 10 and you can define the number
of subdivisions (ticks) in each step. Choosing 1 will display zero
ticks between divisions.

To changethe axisto logarithmic

* Right click on the axis and select options
» Select the Logarithmic scale check box

8.4.10 Change Axis Data

ToswaptheX and Y axis:
» Right click on the plot and select Options.
e Select the Swap X and Y button.
» Click OK.
To changethedata sourcefor either the X or Y axis:
» Right click on the plot and select Options.
e Select the drop down arrow as shown below and select a different

column from the table.
* Click OK.

8.4.11 Logarithmic Plots

To changethe scale of the axisto logaritmic:

» Right click on the plot and select Options.
e Select the Logarithmic check box.

8.4.12 Change Mark Shape or Size

To changetheplot mark, shape, styleor label:
» Right click on the plot and select Options.
» Select the desired size and shape using the drop-down buttonsin
the M arks section of the window.
Toadd point labels:
» Right click on the plot and select Options.
» Select the drop down arrow in the Point labels dialog box
 If you only want to label selected points check the Show labels

for selection only option. Making plot selectionsis described
her e.

8.4.13 Change Mark Color

To changethecolor of the plot marks:

» Right click on the plot and select Options.
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Calor

Source

In the Color section of the window select the Sour ce (column name
plotted as X or Y) you wish to color.

Select the color palette and choose the desired color or you can
choose a Gradient of colors.

Color palette button

l

| Mol/eight x| @

Gradient |red.r'u:urangea‘yeIIowa‘green!blue#darkhlue!purple ﬂ e

Color gradient editor

To edit the color gradient

Right clickona __| R M !
color panel to edit it _H:I [ R S R

Click on the Color gradient editor button and awindow as shown
below will be displayed.

Click and drag on amark in the gradient plot to change the color
gradient.

Right click on acolor in the Y-axisto - Edit, Duplicate or
Remove Color.

The color gradient can be applied to al pointsin the data or for
afixed range.

9 Color, Gradient Editor

Edit Colar....

Duplicate Color

| Click and drag to change
gradient

i'I'I'I'I'I'I-'i'i'I-'I-
0.0.1020.30.4050.6070.680.9 1.

Data range

f* Calculate from the data

" Fized range  from |EI to |‘|

(] | Cancel

8.4.14 Grid and Axis Display

Toremovethegrid display and/or highlight the axes:

Right click on the plot and select Options.
Check the Show grid or Emphasize axes options.

8.4.13 Change Mark Color 365
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8.4.15 Least Squares Fitting
Tofit thedatato a straight line using least squar e fitting and report
the equation:

» Right click on the plot and select Options.

» Select the check box for L east squar esfitting line.
e Choose Linear, Logarithmic or X=Y.

Regression line and value

8.4.16 Zoom, Translate and Center

To zoom into a plot:

* Click outside the plot on the | eft-hand-side and drag the mouse or
use the middle mouse whedl to zoom in and out.

Totrandlate a plot

 Click, hold and drag using the middle mouse button on the plot.
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To center onto a plot
* Right click on the plot and select Center all or Center Selection.
Making selectionsin aplot is described in the next section.

To center into an axis

Right click on the axis and select center.

To zoom into an axis
» Hover the mouse over the axis until you see a blue rectangle

surrounding the axis.

User the middle mouse wheel to zoom in and out as shown below.
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8.4.17 Plot Selection

To make a selection in a plot:

» Click and drag in the plot to make a selection. Individual points
can be selected with asingle click.

8.4.16 Zoom, Trandlate and Center
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Click and drag to make selection Red squares represent selection

All selections are directly linked to the table from which the plot was
made. Selectionsin the table are highlighted in blue.

2088 III

Selection highlighted in blue in a table

FPlot selection

SolEl

Non-contiguous selectionsin the plot can be made by holding the CTRL
key.
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8.4.18 Point Label

To add alabel to one or more points:
» Right click on the plot and choose options.
» Look for the section Points and the dialog box *{ Points L abel s}
 For this example we will use the drop down button and choose
"mol".
» Check the option show label for selection only.
To drag the label:
» Left click on the label and drag.
To make the label display bigger

* Hold the Ctrl key and use the middle mouse button.
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8.4.19 Print Plot

Toprint aplot:

* Right click on the plot and amenu will be displayed.
» Select the print option.

8.4.20 Saving a Plot Image

To saveaplot image or copy to clipboard:
 Rifht click on the plot and select Options and then check the
antialias button. Click Apply and OK.

* Right click on the plot and amenu will be displayed.
» Select the Save/Export I mage option.

8.4.21 Table Inline Plots

Plots can beinserted into a tablerow by:
» Select the columns you wish to plot.

* Right click on the column header and select Inline Plots
e The plot will then be displayed in each row of the table.
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8.4.22 Annotate Plot

Y ou can add text, lines, rectangles, and ellipse to a plot. To annotate
aplot:

» Right click on aplot and select Annotate.
» Select the draw element and then click on the plot.
* Change the draw element propertiesif neeeded (e.g. font size).

&) Annotations P

|

|

9 selector | Line X = |
i [ Fill Color... - M5 Shell Dig 2 = i

|

|

&% Ellipse % Rectangle

aa Text [ Outline Color. ..

<

8.4.23 Plot R-Groups

To plot R-groups e.g. from theresultstableof | i brary deconpositi on.

* Click onthe pl ot button on the side of the chemical spreadsheet.
» Select the R-group column for the X and Y axis.
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8.4.24 Tooltips Balloons

When you hover over apoint in aplot it is sometimes useful to be able
to visualize some data regarding that plot. Y ou can do this by setting a
ballooon.

» Right click on the plot and select Options.

 Enter the name of the columns containing the data you wish to
display in the balloon (e.g. mol, ID).

» Hover over apoint in the plot and the balloon will be displayed.

8.4.23 Plot R-Groups 373
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Availablein the following product(s): | CM Cheni st || CM Chemi st - Pro
[l CM VLS

Principal Component Analysis (PCA) is the younger brother of ICM’s more
powerful data analysis tools, like property prediction and cl ust eri ng,

though it still may give a good description of the data with afew

columns or even chemical compounds. PCA is amathematical procedure that
transforms a number of correlated variables into a number of smaller
uncorrelated variables known as Principal Components The first component
accounts for as much of the variability as possible with the rest of the
components accounting for the remainder. PCA may be very helpful when
you believe the data actually contains only afew meaningful components.
Principal components are linear combinations of the provided data

columns.

To perform a PCA analysis atable (either chemical or standard ICM
table) needs to loaded into ICM. For information regarding | CM Tabl es
and | CM Chemi cal Tables please follow these links.

To begin the PCA procedure

374

* Rightclickonal CM Tabl es and| CM Chemi cal

Tabl e and select the

PCA option. It isimportant to right click inside the data table
and not on a column or row header in order to see the correct menu

on which pcais listed.

» Select which columns you wish to incorporate into the PCA

analysis.

8.4.24 Tooltips Balloons
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€ PCA Parameters @@

Table: | mielanin J
Column Prefix: FLC
P Number Limit |2 2

Explain Data Warance [%]; |EIEI

Descriptors:

" the "mol" column and all numerical colummns
(" the selected columnz only

{* the mal column anly

Flot principal componets:

" Do not plot
™ Build scatter plot for the first 2 components

fo" Build colored scatter plot for the first 3 components

Ok | Cancel Help

» Enter the table name on which you wish to perform the PCA
analysis. If only one tableis loaded this option will be greyed

out.

» Enter the number of Principal Components (PC number limit) you
wish to generate. Generally 3 principal components may be
effectively visualized and it will be enough often to fulfil the
data variance percentage requirement (see next option). The value
displayed in the terminal window under the heading "cumulative
explained data variance" will show what percentage of datarelates

to each PC.

» Enter avaueinthe"Explain Data Variance (%)" data entry box
(99% is the default value) if you prefer thisindirect way of
limiting number of PC. The algorithm will stop when either PC
number or explained variance limit is reached, so if you want only
one of this criteriato work, make sure that the other limit is
weak (by assigning accordingly the number of PC limit ahigh
value, e.g. 50, or setting data variance to 100%).

 Select which descriptors you would like to include in the PCA

analysis.

» Select which plot you would like to display. If you choose to
display aplot use the color key on the side of the plot and the
information contained within the ICM terminal window to relate
which axes and points relates to which PC. PC3 is usually the
color in the plot with the values displayed in the plot key.
» Click OK and if selected a plot will be displayed on the
right-hand-side of the table. Points within a plot are linked to
the table and can manipulated as other pl ot s contained within a

t abl e.

8.6 Learn and Predict

Availablein the following product(s): | CM Cheni st - Pro || CM VLS
Please click here to go to the Learn and Predict chapter.

8.5 Principal Component Analysis
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8.7 Data Clustering

ICM alows you to create hierarchical clusters for chemical and other
objects. Cluster trees can be used for:

Navigation through large data sets.

Selecting group representatives (taxons).

Filtering tables to exclude redundancy.

Finding similar elements, and more.

Creating hierarchical views of data setsin many different styles,
with subsequent image export/printing ability.

8.7.1 Cluster

Availablein the following product(s): | CM Chemi st || CM Cheni st-Pro
[l CM VLS

To perform clustering based on chemical similarity or any other data you
must have an SDF file or table loaded into ICM.

» Right click on the table and select the Clustering option OR
select the Chemistry menu and choose the option entitled Cluster
Set.
OR
» Toolg/Table/Clustering.

A data entry box as shown below will be displayed.

21 Clustering Parameters ? *
Table: |.‘»:idict :J
Marne: |

Take Labels from Column: | MAME _ :J

[ Keep the euisting trees

I Add column with duster rumbers, name: | d
[T 8uild for the selected 0 rows (at ieast 2 required;

Descriptors:

{+ the "mol” column and 2l numerical columns 7 the mol column only (2D pharmacophore)  |dimt_UPGMA -

(" the selected columns only {" the seq column only
" the "mol” column only {fingerprints) i use existing distance matrix:
Method:
(s Tres Memary required: 1 MB
Parameters:
Linkage type: LIPGMA |

[ Keep distance matrix

" Compressed hierarchical dustering
oK I Cancel ‘ Heip !

» Select the table you want to cluster from the drop down menu.
* Givethetreeaname.
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Select the column you would like to use to label the tree (this

can be changed or appended to once the tree has been made - right
click on tree and choose "Change Record Labels".

Y ou can choose to keep the existing tree.

The cluster number names will be added to your table - you can
change the label of the columns (default = cl).

Now select the descriptors you wish to use for clustering.

The"mol" column and all numerical columns.

The"mol" column only (2D pharmacophore)

The selected columns only.

The sequence column only.

The "mol column only ( fingerprints).

Use existing distance matrix. UPGMA is alinkage method which is
used to group tree nodes together. (they are described in the link
below). dimt_ UPGMA is used when ’"use exiting matrix’ modeis
selected. It can be any exiting matrix. This usually comes from
previous clustering if ' Keep distance matrix’ option was selected

Select the method you wish to use for clustering.

UPGMA (unweighted pair group method using averages): Distance

calculated isthe average of all elements (recommended).

https://en.w ki pedi a. or g/ wi ki / UPGVA

Single linkage: Nearest neighbour linkage -

https://en. w ki pedi a. org/w ki/ Si ngl e-1inkage_cl ustering
Complete linkage: Furthest neighbour linkage -

https://en.w ki pedi a. or g/ wi ki / Conpl ete-|i nkage_cl ustering
WPGMA: (weighted pair group method using averages): Rough

approximation of weighted (slightly faster)

Farthest

https://en.w ki pedi a. org/w ki / Conpl et e-1inkage_cl ustering
Ward: https://en.w ki pedi a. org/ wi ki/Ward¥%27s_net hod

UPGM C: Centroid linkage clustering

UPGM C-corr: Correlation clustering provides a method for

clustering a set of objects into the optimum number of clusters

without specifying that number in advance.

NOTE If you wish to cluster a selection of atable; first select the
compounds you wish to cluster (Ctrl A will select al or see the
section of the manual entitled maki ng t abl e sel ecti ons.

Check the option "Keep Distance Matrix" if you wish the Distance Matrix
to be saved.

8.7.1 Cluster
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8.7.2 Tree Selection

A number of different selections can be made once the tree has been

created
: HOR-2
o ——1 T ones
Click in free area — +  TAFEDIPINEDILOL-A
i SBE-215355
unselects all {53_209834
_;:53—234551
H SE-247083
; S-1255

———EMD-12294%6
; PD-161721

Click on node selects — PD-156707

node and all its heirs FD-163070
PD-155080
PD-166557
RPR-111613
RPR-111244
RPR-118031-4
RPR-111723
RPR-109552
RPR-110477
BL-4170
ENRASENTAN
SB-219862
SBE-208601
SB-220501
SB-217585
SE-209670
SB-219730
SB-225757

Click in label zone selects
hode

» Clickinfree areaunselectsal.

» Click on node selects node and al its heirs.

» Citrl+click addsto (if not selected yet) or removes from (if
already in selection) current selection.

» Shift plus click allows arange to be selected.

* Click inlabel zone selects node.
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» Keyboard "Up"/"Down" cursor keys move selected node up/down in the
tree. With Shift held the selection expandsin the according
direction.

» Keyboard "Escape" unselects all.

Select Center Representatives From a Node.
To select the "center" representative compound or value from a cluster.

» Right click in the free area of the tree and select the option
"Select Centers'.

NOTE: Selectionsin the tree will be highlighted in blue in the tree
:SB—247083

5-1255
EMD-122946
PD-161721

and in the table. —PD-156707
Copy selection to new table.

All selections can be copied to anew table by:
* Right clicking on the selected rows in table and a menu will be

displayed.
» Selecting the "copy selection to ICM table" option.

8.7.3 Save and Print Tree

Tosaveatree
Option 1:

» Savethewhole session as an ICM project. See Savi ng an | CM
pr oj ect

Option 2:

» Savethetableasan .icbfile. Right click on table header and
select "save as'.

Tosaveatreeasapicture

* Right click inthe "free area".
» Select "Save Image..."

The image of the tree can also be saved to the clipboard.

* Rightclick inthe"free area’.
» Select "Copy Imageto Clipboard"

Toprint thetree

* Right click inthe "free area’.
» Select "Print"

8.7.4 Tree View

A number of changes to the tree view can be made by right clicking in
the tree "free area" and selecting preferences as shown below.

8.7.3 Save and Print Tree
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| 1
weighted

Efj]_ Close Clusters

) Open
Select Centers

. EF

Select in Clusters... i BE

& Frint . ! EE
! RE

% Save Image... : RE
Copy Image To Clipboard _E: RE.
———FEL

Labels/Sort i

A preferences window as shown below will be displayed.

9 Preferences @@

[ Reverse Growth
[~ FRewverse Order

Use colar for | Calor lines ﬂ
Fill

;l::l:lll:lf lines
Calor lines o parent

o Only labels
Line width L =

Left margin 20 El: Right margin |20 =
ak | Cancel ‘ Label Font... |

Diztance range: from Oto |1

tirimal ine spacing

Rever se Growth:

HOR-2

HOR-4
LABEDIPINEDILOL -4
SB-215355
SB-209834
SBE-234551
SE-247083
5-1255
EMD-122946
PD-181721
PD-156707
PD-163070
PD-155080
PD-166557
RPR-111613
RPR-111844
RPR-118031-4
RPR-111723
RPR-109552
RPR-110477

Distance Range:
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Distance range changes scale here

HOR-2
HOR—4
LABEDIPTIHEDILOL -4

_i_:SEI—215355
! SE-209834
_5_:513—234551
: SE-247083
S5

Color Preferences:

SB-215355 SB-215355
_:88—209834 - SB-209834

SB-234551 SB-234551
:88—247083 ':SB—24?083
L eft: Fill Right: Color Lines

SB-215355 i SB-215355
SB-209834 {88—209834

SB-234551 i SB-234551
SB-247083 —1_Sp-247083

Left: Color linesto parent Right: Only labels

Increase or Decrease Line Spacing:

——SB-215355

——SEBE-2095834

SBE-234551

SB-247083

Increase or Decrease Line Width:

: HOR-2
— | yor-s
pr— [ ABED TP ITHED ILOL—A
i SBE-215355
! SB-209834
! SB-234551
SB-247083
S5-1255
EMD-122945
PD-181721
PD-15&707

] PD-163070
: PD-155080
i PD-166557

Change Font and Margins:
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€ Preferences @

[ Reverse Growth
I Reverse Order

Usge color for | Color ines j
Fill

;l::l:lll:ll' lines
Color lines to parent
Only labels

Line width T =
Left rmargin 20 El: Right margin |20 =
] | \Beccel | JAIH Font... ‘_ Change Label Font

Y,
Change Margins

Diztance range: from Oto |1

kdinimal line pacing

Change Labd
To change the tree labeling (GLOBAL):
* Right click inthe "free ared’ and select the Label/Sort option.

weighted
ﬁfﬁ Close Clusters
) Dpen &l
Select Centers

Select in Clusters. ..

& Frint...
@] Save Image...

%, Preferences...

A window as shown below will be displayed:

e LabelsfSorting @

Edit Object Label Format;
Faormat: |;ZMF;3§MDLN.&ME;%MDL_WEIG HT:

Chooze column; MOL_WEIGHT = | Append to Format
Update Labels

Rank. tree by column: - Fearder
Sort Table by Tree | [ reverse

E it

» Choose the column name you wish to label the elements of your
tree.

* Click the Append to Format button. Y ou may wish to delete some of
the information in the Format data entry box if you do not wish
that column header to be displayed. Note more than one column
header can be used as alabel.

* Click the update labels button to view the changes.
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To change the tree labeling (NODE):

» Right click on the node you wish to change the label of and select
"Edit Label" and a data entry box as shown below will be

displayed.

€3 Node Label
Enter Label

|Enter Mew Label Herel

Q. | Cancel |

» Enter the new label.
Change Node Coloring
To change the color of anode:
» Right click on the node you wish to change the color of and select

"Edit Color".
» Select the desired color and click OK.

8.7.4 Tree View
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9 Working with Local Databases

| CM t abl es are capable of storing tens of thousands records. However,
some problems operate with data sets so large that they do not fit in
computer’s memory. To work with such large amounts of datalCM usesthe
concept of Molsoft database (MOLT) files. Unlike many other tablefile
formats, such as SDF, CSV and others, database files are optimized for

fast search and other operations, like unique entry addition and diverse
subset selection.

Database files do not provide all the functionality available for tables
but they allow the user to organize large amounts of data, search data
using various advanced criteria and share created data collections with
other users. For large amounts of chemical data database files provide
specialized chemical functionality.

ICM provides the following database file operations:

create dat abase fil es from SDF, CSV/TSV, SMILESfilesand from ICM

tables;

impose unique constraints on certain columns upon table creation

to avoid redundancy;

store multiple tablesin asingle file; rename, delete tablesin a
databasefile;

search fast using advanced conditions, including advanced chemi cal
search;

sel ect diverse subset s from chemica database files;
browse dat abase t abl es using flexible filtering and sorting
conditions;

directly edit/delete/insert entries inthedatabase;
export in popular formats, such as SDF (for chemistry) and CSV;
export and import tablesto and from Mol cart .

Chapter Contents:

How to nake a | ocal database
Br owse Dat abase

Edit Dat abase

Query Local Database

9.1 How to make a local database.

Availablein the following product(s): | CM Chemi st || CM Chemi st - Pro
|l CM VLS

To convert afileinto MOLT format.

File/Convert large SDF, CSV to Database (molt).

A Database Import dialog box will be displayed. Select the fields
you wish to import.

Once the file has been converted to MOLT and imported then it will
be displayed in the ICM Workspace.

Double click on the file namein the ICM workspace and the
database browse mode will activated.

9.2 Browse Database

Availablein the following product(s): | CM Chemi st || CM Chemi st - Pro
[l CM VLS

To browse a databasefirst decide how many rows of your database you
wish to view

9 Working with Local Databases

385



¢ Double click on thefile name in the ICM workspace and the
database browse mode will activated.

¢ Select the number of rows you wish to be displayed in the Limit
data entry box.

¢ Click on the Apply button.

¢ Scroll up and down the displayed rows using the scroll bar on the
right hand side of the table.
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To sort adatabase by avaluein a column

¢ Click on the drop down arrow next to the Sort by data entry box
and select a column.
¢ Click on the Apply button.

NOTE: The database will be sorted globally not just the displayed
rows.
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Tofilter adatabase:
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* Double click on the panel labeled and the filtering tools will be
activated.
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Click and select a column to filter (as shown below).
Enter a condition.

Enter avalue.

Add or remove another condition

Click the Apply button
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Toview adiverse set of rows from your database:

¢ Right click on the database in the ICM Workspace and select Select
Diver se Set.
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9.3 Edit Database

Availablein the following product(s): | CM Cheni st || CM Chemi st - Pro
[l CM VLS

To make any changesto a database you must first unlock it:

* Click on the Allow editing rows button which has a picture of a
lock onit.

» Once this button has been selected the Delete Rows, New Row, and
Update DB buttons will become activate.
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D (= O

Todeleterows

» Select the row(s) by clicking on the row numbers. A range of rows
can be selected by holding the shift key and clicking a
non-contiguous set of rows can be selected by holding down the
control key.

 Click the Delete Rows button.
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Toinsert anew row

Select arow.

* Click onthe New Row button. A new row will be inserted underneath
the selected row.

¢ Click Update DB

Toedit stringsand numbersin arow
¢ Double click on the cell you wish to edit and then enter a new
. \é?!gI?Update DB

Toedit a chemical (2D sketch):
¢ Right click on the cell and select Edit Molecule

¢ Make changesusing the Mol ecul ar Edi t or
¢ Click Update DB
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9.4 Query Local Database

Availablein the following product(s): | CM Cheni st || CM Chemi st - Pro
[l CM VLS

Toquery alocal database:

¢ Right click on the database in the ICM Workspace and select Query.
¢ Query usingthecheni cal sear ch tools.
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10 Tutorials

Molecule Representation, Coloring, Labeling

and Annotation

Creating Fully Interactive Slides for
PowerPoint and the Web

Read Sequences and Align
Link Sequence to Structure
Alignment Annotation

PDB Search

Convert PDB to ICM Object
Superimpose Proteins

Structure Analysis

Calculate contacts

Display hydrogen bonds

Identify ligand binding pockets

PDB Preparation: Symmetry

PDB Preparation: Occupancy & B-Factors
PDB Preparation: Alternative Orientation
PDB Preparation: Biomolecule

Building an Homology Model

GPCR Modeling Example

Loop Modeling

Predicting the Effect of a Mutation on
Binding

Predicting the Effect of a Mutation on
Stability

Chemical Sketching using the Molecular
Editor

Chemical Search

Chemical Clustering

Working with Large Chemical Space
3D Pharmacophore Search

2D Pharmacophore Search

How to Create a Markush Structure
How to Enumerate a Markush Library

How to Decompose alibrary based on a
Markush Library

How to Enumerate alibrary by reaction
Detecting Activity Cliffs

APF Superposition, Score, Consensus,
Screening and Clustering.

Working with the ICM Interactive 3D Ligand

Editor

Dock Biotin to the Streptavidin Receptor

Re-Dock an Inhibitor to Ricin Crystal
Structure

10 Tutorials

HTML
HTML
HTML

HTML
HTML
HTML

HTML

HTML

HTML

HTML

HTML
HTML

Ref erence Cui de |
V\ebi nar

Vi deo
Vi deo

Ref erence Qui de

Ref rence Cui de

Vi deo
Vi deo
Vi deo
Vi deo

Vi deo
Vi deo

Reference Guide.

Vi deo
Vi deo
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Covalent Docking

Protein-Protein Docking using FFT Method
Virtual Ligand Screening to Ricin Receptor
Virtual Ligand Screening to Cyclooxygenase
Docking a Markush Library

Multiple Receptor Conformation Ensemble
Docking Example

Explicit Group Docking

2D FingerPrint QSAR Model
2D 3D Pharmacophore QSAR Model

10.1 Graphics Tutorials

Introduction

The following examples are focused on the structure of the kinase

HTML Vi deo

HTML

HTML

HTML Vi deo-1]| Video-2

HTML

HTML
HTML

HTML
HTML

catalytic domain. The catalytic domain is nestled between the N- and C-
terminal and has high sequence conservation between kinase families. The
adenine moiety of ATP interacts with the hinge region which links the N-
and C-terminals of the catalytic domain. The ATP sugar binding regionis
on the "floor" of the pocket where ribose makes a hydrogen bond with a
polar residue. A conserved lysine residue on the beta3 strand is part of

the "roof" of the pocket where the triphosphate group of ATP binds. A
flexible glycine-rich loop movesin and out of the pocket depending on
the ligand bound state of the PK and is regulated to some extent by the
movement in and out of the pocket by the AlphaC helix. A buried region

at the "back” of the pocket is protected by a "gatekeeper residue’

forming a variable hydrophobic cavity. The hydrophobic cavity along with
the DFG not i f region are of interest for drug design because it opens up
regions of the pocket which are not conserved and do not bind ATP.

To learn the basics of the graphical user interface we will annotate the

key structural regions of a protein kinase.
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10.1.1 Change Molecule Representation and Color

Thistutorial shows you how to:

¢ How to load a PDB structure into ICM.

« How to change the background color.

¢ How to display and undisplay a molecule.
* How to color ribbon representation.

Introduction
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Load a kinase structure from the PDB.

1. Click on the
, "Search” tab

&

3. Click on the search button
and a table of hits will be
displayed

sodr Wod e

2. Enter
search string
“2vze”

IsoDoooon: ¢ o§
ESCFERENTE {

4. PDB stucture is
automatically listed
in the ICM
Workspace and

displayed

Step 1: Click on the search tab to load and display the PDB structure
2vz6

Change the background color.

" _ﬁ' =) (7 | . e | T o ) al= ?
rrnzma Lawt FE: +"
Cpes 1. Right click g
" £y
E _ here °
8 :
b
H
=
Step 2: Change the background color by right clicking on the color
palette.
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Display the “a” subunit and ligand.,

Fh DR e Bonis Lok Moeoop Oy eong  Mielens  eedes 0

D@EEAe TR0 AR cf i mEBsELGA 2% TTEEE8L

A TR W U s i Ve L L
H & FeE e |
Srai e Farmi =

S eyt
Diri
o

(| @) | el # | (i | [=]

2. Use these
buttons to

"% 1. Click in the
hoxes to display]
and undisplay

rotate molecule

GHLES DAMe-- peodd bt WDt B

Color ribbon by secondary structure
| segment.

Note: All
representation [~
buttons have
similar coloring
options

= il Bl aa ok |
e A gEEpL

B

=R
b riskeatotariylaeTEned®

s B4 v b T B
]! - s

o e 0| m a8 me——— T

BAMen= Godd P dod

B IS

Step 4: Usethe optionsin the "Display Tab" to color the ribbon.

10.1.1 Change Mol ecul e Representation and Color
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T G e s ek Gy toany M e Color Beta 3 strand yellow.

DaEEAr TG0 ERclin mEBsEDi0%: TTEEE0L

e

)1, 13- Click on yellow gy o) | cizcia | ¢ [ 0[a)

TR 2. Click and drag
Ly to select Beta 3
stand (residues 37
to 43)

1. Expand to
see sequence
here

8 CAmSSin depandnnt prinnn kinae ©
i

] |m als] Fmanon

GHDES DA =-= ool dodnd

Step 5: Select the beta 3 strand (residues 37:43) and color yellow.

10.1.2 Annotation

Thistutorial shows you how to add user defined annotation to a
particular region of a protein structure.
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5. Left click to
change level of
detail

2. Right click
and select
“Annotate
Selection”

1. Use the lasso
= 1| toselectthe
; helix

3. Enter
annotation

o KOS

Oof dodnd

S NS DA

Step 6: Select the region you wish to annotate and right click on the
selection for options.

10.1.3 Labels

Thistutorial is a continuation from the previous tutorialsin this
section and shows you how to:

How to select individual residue types.

How to propagate a selection from one atom to all.
How to use the residue label button.

How to make a spherical selection.

How to label aresidue selection.

10.1.3 Labels



DG Ae TRt HRE
== T

H| 2 e ey

——

o 238 At T4 P ST D

..# .'Jl’:.f;:‘ e
1, Click on
“Filter
Graphical
Selection”

im mEvED /0% TUEHEEL
| D (P | o) | s () o | (e

Display and Label Beta 3 to Alpha C 5alt

2.Click “by f ©
type” | 3

Bridge (1)

2, Check the
charged
residues (Asp,
Glu, Arg, and

GHEEE DAMESe DR RS

residues.

:‘:‘:“ml _
'-’Iﬁf-ﬂ 3 -
ol R
= 2. Click here
w1 displayall

charged

residues in wire

propagate
selection to all

atomsin
residue

to

et

Display and Label Beta 3 to Alpha C Salt

Bridge (2)

GHBES DAMELs  EEED P RDE S

Step 8: Propagate selection to all taomsto display all atoms of the

side chain.
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Ch gt makmati £ LT fn (b 7] {1 gt

q.fﬁ- mEBsyBEBA0%% T

LG A TR W
R e \

1. Undisplay all
xstick
representation:

for clarity

- 5. clck and
hold on the
residue label

coloring and

button for label

Display and Label Beta 3 to Alpha C Salt
Bridge (3)

TERELL

2. Use the zoo
in button to
locate alpha C
to beta 3 salt
bridge

3. Click on the
residue label
button

style options

@ e (N[0 = [G)al=])

4. Click on each
residue to label

MR T LT

Step 9: Locate the B3 to AlphaC salt bridge (K42- E60) and label using
residue label button. Note: Once you have selected the two residues you
can invert selection (click on invert selection button) and then

undisplay all the other charged residues.

Display and label the residues near the
.- ligand binding pocket (1).

P LR ves B bon Mo Oweny Coden Mofetawn  svdoes

LFHE Ae TR0 ER
e

E e e

4. Propagate
selection to all

— S | =

M T [EEEEH]
1. Undisplay wire and other
label annotations from

previous examples

atoms

Degdend P bele T

2. Right click on
the "a” subunit
ligand and choose

F s
3. Enter the
parametersas

‘e (W0j= Glalals)

A= neodl Bods

eHBSS

Step 10: Select neighboring residues to the ligand.

10.1.3 Labels
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Display and label the residues near the

ligand bindin cket (2).
S (O | e | e | e g pocket (2)

residue labels

MDA oedd Pt dBDds

L R

b
8 CAmSSin depandnnt prinnn kinae ©
wl ]

Step 11: Display the residues and label them.
10.1.4 2D and 3D Labels

Thistutorial is a continuation from the previous tutorialsin this
section and shows you how to:

Create and display a 2D label.
Delete and move a 2D label.
Create and display a 3D label.
Delete and move a 3D label.

400 10.1.4 2D and 3D Labels



m_ Createand display a 2D label.
LEEG A TRO AR A IN mEvERAO®S TTEIREEL

|| DE | =i

1. Select the
labels tab

2. Select the 2D|
label button

Calcium Calmodulin Depgige

EESTE

DAt BedO b WD O

i s

e _R ht glu:lr. herE =ta:: edit or delete

Ik [0
[
e
g b
wid
e
Bege |
ar

TEr T
¥

Click here with
middle mouse
button to move

gl T
a7 Tenie bbel w_guach
mr balem] ~Cakaime Chietain [prstret Prrbals Eimme iR IeACtmialT IS CReRTE 0,0

£ o - —
0 W5 = Gelals)

ELETE

DA ool dod

R

Step 13: Right click on the 2D label to edit or deleteiit.

10.1.4 2D and 3D Labels
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Create and display a 3D label. A 3D
label will move with the object when
rotated or translated.

LEEEac TR0 AR AN mEsERA0%: TTEEELL

o | B | BE | H e

s GCalcium Calmodulin De r
e =
B 1. Select the “
g | labelstab B
1L
L
‘B . -
-
| -]
2. Select the 3D 5
label button 2
H
:-:-;db‘p;’c\-‘ul“--_ s
T
L= % = I il
W Gomilends i BEan Eaaiid 3 iade il TeNLeves al° Egee|d i, 8,00 =
T e i AN
e i eyt
ul-:nh":-:w”u.:: ilm:l-l::-: mddnblinbed, Wish| tewieg io DS drssetied wwlerades Ded easy mewipdlid s
i i | o
9'- E@:HE ['_'5|:1"C' FEeTE
Step 14: Create a 3D label using the options in the "labels" tab.
T How to move, edit and delete a 3D
G R TR0 AR F N mEBsELGa0%: TTTEE8L
TR s e label.
e | @ | | H | EEE | = e hn -
s #au A = +
o vkt by Calcium Calmodulin Dependent Protein Kinase i
'.\'-me-me:mn a
laﬂf: I
Y 1. A 3D label >
e object is . s
Fin created =
.- e 5 :
f -
- =]
%
#
-
#
Connect to 3DMesh will
enable you to move the
3D label. Press “escape”
button to disconnect
- 3 T v =il
WiGoarFrids st Goan e l9d 5 sTeesil Genietes |AL° cgee] TIE, 5,01 =
@ o Tvede diepley Lebeida ) i
ATt vosaats AT . ) )
;e'i"" R — T |
ow (NEn [@e]a)s i

Step 15: Right click on the 3D label to edit or deleteiit.
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10.2 Creating Fully Interactive Slides
for PowerPoint and the Web Tutorial

Introduction

A dlide enables you you to conveniently store alarge number of

different 3D visualization properties (e.g. color, viewpoint,

representation etc...) along with text and window layout. Act i vel CM
enables you to view and display ICM graphical sl i des and ani mat i ons
interactively inside Windows Microsoft PowerPoint and web browsers such
as Internet Exporler and Mozilla Firefox.

In this example we are going to look at the effect of an agonist binding

to the Beta-2-Adrenergic GPCR (B2AR) and prepare a molecular document. A
prepared ICM file containing three B2AR GPCRs superimposed can be
downloaded heref t p: / / ft p. nol sof t . com pub/ wor kshop/ (1. cut and paste
the address into aweb browser. 2. Right click on GPCR_dlides.icb and

choose "Save Link As". 3. Open the.icb in ICM File/Open). Thefile

contains pdb files 2RH1 (R inactive state), 3POG (R* active state, with
G-aphamimic), and 3SN6 (R*G G-protein signalling state). The agonist
ligand causes Helix 5 to shift inwards and Helix 6 to swing outwards.

This agonist binding poses were predicted using ICM ayear before the

crystal structures were solved, you can read about thisher e and a good
review of the structure and function of GPCRs her e.

Tutorial

In this tutorial we will build a series of slides and then annotate them
using HTML to create hyperlinksto the slides. The resulting molecular
document can be exported in movie format or in fully interactive 3D

files.
3 GRCR_Shdevich Mol wm 38-3 [HsrdrnasGRCH Shdetach [ (3 ﬂb,uc:'l)lall{ Make a SlidE b‘!‘ flifking on the camera butttll'l.
ME@o 90 TG0 ERB: FlPE MBDa«cBRHG® % TiIEFEF2EER

iy '\ ight \/ bk \/ medus W smarch \{ bgedt | o
H| 2 EEed i | @RS || exideads |G| @) -
[Wiariapuce Paral 8 x +
R SekEction 2
-l obgects e
- 2rhii) L
il - Jsndly ;
B - Jolgll 2

4 SOQUBNCES i |
L algrments o
Al

¥

r

§

-

£

o

it
ﬁ‘

I t ]

mEra 1. Click on the camera |
. “’q |¢v @. button to make a slide. |
&5 @ ﬁi.rf' = * § 486 dtremns 1184 Res,7 Mol 3 Dby

Step 1. Download the example file here
ftp://ftp.nol soft. con pub/workshop/ (1. cut and paste the address into

10.2 Creating Fully Interactive Sides for PowerPoint and the Web Tutorial
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aweb browser. 2. Right click on GPCR_dlides.icb and choose "Save Link
As'. 3. Open the .icb in ICM File/Open). Make a slide by clicking on
the camera button at the bottom of the GUI.

5 GPCR.Shdenicl Mool om 383 mAmariGPC3, S5ams 2 16 2= 14 Thee slide will be stored in the ICM workspace.
LEE0 90 TGO AR FISH MO«BOEFE TEE381
4 ! A e a8k | Frig-iet I 1 Ei' ! s 5 B ] 2 ! ol | 8 n &
A seleeAECHON T e o
;’/‘/‘ﬂ shdes {1 item) ‘“l. i — -
fl | & v slideshow &
11| L~ 1Side1 | g
W = objects (3 kems) Y >
N - amly (1R 27 .
=Sl . 3snb 0 e
- abgnmenits- am!; .----j-@- _ =
-
$
¥
2
-]
o
4]
&
;‘-I
#
a | = § @
oe EDzo@a s = = |iSe - Q] 565 Abom 184 87 Mok 084

Step 2: Thedideis stored in the ICM Workspace panel (left hand side
of the GUI). Y ou can make changes to the 3D display and return to the
display in the slide by clikcing on the slide in the ICM Workspace.

404 Tutorial



) GRCR Shdesich Moliaft om 383 IMknd] Edlie the name of the slide and enter smooth and blend transitions.

flo an TQQ i :Fi,H ME«cBREITes TEEF22E
{ ety T\ T/ st \/ oo\

| e s | BN || exEdex | 6] @0) .
erisnce Paral £ x AT +
Al selestion b 5 ¥ B £
—ffy shdes (1 dem . :
S - shdeshow Mame: Extracehiar Vi 2. Edit Name. F
= § Shda 1 £ i — ‘}, |

1: { MS [ & T
olotjects  (drems) - e O ' 8
1. Right click and s
choose "Edit Slide”. -
- o
-
_;_
Trarsmitine effects 3

| Smooth viespoint rardition  1500mg
4 Blerd varsfamation

o 3 Select and changelEﬂEth

100ms 3 of transition effects.

eI LS

u |8 |= 1 [@

0 ® B0z 0lelE) = » [ )E T ——

Step 3: Properies of the slide can be edited by right clicking on the
slide in the ICM workspace.

?M"'[ You can also save viewpoints to help make other slides in the same orientation.

i

1. Click here to save a
# = t -
it L= ] ‘l@ _ h viewpaoint.
oe 80z

G856 Stoems 1154 Res, T Bol, 3 Oby

DEBo 90 M@0 A8 fiFE MBD«BDEBYE TFIEFEEE |
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e aret 8 x st 3
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=) Extraceiuier ViewFot 2. Viewpoints are T
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» shufsshow # u

« 1 Exdracelular View o

< ff objects (3 fems) ]
B8 - Ihigy 5
.,ﬂ - Jsnlll (2 0RE 2R mmp |
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immmes i Ao T
3 ahgnmments (1 aem £
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E-

A 9

2 b

Ve =
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Step 4: Saving aviewpoint is useful if you are making many slides from
the same viewing position.

Tutorial
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s

@ “"““""“’_""‘“"’“ . '“f { Make another slide of the inward shift of Helix 5 when an agonist binds,

Lo e 90 E8r Pl fE MO«cERHAGE TFE§235E8
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» shieshow it
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Step 5: In this slide we show that Helix 5 makes an inward shift when

an agonist binds.
b “*‘“”""“‘""“mm{m%ea slide of the side chain changes of 1121 and F282.
BEEo N Qﬁ‘ AR Fl e MO«cEDHRe*s TTE#258 |
| ectay o AL b N obes A e Vbl N ——_— o
M| e et BEE N |Pe | axades | 6| (mle) i
= = e o =
no selecton & B
i vewpords 1 dem <
- Estracefular_ViewPaint L
gasms i1 dem) g
» Shilehow -]
- 1 Extraceliuiar View D
= 2 H5 rwand Shilt -]
= 3 BelZ9 and Pha282 : u

=i objects (3 tems)
L8 - 2hil 1) XR 248
- B8 - 3sndll 2 -
=i - Iplghy (7R 38 -

BHBLS BA

.5 [G)[@)fm |
L] @a' @; '_ | 5486 Atmems 1184 Res,7 Mol 3 Ok

Step 6: In this slide we show that upon binding an agonist 11121
switches its rotameric state and Phe 282 moves.
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| SICR Sitesich Moot cm 303 kmfmanGOCR Shdesch o imm, [ Make a slide of the helix 6 swing.
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1. Chck on the camera |
. [O)@ @)= S—
o ;ﬁ@ button to make a slide. A_J{E{] i ST

Step 7: In this slide we show that agonist binding causes Helix 6 to
swing out.

m““‘;;ﬂ;{ Export a movie of the slides or browse through them using the arrow buttons,

Fiy  Tewly  Edie iew
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shdeshow
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Step 8: You can export the slidesasanovi e or you can browse through
them using the arrow buttons.
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® (FCRSesb Mebeh cm 343 [Ruend e Now annotate your slides and create hyperlinks using HTML.
@sno o 1&@ Ra:siam fEeaBBAGS TEfs258
1. File/New “"“[?"’“ o= =
- - !I 2. Choose the Htmitab. i.‘ﬁ |.ﬂ;ﬁ =
—— _-: W -
T sedection o st Sl S s et N el e o ey B
—-# vewpoirds (14 %
L= Extracelhdar Mmooyt EPCRAvation - &
= shdes (1 dem) #] poy s Browser
%« glideshow g 0
o
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#
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=
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&
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3. Click OK. o o ][ cews |
o TH TS TE e = —a
o ® W= Dlalals)(s] » [Jommmn]g) et 4435
Step 9: To build amolecular document you can annotate the slides using

HTML.

| Edit the HTML document.
IDeEe 9 TR0 ER:PIi LB ABaBRlEGeE T35 8

H | Eee el | R 08 | Phe | o xaea “ﬁ”@%ll
¢ 1 b

- 8 % : e

1. Right click and
choose Edit,

Fiesth i Tt Cedaf

& GoBsk

& Eda CirisE

Step 10 Edlt the document by rlght C|ICkI ng on the HTML panel and
choosing Edit.
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Step 11: Hyperlinks can be made to the slide. Other f unct i ons such as
adding check boxes, ICM scripts and external links are also available.

st MSW& the Molecular Document as an icb file. The fite can be

H’__‘:‘; :‘ ;: :"1; m ‘c .1 exported to a web browser or into Windows PowerPoint.
J Sl

" search A/ Bgedit |
1. FliEfSﬂUE‘AS,.. ‘ ,Eljﬁ-‘ l ,:}[a;: F -?;- ﬂ ¥

st et | | (@)

| GPCR Activation

:  Agomists that bind to the Beta 2

| Adrenergic receplor cause a

| conformational shift in Halix 6. Agonists

| interact with Ser203 and Ser207 on Helix _ _
| 5which causes the extracalldar saction of BF REEE 2 T ppgg
§  Hebix 5 1o shalt inwards. This resultsin g

| rolarner change of Be1219 and a

| movement of Phe262

LI EALEL, L

G e s

mwm it Bouments

Step 12 Savethe molecular documentmlcb format and view in ICM Pro
or ICM-Browser. Y ou can also export to aweb br owser or view the fully
interactive slidesin W ndows Power poi nt using aplugin called
Activel CM

Tutorial



10.3 Protein Structure Tutorials

Introduction

The positioning of the DFG motif in the activation loop of a protein
kinase has an effect on the size and properties of the ATP binding
pocket. Most kinase inhibitors target the kinase with the DFG inwards to
the ATP binding site. Type-ll inhibitors target the site where the DFG
motif isin the out position which opens up the pocket and provides
additional hydrophobic binding sites. Targeting DFG-out conformations
can improve inhibitor specificity and slower-off rates.

Comparison of the crystal structures of Abl kinase with DFG-IN and
DFG-OUT (Left). Imatinib (Gleevec - right) binds to the DFG-OUT
conformation.

Tutorial

In this example we will look at two kinase structures and compare their
binding pockets. One of the structuresis bound to the Type-11 inhibitor
Imatinib (Gleevec) a drug used to treat Chronic Myelogenous L eukemia. We
will use ICM toolsto look at the side-chains that interact with the

inhibitor and compare the pocket with a DFG-in structure using

| CMPocket Fi nder . Please click on the links provided to learn more about
the methods used.

10.3.1 PDB Search
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i

e e L _| Read in two kinase structures liep and lopk.

'Bbﬂnﬂﬁ im0 'ilﬂﬂﬂd'ﬂ fi@ecBOlddes TEEFLIEE

daplsy \f Bght Idbd.-r mashes ) weere \[ Bgedt | -
[P eman *—41 1. Enter PDB code. }"

2. For clarity color each
object a different color
using the display tab.

4
e

uECE P Bo+E e

BT T L L EL
g
&=

vE]’t;i' {172 waler molecyules

GHRLL DAMHEHEN

W (270 waler moleciiss

0 @ MD)n [0)@]a]8] v w0

Step 1: Click onthe Sear ch Tab and choose "PDB Search” and oad the
PDBs structures liep and 1opk. Y ou can color each object a unique color
by clicking on the Display Tab and clicking and holding on the ribbon
button and selecting Color by>Object.

10.3.2 Convert PDB to ICM Object
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|9 topk Moo cn 383 PlenPrjct 12 oyt Convert each object from PDB to ICM object.
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Step 2: Convert each PDB fileinto an ICM object.

10.3.3 Protein Superposition

chibide bl el [ Superimpose the kinase structures.

Fde Tools Edit View Beoindfn Homology C{hemistry Doching Bdc A
DERO O TR0 KArRFiFe oD TEt#288
¥ gy \liohe \/ baiosls \/ mesbes \/ seerch \/ Bomdt |

HY| 3P0 @ @5 et | [R5 ES (MR ME Eﬁ_is.l:}i:-i{#qﬁ|?i 2|
3. Select the gx

display tab. 4, Click on the
B . superimpose
Tem~ g 1. Double click to p:;m o‘r::

@b 2744 5stes ABLT_MOUSE
@] el H chiorde on

?!-{:] = acld H chionde won
#{]l»acd3 H chionde on

w{]r acld H chionde ion

I-{:] wash H 4-{4d-mettyl-piperasn-i-y
o] bedl  H chiloride ion

{]le bel2 W choride ion

b ] bsti H d(dmetiydpaperazin.g .y

select.

et e

€ 2.Hold Ctrikey i
U and click.
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Step 3: Super i npose the two kinase structures.
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10.3.4 Protein Structure Analysis

[ B topk Moksoticm 5.3 Mewrojct ) 2 bt | Locateand display the DFG motif in liep.

Fibe Tool ot Yew Bowfo Homoiogy Chemamy Dodimng  bdolkechenics
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40% WTAPESLAYN EFSY .
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]« ac e
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hEf gt Dbl Wi
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a8
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Step 4: Search the "a" subunit of liep for the "DFG" motif. Y ou can
press Ctrl F and expand the sequence in the ICM workspace. Display the
DFG region in xstick.
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‘9 b b e Tl I Locate and display the DFG motif in lopk.
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Step 5: Search the "a" subunit of 1opk for the "DFG" motif. Y ou can
press Ctrl F and expand the sequence in the ICM workspace. Display the
DFG region in xstick.

6' e Observethat liep has DFG out and 1opk has DFG in.

e Tmoh Edt Yew Biowdo  Homaology
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Step 6: Observe the DFG location in both structures.
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10.3.5 Contact Areas

. m————— A et o b [ Display the receptor contacts with Gleevec,
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3. Click OK.
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Step 7: Use Tools/Analysis/Contact Areas to display the contacts with

the Gleevec ligand.
& lnvll uum:sunns W | (2 obgects 1 table : e Display and tag the contacts with Gleevec.
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10.3.5 Contact Areas
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Step 8: Tag the residues surrounding the ligand. Repeat Steps 7 and 8

for the 1opk structure and ligand.

10.3.6 Hydrogen Bond
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Step 9: Comparethe hydr ogen bond interaction of the Typel and Typell
inhibitors with the hinge region (liep - residues 317:322) of the

kinase.

10.3.7 Pocket Identification
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? fostpshefion 363 Mebea TR e 2 Calculate the binding pocket surface using ICMPocketFinder.
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Step 11: Usel CMPocket Fi nder to compare the pockets of DFG-IN and
DFG-OUT. Run ICMPocketFinder for each structure - rename the pocket so
as not to overwrite it.

10.3.8 Protein Preparation and Crystallographic
Analysis Tutorial

10.3.9 PDB Preparation - Symmetry

Background When inspecting a ligand binding pocket it isimportant to
check that the true pocket is formed by chains which are not explicitely
present in a PDB entry. Thereforeit is necesary to use Tools/X
Ray/Crystallographic Neighbor to find all molecules/subunits or chains
involved in the interaction with the ligand. Molecular objects and 3D
density maps may contain information about crystallographic symmetry. It
consists of the following parameters:

1. Crystallographic group eg. P2121 that determine N (depends on a
group) transformations for the atoms in the asymetric unit.
2. Crystdlographic cell parameters A, B, C, Alpha, Beta and Gamma

To generate the coordinates within one cell one needsto apply N
transformations and then to generate neigboring cells the content of one
cell needs to be tranglated in space according to the cell position.

Example As an example let uslook at Cycloldextrin glycosyltransferase
(PDB Code: 1CDG). The problem with docking to this receptor isthat the
true pocket is formed by chains which are not explicitly present in the
PDB entry. Site mb1 includes serine 382. This cannot be predicted just

by looking at the structure. Therefore we need to identify symmetry
related molecules to this protein.

» Usethe PDB search tab to load the crystal structure 1cdg.
* Inspect the ligand binding pocket of maltose (mal)

10.3.7 Pocket Identification 417



» Toidentify if there are any other chainsinvolved in the
interaction with the ligand select the whole structure in the ICM
Workspace.

File Edit View EBioinfo | Tool: Homology Chemistry Docking Moldechanics Wind

NESEE 9 '

Cryzstallographic Meighbar...

Select:

izplay light labe 30 Predict 3 Crustallographic Cel ToolsiC I"_',‘Stﬂ"ﬂ!
ﬂ y A ﬂ x" Analpsis » Biok clecule Generatar - Neighbor
= Superimpose b Get Electron Density Map... =
_ Table bap'z Original Cell...
o5 1 non-ICM Obj S
: e Contour Electron Density...
=« Jobjects (1 itern)
i Corveert Xray Density to Grid...
Double click here to select "
the structure 7

» Tools/Crystallographic Neighbor
* Select a7A radius
» Check "create symmetry related molecules’ and "display symmetry

neighbors".
* Ingpect the neighbors surrounding maltose(mal). Each symmetry

related subunit can be colored by object by clicking and holding

the representation button in the display tab and selecting

color-by.

site mb [ includes residue ser 382 for symmetry relsfed molecwle. sie mb3 includes the following residucs for symmet
¥ & M
#yiﬁ;r:?i* "Symmetry related subunit

10.3.10 PDB Preparation - Occupancy and
B-Factors

Background When preparing a PDB for analysis (eg docking or modeling) it
isimportant to check the reported occupancies and b-factors. The

occupancy is afraction of atimic density at a given center. If there

are two egally occupied conformers both will have an occupancy of 0.5 -

the normal valueis 1 range 0-1. The *{ B-Factor} isthe mean-square
displacement of atom from its position in the model - the normal range
is5-50.

One way of visualizing the occupancy and b-factor is by coloring the

structure by these values. Y ou can do this by clicking and holding on a
representation button in the display panel and selecting Color-by.
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Asan examplelet uslook at the crystal structure 1ATP

» Typeinthe PDB search tab latp and the structure will be
displayed in the graphical display.

» Usethe |ICM workspace to undisplay everything except for the "e"
subunit. Y ou can do this by clicking in the blue boxes in the ICM
Workspace.

» Display the"€e" subunit in wire representation using the wire
button in the display tab.

* Click and hold on the wire button and select Color-by B-Factor.
Regions of high B-factor are colored red.

Click and hold

|
£ display Yy light Y labels Y pdb search % meshes % mowie
H A4 ol @ ol Aol | ws[zl arou|-| yan|.| g
|| B T @ 2T @) |5 | as]T T 2T NS
e | ---l pp—
na sel; @ ool
= n 0 by > atamm type
£ I wire residue sc
chemsitry residue
tree moleculs
thik molecule_C
normal object
thick. bfactor

undizplay ather representations OCCUPEnCY

rezet to default accezzibilit
zelect hydrophobicity
polarity
zec. structure
ol

uzer atom field
uzer res. fisld

alignmment

10.3.11 PDB Preparation - Residue Alternative
Orientation

For some very high resolution structures two alternative conformations
for aresidue are provided. Therefore for docking you need to decide to
use one conformation of the residue or generate seveal separate docking
models. This could be performed using multiple receptor conformation
docking.

Here is an example of alternative residue orientations found in a

crystal structure of a Fatty Acid Binding protein in complex with
stearic acid.

10.3.10 PDB Preparation - Occupancy andB-Factors

Residues with high
B-Factor are colored red
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2. Undisplay xstick,

I Load and display the PDB structure
— 1HMT.

S | @) | s

g0 Wod;

residue and variable 3
labels ]
e %0 4 .| -
= N ——— Display alternative conformations for
R e o —— _‘ = — V32 and T36.
ol EEemes 3, Click the xstick button

ﬂﬂ‘_ !
8
b _ .

1. Click here to
expand residue level

2. Hold the control key
and click and drag over
V32 and T36

4. Click center button

10.3.12 Biomolecule Generator

Objective
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Here we will investigate the biological environment of avirus protein .
PDB code 1IDWN.

Background

It isvery useful to know how a protein from the PDB may look in a
biological environment. The PDB entries solved by X-ray crystallography
and deposited in the PDB contain the information about the crystal
structure rather than the biologically relevant structure. For example,

for aviral capsid only one instance of capsid protein complex will be
deposited and only one or two molecules of haemoglobin that isa
tetramer in solution maybe deposited. In some other cases the asymmetric
unit may contain more than one copy of a biologically monomeric protein.
ICM reads the biological unit information and has atool to generate a
biological unit. Not every PDB entry has the biological unit

information.

Instructions

* Read and load the PDB file IDWN

» Toolg/Xray/Biomolecule Generator

» Tick the makeAllBiomolecules box (Warning this may take afew
minutes to generate)

» The generated molecules will be listed in the ICM Workspace. Each

one can be selected and displayed. The biomolecule is shown below.

NOTE: Please note that right clicking on a PDB file in the ICM
Workspace will tell you whether there is any Biomolecule information
available for the structure. If thisinformation is not present then

the option will be greyed out.

Manual References (Web Links)

Bi onol ecul e Gener at or

10.3.12 Biomol ecul e Gener ator
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10.4 Cheminformatics Tutorials

10.4.1 Chemical Draw and Spreadsheet Tutorial

Background

Cycloxygenase 2 (COX-2) inhibitors can target inflammation and pain and
are non-steroidal anti-inflammatory (NSAID) drugs. Some of the COX-2
inhibitor drugs have an interesting history because some of them cause a
significant increase in heart attacks and stroke in patients. Probably

the best known COX-2 inhibitor is Merck’s drug Vioxx which was
voluntarily removed from the market in 2004. In this example we are

going to build a small database of COX-2 inhibitor drugs, learn how to
import COX-2 inhibitor data from ChEMBL and how to manipulate chemical
spreadsheetsin ICM.

Tutorial
ok R | Sketchthe COX-2inhibitor Celebrex
File Edt ‘Yoew Bicindo Tock Homology Chemistry Doclimg Molblechsnics
PE@Ee @ TR0 HEn FiSE mBaBB409% TTESFELE
T aTE
PLE Goar £ Apperdd To i eafanrtioce | DroPn ¥ ..,_
1. Click on the Molecular oot p . m_ ad
Editor button 3. Monitor Properties ]
m&eh’:ﬁuq 1
CHEE O fFHSEE O o 7 0@ @ xS G,
= 2. Use the bond - wa | ©
& and atom o ssioiged T[>
# buttons to sketch 3 mear e 1 T
£ PR InChie5/C1%
5 inchiey e ||
r — b PR — 383075 | o
- ” / T oHEa 4
B | B 1 5 D 2 1 ’-::}
o ” \. / 9 el 4 ] e
FUE- ] _"‘m e
F 11 Malives 184,735 g
P 3 Mo o v
11 Mologd 15821 -
g 14 Holings 1557
i 5 MeEsa 16548 e
3  ckme 13115
B 7 BadGrougs T
1 Pheri |
Pyragee
& B Geoags :.:ib
H
] s

kow 8F BB

Step 1: Sketch Celebrex. Thefirst COX-2 drug we are going to draw is
Celebrex (Celecoxib) from Pfizer. Click on the Molecular Editor button
and use the bond and atoms button to skethc Celebra (shown). Note you
can monitor key chemical properties of the molecule as you sketch it.
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e Add the name of the drug and export
B Sam  wew  Baefs Too BasihAschamcy W "
SEHSs @0 _“Q !‘ = ‘F " :l'l w1 e 1 o, O chemical spreadsheet.
m y
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D e w 5$E§iﬂ&|h " ame o JEX
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- , T munnz @ oy
1
2. Export to e e BRI [ =]
1 Chemical i 3 meac il ] ;
P i F 4 bntHl InCiniw 15013
q Spreadsheet \>(/ | Iz st O -
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il 17 Bedteoas | |5 = ) g
1 pram
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B W s e it [
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L] S —
Step 2: Export to Chemical Spreadsheet. Rename the chemical toits
brand name (Celebrex) and export to achemical spreadsheet.
.................................... 1 Observe new chemical sp;eadshee’tq
file sty Bocking ics
EEEO 90 TR0 HAs FiLfH mBadBGi0esx TFFE28E :
aamen \ et ol
w06 Search =] kb | 4 Pt | hppend T Hemit | M) | ockbfeachimrdode #  ooancyOsgley [none =
erapace 8 3% [ Coxi b | .;.
no selection | ] iy B
- 3 tables e — @ B
a2 b [ # ]
=Rl
B
1 g B
|
i
b
=
=]
B
A
2
&
sf

IT"'“

Step 3 Observe Chemlcal Spr eadsheet You should now have one chemwal
in your Cox2_Inhibitors spreadsheet.
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@ et Lt 8 e o | Add a new row to the chemical
NGRS O® TGO EU L P E fﬁ w1 o 1 | SPreadsheetand add Vioxx.
(= i\ : e
= o |3 o &
— OB miroren W orandthe 1) o
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Step 4: Add a new row. Add anew row to the spreadsheet and then sketch
the Vioxx (Rofecoxib) drug (shown).

| Now you should have two chemicalsin

DEEBO O TRO MU0 AR o B, OU SPreadsheet. y
eemh \ gedt } , i
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Step 5:0Observe Chemical Spreadsheet. Now you should have 2 chemicalsin
your spreadsheet.
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Step 6: Using SMILES. A convenient way to import chemical datais by
using SMILES. Bextra (Valdecoxib) is a COX-2 inhibitor that was removed
from the market by Pfizer in 2005 due to concerns ofan increased risk

of heart attack and stroke. Bextra's SMILES string is:
0O=S(=0)(N)c3ccc(c2c(onc2cleccecl)C)ec3

i

ettt Bl e bl S ... Usethe chemical dictionary to read in
T T T T L EF LT the drug Relafen (Nabumetone).
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Step 7: Using the Chemical Dictionary. Another convenient way to import
chemical dataisto use thein built chemical dictionary. Relafen is
Nabumetoneis an NSAID that israpidly metabolized in theliver to a

major active metabolite, 6-methoxy-2-naphthyl acetic acid.

- - = ‘ e A “y
7 dcacloboftiom 381 NewPogect | L otiect Ltable) (L Extract a COX-2 inhibitor from a PDB
Fibe Edt Vs Hicinfo  Tools Homology Chemistry  Dockimg  hodhdschenics i flle
DEEO &0 TR U Pl LR EMEHaED y
ey N R\ T/ mibea M v /B dEis _ ikl il — @
| (2 B2 - ? =eER e axaaa | 0 (el =
& x v
.......... §]
objects (1 4 &
Bacoly | &
+BRas e
e stoang eswesPGHZMOU | Fad - EEEEEy S o
~gld 55 i o
B ahem . 32

2. Right click on # Tama? v .0
“indomethacin” and choose & ' _— - N
the option “Extract Ligand”

T L o e
=1l tables
Con2_inhibiicrs

o B Bp L5 B Db ol B e e

........ = | 3, Enter as shown

v PRpgm—"
GO8 BDo 06 %

Step 8: Extracting Chemicals from the PDB. Y ou can extract a chemical
from aPDB fileinto achemical spreadsheet by right clicking on the
ligand in the ICM workspace and choosing the option "Extract Ligand".
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Step 9: Calulate Propertiesand Insert Columns. Usethe
Chemistry/Calculate Properties to calculate properties (e.g. logP,

logS, MW) for the drugs in the spreadsheet.

In this example we will import more COX-2 inhibitor information from
ChEMBL. ChEMBL is adatabase of bioactive drug-like small molecules
curated from the primary scientific literature.

Note: In version 3.8-4 and higher you can sear ch ChEMBL directly from
the GUI interface.
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Step 11: Select Human COX-2 entry.
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- Open up the records containing IC50 data _}
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Step 12: Select chemicals annotated with Ki values.
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Step 13: Download in XL S format.
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Step 14: Convert to csv format. Open the .xIsfilein Excel and savein
comma separated value format (.csv). Read in the .csv file into ICM
using File/Open. Rename the table Cox2_Inhibitors - right click on
table header tab and choose rename.
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Step 15: SMILESto 2D. Convert the SMILES column into 2D. This may take
alittle bit of time because the table is quite large. We can use this
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tablein thefollowing t ut ori al .

10.4.2 Chemical Searching

Background

Thistutorial follows on from the previoust ut or i al where we made a
database of COX-2 inhibtors (Cox2_Inhibitors) and read in a chemical
spreadsheet containing 1C50 data from ChEMBL (chembl_cox2). In this
tutorial we will perform chemical spreadsheet comparison and explore
some of the chemical search optionsinside ICM.

Tutorial

) e e "_'{I.ei us compare our small spreadsheet of
COX-2 drugs with the largerset of
inhibitors from ChEMBL,
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Step 1: Similarity search - compar e two spreadsheets. Here we can
compare our two chemical spreadsheets using Chemistry/Compare two sets
using asimilarity search.

10.4.2 Chemical Searching
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Step 2: Output the similar chemicalsto a new spreadsheet. Similar
compounds are selected (shaded blue) we can extract them to a new table
using the right click menu.

“ 111 Save the spreadsheetsin SDF format and
.‘Ldelete Cox2_Inhibitors and similar_0_5
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Step 3 Save as SDF. Y ou can save any chemwal spreedsheet by rlght
clicking on the table header tab.
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Step 4:Chemical Searching. Now let us explore the chemical search
options.
'5;’ l: {4 : | ‘We will start by sketching a sulfonamide

E:n g File EdR View group and setting ring membership as R1
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Step 5: Sketch %arch query We WI|| start by sketchl ng asulfonamlde
group and setting ring membership as R1 and an Attachment Point on the

Carbon atom.
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screenshot and press search.
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Step 7: Search query results. The r&sultswnl be dlsplayed in atable
as shown.
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Step 8: Query filter - connectivity. By changing the connectivity of
the Nitrogen we can find only terminal sulfonamide groups similar to
the drug Celebrex.
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By changing the connectivity of the Nitrogen
we can find only terminal sulfonamide groups
similar to the drug Celebrex,
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Step 9:Query filter results By changing the connectivity of the

Nitrogen we can find only terminal sulfonamide groups similar to the

drug Celebrex.
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Step 10:Query filter - Custom Element. Now let us expand the search a
bit by including sulfonyl groups as well as sulfonamides - thiswill
identify Vioxx like molecules as well.
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Step 11: Queryfllter r&ults By addlng to thefllterswecan |dent|fy

Vioxx-like chemicals containing sulfonyls and Celebrex-like chemicals
containing sulfonamide groups.
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10.4.3 Chemical Clustering

Background

Thistutorial follows on from the previoust ut or i al where we made a
database of COX-2 inhibtors (Cox2_Inhibitors) and read in a chemical
spreadsheet containing |C50 data from ChEMBL (chembl_cox2). In this
tutorial we will perform chemical clustering on the ChEMBL chemical

spreadsheet.
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Step 1: Cluster Cluster the ChEMBL_Cox2 table by chemical substructure

using the options shown in the screenshot.

10.4.3 Chemical Clustering

437



ﬁ’ L'” : " va":‘""_”: o “ The cluster is colored by branch and is fully
TR 1'@,} '-j"' . é.l.;ll i ® interactive. Selections can be made in the
e ateates el tree or table. The cluster distance can be
| 2 EEe@ e bltes | EEE changed by dragging the bar as shown.
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Step 2: Changethe distance of thetree. The cluster is colored by
branch and is fully interactive. Selections can be made in the tree or
table. The cluster distance can be changed by dragging the bar as
shown.

- 4 Usethe right click selection tools to find

Z :Iil“: :;_":' _": t}l =:t . ; . s .’ "_Z_ clusters containing known COX-2 drugs.
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Step 3: Cluster options. Usethe rlght cI|ck selectlon toolstofmd
clusters containing known COX-2 drugs. For example, right click and
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choose select centers, explore other optionsin the right click menu.

10.4.4 Working with Large Chemical Space

10.4.4.1 Build and Visualize Chemical Space

B ey File/Open > use Filter MDL :’M‘::::’:”:M:{ Building and Visualizing Chemicai Space |
0 Mol Format as SMILES
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Step 1: Read in alarge SDF file. In this example we are reading in an
SDF file containing >250K chemicals. Thisistoo large for the memory
of most desktop computers and so we read it in using the File/Open
filter MDL Mol Format as SMILES.
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® [Now let us calculate sorme chemical properties,

neBmo® oo wae !
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Step 2: Add some chemical propertiesto the chemical spreadsheet.

-

2. Chemistry/PCA _ o ' {Generate Principal Components
Analysis
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& gl esomn oy (20 pharmacephore)
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plot
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B | ; f_l
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Step 3. PCA Select 6 of the new properties you added to the table.
Generate Principal Components using the options in Chemistry/PCA
Anaysis.
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Step 4:PCA Analysis Plot is Generated. Right click on the plot and
choose Options to change parameters such as point size.

10.4.4.2 Select Molecules in Chemical Space

B chemspace "”””"“‘"[ Selections can be made in the plot and propagated to the table and vice-versa.
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Step 5: Selections. Selections can be made in the plot and propagated
to the table and vice-versa.

10.4.4.3 Delete Row

5’ chasnanard. ol Molsol o 3.8-5 [Lkerdardyen e Do Doourentsuchemipace b *] 1 taie] [ Hemove se|emd malecules
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e gt
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1. Right click on a

selected row header &
and choose delete
row.
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Step 6: Delete Rows

10.4.4.4 Append to New Workspace (Spreadsheet)
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& chamspaca ot Mool om 356 (Clkeandyold Fogy ar append selected rows to a new chemical spreadshest,
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Step 7: Copy or append selected rowsto a new chemical spreadsheet.

10.4.4.5 Export Chemical Space to SDF File Format

# charraars. ol Molsol om 386 [CilerdandyolUne Dot Doourents\chemipacech *] {1 table!

[Expnn as SDF, csv or Excel. ]
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Step 8: Export as SDF, csv or Excel.
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10.4.4.6 Project New Molecules in the Chemical Space

@ [iject New Moalecules into Chemical Space ]
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Step 9:Project New Moleculesinto Chemical Space Use Tools/Table/Append
Row(s).
. [Mew chamicals are now added to the spreadsheet and selected in the table and plot. ]
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Step 10:New chemicals are now added to the spreadsheet and selected in
thetable and plot.

10.4.4.7 Distinguish between different sets of molecules
in Chemical Space

2 [ Differentiate between two series.

File Tools [ View Bicanfo Homology Chemitry Docking RMolbdechsnics Windows Help
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(%] .
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250055 ; et i?[) 2. Right click >
ke Mark Rows >
i Choose Color
sy 7335
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faf | ] PCA
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Step 11: Differentiate between two series. You can differentiate between
two series by coloring rows and then propagating that row color to the
plot.

10.4.4.8 Compare, Merge and Select Duplicates in Chemical
Space
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- O Usersandyot One Drive Documems\chesngpace.ich | (31
1, Chemistry cm:m N Compare, Merge and Select Duplicates. ]
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Step 12: Compare, Merge and Select Duplicates.

10.4.5 3D Pharmacophore Searching

Objective Undertake a 3D pharmacophore search of atable containing 3D

coordinates.

* File/Open example_ph4.icb (thisfileisprovided in the ICM
distribution and therefore can be found in $iICMHOME or in Windows
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Program Files/M ol Soft

* Inthis example the 3D pharmacophore has already been extracted
from aligand. To find out how to generate a 3D pharmacophore see
the section entitled Phar macophor e Draw 3D.

 Inthis example atable containing 3D coordinates is already
provided containing 3D coordinates. Thetableiscalledt 3D.

» Torun 3D pharmacophore searching right click on the name of the
pharmacophore object in the ICM Workspace and select Sear ch
Phar macophore.

» Select thetablet 3D from the drop down list and click OK.

» A table of search results will be displayed.

Right click here

-ﬂ pha#na Clear Default Display...

vElp3 1 Edit Descript

phior... <

:E E? 1 Edi » 2
+n pB 1 Search Pharmacophore. .. table Ta Search In | t_3D . ﬂ
_@ tab|ES (1 |t Advanced » Dk '“anu:el
. Lt3D 994 | |

Center

LN Connect to Object

Enter name of table containing 3D coordinates

* You can browse the results by clicking on the table and the ligand
will be displayed in the graphical display.

» Remember you can use the check boxesin column L tol ock compounds
and overlay them.

Browse and lock compound in 3D display

3D phd_res
mol | N.-’-'«ME_| maolid | confid | L | mzd | SCOME |
chiral 3D->20 822 189664 000465 100
ot
0.
S
1 F{-\.D /'h‘-\.\_ d.
P
N M SN Br
A a4 10 a4 nANTESR (10N

Double click to view in 3D

Manual References (Web Links)

3D Phar nacophore Search

10.4.6 2D Pharmacophore Searching

Objective Undertake a 2D pharmacophore search of acheni cal spreadsheet.

» File/Open example_ph4.icb (thisfileis provided in the ICM
distribution and therefore can be found in $ICMHOME or in Windows
Program Files’M ol Soft

» Chemistry/Chemical Search

» Draw the query as shown below using the
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Distance bond —e"
C
Y
O
F
P
S
Cl e
Br [(a]
I
B
H
G
Add pharmacophore — Hydrogen band acceptor
group v Hydrogen bond donor

* Fill in the query and results option as shown below.

Data Source
L@ @ rs A S| 6 LocaiTables ﬂ  MolCar
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[ ] | Table 13D -
Q Search Type lm
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f* Mew Table ™ Select in Source

Add ta DB
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| ﬂ [~ Dizplay az Grid

Search

Manual References (Web Links)

2D Phar nacophore Search

10.4.7 How to create a Markush structure.
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Setup A pre-prepared example is available in File/Open Examples >
example_enum.ich. The markush structure has already been dr awn and the
R- gr oups have been read into ICM. The Markush structure is ready to be
created.
& o Malsaf e f [craate or Edit Markush R-Groups and Filter.
E@ 00 GG £BRS 1 VE Bl -@80C0 EEEES
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Create or Edit Markush R-Groups and Filter. Right Click and choose Edit
Markush R-Groups and Filter. Add the R-groups, labels and filters and
then click on Create/Modify.

G enampde snumich Blalsal iom 1E-8 [READ CINLY) |C:/Program FilesRolsals LLCACM-Srofemmpie snumich *] (4 tables) s
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1. Markush is
Lr
:; :'s::ﬁ: % —{ created. J
» .,
o8| & ir-I__ll__.L_.l

TheM arkush Structureis Created. If you want to see the R-Groupsin a
separate table you can extract them by right clicking on the Markush
and choose Extract Markush/Scaffold R-Groups.

10.4.8 How to enumerate a Markush library.
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Enumeration Setup A pre-prepared example is available in File/Open
Examples > example_enum.icb. The markush structure has already been
dr awn and the R- gr oups have been read into ICM. The Markush structure
is prepared for enumeration.
-
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EnumerateLibrary - Step 1: Choose the menu option
Chemistry/Combinatorial Chemistry/ Enumerate by Scaffold/Markush.
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Results Table The enumerated library will be displayed in anew

chemical table.

10.4.9 How to decompose a library based on a

Markush structure.
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Read in the SDF Fileto be decomposed. A prepared ICM file containing
COX-2 inhibitors with a common scaffold and activity data can be
downloaded from here: ft p: // ft p. nol sof t . coni pub/ wor kshop/ (1. cut and

paste the address into aweb browser. 2. Right click on

COX2_Decomposition_Example.ich and choose "Save Link As'. 3. Open the

.icbinTCM File/Open).”

10.4.9 How to decompose a library based on a Markush structure.

[ Read in Chemicals to Decompose
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Create Markush Structure Table Save the Markush structure to a new
chemical table.
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Results Table. The decomposition data will be displayed in a new table.
Y ou can sort the columns by Actitiy or R-Group. The R-group

decomposition can also be used to build more complex
described her e.

SAR tables as

10.4.9 How to decompose a library based on a Markush structure.
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10.4.10 How to enumerate a chemical library by
reaction.
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reaction. (3)
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How to enumerate a chemical library by

reaction. (4)

1. Enter the names of the tables with
your reactantsand a new table
called “react_results” will be
displayed with your new library
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10.4.11 Detecting Activity Cliffs

There are two methods to detect activity cliffs Mat ched Pai r and
Structure--activity | andscape index(SALI).

10.4.11 Detecting Activity Cliffs
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TheMat ched Pair Anal ysi s performs Maximum Common Substructure search on
various pairsto find one-point variationsin R-group. It returns a

chemical spreadsheet with the delta differencein Activity and a score

which is a combination of delta activity and size of R-group therefore

looking for smaller R-groups with bigger activity difference.

-

S5l A2 DeaRo0 o f Load in example sdf file containing inhibitors and activity data from ChEMBL.

Fidp Tooly Idie View 8

PBEC L OC BR0

[ 1. File/Open sDF ]
_,\-“‘ ll‘_}/
;’_"i;{ e
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Read in Activity Data A prepared ICM file containing COX-2 inhibitors

with a common scaffold and activity data can be downloaded from here:
ftp://ftp.nol soft. com pub/workshop/ (1. cut and paste the address into
aweb browser. 2. Right click on COX2_Decomposition_Example.icb and

choose "Save Link As'. 3. Open the .icb in ICM File/Open).
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— : e [ Run Matched Pair Analysis (MMP /MPA)
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*{Matched Pair Analysis Results} A table of the results will be
displayed - you can sort by score. The plot is displayed activity 1
versus activity 2 colored and sized by score (red is better). The plot
and the table are linked so a selection in one is propagated to the
other.

e
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Results Analysis The top scoring comparison shows that the addition of
amethyl group significantly improves activity. Y ou can also add

filtering e.g. R1_2 filter and select methyl groups - right click on

column header and choose filter.

The SALI method developed by John Van Drie s calculated using chemical
distances and activity and can identify different changes compared to

MPA.
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ot Structure--activity landscape index (SALl):
identifying and guantifying activity cliffs,
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Structure--activity landscape index (SALI): identifying and quantifying
activity cliffs. Use the menu option Chemistry/SAR Analysis/SALI.
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SALI Results A fully interactive table and plot is returned contammg
the SALI index.
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Results In this example the fluorine movement around the ring affects
activity.
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7.8
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3.7.8
7.
3.
3.

8
1.14,5. 16,
7.2

Index

labelOffset, 3. 7. 7
wrap Comment, 3. 7. 7
SLIDE.ignore Background Color,
3.7.4
Fog,3.7.4
SMILES, 7.1.2,7.2.4,7.4.12
Select Min Grad, 3. 7. 10
Show Res Code In Selection,
3.7.7
SureChEMBL, 3. 2. 4
Swissprot, 2. 5. 1. 7
Dat,3.7.2
link, 8. 1. 39
Temp Directory, 3. 7. 2
USER.email, 3. 7. 11
friends, 3. 7. 11
full Name, 3. 7. 11
organization, 3. 7. 11
phone, 3. 7. 11
Uniprot, 8. 1. 39
Van Drig, 7. 30. 4
Label Style, 3. 7.7
Water Radius, 3. 7. 10
Wire Style, 3. 7. 1
XPDB Directory, 3. 7. 2
Xstick, 2. 6. 1

abright, 2. 6. 2

acceptor, 7. 4. 9
active, 6. 7
activelCM, 6. 8
activeicm, 6. 7,6. 12, 6. 14,
6.14.1

advanced, 6. 14

background images, 6. 15

control, 6. 13
activeicmjs, 6. 16
activity cliff, 7. 30. 4,7. 30. 5,
10.4. 11

tutorial, 10. 4. 11

activityy, 8. 6
add database, 7. 9. 3

new data, 7. 3. 7
adding fragment, 7. 4. 8

in editor, 7. 4. 8

administration, 7. 9. 5
abum, 5. 15. 3
dias, 7. 4.5
align,3.1.11,7.13

color 2D scaffold, 7. 13

alpha, 2. 6. 2
channel, 3. 7. 6
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amidinium, 7. 14 images activeicm, 6. 15
amino acid, 3. 3 image, 5. 4. 3
acids, 7. 4. 6 backup, 2. 5. 2. 11
anaglyph, 5. 6 bad, 7. 10
analysis, 2. 5. 4 groups, 7. 4. 9
gr?gllg,.% 5.7,4.5.8,5.8.5,5.9, ball, 3. 7.5
animate, 2. 5. 3. 15,5. 10. 7 and stick, 2. 6. 1
view,5. 10. 7 baloon, 8. 4. 24
animation, 5. 10. 7. 1,5. 10. 7. 2,
5.10.7.3,5. 10. 7. 4 bases, 7. 4. 6
store, 5. 10. 7. 4 basicsdl, 3. 6. 2
animations, 6 best, 7. 3. 34
annotate, 3. 6. 21,7. 12 bicyclics, 7. 4. 6
by substructure, 7. 12 binding properties, 5. 3. 1
plot, 8. 4. 22 bioinfo menu, 2. 5. 4
antialias, 2. 5. 1. 15,2.5. 3. 10 bioisoester, 7. 8
lines, 2. 5. 3. 17 bioisostere, 7. 8,7.8.1,7.8. 2
lines, 2. 5. 3. 17 biological, 4. 3. 3
biomolecule, 2. 5. 5, 4. 3. 3,
apf, 4. 4.6 10. 3. 8, 10. 3. 12
append, 8. 1. 43 blast,3. 2. 5
table, 8. 1. 43 search, 3. 2. 5
rows, 2. 5. 10. 7 ?OT’ foz. 3,4.2.3.1,4.2.3. 2,
area, 4.5.3,4.5.13,10.3.5 bonding, 5. 1. 8
aromatic, 7. 3. 28 preferences, 3. 7. 1
arrange, 3. 1. 13. 1 box,3.7.7,5.8.15
window, 3. 1. 13. 1 browse, 7. 3. 31
as2 graph, 3. 6.5 mode, 7. 3. 31
assign,5. 1. 3 molt, 9. 2
2D coordinates, 7. 16. 1 build, 5. 10. 7. 1
atom,3.7.5,7. 3. 28 buttons, 6. 14
atomL abelStyle, 3. 7. 7 bye, 2. 5. 1. 19
atomic property fields, 4. 4. 6 alpha, 5. 1. 10
attachment, 7. 4. 3,7.5. 1 trace, 5. 1. 10
point, 7. 29. 4 catrace 5. 1. 10
author,3.2.1. 3 cache 6. 14. 1
closetree, 7. 22. 5 caculate, 7. 10
play dide, 6. 13 properties, 7. 10
ave 8.7.1 carboxylic acid, 7. 14
avi,5.16,5. 16. 2 cavities, 4. 5
axes, 8. 4. 14 closed, 4. 5. 4
axis, 8. 4. 10 cel,4.3.2
. center,2.5.3.20,3.1.3,5.12,
options, 8. 4.9 5.12.5,8. 1. 39
grid, 8. 4. 9 o ;\nd2 representative members,
range, 8. 4. 9 change height of al rows, 8. 1. 6
title, 8. 4. 9 row height, 8. 1. 6
b-factor, 4. 5. 12,10. 3. 10 selection, 3. 6. 7
backbone, 5. 1. 10 speed range, 5. 10. 7. 2

charge, 2. 5.3.21,5.8.2,7.4. 3,

background, 5. 4. 2,5. 4. 3 751
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chembl,3.2.3,3.2. 4
chemical, 7,7. 3. 28, 7.
7.3.31,7.3.34,7. 3.

export excel, 7. 2. 3
save, 7. 2

3D,7.2.5

editor, 7. 2. 4
image, 7. 2. 6
table, 7. 2. 2
view, 7. 3. 28
3. 2.
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spreadsheet tutorial,
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edit buttons, 7. 4. 11
editor, 7. 4,7.4. 8
fragments, 7. 3. 33
group, 7. 4.5
groups, 7. 4.5,7.4.8
modifiers, 7. 29. 2
properties, 10. 4. 4
right click, 7. 4. 3
search, 7. 5
filter, 7. 5. 2
text,7.5. 4
sketch, 10. 4. 1
space, 7. 24
spreadshest, 3. 2. 3,7. 1. 3,

.3.1,7.4.14,10. 4.1

compare, 7. 3. 22
template, 7. 3. 2
spreadsheets, 7. 3
substituent, 7. 8
substructure, 3. 2. 1. 1
tabledisplay, 7. 3. 3
tables, 8. 2
toxicity, 7. 10. 2
append, 7. 4. 13
clustering, 7. 22,7. 22. 1
draw,7.4.1
duplicates, 7. 3. 21
editor, 7. 2,7.2.2,7. 2. 4,

.2.5,7.2.6

load, 7. 1

merge, 7. 26
new,7.4.1
properties, 7. 3. 19
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7.5.3
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7.5.1,7.5.3
Spreadsheet, 7. 2,7. 2. 2,
7.2.4,7.2.5,7.2.6,7.3
structure, 7. 4. 13
table, 7. 3,8. 2
cheminformatics, 7, 7. 3
tutorias, 10. 4
chemistry, 7. 18

convert, 7. 16

pca, 7. 23

smiles, 7. 16. 2
duplicates, 7. 27
remove.redundant, 7. 27

chemspace append, 10. 4. 4. 4
build visualize, 10. 4. 4. 1
compare, 10. 4. 4. 8
deleterow, 10. 4. 4. 3
distinguish, 10. 4. 4. 7
export,10. 4. 4. 5
project, 10. 4. 4. 6
select, 10. 4. 4. 2

chi,5.8.5

chird, 7. 19

chirdlity, 7. 19

clash,3.7.5,5.8.14

classes, 7. 3. 28

clear display and planes,

2.5.3.2
selection, 3. 6. 6
planes, 2. 5. 3. 2

click,3.1.12,5.11,5. 12

clip,5.3.10,5.13. 1

clipboard, 5. 15. 3,8. 7. 3

clipping planes, 5
tool, 5. 13
tools, 5. 13

clong 2.5.1.2

close, 5.3.3,5.3. 4
downstream cluster, 7. 22. 5
cavities, 4. 5. 14

cluster,8. 7. 1

representative.center,
7.22.2
clustering, 8. 7,10. 4. 3
cns, 7. 28
collada, 2. 6. 6, 5. 3.
color, 4. 5. 11,5. 3. 2,5.
5.3.4,5.3.9.4,5
5.8.2,5.8.3,7.3.
8.1. 44 8.7.4
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surface by proximity, 5. 3. 3 pdb, 10. 3. 2

selection, 5. 3. 4 local.database, 2. 5. 1. 6
smiles, 7. 16, 7. 16. 2,
table, 7. 3. 27 7 16.3
2D sketch, 7. 5.5.5 converting pdb, 4. 1. 2
background, 2. 5. 3. 18,5. 4. 2 coordinates, 7. 1. 3

copy, 7. 3. 25,7. 4.11,7. 4. 17,

distance, 5. 8. 10 7.5.5.2.8.1. 34

mesh,5.3.9.3 cel, 8. 1. 35

table, 7. 3. 27 chemical, 7. 3. 25
coloring, 5. 4. 1 pasterow, 8. 1. 34
coloumn, 8. 1. 24 row, 8. 1. 35
column, 8,8. 1. 21, 8. 1. 38,
8.1.39,8.4,8. 4 1 rows, 8. 1. 43

annotation, 8. 1. 40 selectionto table, 8. 1. 36

order, 8. 1. 28 chemical, 7. 3. 16

row width, 8. 1. 21 cpk,5.1.5

statistics, 8. 1. 31 crash,2.5.2.11

visibility order, 8. 1. 27 creat, 6. 6. 1

color,8.1.9 create, 8. 1. 1

hide, 7. 3. 8 markush, 7. 29. 3

show, 7. 3. 8 new objects, 3. 3
combinatorial chemistry, 7. 29 cross section, 5. 13

library, 10. 4. 8 crystal, 4. 3. 2
combine, 2. 5. 10. 5 crystallographic analysis, 4. 3

display style, 3. 7. 9 biomolecule, 4. 3. 3
compact tree, 7. 22. 5 contour map, 4. 3. 6
compare, 7. 3. 29,7. 25,7. 26 convert2grid, 4. 3. 7

crystallographic cell,

table, 7. 3. 22 4.3 2

tables, 7. 25 load eds, 4. 3. 4
compatible, 2. 5. 1. 10 mapscell, 4. 3. 5

symmetry packing,

complex, 7. 6 4.3 1
compound, 3. 2. 1. 3,7.18,8. 2 tools, 10. 3. 8
compress, 3. 7. 6 cel,2.5.5
conditions, 7. 5. 2 neigbor, 4. 3.1
conformational entropy, 7. 21 neighbors, 2. 5. 5
connect, 5. 3. 9. 1,5. 12,5. 12. 7 crystallography, 4. 3. 4,4. 3. 6,

object, 5. 12. 7 csv,7.2.3,8.1.2,8.1.3,8.1.20
connectivity, 7. 4. 3,7.5. 1 current.slide, 6. 13
construct,2.5.1.1,5.10.7.1 curves, 8. 4. 5

molecule,2 5.1.1 custom, 5. 12,7.3. 3

object,2.5.1.1 actions, 8. 1. 39
contact, 4. 5,4.5.3,10. 3.5 fragments, 7. 12

surface 5.3.2 label, 5. 8. 8
contacts, 5. 3. 3,5.3.4,7.6 rotation, 5. 12. 2
contour, 4. 3. 6,4. 3. 7 cut, 8. 1. 34
convert,4.1.2,7.16. 4 database, 7. 9,7.29.4,9. 1

chemlcal 7.3.24 decompose.library, 10. 4. 9

3D molecular editor, decomposition, 7. 29. 4,7. 30. 1,

7.4.16 8.4.23

local database, 2. 5. 1. 6 default, 3. 1. 13
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dl,2.5.2.2 display.macroshape, 2. 6. 6

columnrow, 8. 1. 37 molecule, 7. 3. 24
label, 5. 8.9 origin, 5. 8. 11
al,2.5.2.2 potentia, 2. 5. 3. 21
anglelabel, 5. 9. 4 representations, 2. 6. 1
column, 8. 1. 37 restraints, 5. 8. 13
distancelabel, 5. 9. 4 ribbon, 5. 1. 3
label, 5. 8.9 skin, 5. 1. 4
row, 8. 1. 37 surface, 5.1.6,5.3. 1
selection, 2. 5. 2. 1 surfaces, 2. 6. 6

dendrogram, 7. 24. 1 table, 7. 3. 3

density, 4. 3.4,4.3.6,4.3.7 tethers, 5. 8. 12

depth, 5. 3. 12,5. 10. 5 wire, 5. 1.1

didog, 6. 6.5 xstick, 5. 1. 2

- distance, 4. 5,4. 5. 6,5. 8. 10,

diffuse, 2. 6. 2 5.9 7.25

dihedral, 4. 5. 8,5. 8.5 label, 3. 7.7
angle, 4. 5 distances, 2. 6. 3

directories preferences, 3. 7. 2 diverseset, 8. 7

directory, 3. 7 docking, 4. 5. 13

dislay ligand receptor document, 6. 6. 4,6. 6. 5

interaction, 7. 6
display, 3.1.4,3.1.13.1,3. 7,

4.2.3,4.2.3.1,4.2.3.2,5.8. 14, navigation, 6. 6. 7
5.14,7.19
delete distances, 5. 9. 4 documents, 5. 15. 3
dihedral, 5. 9. 3 donator, 7. 4. 9
distancerestraints, 5. 8. 13 envelope, 2. 6. 1
distance2, 5. 9. 1 surface, 3. 7. 5
angles, 5. 9 dotted line, 5. 1. 3
formal charge, 5. 1. 9 double, 7. 4. 10
gradient, 5. 8. 16 doublet, 7. 4. 7
hydrogen, 5. 1. 7 grag 3:1 1.11,3.7.7,5.8. 3,
mesh, 5. 3.5 residuelabel, 2. 5. 3. 16
meshes, 5. 3. 8 draganddrop, 3. 1. 11
planar angle, 5. 9. 2 draw,7.4.17,7.29.5
tab, 2. 6.1 chemical, 7. 4. 1
tether, 5. 8. 12 drop,3.1.11,6.6.4
toggle, 5. 8. 15 drug, 7. 10
CPK,5.1.5 bank, 3.2,3.2.8,7.1
angle, 5. 9. 2 drugbank, 7. 1
chemical, 7. 3. 3 druglikeness, 7. 4. 9
dihedral.angle, 5. 9. 3 dsPocket, 3. 1. 8
distace, 5. 8. 10 easy rotate, 2. 5. 3. 12
distance, 5. 8. 13,5.9. 1 edit,4.2.3. 1
electrodtatic, 2. 5. 3. 21 chemical moledit, 7. 3. 26
energy.gradient, 5. 8. 16 ligand tools, 2. 5. 2. 17
hydrogen, 5. 1. 7 menu, 2. 5. 2
polar,5. 1. 7 molecular document, 6. 6. 1
macroshape, 5. 3. 6 molecule, 7. 4
meshes, 5. 3. 5 molt, 9. 3
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dide, 6. 4.1
tablerow, 8. 1. 23
molecule, 7. 3. 26
structure, 7. 3. 26
editpdbsearch, 2. 5. 2. 12
eds, 4.3.4,4.3.6,4.3.7
eectron, 4. 3.4,4.3.6,4.3.7
denisty map, 4. 3. 5
densitry map.contour, 2. 5. 5
map,2.5.1.7,2.5.5,
4.3.4,4.3.6
electrostatic potential,
2.5.3.21
surface, 5. 3
electrostatics, 5. 3. 1
elegant sketch, 5. 10. 4
element, 7. 4. 10
embed browser, 6. 11
powerpoint03, 6. 8
powerpoint07, 6. 9
powerpointl0, 6. 10
activeicm, 6. 13

script, 6. 13

browser, 6. 7,6. 11
firefox, 6. 7,6. 11
internet.explorer, 6. 7,
6.11
microsoft, 6. 7
powerpoint, 6. 7,6. 8,6. 9,
6.10
energy,4.5.11,5.8.14,7. 21,
7.21.2
entropy, 7. 21. 1
enumerate formal charge states,
7.15
reaction, 10. 4. 10
enumeration, 7. 29. 4
eps,7.2.6
eraser, 7. 4. 11
exact, 7. 25
excd,7.2.3
exclude fragment, 7. 5. 2
exit,2. 5. 1. 19
explicit, 7. 3. 28
export, 4. 5. 10
extrawindows, 5. 2
extract,3.4.2,7.1. 3
2D,7.1.1
3d coordinates to
spreadshest, 7. 1. 3
icb,2.5.1.5
objectich, 3. 4. 2
icb,2.5.1.5

pharmacophore, 7. 5. 5. 4

file,2.5.1. 3
close, 2.5.1.13
compatible, 2. 5. 1. 10
export,2.5.1.12
high quality image, 5. 15. 1
load,2.5.1.7
menu, 2. 5. 1
password, 2. 5. 1. 11
preferences, 2. 5. 1. 16

quick image, 2. 5. 1. 14

icb, 3. 1. 10

recent,2. 5. 1. 17

bak,2.5.2.11
filter, 9. 2

selection, 3. 6. 8
find chemical, 7. 3. 32
fit, 7. 3. 34
fitting, 8. 4. 15
flexibility, 4. 5. 12
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preferences, 3. 7. 7
formview,8. 1.5

formal charge, 5. 1. 9,7. 14,7. 15

format, 8. 1. 2,8. 1. 39
formula, 7. 4. 9,7. 10

fragment, 7. 3. 35,7. 30. 1
fragments, 7. 7
freeradical, 7. 4. 7

freeze column, 8. 1. 29
row, 8. 1. 30

frequency, 7. 3. 35

front, 5. 3. 10,5. 13. 1

full scene antiaias, 2. 5. 3. 10
screen, 2. 5.3. 8

function, 8. 1. 25,8. 1. 31

functional .groups, 7. 12

genera preferences, 3. 7. 5

generalselecttools, 3. 6. 1

generator, 4. 3. 3

getting started, 3

glasses, 5. 6

google, 2. 5. 1.7

objects, 5. 3. 7
3D,2.6.6,5.3.7
graphical display tutorial, 10. 1
2D3D labels,
10.1.4
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color
representation, 10. 1. 1
labels,
10.1.3
graphics, 3. 1
controls, 5
effects, 5. 10
pandl, 5. 2
preferences, 3. 7. 3
shadow, 2. 5. 3. 13,
5.10.2
orid, 7. 3. 3
grob, 3. 7.5,4.3.4,4.3. 6,
4.3.7,5.3
group, 7. 30. 1
column, 8. 1. 45
groups, 7. 7,7.10,7. 11
guanidinium, 7. 14
Qui,3.1.1,3.7.4
menus, 2. 5
preferences, 3. 7. 4
tabs, 2. 6
h-bond, 4. 2. 3,4. 2. 3.1,
4,2.3.2
halogen, 7. 10. 1
hardware stereo, 2. 5. 3. 7
hbond, 4. 2,10. 3. 6
header, 3. 2. 1.6,8. 4.8

hedlth, 4. 5. 11
heatmap, 8. 4. 6
example, 8. 4.6. 1
help, 1
videos, 1
hetero, 7. 3. 28
hide, 8. 1. 38
column, 8. 1. 27
high,2. 5. 1. 15

quality, 2. 5. 3. 11

highlight new data, 7. 3. 7. 1

histogram, 8. 4, 8. 4. 1,
8.4.8,8.4.10,8.4.12,
8.4.13,8.4.14,8.4.15,
8.4.16,8.4.17,8.4.19,
8.4.21

bins, 8. 4. 3
options, 8. 4. 2
bin.size 8. 4. 2

bins, 8. 4. 3
color, 8. 4. 2

source, 8. 4. 2
style, 8. 4. 2
title, 8. 4. 2

homology, 3. 2.1.2,3.2.5
hover, 8. 4. 24
add columns, 7. 3. 4
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color 2D by ph4,7.5.5. 5

copy 2D, 7. 3. 16

paste, 7. 3. 6
decompose, 10. 4. 9
duplicate chemicals, 7. 3. 21
edit table, 7. 3. 17

tree, 7. 22. 4

excd, 7. 3. 10
extract 3D ph4, 7. 5. 5. 4
filter, 7. 3. 12

find replace, 7. 3. 13
mark row, 7. 3. 14
markush, 10. 4. 8
structure, 10. 4. 7
mergetables, 7. 3. 23
properties, 7. 3. 19
reactions, 10. 4. 10
reorder, 7. 22. 3

sdf, 7. 3. 9

show hide, 7. 3. 8
sort column, 7. 3. 5
standardize, 7. 3. 18
table hyperlinks, 7. 3. 15
print, 7. 3. 11
activeicm, 2. 3
create molecular
documents, 2. 3. 3
dlides, 2. 3. 2
getting started, 2. 3. 1
ppt, 2. 3. 4
web, 2. 3.5
chemical clusering, 7. 22. 1
icm browser convert display
pocket, 2. 1. 4
distances angles,

2.1.9
get started,
2.1.1
graphical
display,2. 1. 2
effects,
2.1.5
images, 2. 1. 7
labels
annotation, 2. 1. 6
pro
crystallographic tools, 2. 2. 6
get started,
2.2.1
graphics,
2.2.2
plots, 2. 2. 8
sequence
analysis, 2. 2. 7
structure
analysis, 2. 2. 3
superimpose,
2.2.5
surfaces,
2.2.4
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cluster center, 7. 22. 2 selections, 2. 1. 3
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search, 3. 2 instal, 7. 9. 1

usegui, 3.1 interaction, 4. 5. 3,7. 6
gtnél, % 5.1.12,3.3,6.6. 1, interactive, 10. 2
hybridization, 7. 4. 3,7.5. 1 interrupt, 5. 10. 7. 3
hydrogen, 4. 2. 3,4. 2. 3.1,
4,2.3.2,5.1.8,7.4.3,7.5. 1, animation, 5. 10. 7. 3
10.3.6
10°9d4.2,5.1.8.7. 6, invert selection, 8. 1. 22
label edit, 4. 2. 3. 1 isee, 6. 6.5
move, 4. 3 2 isis, 7. 4. 17
bonds, 4. 2. 4 isotope, 7. 4. 3,7.5.1
bond, 7. 4. 9 iupac, 7. 2. 7,7. 3. 20
hydrogens, 7. 3. 28 javascript, 6. 16
remove, 7. 3. 18 join, 7. 26
hyperlink, 6. 6. 1,6. 6. 2,8. 1. 39 jpg, 5. 15
iSee,2.5.1.5,2.5.1.12,3. 1. 10,
5.15.3.10. 2 means, 8. 7. 1
ichb,3.4.2,3.5 key chemical, 7. 4. 10
Sea(r:g(]arglstdfho;vto chemical keyboard mouse, 5. 11
cluster,2. 4.5 keystokesin chem-edit, 7. 4. 10
, 4 5 COmbiiibrary, kmz,2.6.6,5. 3.7
phd,2. 4. 4 label,3.7.7,8.7.4
plots, 2. 4. 8 atoms, 5. 8. 2
sketch, 2. 4. 1 color,5. 8.7
242 spreadsheets, move, 5. 8. 4
stereoisomers ;
tautomers, 2. 4. 6 resaues, 5. 8. 3
tutorials, 2. 4 Sites, 5. 8. 6
object, 4. 1,10. 3. 2 variables, 5. 8. 5
script, 8. 1. 39 2D,2.6.3
icmPocketFinder, 4. 5. 14 3D,2.6.3,5.8.1
icmjs, 6. 16 atom,5. 8.1
icmpocketfinder, 10. 3. 7 atoms, 5. 8. 2
id, 8. 1. 26 color,5. 8. 7
identity, 3. 2. 1. 2 custom, 5. 8. 8
image311437375
5.15.3,6.6.3,7.2,7. 2.6, delete,5.8.1,5.8.9
8.4.20
advanced, 5. 15. 3 distance, 5. 8. 10
preferences, 3. 7. 6 drag, 2. 5. 3. 16
multiple, 2. 5. 1. 7 move, 2. 5. 3. 16,5. 8. 4
quality, 2. 5. 3. 11 residue, 5. 8. 1
quick, 2. 5. 1. 14,5.15. 2 residues, 5. 8. 3
images, 5. 15 site,5.8.1
inchi, 7. 16. 2 sites, 5. 8. 6
increment, 8. 1. 26 variable, 5. 8. 1
id, 8. 1. 26 variables, 5. 8. 5
insert, 6. 6. 4 labeling, 5. 8. 1
column, 8. 1. 25 labels, 5. 8,7. 3. 28
image, 6. 6. 3,8. 1. 33 distances, 5. 8. 10
table, 8. 1. 33 tab, 2. 6. 3
row, 8. 1. 32 landscape, 3. 7. 6
script, 6. 6. 4 large chemical space, 10. 4. 4
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layer, 5. 14 make, 5.10.7.1,8.1.1

layers, 5. 14 animation, 5. 10. 7. 1
learn, 7. 17,8. 6 molecular document, 6. 6
least.squares, 8. 4. 15 molt, 9. 1
library, 7. 29. 4 selection, 3. 6

reaction, 10. 4. 10 molecule, 2. 5. 1.1

ligand, 4. 2.2,7.6,7. 21,

7.21.1,7.21.2 object,2.5.1.1

code, 3.2.1.3,3.2.7 making molecular dides, 6. 1
editor preferences,
2.5.2.18 html, 6. 6
energetics, 7. 21 color, 8. 4. 13
conformational
entropy, 7. 21. 1 map,3.7.7,4.3.4,4.3.6,4.3.7
strain, 7. 21. 2 ce,4.3.5
pocket, 4. 2. 4 mark, 8. 1. 44
receptor display, 4. 2 row, 8. 1. 44
interaction, 7. 6 shape, 8. 4. 12
surface, 4. 2. 2 Size, 8. 4. 12
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